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Welcome to Micetro by Men&Mice, a backend-agnostic DDI orchestration software for complex enterprise network
environments.

Deployed in any on-premise, hybrid, or multicloud network environment, Micetro acts as a non-disruptive overlay that
unifies server management under a single GUI and API. Micetro is a modular, software-defined DDI solution built
around a number of components, and accessed through a unified user interface and API.
This documentation is divided into four parts:
1. Implementation Guide
2. User Manual
3. admin-overview
4. Micetro reference articles
Use the Implementation Guide to familiarize yourself with Micetro’s architecture and installation procedures for components on different platforms. The User Manual covers all of Micetro’s functionality. admin-overview is aimed at
system administrators managing Micetro.
Tip: Use the search function for quickly locating the information required.

Note: For how-to articles and troubleshooting, see Micetro reference articles or visit the Knowledge Base.

Note: If you’re using version 9.2 or older of the Men&Mice Suite, refer to the documentation on https://cdocs.
menandmice.com/display/MM/Documentation+Home.
The documentation is open-source, under a modified MIT license (see docs-license), and you’re welcome to file issues
and improvements on GitHub.
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1.1 Release notes
Note: Major releases are supported for 2 years.
Jump to: 10.1, 10.1.1, 10.1.2, 10.2, 10.2.1, 10.2.2, 10.2.3, 10.2.4, 10.2.5

1.1.1 10.2.5
November 29, 2022
Bug Fixes
• Fixed a bug where CNAME and TXT records would sometimes be removed when they shouldn’t while clearing
IP addresses.
• Fixed an issue where some auto suggestion fields would auto select the first suggestion.
• Fixed a bug where the quickfilter showed the value [object Object] when searching for a partial string of the word
“object”
• Fixed a problem with BIND possibly getting stuck when doing a logrotate if the appliance was configured to
send the system log messages to a remote server.
• Accessibility improvements in the UI

1.1.2 10.2.4
Improvements
• Fixed BIND v9.16 vulnerabilities on the Micetro appliance addressed in CVE-2022-2795, CVE-2022-2881,
CVE-2022-2906, CVE-2022-3080, CVE-2022-38177 and CVE-2022-38178
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1.1.3 10.2.3
July 5, 2022
Improvements
• Micetro now detects, and reports, if Microsoft Server 2022 is the installed operating system.
Note: Microsoft Server 2022 is now supported in versions 10.2.3 and up

Bug Fixes
• Fixed a bug where all DHCPv4 client identifiers were forced to MAC on Kea
• Fixed a bug regarding the $GENERATE directive in BIND configs
• Fixed a performance regression when viewing object history in large Micetro databases
• Fixed disappearing values in scope options while hostnames are being resolved
• Logging was improved to not include sensitive information when editing AD Forests, Users, and Cloud Services
• New API commands to create and get reservations from ranges.
• Various accessibility improvements were made to the Web Application

1.1.4 10.2.2
March 16, 2022.
Bug Fixes
• Fixed BIND v9.11 and v9.16 vulnerabilities on the Micetro appliance addressed in CVE-2021-25220 and CVE2022-0396 from ISC

1.1.5 10.2.1
March 8, 2022.
New Feature
• Users with manage access permissions can view and manage access for multiple objects at the same time.
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Improvements
• User can select to inherit parent access when managing access for multiple networks
• Failed login attempts are now throttled to prevent brute force attacks
• Admin users can now change custom property types when editing custom properties (except for Yes/No properties)
Bug Fixes
• Cisco DHCP remote reservation issues fixed when MAC addresses are missing
• Users are able to more easily reorder property columns in the grid of the Web UI
• Editing reservations for split scopes now appropriately modifies the reservation for all servers
• Deleting reservations for split scopes now appropriately deletes reservations for all servers
• Custom properties modified with change requests from DNS Workflow are now properly logged in audit history
• Requiring definition of custom properties which are children of optional properties is no longer possible
• Setting DHCP boot-file-name option is now supported on Kea
• An issue with editing large Kea configuration files is now fixed
• Fixed a problem where users were unable to bulk import DNS data when there are required custom fields on
DNS record level
• Resolved a problem where RPZ zone records can’t be edited in the web UI
• Web UI no longer shows error in server page when system does not have an active IPAM license
• An issue was fixed where an incorrect error message was displayed when login failed
• Multiple minor improvements and fixes to enhance user experience

1.1.6 10.2
February 3, 2022.
New Features
• DHCPv6 Management: Enjoy the same level of management and visibility for dynamically allocated IPv6 addresses as you have with IPv4 and DHCP in your Windows environments. Toggle DHCPv6 management on or
off by server or enable it on multiple servers at once.
• Custom Property Management: Custom Properties can now be managed through the Micetro web interface.
Create searchable fields to track information about your DNS zones, DNS records, DHCP scopes, networks, IP
ranges and other objects in Micetro. There are two Default Custom Properties built in to the Range object type
that come with Micetro which are Title and Description.
• HA Management: Administrators can now manage High Availability for Micetro Central by adding servers,
defining priority, and executing failovers via the Web UI.
• Reconcile DHCP Scopes: Manage DHCP scope reconciliation for Microsoft DHCP server from the Micetro
Web UI to ensure consistency between the DHCP database and DHCP registry.

1.1. Release notes
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Updates
• Microsoft has deprecated support for Windows Server 2008 R2 and therefore Micetro will no longer support this
Operating System
• Microsoft has deprecated support for SQL Server 2008 R2 and therefore it will no longer be supported by Micetro
• Micetro will no longer support the 32-bit Linux Operating Systems
Improvements
• Users are now able to create DHCP split scopes in the Web UI for both DHCPv4 and DHCPv6
• When hovering over the folder icon next to a network or DNS zone, the tooltip now shows the full folder path
when an object is in a subfolder
• NAPTR records are now supported in AWS Route53
• Colons are now supported when entering hex values in the UI. For example “f1:04:0a:03:e0:0a” is now accepted
as an appropriate entry for a field which requires hex.
• Admins may now manually specify a BIND user or BIND group when deploying Micetro to work with BIND
• Folders are now sorted alphabetically in the left sidebar
• The email support address shown under licensing support and error messages is now consistently the same address
• When deleting a folder the folder name is now shown in the popup message confirming deletion
• Improved the order of permissions to be consistent among multiple dialog boxes
• When performing an action on multiple objects, task names are now displayed in plural form
• Read-only Active Directory sites are not shown any longer in the dropdown for setting AD Sites for DHCP scopes
or IP ranges
• When there are no DHCP or DNS servers present, the information shown reflects the empty state with helpful
information
• For a zone or network that is contained within a folder, users can now click on the folder icon next to that object
to view a list of all other objects contained within that folder. Hovering over that folder icon still shows the name
of the folder.
• When editing DHCP options to enter a subnet mask value, the IP insight information is no longer displayed as it
is when entering IP address information
• Users are no longer given the option to manage read-only forests under AD Sites
• Users with correct permissions may now perform a bulk action of unblocking multiple roles at the same time.
• When running reports users may now specify which DNS servers to include in the filter so as to avoid duplicate
information within the report from redundant or testing servers for example.
• By default, when there are no additional address spaces to the default address space, permissions will automatically be assigned to the default address space. When there are additional address spaces, then permissions will
need to be managed specifically for each address space.
• When editing a user under the Admin>>Configuration tab the user name will now be displayed in the dialog box.
• Users may be authenticated with read-only domain controllers by setting the ReadOnlyDC preference value.
• Reserved and Leased IP address states are now filterable/sortable in the IPAM grid for a network
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• The API call GetAvailableAddressBlocks will now claim subnets for a short amount of time so they can’t be used
by others
Bug Fixes
• Editing a record in an AD integrated zone will no longer create duplicate records by leaving the old record in the
zone
• DHCP Option 43 is now stored as Hex value instead of ASCII making it possible to configure option 43 for ISC
DHCP users.
• If the BGPD service is enabled on DDI appliances it will now start automatically after a restart of the appliance
• Increased the size of the externalID column in the mm_users db table to fix an issue where users with longer
usernames couldn’t login
• In the “Delete Zone” dialog box, when master zones are selected, other unrelated zones are no longer selected
as well.
• Double clicking on the meatballs menu of a row in the IPAM or DNS grid only opens menu options instead of
following the behavior of double clicking on the row itself to open the properties
• Hovering over an action button in the inspector on the right side of the Web UI no longer displays two tooltips.
• Improved error message is now shown when a user tries to rename an SNMP profile with a name that already
exists.
• Labels in the Change Request dialog box under Workflow have been enlarged with legible text
• It’s now possible to create multi-string TXT records
• Filtering scopes by server no longer shows scopes from unrelated servers
• Next button will now appear so users may move forward when editing reports to adjust the utilization percentage
in the Reports Wizard
• The admin page in the Web UI is no longer visible to those without privileges
• Improved indicator display of subranges inside range folders
• Improved error message shown when a user tried to rename an SNMP profile with a name that already exists
• When using a REST call to add a DHCP reservation the reservation will now be added to the active and failover
scope in the case that failover has been configured
• Long DHCP reservation names no longer cause errors when sending requests to the servers
• Renaming Azure accounts without re-entering the client secret management account credentials is now allowed
• Multiple minor improvements and fixes to enhance user experience

1.1.7 10.1.2
December 15, 2021.

1.1. Release notes
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Improvements
• Messages when no folders are present under DNS or IPAM are now more human readable and informational.
• Links within the Micetro Management Console and Web UI now direct readers to updated documentation.
• Consistent format shown for read-only Active Directory Sites in all dropdown menus.
• Error message that appears when trying to change an SNMP profile name to an existing name has been improved
to be more informational.
Bug fixes
• There’s no longer a syntax error that pops up when modifying text records that contain data fields over 255
characters.
• Admins will be able to add AD groups in the Web UI when AD Sites and Services feature has been disabled.
• Selecting A or PTR records no longer intermittently causes unnecessary data fetching from server.
• “PTR Status” column will now always show correct status for IP addresses.
• NAPTR records are now correctly formatted before being sent to AWS Route 53.
• Filtering scopes by server no longer shows scopes on unrelated servers with similar names. Your bulk clean-up
operations are safe again!
• Accurate informational error message pops up when trying to create a folder that already exists.
• Fixed alignment issue under Access column when creating/editing permissions list for new Roles.
• Correct SNMP profiles will appear when switching between Micetro Central platforms without having to refresh.
• Find Next Free Address command in the web UI glitched at times but is now guaranteed to work correctly.
• Expand/contract function when viewing nested CIDR boundaries, or “Tree View,” under the IPAM tab will work
as expected.
• Text for task in Groups under Access Control has been changed from “Remove User” to “Remove Group.”
• Create Network Wizard is now more intelligent when checking whether a range can be created.
• Fixed rendering issue in filtering sidebar where two items might appear to be selected at the same time.
• Column alignment in Import DNS Records” list has been corrected.
• TXT records that include quotation marks can now be created on Akamai and Dyn DNS.
• Fixed minor issues when adding, removing, and editing Active Directory Forests.
• Extra comma(s) in the IN operator in the API no longer returns “No Results.”
• Multiple minor improvements and fixes to make user experience better.
• Improved string validation in a number of API commands.
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1.1.8 10.1.1
October 27th, 2021.
• Fixed BIND vulnerability CVE-2021-25219 on the Men&Mice Virtual Appliances. See Security announcements
for details.
• Fixed an issue with upgrading to Micetro 10.1 with a Microsoft SQL 2008R2 or earlier database.

1.1.9 10.1
October 19th, 2021.
Important: Version 9.2 will no longer receive bug fixes and feature updates. Please update your Micetro to at least
version 9.3.

Known issues
New features
• New Access Control management: access controls in Micetro have been redesigned from the ground-up, and
provide a fully role-based, flexible management. Existing configurations will be converted into the new model
while preserving backward compatibility. Read Access control and Role-based access example for details.
• Folder management is now available in the Web Application. Users can organize DNS and IPAM objects using
traditional folders and customizable smart folders (saved filters) to quicken their workflows. “Smart people use
folders. Even smarter people use smart folders.”
• AD Sites and Subnets management has been streamlined and integrated into the IPAM context of the Web Application.
Improvements
• DNS administrators can manage preferred servers for DNS zones in the Web Application.
• SNMP profile management is available in the Web Application.
• A new slide-in help is available for many functions, offering further details on functionality and syntax for their
respective operations. Not a water slide in a theme park, but it is still weirdly satisfying.
• Micetro components will no longer display errors if they’re reporting different minor versions. We’re all one
family here.
• Users can import DHCP reservations to Micetro using the Web Application, including bulk import. Get yer CSV
goodness on!
• Lease names are searchable in the Quick Command. So you can have a better leash on them. (We’ll see ourselves
out.)
• Custom links can be added to the Micetro login screen.
• Improved subnet management, including splitting and merging subnets. Alchemy, almost; although no turning
iron into gold with Micetro. Yet.

1.1. Release notes
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Bug fixes
• Wildcard policies on AWS will display a descriptive error message (as they’re not currently supported in Micetro).
• Users can use relative time (i.e. >=-7d) in the Reporting module. Because time is relative, and E equals m times
c squared. Except in quantum, but let’s not sweat the small stuff.
• BIND installer will no longer get stuck during installation. Sticks and stones may break our bones, but stuck
things are just weird.
• DNS and IPAM data is properly updated when changing address spaces. Multiverse mixup, we’ve had words
with the Sorcerer Supreme.
• Using the Quick Filter properly highlights the query in the name column. As this is how it’s supposed to work,
this fix is a highlight to share.
• Using the ‘View scopes’ action on a DHCP server will properly show the scopes on the DHCP server. Because
it. Has. One. Job.
• Creating a scope on a Cisco DHCP server no longer fails randomly.
• No longer possible for the logged-in user to remove themselves. Word came down that it created a bunch of
variants that bottlenecked the TVA, and who needs that?
• Updating refresh times on SOA records will no longer fail with a cryptic error.
• Tooltips no longer appear erroneously on top of the screen after closing their window. They understand now that
they have to respect the boundaries of others, just like all polite UI elements do.
• Editing a DHCP pool will no longer result in a locked up dialog window due to illegal from/to address input.
• Converting a network to a DHCP scope will no longer have a missing field. It’s returned safe and sound, we can
take it off the milk cartons finally.
• Using the ‘View history’ action will no longer return an error message when a filter is applied.
• The ‘Reserve’ button will no longer disappear from the Action menu. This type of hide-and-seek is not appropriate in the workplace.
• Streamlined the Men&Mice Central binary to reduce size. Took a lot of pilates, but now it’s in much better shape.
• The ‘Import records’ task is no longer available in Quick Command. We don’t know why it was there in the first
place. It’s not like we put it there. <whistles innocently>
• Login no longer fails if no DNS license key is activated. Some like IPAM with no pulp, and we don’t judge.
• Users can use the ‘subType’ field as a query parameters within data from cloud providers. Suber!
• Adding a cloud provider to Micetro properly runs synchronization for DNS data.
• Men&Mice Web Services will no longer report unhandled exceptions on a Windows Server. While Micetro is
exceptional, we’re plenty able to handle it.
• The ‘Edit reservation’ button once again works as expected. Good button, have a cookie.
• Resizing the Inspector panel will no longer cause sections to lock up. No DataTables left behind.
• You can use ‘Add to favorites’ on IPAM objects as well. We don’t like to play favorites, so we’re giving favorites
to all.
• Removing a cloud account will properly remove all related data from Micetro. Having your ex’s stuff around is
never a good idea.
• Men&Mice Central will no longer run out of memory when scanning a large number of SNMP profiles. To
paraphrase Lady Liberty: give Micetro your huddled SNMP masses yearning to breathe free.
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• Pool indicators are refreshed when editing exclusions for a scope.
• Deleting TXT records containing & in the data field no longer fails in AWS. & all rejoiced & the world was at
peace again.
• Using the Quick Filter for Networks will no longer cause loading skeletons to appear.
• Exceeding the retry limit in Azure will properly throw an exception.
• Fixed an issue where DNS administrators would not have access to a DNS record’s history. Obviously they
should. And now they do.
• The ‘Edit configuration’ task is no longer enabled for unreachable servers.
• The ‘Add DNS Zone’ task from Quick Command properly fills out the name for the zone. Otherwise it’s not
magic, now is it?
• Clicking ‘Save’ on dialogs with no changes made closes the dialog. Clicking save on dialogs that have been
modified validates the input. Save the cheerleader, save the world.
Other
• Various performance improvements and UX tweaks. Micetro does things faster and nicer.

1.2 Security announcements
1.2.1 October 27th, 2021
Vulnerabilities were found in the BIND software running on our virtual appliances.
• CVE-2021-25219: malicious actors can exploit a flaw in the response processing of affected authoritative servers
that can cause degradation in BIND resolver performance.
We have updated the Men&Mice Virtual Appliances with the appropriate patches, and recommend all customers to
update to the latest 10.1.1 version as soon as possible.
The appliances can be easily upgraded using the Automatic Updates feature of Micetro.
For details on how to update Micetro, see Update Guide.
For more information regarding the upgrade, contact Men&Mice Customer Care. See Contacting Support.

1.3 Contacting Support
Providing the best possible support to our customers is very important to us. Please help us help you by following these
guidelines.

1.2. Security announcements
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1.3.1 Critical Issues
If you have a valid service contract and the issue is considered critical, please contact our Call Center and clearly state
that this is a critical issue. Your Service Contract User Guide contains the necessary Call Center contact information.

1.3.2 Clear Description
It is important that you write a clear description of the issue. Please include the current version number of Micetro and
related components and provide detailed information based on the following questions.
• What were the circumstances when the issue came up?
• Did an upgrade take place recently?
• Has anything specific to your DNS/DHCP changed recently?
• Do you have any logfiles or screenshots available that might help diagnose the problem?
• In which part of Micetro did the issue come up? E.g. Management Console, DNS/DHCP Controller, Men&Mice
Central, Web Application?

1.3.3 Send an email to us
Send an email to support@menandmice.com with the above information. We will get back to you as soon as possible.

1.3.4 Support Contracts
If you have a Support Contract, please refer to the contract for more information.

1.4 Open-source licenses
Name
BIND
DHCP
Unbound
TinyCore
SQLite

Version
9.11.36
4.4.2-P1
1.10.1
4.7.5
3.35.4

License
isc-license
isc-license
bsd-license
gplv2-license
sqlite-license

1.5 Implementation Guide
This document is intended to help administrators to install and configure Micetro by Men&Mice. It will help the
administrators to identify strategic servers to install the Micetro components on, as they do not have to be installed on
all DNS and DHCP servers in the managed environment.
Note: All Micetro components can be installed on virtual machines.
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1.5.1 Architecture
Architecture overview
Micetro is a non-destructive, software-defined overlay for managing DNS, DHCP, and IPAM in diverse network environments.

• non-destructive: Micetro does not interfere with network structure or service integrity
• software-defined: Micetro can be deployed using virtual machines (no hardware component is necessary) and is
using a single-layer API for orchestration
• overlay: Micetro is capable of managing multiple DNS and DHCP services dynamically, on-premise, in data
centers, or in cloud platforms

Components
Micetro consists of the following components:
Men&Mice Central
The server component of Micetro, running the orchestration logic for all configured services. Can be configured
for high availability on certain platforms.
Data storage
Accumulating and organizing data from connected services. Can be configured for high availability on certain
platforms.
Server Controller(s)
Minimal-footprint service handling communication between Men&Mice Central and the connected services.
Some services can be connected natively to Central and don’t need a Server Controller.
User interface(s)
Users can manage connected services through a browser-based UI (primary) and a Windows application (transitional, will be deprecated in favor of the web application).

1.5. Implementation Guide
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Note: All communications between the Micetro components are encrypted.

Men&Mice Central

Note: At least one copy of Men&Mice Central needs to be installed.
Men&Mice Central, through the connected database, stores all data including user specific and centrally stored information.
Men&Mice Central handles user authentication and contains information about access privileges for the user. If the
Micetro IP Address Management module is activated, Men&Mice Central is responsible for management and allocation
of IP Addresses.
Men&Mice Central listens on TCP port 1231. See Networking requirements for more details.
Men&Mice recommends the following table as guidelines for allocating sufficient resources for smooth operation of
Micetro:
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Size of environment
Small to medium
Medium to large
Large
Enterprises and service
providers

Number of objects

Hardware guidelines (per Central instance)

Zones: fewer than 100 IP addresses:
fewer than 5000 Subnets: fewer than
1000
Zones: fewer than 1000 IP addresses:
fewer than 50000 Subnets: fewer than
10000
Zones: Tens of thousands IP addresses: Millions Subnets: Hundreds
of thousands

Central can be run on a server alongside other services, such as on a DNS/DHCP server or a Domain
Controller1
4 CPU cores, >= 2 GHz 8 GB of memory 50GB disk
space
>=8 CPU cores, > 2 GHz >=16 GB of memory
100GB disk space

Additional instances of Micetro’s Central can also be installed as a “cold standby”. With Micetro’s embedded SQLite
data storage, the database is periodically copied from the active Central server to the cold standby and, if the active
server becomes unavailable, the Central service on the cold standby can be activated. If Central is configured with a
different database backend, the database needs it’s own high availability setup for redundancy.
See Configure High Availability for Micetro Central for running multiple Central instances for high availability.

Data storage

Note: In case of conflict, the authoritative data is always the data source itself (i.e., the DNS or DHCP server).
By default Men&Mice Central will use an embedded SQLite database. The embedded database is suitable for small to
medium environments but larger environments should instead use a more robust database backend. Currently supported
database platforms are MS SQL and PostgreSQL server.
Information on how to use MS SQL or PostgreSQL as the database for Men&Mice Central can be found in the Database
backend section.
Note: Deploying Micetro through the Azure Marketplace will use Azure SQL as its database backend automatically.
See installation-azure for details.

Server controllers
The Men&Mice Server Controllers are minimal-footprint services running on the DNS/DHCP server or alongside
Men&Mice Central, and facilitate the communication between the connected service and Central.
1 In smaller installations, Micetro’s Central component can be installed on one of the DNS or DHCP servers, as it will not require much resources.
More resources are needed as the managed environment gets larger.

1.5. Implementation Guide
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DNS Server Controllers
The Men&Mice DNS Server Controller is used to control the DNS server and must be installed on each DNS server
machine you want to control. The Men&Mice DNS Server Controller reads and writes zone data and option files, and
sends commands to the DNS server. The Men&Mice DNS Server Controller listens on TCP port 1337.
(Unix) BIND DNS environment
Micetro’s DNS Server Controller (i.e., DNS agent) is installed on each DNS server that is to be managed.
(Microsoft) AD environment
The DNS agent can be installed on some of the DNS servers or they can all be managed agent free. If they are to
be managed agent free, then the DNS Server Controller is typically installed on the machine running Men&Mice
Central and when adding the DNS server, the option to add the server as “Microsoft Agent-Free” is chosen. (See
Agent-free management of DNS/DHCP servers.)
The DNS Server Controller must be running as a user that has necessary privileges.
If the plan is to install the DNS agent on some of the DNS servers in a Microsoft AD environment, and the
environment is a pure AD environment (meaning that all zones are AD integrated), the DNS agent is typically
installed on 2 DNS servers in each AD domain. Micetro will read and write DNS updates to the first server from
each AD domain, but if the first server becomes unavailable it will failover to the second server.
For more information see Edit Preferred Servers.
Other environments
The Men&Mice Server Controller service can also communicate with other DNS platforms, such as PowerDNS.
See Generic DNS Server Controller for more information.
Note: The Men&Mice DNS Server Controller communicates with the DNS server using RNDC (BIND) or DNSP/RPC
(Windows Server 2008 and above).

DHCP Server Controllers
The Men&Mice DHCP Server Controller is used to control the DHCP server.
ISC DHCP
A copy should be installed on each DHCP server machine.
MS DHCP
A copy can be installed on each DHCP server machine, or in certain circumstances it can be installed on another
server and connect to the DHCP service over the network. In order for this remote DHCP management to work,
the DHCP Server Controller must be installed on a Windows server and must run under an account that has
privileges to manage the DHCP service over the network. Operating this way, one DHCP Server Controller can
manage several different DHCP servers.
Cisco DHCP
The DHCP Server Controller can be installed on any machine.
The DHCP Server Controller listens for connections from Men&Mice Central on TCP port 4151.
Tip: There are a few strategies to install the Men&Mice DHCP Server Controller (i.e., DHCP agent).
• In a Unix ISC DHCP environment, the DHCP agent is installed on all DHCP servers that are to be managed.
• In a Microsoft environment, the administrator can install the DHCP agent on one server, some of the servers, or
all the servers. If all the DHCP servers are in the same security realm (maybe in different forests but with trust
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between them), the DHCP agent can be installed on one server, typically the server running Micetro’s Central
component.
Note: If the DHCP agent is to be used to manage DHCP on other DHCP servers, the DHCP agent must be
running as a member of the AD DHCP Administrators group.
• If some of the managed DHCP servers are not in the same forest as Micetro’s Central component, and there is
no trust between the forests, the administrator must install at least one DHCP agent in the foreign forest. That
DHCP agent can act as a proxy between Central and the DHCP servers and must be running as a member of the
AD DHCP Administrators group in the foreign forest.
• The DHCP agents can be installed on each managed DHCP servers. In that scenario, the DHCP agent can be
run as the Local System account, which means that no additional configuration is needed after the installation is
complete.
Cisco IOS DHCP servers can be managed using Micetro. A Men&Mice DHCP Server Controller has to be installed
on a machine in the environment, which will then act as an proxy to manage the Cisco IOS DHCP servers, and will use
either plain telnet or ssh to connect to the managed servers.

User Interface

Note: Of the different user interfaces, multiple copies may be installed, and multiple instances can be logged in at
once to manage the environments.

Web Application
The Men&Mice Web Application can be installed on any server on the network running Microsoft Internet Information
Services (IIS) or Apache. The Men&Mice Web Application talks directly to the Web Server (IIS or Apache) which
redirects its request to Men&Mice Central through TCP port 1231.

1.5. Implementation Guide
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Tip: It is common practice to install the Web Application on the same server that Micetro’s Central component is
installed on.

Management Console
Micetro’s Management Console is a Windows-only rich client that can be installed on as many client computers as
required, and is typically installed on each administrator’s workstation.

Important: The Management Console is being deprecated in favor of the web application. No new features will be
added to the Management Console.

Men&Mice Virtual Appliances (Optional)
There are two types of Men&Mice Virtual Appliances: a DNS/DHCP Appliance and a DNS Caching Appliance.
The DNS/DHCP Appliance can be used as both a DNS and a DHCP server. Once the DNS/DHCP appliance has been
configured, you work with the DNS and DHCP server just as you would work with the BIND and ISC DHCP servers.
See Virtual DNS - DHCP Appliance Setup Guide for more information.
The DNS Caching Appliance contains a high-performance Caching-only DNS server. See Caching DNS Servers for
more information.

1.5.2 Installation
Networking requirements
Certain ports need to be open for Micetro’s different components to communicate with each other.
The following table lists all services and their respective ports to be opened for incoming communications from the
source components.
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Service name

Port

Men&Mice Central
Web Application
PostgreSQL
PostgreSQL
Kea
DNS Server Controllers
DHCP Server Controllers
Men&Mice Updater

1231
80/443
5432
5000
8000
1337
4151
4603

Protocol
TCP
TCP
TCP
TCP
TCP
TCP
TCP
TCP

Source(s)
Management Console, Web Application, SOAP API
User’s browser
Men&Mice Central
PSQL HA nodes
Kea Control Agent
Men&Mice Central
Men&Mice Central
Men&Mice Central

Make sure that the servers running these services have the corresponding ports open in their firewalls.
Micetro by Men&Mice components
Linux

Important: All Micetro non-Windows components (Central, Server Controllers, and the Web Application) require
Python (version 3 or above) to be installed on the target server.
Download the following installer packages:
• Men&Mice Central: mmsuite-central-10.2.2.linux.x64.tgz
• Men&Mice Server Controller: mmsuite-controllers-10.2.2.linux.x64.tgz
• Men&Mice Web Application: mmsuite-web-application-10.2.2.linux.x64.tgz
• Men&Mice Management Console: Men_and_Mice_Management_Console.exe
Note: Unless noted, all commands are run as root.

Windows
Download the following installer packages:
• Men&Mice Central: Men_and_Mice_Central_x64_10.2.2.exe
• Men&Mice Server Controller: Men_and_Mice_Controllers_x64_10.2.2.exe
• Men&Mice Web Application: Men_and_Mice_Web_Application_x64_10.2.2.exe
• Men&Mice Management Console: Men_and_Mice_Management_Console.exe
Note: Unless noted, all applications are run as Administrator.
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Location of important config and log files
Important: The paths below represent the default values. Depending on your installation, your environment may be
using different paths. See central-non-standard-install.

Linux

Path
/var/mmsuite/mmcentral/
preferences.cfg
/var/mmsuite/
dns_server_controller/
preferences.cfg
/etc/httpd/conf/mmweb.conf
/etc/httpd/conf/mmws.conf
./[monitor|nodeX]/postgresql.conf
./[monitor|nodeX]/pg_hba.conf
/var/mmsuite/mmcentral.log
/var/mmsuite/
dns_server_controller/logs/
./[monitor]/pg_log/
postgresql-[WeekDay].log
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Information
Men&Mice Central configuration file.
Men&Mice DNS Server Controller configuration file.
Men&Mice Web Application configuration file.
Men&Mice Web Services proxy configuration file
PostgreSQL HA cluster database configuration file.
Stores client authentication information for the database cluster.
Men&Mice Central logfile.
Men&Mice DNS Server Controller logfile.
PostgreSQL HA cluster monitor logfile.
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Windows

Path
C:\Program Files\Men and Mice\
Central
C:\Program Files\Men and Mice\
Console
C:\Program Files\Men and Mice\DNS
Server Controller
C:\Program Files\Men and Mice\
DHCP Server Controller
C:\Program Files\Men and Mice\Web
Services
C:\ProgramData\Men and Mice\
Central\preferences.cfg
C:\ProgramData\Men and Mice\
Central\mmsuite.db
C:\ProgramData\Men and Mice\
Central\backups\
C:\ProgramData\Men and Mice\
Central\logs\
C:\ProgramData\Men and Mice\
Central\updates\
C:\ProgramData\Men and Mice\DHCP
Server Controller\preferences.cfg
C:\ProgramData\Men and Mice\DNS
Server Controller\preferences.cfg
Logfiles for Server Controllers

Information
Men&Mice Central install directory.
Management Console install directory.
DNS Server Controller install directory.
DHCP Server Controller install directory.
Men&Mice Web Application install directory.
Men&Mice Central configuration file.
Default, built-in database for Micetro.
Server configuration backups for Men&Mice Central.
Men&Mice Central logfiles. See central-logging.
Men&Mice Updater service install directory.
Men&Mice DHCP Server Controller configuration file.
Men&Mice DNS Server Controller configuration file.
Enabled in the controller’s preferences.cfg file. See Configuring
logging for the Men&Mice Server Controllers.

Men&Mice Central
Men&Mice Central is the central authentication server. It also serves as the meta-data storage engine, containing data
such as zone history logs, user accounts and permissions, etc. You must have at least one copy of Central installed in
the environment. Central does not need to be installed on a DNS server.
Important: The installer was designed to be quick and straightforward. Pay attention to the steps, if you’d like to
customize your installation. (Such as installing Central to a different path.)

Men&Mice Central on Linux

Note: Before installing Men&Mice Central, decide the following:
• What user account will own the Men&Mice Central process?
• Where do you want everything stored? There are defaults provided.
Extract and run the Men&Mice Central install package:
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tar -xzvf mmsuite-central-10.0.linux.x64.tgz
cd mmsuite-central-10.0.linux.x64
./install
Installer Questions
Here are the questions asked by the installer that pertain to Men&Mice Central:
• Do you want to install Men&Mice Central?
• Where do you want Men&Mice Central to keep its configuration files?
• Enter the user and group names under which you want to run Men&Mice Central.
• Where do you want to install the Men&Mice Central binary?
Removing Men&Mice Central
Installing Men&Mice Central puts the following files on your system:
Description
Men&Mice Central daemon
Data directory for Men&Mice
Central
Update directory
Preferences file
init script, the shell script that
can be used to control the service; used by init during system
startup
settings file used by the init
script (Ubuntu Linux only)

File(s) or directory
mmcentrald, usually in /usr/sbin or /usr/local/sbin
Usually /var/mmsuite/mmcentral
update, located in the data directory
preferences.cfg, located in the data directory
/etc/init.d/mmcentral

/etc/default/mmcentral

To remove Men&Mice Central, first use the init script to stop the service (give it the “stop” argument). Then simply
delete the daemon and the init script, and remove any references to the init script in the rest of the boot system if
necessary. Also delete the data directory if desired.
Men&Mice Central configuration files on Linux
See Linux.
Men&Mice Central on Windows
Run the downloaded binary and follow the instructions on-screen.
Note: Installing Men&Mice Central does not require special privileges. The service will be started automatically after
installation.
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Note: Running Men&Mice Central under a privileged user account Running Central as a specific service account
affects a few functions when it talks to the Active Directory, such as Integrated Security communications with an SQL
server database, communications with AD Sites and Services, authentication of AD users, and ability to ping.
When creating a service account for Central, make sure the user is in the local “administrators” group on the Central
machine. Otherwise it will not be able to utilize the ping functionality.
The service account running Central needs to be added to the DNS Admins and/or DHCP Admins group to manage
data.

Important: The installer creates the data directories for Men&Mice Central at the default location (C:\Program
Files\Men and Mice\Central) even if the installation target is on a different drive or path. See config-files-windows.

Men&Mice Central configuration files on Windows
See Windows.
Database backend
Micetro can be used with the following databases:
SQLite
The Men&Mice Central application is shipped with an embedded SQLite database, that will be used if no external
database is configured. Customization options for SQLite are not available, Central will use the built-in configuration.
Microsoft SQL Server

Important: We recommend that the network latency between the SQL server and M&M Central is no more than 5
ms. Otherwise, the performance of M&M in conjunction with SQL Server can’t be guaranteed to be acceptable. We
recommend that the SQL Server database is managed and maintained by a database administrator (DBA).

Setting up the Database
Micetro requires that a blank database is created on the database server, with the collation
SQL_Latin1_General_CP1_CS_AS, and a login (Windows or SQL server authenticated) that has db_owner
access to that database and an effective default schema of mmCentral.
The CreateDatabase.sql script is a suggestion for the database and database server setup. Please note that this script
also configures the SQL server itself, which is unnecessary and undesirable in most cases. Therefore, review the script
with your database administrator and only run appropriate parts of it.
Before you run the script please go through the script and change the necessary entries accordingly. This includes path
strings (default C:/Data) and very important also the password, which is set by default to “1234” in the script!
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Warning: The script is preconfigured for an 8 core processor machine, i.e. as a best practice we recommend to
create for each processor core one temp file. If you have only a two core machine please comment out the last 6
temp file creation commands in the script.

Danger: The script will, without confirmation, drop the existing database using the name “mmsuite”! Make a
manual backup to avoid possible data loss.
Subsequently the script will create:
• a user “mmSuiteDBUser” with the password that you have inserted in the script.
• an empty database with the
SQL_Latin1_General_CP1_CS_AS

name

“mmsuite”

and

the

following

collation:

COLLATE

Note: For further details take a look at the CreateDatabase.sql script.
Configuring the connection parameters
Warning: If you’re configuring MS SQL on a dedicated server, make sure to enable the TCP/IP protocol with the
SQL Configuration Manager.

Warning: An ODBC driver will need to be installed on the Central server to be able to use Microsoft SQL Server.

Men&Mice Central running on Windows

Note: To use Windows Authentication with Micetro and Microsoft SQL Server, make sure Men&Mice Central is
running under an Active Directory service account that is a member of the local administrators group.
The preferences.cfg file in the data directory contains (beside the fingerprint of Central, i.e. the “password” XMLtag) four additional XML tags: database, databaseserver, databaseusername and databasepassword.
The preferences.cfg file for normal user/password authentication should look like:
<password value="plaintext:PASSWORD"/>
<database value="MSSQL"/>
<databaseserver value="<name or ip of the SQL server>\<name of instance, e.g. SQLEXPRESS>
˓→@,<name of database, e.g. micetro"/>
<databaseusername value="mmSuiteDBUser"/>
<databasepassword value="plaintext:DBPASSWORD"/>
The plaintext: directive in the password inputs allows you to enter the passwords in plaintext, which Central will
automatically encrypt and replace with the hash during first startup.
An example preferences.cfg file for the Windows Authentication method should look like (databaseusername
tag must be present and the value attribute must be set to empty string):
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<password value="the fingerprint hash"/>
<database value="MSSQL"/>
<databaseserver value="<name or ip of the SQL server>\<name of instance, e.g. SQLEXPRESS>
˓→@,<name of database, e.g. mmsuite"/>
<databaseusername value=""/>
Restart Central and verify it’s running. If the database connection fails, the service will fail to start with the appropriate
error message.
Men&Mice Central running on Linux
Navigate to the data directory of the Men&Mice Central, usually located in /var/mmsuite/mmcentral.
Edit the preferences.cfg file with in that directory with the following:
<Database value="MSSQL" />
<DatabaseServer value="ip/dns name of SQL server><,port>\<Instance name>@<Database name>
˓→" />
<DatabaseUsername value="mmSuiteDBUser" />
<DatabasePassword value="plaintext:<your password here>" />

Note: If the DatabasePassword value is prefixed by plaintext:, it will be replaced by Men&Mice Central for a
password hash during start up.

Connecting to the MS SQL database
Restarting the Men&Mice Central service with the new preferences file should connect the Men&Mice Central to your
freshly created database. The Men&Mice Central creates the database schema (tables. . . ) during the first connection.
Since the database was freshly created you can now follow the normal installation procedure.
Restart Central and verify it’s running:
systemctl restart mmcentral
systemctl status mmcentral
If the database connection fails, the service will fail to start with the appropriate error message.
PostgreSQL
Men&Mice Central running on Linux
Edit the configuration file for Men&Mice Central:
nano /var/mmsuite/mmcentral/preferences.cfg
Find (or create) and set the following values:
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<database value="postgresql"/>
<databaseserver value="HOSTNAME@DATABASE"/>
<databaseusername value="USERNAME" />
<databasepassword value="plaintext:PASSWORD" />
Where
• HOSTNAME and DATABASE: the server’s hostname running the PostgreSQL service, and the system user on the
server
• USERNAME: the user with permissions to read and write the PostgreSQL database
• PASSWORD: the database user’s password
Note: Once Central starts and reads the configuration file, it’ll automatically change the plaintext password to hashed,
to increase security.
Restart Central and verify it’s running:
systemctl restart mmcentral
systemctl status mmcentral
If the database connection fails, the service will fail to start with the appropriate error message.
Men&Mice Central running on Windows
The preferences.cfg file in the data directory contains (beside the fingerprint of Central, i.e. the “password” XML-tag)
four additional XML tags: database, databaseserver, databaseusername and databasepassword
The preferences.cfg file for normal user/password authentication should look like:
<password value="the fingerprint hash"/>
<database value="postgresql"/>
<databaseserver value="<name or ip of the PostgreSQL server>\<name of instance, e.g.␣
˓→PSQLDB>@,<name of database, e.g. mmsuite"/>
<databaseusername value="mmSuiteDBUser"/>
<databasepassword value="password hash"/>
An example preferences.cfg file for the Windows Authentication method should look like (databaseusername tag must
be present and the value attribute must be set to empty string):
<password value="the fingerprint hash"/>
<database value="postgresql"/>
<databaseserver value="<name or ip of the PostgreSQL server>\<name of instance, e.g.␣
˓→PSQLDB>@,<name of database, e.g. mmsuite"/>
<databaseusername value=""/>

Note: High Availability for the database is only available for MS SQL and PostgreSQL.

Note: Deploying Micetro using the Amazon Marketplace configures the environment automatically for Azure SQL.
See installation-azure for details.

26

Chapter 1. Table of Contents

Micetro by Menamp;Mice Documentation, Release 10.2

Management Console
Men&Mice Management Console is a soon-to-be deprecated, Windows-based user interface of Micetro. As a
Windows-based application it needs to be installed on a Windows machine.
Note: Functionality from the Management Console is in the process of being migrated to the Web Application.
Run the Men&Mice Management Console installer (with Administrative privileges). Once installed, launch the application:

Log in with the default credentials:
• username: administrator
• password: administrator
The “Server name” field requires the domain or the IPv4/v6 address of the server running the Men&Mice Central
application. (This only needs to be defined once, and will autofill on subsequent logins.) Successful login confirms
that Men&Mice Central is running, connected to the database, and accessible for the Management Console.
Note: You can disable the “Server name” field: see Configure the web application to use a fixed M&M Central server.

Server controllers
Micetro uses server controllers to connect with DNS and DHCP servers in the network.
Important: The installer was designed to be quick and straightforward. Pay attention to the steps, if you’d like to
customize your installation. (Such as installing Central to a different path.)
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Micetro DNS Server Controllers
Men&Mice DNS Server Controller is the DNS server agent. It sits on each DNS server machine and manages the DNS
service on your behalf.
By default, when executed the controller installer tries to figure out the installed service (e.g. BIND) automatically and
will try to install it without further user input.
In case it can’t install the service it will print out hints and further information.
Note: For DNS servers running BIND, the DNS Server Controllers need to be ran as the same user as BIND. (By
default: named.)
If BIND is running as a different user, or files are updated, make sure that the mmremote service is ran as the same user
and has sufficient access to files and directories.
If the machine has multiple services installed, like ISC DHCP and ISC BIND DNS you want to specify explicitly the
Men&Mice Controllers that should be installed.
To get the list of available controllers/parameters just run the installer script with the –help parameter:
cd archive-name
./install --help
Men&Mice server controller installer.
--help: Print help.
--quiet: Suppress output during install.
--auto: Automatically determine what controllers to install. Default if no␣
˓→other option is given.
--bind-dns-controller: Install a DNS server controller for BIND.
--unbound-dns-controller: Install a DNS server controller for Unbound.
--generic-dns-controller: Install a Generic DNS server controller.
--isc-dhcp-controller: Install a DHCP server controller for ISC dhcpd.
--kea-dhcp-controller: Install a DHCP server controller for Kea dhcp4.
--update-controller: Install update controller. Always installed, if another␣
˓→Men&Mice service is installed.
Multiple controllers can be specified. If you want to, for example, have both ISC BIND and the generic DNS controller
running on the machine just run the installer as follows:
./install --generic-dns-controller --bind-dns-controller --isc-dhcp-controller

Note: If you have only a single service like BIND or Unbound installed we recommend to run the installer without
parameter. It will then use the --auto parameter and figure out the service automatically.
Quiet/unattended installation is possible with the --quiet parameter (no output at all):
./install --generic-dns-controller --bind-dns-controller --quiet

Note: The Men&Mice Update Controller always gets automatically added to the list when another Men&Mice service
is installed, e.g. in the above listed example the --update-controller gets added automatically.
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If you plan to use the Generic DNS Controller, please see Generic DNS Server Controller.
If you run into issues with the new installer, the old interactive Perl based installer is still present in the same archive
as:
deprecated_installer.pl
To execute the deprecated installer for the Men&Mice Server Controllers please run it as follows:
cd archive-name
./deprecated_installer
The installer will ask a series of questions. Be prepared to answer them, as described for each component.
Micetro Controllers running on Linux

Note: Before installing Micetro DNS Server Controller, examine your named data and operating environment, plus
the init script and/or settings file used to start named. Be aware that the installer will rearrange named.conf and your
named data directory. Know how to answer the following questions:
• Is there a starting configuration file, such as /etc/named.conf? * If not, you will need to create one. * If there is,
is it valid? It must load without errors.
• Does named.conf contain the necessary statements? See the notes below.
• Does the named init script change the ownership of the named data directory? If so, this will cause problems
and should be fixed. (This is aimed at users of some Red Hat Linux versions, and derivatives. Look for the
ENABLE_ZONE_WRITE setting.)
• Does named run in a chroot environment? If so, look for the following problems, and fix or work around any
encountered. (Check the installation walkthroughs in the knowledge base for solutions.) * Does the named init
script copy anything into the chroot jail when starting the service? (This is aimed at users of SUSE Linux.) *
When the installer rearranges the data directory listed in named.conf, will that cause problems? (This again is
aimed at users of SUSE Linux.)
• What user account owns the named process? Men&Mice DNS Server Controller must typically run as the same
user. However, it is sometimes possible to use group membership instead.
Extract the Men&Mice Controller install package (as root):
tar -xzvf mmsuite-controllers-10.0.linux.x64.tgz
In the newly created mmsuite-controllers-10.0.linux.x64 directory run the installer script to install the
Men&Mice Controller (as root):
cd mmsuite-controllers-10.1.linux.x64 && ./install
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Installer Questions
Here are the questions asked by the installer that pertain to Men&Mice DNS Server Controller:
• Do you want to install the Men&Mice DNS Server Controller?
• Are you running named in a chroot() environment?
• What is the chroot() directory?
• Where is the BIND configuration file?
• Would you like the DNS Server Controller to run name-checkconf to verify changes when editing advanced
server and zone options?
• Where is named-checkconf?
• The installer needs to rearrange the files in <directory> and restart the name server. A backup will be created. Is
this OK?
• Enter the user and group names under which you want to run the Men&Mice DNS Server Controller. This must
be the user which is running named.
• Where would you like to install the Men&Mice external static zone handling utilities?
• Where do you want to install the Men&Mice Server Controller binaries?
• BIND needs to be restarted. Would you like to restart it now?
Ensure the named-checkconf file is readable:
chmod a+s /usr/sbin/named-checkconf

Required named.conf Statements
Men&Mice DNS Server Controller requires that named.conf (including any files listed in include statements in
named.conf) have certain settings. The following are required:
directory
The directory substatement of the options statement must be present and must point to a directory that the installer
can replace. Specifically, it may not refer to /, /etc, the root of a chroot jail, or any partition mount point. If
you need to change or add the directory statement, you may then have to move files around or change the paths
used elsewhere in your named.conf (or its included files).
key

For BIND, there must be a key defined, so that Men&Mice DNS Server Controller can control named using rndc
commands. It is common for there to be a key in a default file such as rndc.key, which is almost always found in
the same location as named.conf; however, Men&Mice DNS Server Controller requires that this key be defined
explicitly in named.conf. If there is a file named rndc.key, its contents can simply be copied directly into
named.conf.
To generate a key, the following command usually works, though you may have to specify a path to the command:
rndc-confgen > /etc/rndc.conf
This creates the file rndc.conf in the default directory (usually /etc, which may or may not be where you
want it). This file contains a complete rndc configuration for local use, as well as key and controls statements,
in comments, that can be copied into named.conf (after removing the comment marks).
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controls
Men&Mice DNS Server Controller uses a controls statement for BIND. There must be a controls statement
with an inet substatement that references an explicitly defined key (see above); the inet statement must allow
connections from the loopback address, 127.0.0.1. If there is no controls statement defined, the installer will
remind you to create one manually.
Changes in named.conf
Installing Men&Mice DNS Server Controller rearranges your named configuration data, including rewriting named.
conf and rearranging the data directory. The new configuration is functionally equivalent to the old, except the logging
statement is either added or changed to add some new channels.
Common Files
The file layout is a little different with or without BIND views. Here are the parts in common:
Description
Men&Mice DNS Server Controller daemon
Men&Mice external static zone handling
utilities
Data directory for Men&Mice DNS Server
Controller
Backup of original data directory
New starting configuration file
Backup of original starting configuration file
logging statement from named.conf
key and acl statements from named.conf
options statement from named.conf
controls, server, and trusted-keys statements
from named.conf; also, if present and if not
using views, the root hints zone statement
Preferences file
init script, the shell script that can be used to
control the service; used by init during system startup
settings file used by the init script (Ubuntu
Linux only)

File(s) or directory
mmremoted, usually in /usr/sbin or /usr/local/sbin
mmedit and mmlock, usually in /usr/bin or /usr/local/bin
Usually /var/named, /etc/namedb, /var/lib/named, or something
within a chroot jail; the same location as before the DNS Server
Controller was installed
Same as above, with ‘.bak’ appended to the path
Usually either /etc/named.conf or /etc/namedb/named.conf; possibly
located within a chroot jail
Same as above, with ‘.bak’ appended to the path
conf/logging, relative to the data directory
conf/user_before, relative to the data directory
conf/options, relative to the data directory
conf/user_after, relative to the data directory
mmsuite/preferences.cfg, located in the data directory
/etc/init.d/mmremote
/etc/default/mmremote

Without Views
If views are not defined, the following files are created inside the data directory:
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Table 1: Without BIND views
Description
File(s) or directory
List of include statements, one for each zone conf/zones
statement file
Directory of zone statement files
conf/zoneopt
A sample zone statement file, for the zone conf/zoneopt/localhost.opt
‘localhost’.
Directory of primary master zone files
hosts/masters
Directory of slave zone files
hosts/slaves
A sample zone file, for the primary master hosts/masters/localhost-hosts
zone ‘localhost.’
With views
If views are defined, the following files are created inside the data directory:
Table 2: With BIND views
Description
File(s) or directory
View statements, not including zone state- conf/zones
ments within each view
List of include statements for a particular conf/zones_viewname
view, one for each zone statement file
Directory of zone statement files for a par- conf/zo_viewname
ticular view
A sample zone statement file, for the zone conf/zo_internal/localhost.opt
‘localhost’. in the view ‘internal’
Directory of primary master zone files for a hosts/view_viewname/masters
particular view
Directory of slave zone files for a particular hosts/view_viewname/slaves
view
A sample zone file, for the primary master hosts/view_internal/masters/localhost-hosts
zone ‘localhost.’ in the view ‘internal’

Removing the DNS Server Controller and Reverting to Original Data
To remove the DNS Server Controller, first use the init script to stop the service (give it the stop argument). Then
simply delete the daemon and the init script, and remove any references to the init script in the rest of the boot system
if necessary. To revert to your original data, stop named with its init script. Then delete the initial configuration file
and the data directory and rename the originals, removing the “.bak” from their names.
SELinux

Note: The following commands apply to Linux distributions based on RedHat EL 8 or higher. Your distribution may
differ.
After installing the DNS Server Controller, run the following commands as root:
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semanage fcontext -a -t named_cache_t --ftype f "/var/named(/.*)?"
semanage fcontext -a -t named_cache_t --ftype d "/var/named(/.*)?"
semanage fcontext -a -t named_conf_t --ftype f "/var/named/conf(/.*)?"
semanage fcontext -a -t named_conf_t --ftype d "/var/named/conf(/.*)?"
semanage fcontext -a -t named_zone_t --ftype f "/var/named/hosts(/.*)?"
semanage fcontext -a -t named_zone_t --ftype d "/var/named/hosts(/.*)?"
restorecon -rv /var/named
These will adjust the SELinux security label for the BIND 9 configuration and zone files.
Note: Due to the complexity of and variation between SELinux configuration files, we are unable to officially support
SELinux configuration at this time, as SELinux settings can interfere with the normal operation of named after its
configuration has been rewritten by the installer for Men&Mice DNS Server Controller. It is possible to make named,
Micetro, and SELinux all work together, but we cannot currently offer official support for this.

The $INCLUDE and $GENERATE Directives
Please refer to the following articles for information about how these directives are handled in Men&Mice Suite.
• Men&Mice DNS Server Controller and $INCLUDE Directives
• Expanding $GENERATE directives into records
Installation with Dynamic Zones
Men&Mice Suite expects dynamic zones to be made dynamic by allowing signed updates. Any dynamic zone must
have an allow-update statement whose ACL contains a key. If you do not otherwise have a need for signed updates,
add the rndc key (or any other key) to the list.
Furthermore, after installation, be sure that your server allows zone transfers of dynamic zones to the loopback address,
127.0.0.1, or users will be unable to open dynamic zones from this server. Zone transfer restrictions can be set or
changed in the server’s and in each zone’s Options window in the Men&Mice Management Console.
Verify the DNS Server Controller is running
Verify the Controller application is running:
systemctl status mmremote

Micetrol controller running on Windows
Active Directory Integrated Zones and Other Dynamic Zones
In order to open a dynamic zone, Micetro must read it from the DNS service rather than from a file. The way this is
done is via zone transfer. On Windows Server 2003 and later, the zone transfer restriction setting in the zone’s options
window must be set to allow transfers to an explicit list of IP addresses that includes the server’s own address. The
default setting of allowing zone transfers to any server listed in the zone’s NS records will not suffice.
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In some cases, Micetro DNS Server Controller will also need to be told specifically which interface to use when
requesting zone transfers. If you have trouble opening a dynamic zone after setting the zone’s transfer restrictions
appropriately, check the Event Log / Application Log for messages from Men&Mice DNS Server Controller. If there
is a message indicating that it was unable to get a zone transfer, note the address it tried to use; you can either add that
IP address to the transfer restrictions list, or else edit a configuration file for Men&Mice DNS Server Controller.
To configure the DNS Server Controller to use a different address, edit the service’s preferences.cfg file on the DNS
server computer. The file is located in one of the following two locations, where {Windows} is probably C:\Windows:
• {Windows}\System32\dns\mmsuite\preferences.cfg
• C:\Documents and Settings\All Users\Application Data\Men and Mice\DNS Server Controller\preferences.cfg
• C:\ProgramData\Men and Mice\DNS Server Controller\preferences.cfg
If the file does not exist, create it. The file is a text file in a simple XML-based format. Add the following element,
replacing the dummy address here with the server’s correct network address:
<DNSServerAddress value="192.0.2.1"/>
Save the file, and then restart Men&Mice DNS Server Controller using Administrative Tools → Services in Windows.
Then also restart Men&Mice Central, so that it can cache the zone’s contents.
Note: For Active Directory-integrated zones, other domain controllers running Microsoft DNS do not need to get
zone transfers. This is because the zone data is replicated through LDAP, rather than through zone transfers. Thus, for
an AD-integrated zone, the zone transfer restriction list might need only the server’s own address.

Running Micetro DNS Server Controller under a privileged user account / Server type: “Microsoft
Agent-Free”
Normally, the Men&Mice DNS Server Controller is installed on only one host in an Active Directory forest, or one
copy per site. That installation can then manage all MS DNS servers in the forest, or in the site, using Microsoft’s own
DNS management API. In order for this to work, the service needs to run as a user that has DNS management privileges
(i.e. the AD service account must be a member of the DNSAdmins group of the domain).
To configure Men&Mice DNS Server Controller to access DNS servers on remote computers, do the following:
1. Start the Windows ‘Services’ program and open the properties dialog box for Men&Mice DNS Server Controller.
2. Click the Log On tab. The Local System account radio button is most likely selected.
3. Click the This account radio button and enter the name and password of a Windows user that is a member of the
Administrators group.
4. Close the dialog box and restart the Men&Mice DNS Server Controller service.
If Men&Mice DNS Server Controller is run as a local system service (the default), then it will only be able to manage
the MS DNS service on the same host.
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Enable the Generic DNS Server Controller functionality
If the Controller should be configured to run a connector script in order to interface with other DNS servers than the
natively supported Windows DNS/Unix BIND DNS, the script interpreter and the connector script must be configured
in the controllers preferences.cfg file.
The file is a text file in a simple XML-based format. Add the following element, replacing the dummy script interpreter
and script:
<GenericDNSScript value="python /scripts/genericDNS.py" />

Configure the DNS Server Controller to work with Microsoft Azure DNS
For information on configuring Microsoft Azure DNS, see configure-azure-dns.
Where to install Men&Mice DNS Server Controller
If Men&Mice Central is installed on a Windows host, then one option is to install Men&Mice DNS Server Controller
on the same host. If this is not done, then the system will need to be told where to find the DNS Server Controller when
adding a new DNS server to the system. This will be presented as connecting via proxy.
Note: The Men&Mice communication protocol used to control a DNS server is more efficient than the Microsoft
protocol. This means that if a DNS server is separated from Men&Mice Central by a slow network link, it is more
efficient to install a copy of the Men&Mice DNS Server Controller in the same local network (the same site, typically)
as the DNS server.

Generic DNS Server Controller
Micetro by Men&Mice manages DNS servers. Native ISC BIND DNS and Windows DNS is supported. As a result of
an increase in other DNS servers showing up in production environments, as well as DNS offered as a service by Cloud
providers, from Version 6.7 of Micetro, new functions have been added to the DNS Server Controller. This makes the
Controller much more flexible and enables Micetro to communicate with such new DNS server types.
How to install and configure the Generic DNS Server Controller:
1. Install:
• On Windows, run the Controller installer (x32 or x64 - depending on the OS version). There is no special Generic
Controller installer - just use the normal Controller installer.
• On Unix run the Controller installer with the parameter --generic-dns-controller.
2. Install a script interpreter. We recommend using Python as we provide example connector scripts for Python
(2.7.x).
3. Add the GenericDNSScript XML tag to the preferences.cfg file. If the preferences.cfg file is not present, please
create it.
Note:
On Windows 2008/2012 R2 the preferences.cfg file is located under the hidden directory
C:ProgramDataMen and MiceDNS Server Controller
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3. Following an example config for the python interpreter and a connector script located on the C drive in the scripts
sub-directory:
<GenericDNSScript value="c:\python27\python.exe c:\scripts\genericDNS.py" />
The genericDNS.py script implements the generic API and interfaces with the DNS server itself.
4. Login to the M&M Management Console and add the new generic DNS server. Select as Server Type “Generic”.
The name and optional IP address must point to the machine that runs the Generic DNS Server Controller.
Limitations
Reading, modifying zone/server options, reading logs, clearing cache, controlling the server itself is not possible by
the API yet. Depending on the connector script, only master zones are currently supported. That means no slave
zones or special zones like forward or stub zones are supported for Amazon Route53, but slave zones are supported for
Configuring PowerDNS.
Of course, the connector script could interface with a slave zone and return an error when Central tries to update the
zone. However, the zone will show up as zone of the type “Master” in the M&M Suite. In other words, everything else
than reading/writing/updating master zones and their zone data is currently not supported.
Available Connector Scripts
Amazon Route53: see Configuring Amazon Route53.
PowerDNS with MySQL database backend: see Configuring PowerDNS.
Men&Mice DHCP Server Controllers

Note: For a list of compatible DHCP servers, see Add DHCP Servers.
Men&Mice DHCP Server Controller is the DHCP server agent. It sits on each DHCP server machine (or in case of
environments using MS DHCP or ISC Kea servers, on any machine in the network) and manages the DHCP service
on your behalf.
Installing Men&Mice DHCP Server Controller is typically quite straightforward, with far fewer considerations than
Men&Mice DNS Server Controller.
By default, when executed the controller installer tries to figure out the installed service (e.g. BIND) automatically and
will try to install it without further user input.
In case it can’t install the service it will print out hints and further information.
If the machine has multiple services installed, like ISC DHCP and ISC BIND DNS you want to specify explicitly the
Men&Mice Controllers that should be installed.
To get the list of available controllers/parameters just run the installer script with the --help parameter:
cd archive-name
./install --help
Men&Mice server controller installer.
--help: Print help.
--quiet: Suppress output during install.
(continues on next page)
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(continued from previous page)

--auto: Automatically determine what controllers to install. Default if no␣
˓→other option is given.
--bind-dns-controller: Install a DNS server controller for BIND.
--unbound-dns-controller: Install a DNS server controller for Unbound.
--generic-dns-controller: Install a Generic DNS server controller.
--isc-dhcp-controller: Install a DHCP server controller for ISC dhcpd.
--kea-dhcp-controller: Install a DHCP server controller for Kea dhcp4.
--update-controller: Install update controller. Always installed, if another␣
˓→Men&Mice service is installed.
Multiple controllers can be specified. If you have for instance both ISC Kea and ISC DHCP runnning on the machine
just run the installer as follows:
./install --kea-dhcp-controller --isc-dhcp-controller

Note: If you have only a single service like BIND or Unbound installed we recommend to run the installer without
parameter. It will then use the –auto parameter and figure out the service automatically.
Quiet/unattended installation is possible with the --quiet parameter (no output at all):
./install --isc-dhcp-controller --quiet

Note: The Men&Mice Update Controller always gets automatically added to the list when another M&M service is
installed, e.g. in the above listed example the –update-controller gets added automatically.
If you run into issues with the new installer, the old interactive Perl based installer is still present in the same archive
as:
deprecated_installer.pl
To execute the deprecated installer for the Men&Mice Controllers please run it as follows:
cd archive-name
./deprecated_installer
The installer will ask a series of questions. Be prepared to answer them, as indicated below for each component.
Note: The Kea DHCP4 Controller can not be installed by the deprecated installer.
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Men&Mice Central running on Linux
Here are the questions asked by the installer that pertain to Men&Mice DHCP Server Controller:
• Do you want to install the Men&Mice DHCP Server Controller?
• Where is the DHCP server configuration file?
• Where is the DHCP server lease file?
• Where do you want the Men&Mice DHCP Server Controller to keep its configuration files?
• Enter the user and group names under which you want to run the Men&Mice DHCP Server Controller. This
must be the user which is running dhcpd.
• Where do you want to install the Men&Mice Server Controller binaries?
Managing Cisco IOS with DHCP support
Men&Mice DHCP Server Controller can also manage Cisco IOS servers with DHCP support. There is no need to
install any software on the Cisco device, but it is necessary to create a user account on the device that has the ability to
telnet or SSH in. You will be asked for the username and password when adding the server.
When adding a Cisco IOS server to Men&Mice Suite, the options are very similar to those shown when adding an MS
DHCP server; by default, if possible, Men&Mice Central will look for a copy of the DHCP Server Controller on the
same server as itself, but you can also specify a particular installation to use as a proxy. It is recommended to use a
copy of the DHCP Server Controller that is on the same network segment as the Cisco IOS server.
Extract the Men&Mice Controller install package (as root):
tar -xzvf mmsuite-controllers-10.0.linux.x64.tgz
In the newly created mmsuite-controllers-10.0.linux.x64 directory run the installer script to install the
Men&Mice Controller (as root):
cd mmsuite-controllers-10.1.linux.x64 && ./install
Ensure the named-checkconf file is readable:
chmod a+s /usr/sbin/named-checkconf
Verify the Controller application is running:
systemctl status mmremote

Men&Mice Central running on Windows
Running Men&Mice DHCP Server Controller under a privileged user account / Server type: Microsoft
Agent-Free
Normally, Men&Mice DHCP Server Controller is installed on one host in an Active Directory forest, or one copy per
site. That installation can then manage all MS DHCP servers in the forest, or in the site, using Microsoft’s own DHCP
management API. In order for this to work, the service needs to run as a user that is a member of the Active Directory
DHCP Administrators group.
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Please note that for the management of the DHCP failover in Windows Server 2012 R2 the service account must also
be a member of the local Administrators group of the DHCP servers in order to be able to fetch/manage the failover
configuration.
To configure Men&Mice DHCP Server Controller to access DHCP servers on remote computers, do the following:
1. Start the Windows “Services” program and open the properties dialog box for Men&Mice DHCP Server Controller.
2. Click the Log On tab. The Local System account radio button is most likely selected.
3. Click the This account radio button and enter the name and password of a Windows user that is a member of
either the Administrators group or the DHCP Administrators group.
4. Close the dialog box and restart the Men&Mice DHCP Server Controller service.
If Men&Mice DHCP Server Controller is run as a local system service (the default), then it will only be able to manage
the MS DHCP service on the same host.
Where to install Men&Mice DHCP Server Controller
If Men&Mice Central is installed on a Windows host, then one option is to install Men&Mice DHCP Server Controller
on the same host. If this is not done, then the system will need to be told where to find the DHCP Server Controller
when adding a new DHCP server to the system. This will be presented as connecting via proxy.
However, there are other considerations when deciding where to install Men&Mice DHCP Server Controller.
• The Micetro communication protocol used to control a DHCP server is more efficient than the Microsoft protocol.
This means that if a DHCP server is separated from Men&Mice Central by a slow network link, it is more efficient
to install a copy of the Men&Mice DHCP Server Controller in the same local network (the same site, typically)
as the DHCP server.
• Starting in Men&Mice Suite 6.0, Men&Mice DHCP Server Controller can be used to gather lease history data for
a DHCP server. However, this requires that the Men&Mice DHCP Server Controller be installed on the DHCP
server machine itself. If this is done for all DHCP servers, then there is never any need to run the DHCP Server
Controller as a privileged user - the DHCP Server Controller that is only used to control the DHCP service on
the same machine as itself can run as a local system service.
Managing Cisco IOS with DHCP Support
Men&Mice DHCP Server Controller can also manage Cisco IOS servers with DHCP support. There is no need to
install any software on the Cisco device, but it is necessary to create a user account on the device that has the ability to
telnet or SSH in. You will be asked for the username and password when adding the server.
When adding a Cisco IOS server to Men&Mice Suite, the options are very similar to those shown when adding an MS
DHCP server; by default, if possible, Men&Mice Central will look for a copy of the DHCP Server Controller on the
same server as itself, but you can also specify a particular installation to use as a proxy. It is recommended to use a
copy of the DHCP Server Controller that is on the same network segment as the Cisco IOS server.
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Agent-free management of DNS/DHCP servers
Kea
Kea DHCP servers can be configured agent-free, without a DHCP Server Controller running on every Kea machine.
The Kea Control Agent needs to be installed, and available for communication through its defined port (default: 8000).
A single DHCP Server Controller is sufficient to communicate with and handle all Kea servers on the network.
Microsoft
Microsoft DNS and DHCP servers in Active Directory environments can be managed agent free, i.e. without running
a Men&Mice server controller locally on the DNS/DHCP server.
While agent free management of DHCP servers is possible with any 6.x version of Micetro, version 6.3 or newer is
required for agent free management of DNS servers.
Although it is not required to install an agent on the DNS/DHCP server itself, an agent must be installed somewhere
in the same domain as the server resides. This agent will be used as a proxy that will handle all communications to
the remote DNS/DHCP server(s). Usually, this proxy agent is installed on the same server as Men&Mice Central,
assuming the Men&Mice Central server is a member in the domain. If the DNS/DHCP servers are widely distributed
geographically, it can also be of performance benefit to install one agent in each geographic location. For instance,
if there are datacenters in Iceland, India, and the United States, it is probably best to install one proxy agent in each
datacenter that each handles communications with the DNS/DHCP servers in its datacenter. The proxy agent then in
turn feeds all the information back to Men&Mice Central, eventually reaching the end-user in one of the Micetro user
interfaces.
Naturally, the Micetro proxy agent must adhere to the security imposed by the Active Directory. Therefore, the proxy
agent service must be running with a service account that has sufficient privileges for DNS and/or DHCP management
in the domain. If the privileges are restricted, that will translate to the same restriction in Micetro. For instance, if the
service account only has privileges to view DNS zones and records but not do any changes what so ever, the zones and
records will show up in Micetro, but all changes to those zones will be denied by Micetro. The same applies to the
DHCP server management, if the service account has read-only privileges to the scopes, the scopes will show up in
Micetro but the end-user will not be able to do any changes.
Limitations:
DNS:
With agent-free management of MS DNS servers, as opposed to using a locally installed agent, you will lose the
following ability in static zones only:
• Disable resource record
• Enable resource record
• View and edit resource record comments
• Disable zone
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DHCP:
Collection of lease history is only possible when the agent is installed locally. No lease history will be collected from
servers that are managed agent-free.
If netsh with full dhcp functionality is not installed properly, no scopes will show up in Micetro regardless of the
privileges of the service account running the proxy DHCP agent. The proxy DHCP agent must be installed on a
machine that has netsh with full dhcp capability. This is always the case if the DHCP role service is installed. If
not, it can be installed (on Win2008R2) by Server Manager → Features → Remote Server Administration → Role
Administration Tools – >DHCP Server Tools.
It’s recommended (but not required) that Windows 2003 DHCP servers are managed by proxy DHCP agents installed
on Windows 2003 servers, and Windows 2008/R2 DHCP servers are managed by proxy DHCP agents installed on
Windows 2008/R2 servers, due to some minor differences in the netsh between these two operating systems.
Note: Servers in Active Directory environments can be connected without using a controller. See Microsoft.

Cloud integration
Overview
Micetro now can integrate natively with cloud based DNS services as well as manage IP address related data for Azure
and AWS, including virtual networks and subnets that exist in cloud accounts.
In previous versions to version 8.2, only Azure DNS was natively supported and Amazon Route 53 was supported
through the Men&Mice Generic DNS Controller, but as of 8.2 all cloud services are natively supported and all are
easily added to Micetro as cloud instances. In version 8.3 partial support for Akamai Fast DNS was added. In version
9.2 support for managing multiple AWS cloud accounts using the same credentials was added.
Supported Cloud Services

Important: To be able to connect and use cloud services, the DNS Server Controller must be installed on the same
machine that is running Men&Mice Central. See Micetro DNS Server Controllers.

Cloud service
Akamai
Azure
Amazon Web
Services
(AWS)
OpenStack
NS1
Dyn
1

DNS

IPAM

Yes (Akamai Fast DNS)
Yes (Azure DNS1 )
Yes (Amazon Route 53)

N/A
Yes
Yes

No
Yes
Yes

Yes
N/A
N/A

see configure-azure-dns
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DNS
The use of a cloud DNS service in Micetro is transparent to the user. Adding DNS zones, DNS records, or modifying
the two is done in the same way as with other DNS servers in Micetro. Currently only master zones can be created on
cloud DNS services.
IPAM
Configure Cloud Integration
To start using the available cloud services, they need to be added and configured through the Men&Mice Management
Console.
For detailed instructions on how to configure Men&Mice Cloud integration, see Configure Cloud Integration.
Using Cloud Integration
Using the available cloud services in Micetro is as easy as using DNS Zones, records, or subnets as before.
For detailed instructions on how to use Men&Mice Cloud integration, see Using Cloud Integration.
Configure Cloud Integration
Set up and configuration
Before adding a cloud service instance
Micetro communicates with the cloud services through Men&Mice Central (IPAM) and the Men&Mice DNS controller
(DNS).
Before continuing, make sure:
• The DNS controller is installed and set up on the machine running Men&Mice Central. See Server controllers.
• The machine running central can connect to the specific cloud instance on port 443/TCP. See Networking requirements.
If you want to add multiple AWS cloud accounts using single credentials refer to aws-multi-account.
Adding a cloud service
The following are the steps that are needed to start using a cloud service in Micetro.
1. File → New → Cloud Service. Access the Cloud service wizard by right clicking Cloud Services in the Object
Browser of the Management Console and selecting New Cloud Service or highlight Cloud Services in the Object
Browser and clicking + sign in the manager window.
2. The following dialog is shown:
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Proceed with one of the Cloud providers shown below and click Next:
• Akamai Fast DNS
• Azure DNS
• Amazon Web Services
• Openstack
• NS1
• Dyn DNS
Akamai Fast DNS
Fill in the following fields required to connect to Akamai Fast DNS
Name
Client
Secret
Host
Access
token
Client
token

The name of the cloud service in Micetro
The credentials needed for Micetro to connect to
the cloud instance
Obtaining Access Credentials Please refer to the following on how to create API Access Credentials for
use by Micetro: https://developer.akamai.com/introduction/Prov_Creds.html

Warning: Server time setting constrictions Akamai OPEN APIs are time sensitive! Ensure that the system your
client runs on is synchronized with a Stratum 2 or better time source. (source: https://developer.akamai.com/
introduction/Client_Auth.html)

Danger: If the time on the server that the DNS Remote is running on deviates enough from Coordinated Universal
Time the authentication will fail and it will not be possible to access/update zone through Micetro.
Go to Finishing the configuration.
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Azure DNS
Fill in the following fields required to connect to Azure:
Name
Subscription ID
Tenant ID
Client ID
Client secret

The name of the cloud service in Micetro
The credentials needed for Micetro to connect to the cloud instance

Note: See configure-azure-dns.
Go to Finishing the configuration.
Amazon Web Services
Fill in the following fields required to connect to AWS:
Name
Access
Key ID
Secret
Access
Key

The name of the cloud service in Micetro
The credentials needed for Micetro to connect to the cloud instance
Obtaining Access Credentials Please refer to the following on how to create API Access Credentials
for use by Micetro: https://docs.aws.amazon.com/general/latest/gr/managing-aws-access-keys.html

Read more: aws-multi-account.
Go to Finishing the configuration.
Openstack
Fill in the following fields required to connect to OpenStack:
Name
Server Node
User Name
Password
Require HTTPS

The name of the cloud service in Micetro
The credentials needed for Micetro to connect to the cloud instance

Go to Finishing the configuration.
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NS1
Fill in the following fields required to connect to NS1:
Name The name of the cloud service in Micetro
API The credentials needed for Micetro to connect to the cloud instance
Key Obtaining Access Credentials Please refer to the following on how to create API Access Credentials for use
by Micetro: https://ns1.com/knowledgebase/creating-and-managing-api-keys
Go to Finishing the configuration.
Dyn DNS
Fill in the following fields required to connect to Dyn:
Name
Customer Name
User Name
Password

The name of the cloud service in Micetro
The credentials needed for Micetro to connect to the cloud instance

Go to Finishing the configuration.
Finishing the configuration
After finishing going through the wizard, the DNS service (if applicable) and any subnets defined (if applicable) will
be shown in the DNS servers and IP Address Ranges, respectively.
Editing a cloud service instance
To edit the properties for a cloud instance, right click on a cloud instance in the Object Browser and select Properties.
Removing a cloud service
To remove a cloud service, right click on the specific cloud service in the Object Browser and select Delete.
Warning: By removing the cloud service, the associated DNS service and the corresponding zones will be removed. Additionally, any subnets and cloud networks will also be removed.
Click Yes to remove the cloud service.
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Removing a cloud network
To remove a cloud network, right click on the specific cloud network in the object browser or in the manager window
and select Delete.
Using Cloud Integration
Viewing a cloud service instance
Highlighting a cloud service in the object browser will show the cloud networks residing in that cloud service.
Name

The name of the cloud network

Cloud
The name of the Cloud service
Region
The region where the cloud network is located at.
Note: This field is referred to as Location in Azure.
Address blocks
The address blocks in the specific cloud network.

Using a cloud service
Cloud DNS
Using and managing a cloud DNS server is very similar as managing and using a local DNS server. Adding zones and
records to a zone is transparent for the user.
Cloud IPAM
Cloud Networks
The cloud networks can either be viewed in the Object Browser, under the respective cloud service, or in the IP Address
Ranges.
In the Object browser, clicking on a specific cloud network will display the subnet residing in that cloud network.
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In IP Address ranges, a column named Cloud Networks shows the name of the respective cloud network among the
other existing subnets.

Custom properties for Cloud services
Custom properties can be specified for cloud services and cloud networks as for other objects.
Web Application
Install the Web Application on Linux

Important: Before you install the the Men&Mice Web Application, make sure you must have a functioning and
accessible Apache Web Server running. The Web Application will configure its virtual host.
1. Extract and install the Men&Mice Web Application install package (as root):
tar -xzvf mmsuite-web-application.linux.x64.tgz
cd mmsuite-web-application.linux.x64 && ./install --web-virtual-host-domain web˓→application.domain.tld
Where web-application.domain.tld is the domain on which the Web Application will be accessed.
2. Restart the Apache web server:
systemctl restart httpd
3. In distributions based on RHEL8 with SELinux enabled, make sure Apache can connect to the web interface
service:
setsebool httpd_can_network_connect 1 -P
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Install the Web Application on Windows

Note: On Windows, the Web Application requires IIS to be installed. The installer will check if all required components are available.
Install Men&Mice Web Application by double clicking the Microsoft installer file and follow the instructions there.
Warning: If the web application is not installed on the same server as Men&Mice Central, you need to set the
Web app server host value to the webserver’s hostname through System settings → Advanced in the Management
Console for the auto-update feature to work for the Web Application.

Further configuration
Setup SSL for the Web Application
SSL on Linux (Apache)
By default, the Web Application uses unencrypted http connection on port 80. To use it with https on port 443, follow
these steps.
Check that mod_ssl for Apache is installed:
yum install mod_ssl
If you have existing SSL key files: place the .key file in /etc/pki/tls/private/ and the .crt and .csr files in /etc/pki/tls/certs/.
If you need new SSL keys, generate a keypair:
openssl req -new -nodes -keyout mmweb.key -out mmweb.csr -newkey rsa:4096
Create self-signed certificate:
openssl x509 -req -days 365 -in mmweb.csr -signkey mmweb.key -out externaldns3.crt
Place the files in the appropriate directories:
cp mmweb.key /etc/pki/tls/private/
cp mmweb.c* /etc/pki/tls/certs/
Once the keyfiles are placed in their respective directories, edit the mmweb.conf file in the Apache configuration directory (default /etc/httpd/conf, or use find /etc/ -name “mmweb.conf” to locate the file) with the following changes:
• change <VirtualHost *:80> to <VirtualHost *:443>
• add in the references to the key files (amend the path as necessary):
SSLCertificateFile /etc/pki/tls/certs/mmweb.crt
SSLCertificateKeyFile /etc/pki/tls/private/mmweb.key
• enable SSL:
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SSLEngine on
SSLProtocol all -SSLv2 -SSLv3
SSLCipherSuite HIGH:3DES:!aNULL:!MD5:!SEED:!IDEA

Note: The default Apache installation may already have a <VirtualHost _default_:443> directive, which can
conflict with the mmweb.conf file. Comment out this existing VirtualHost block to prevent any errors.
To verify the Web Application is accessible, navigate to https://web-application.domain.tld. The Men&Mice
Web Application’s login panel should appear.
SSL on Windows (IIS)
Configuring SSL Certificate
Open the IIS (Internet Information Services) Manager
Select the Web Server node in the left sidebar, under “Start Page”, and double click on Server Certificates in the middle
pane

Choose one of the actions in the actions sidebar on the left to import an existing .pfx SSL certificate, or create a selfsigned certificate. If your certificate is in a different format than .pfx, please refer to documentation and/or tools that
certificate authorities typically provide to convert their certificates to Microsoft’s .pfx format
Select your website under Sites in the left sidebar (usually Default Web Site) , and click Bindings. . . in the Actions
sidebar on the right.
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In the Site Bindings dialog that opened, click Add, select https from the Type menu, and then select the certificate
added in step 3 in the SSL certificate picklist. Then click OK.

The “Host Name” and “Require Server Name Indication” can be left blank if this the first certificate installed on the
server.
Redirect HTTP traffic to HTTPS
Editing web.config
Locate and open the web.config file for your Default Website in notepad.
C:inetpubwwwrootweb.config

This is typically at

Add the following rule xml to the rewrite > rules section of the xml, at the top below <clear />
<rule name="HTTP to HTTPS redirect" enabled="true" stopProcessing="true">
<match url="(.*)" />
<conditions logicalGrouping="MatchAll" trackAllCaptures="false">
<add input="{HTTPS}" pattern="^OFF$" />
</conditions>
<action type="Redirect" url="https://{HTTP_HOST}/{R:1}" appendQueryString="true"␣
˓→redirectType="Permanent" />
</rule>
In the IIS manager, select the Default Web site, right click, and select Manage Website → Restart to make the changes
to the web.config take effect.
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With Default Web Site selected in the left sidebar, double click on URL Rewrite in the middle pane. Verify the rule
HTTP to HTTPS redirect is at the top of the rewrite rules
Using the IIS manager
With Default Web Site selected in the left sidebar, double click on URL Rewrite in the middle pane
If there’s a HTTP to HTTPS redirect rule already in place at the top of the list of URL rewrite rules, nothing needs to
be done.
Click Add Rules in the Actions pane on the right, and click OK to create a blank inbound rule.
In the name field enter HTTP to HTTPS redirect.
In Pattern field enter (.*)
Under conditions click Add and enter the following condition:

In the Action pane on the bottom, choose Redirect from the Action type dropdown, and set redirect URL to https:/
/{HTTP_HOST}/{R:1} and the redirect type to Permanent (301).

1.5. Implementation Guide

51

Micetro by Menamp;Mice Documentation, Release 10.2

Click Apply in the Actions pane on the left. And click Back to rules.
Move the new HTTP to HTTPS redirect rule to the top of the rules using the Move Up button in the action pane on the
right.
Enable content compression for Apache
To speed up response time for large operations, add the following line to mmws.conf:
AddOutputFilterByType DEFLATE application/json

Configure the web application to use a fixed M&M Central server
By default the M&M Web Application allows the user to specify, which M&M Central server is used for the login.
If you want to set a fixed M&M Central Server for the Web App Login dialog follow the steps provided below.
Windows
Steps to configure a fixed Server name for the Web Application login dialog
1. Edit the preferences.cfg file of the M&M Web Services (c:\ProgramData\Men and Mice\Web Services\preferences.cfg). If not already there add a XML-Tag for the default M&M Central server name:
<DefaultCentralServer value="your M&M Central DNS name or IP" />
2. Add another XML-tag to configure the Web App to use the DefaultCentralServer as fixed server name:
<FixedCentralServer value="1" />
3. Restart the M&M Web Services Windows service
4. After that the Login dialog shows the DefaultCentralServer name as “Server”, greyed out and not editable anymore.
Tip: You might want to clear the browsers cookies that are cached and reload the Web Application site in order to get
the right data displayed.
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Linux
1. Log in to the server running the web application.
2. Edit the preferences.cfg file of the M&M Web Services (/var/mmsuite/web_services/preferences.cfg). If not
already there add a XML-Tag for the default M&M Central server name:
<DefaultCentralServer value="your M&M Central DNS name or IP" />
3. Add another XML-tag to configure the Web App to use the DefaultCentralServer as fixed server name:
<FixedCentralServer value="1" />
4. Restart the mmws service:
systemctl restart mmws

Tip: You might want to clear the browsers cookies that are cached and reload the Web Application site in order to get
the right data displayed.

Increase timeout for webserver proxy
To ensure that the Web Application works smoothly with larger change request queues (that take longer to process by
Central) modify /etc/httpd/conf and increase the mmws proxy timeout value:
ProxyTimeOut 60

Deploying Micetro on Azure
The Azure Marketplace has an offering of Micetro that provides an automated deployment of virtual machines, configured with a database backend using Azure Database. For more information see installation-azure.

1.6 Configuration
1.6.1 Running the Men&Mice components (Central, Controllers)
Linux
After installation, all Men&Mice components are configured as system processes available through systemctl. Only
use systemctl to stop, (re)start, and query the status of the components, i.e.:
systemctl status|start|stop|restart mmcentral
systemctl status|start|stop|restart mmremote
You can set several options when starting Men&Mice Central (by default /usr/sbin/mmcentral):
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-ll <level>
-p <port>
-u <user>
-g <group>
-d <path>
-v
–h

Men&Mice Central sends event messages to the system log. You can change
the log level for Men&Mice Central by using the –ll command-line option when
starting the daemon. Possible levels are 0 - 5 (the default value is 3)
Set port number to listen to (default 1231)
Specifies the user name or user id that the program should run as
Specifies the group name or group id that the program should run as
Sets the path where the data files should be located (the default path is
/var/mmsuite/mmcentral)
Displays version information
Displays available command line options for Men&Mice Central

For example:
mmcentrald -p 9876 -ll 5 -d /temp/data

Windows
Men&Mice Central
Men&Mice Central runs as a service and you can start and stop Men&Mice Central using the Services application.
You can also control Men&Mice Central using these command line options:
mmcentral –i
mmcentral –u
mmcentral –start
mmcentral –stop
mmcentral –v
mmcentral –h

Installs Men&Mice Central as a service
Uninstalls Men&Mice Central
Starts the Men&Mice Central service
Stops the Men&Mice Central service
Displays version information
Displays available command line options for Men&Mice Central

Men&Mice Controllers
The Men&Mice DNS Server Controller runs as a service and you can start and stop the Server Controller using the
Services application. You can also control the Men&Mice DNS Server Controller using these command line options:

mmremote –i
mmremote –u
mmremote –start
mmremote –stop
mmremote –v
mmremote –h
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Installs the Men&Mice DNS Server Controller as a service
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Starts the Men&Mice DNS Server Controller service
Stops the Men&Mice DNS Server Controller service
Displays version information
Displays available command line options for the Men&Mice DNS Server Controller
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1.6.2 First login
After installing and starting the required components (PostgreSQL, Men&Mice Central, at least one Controller, and
the Web Application) administrators must use the Management Console (Windows Client) to log in to and initialize
the system.
The default credentials:
• username: administrator
• password: administrator
After logging in with the default administrator credentials, the system will prompt to change the administrator password.
Warning: Do not lose the password set in this step for the administrator user. It cannot be recovered if lost.
Contact Men&Mice Customer Care if the administrator user password is lost.

License keys
See License Management.
Note: The IPAM license key unlocks both the DHCP and IPAM functionality of Micetro.

1.6.3 First use wizard
When connecting the Management Console to a newly installed instance of Men&Mice Central, or if this is the first
time logging in, you are presented with the First Use Wizard.
The ‘First use wizard’ guides the administrator through configuring the system and make it ready to accept connections
from the Controllers(s) and the Web Application. After the wizard completes, you’re presented with the main view of
the Console.
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Note: The Web Application is designated to carry out all daily tasks in your network environments. The Management
Console is to be used only for advanced management operations and administration tasks. See Advanced configuration.

1.6.4 Enable logging for Central
Important: Logging is not enabled by default.
To help troubleshooting, it is highly recommended to enable logging for Men&Mice Central and all Server Controllers.
(See Configuring logging for the Men&Mice Server Controllers.)
After logging in to the First login in the Management Console, navigate to Tools → System Settings → Advanced` and
locate the log file settings. (You can use the Quick Filter to narrow the options.)
Define the logfile’s location (e.g. /var/mmsuite/mmcentral.log for Linux) and in ‘Logging Level for Men&Mice
Central’ set the value.
Note: Men&Mice recommend setting the loglevel to 5 for troubleshooting. Consult the Customer Care team to
determine the best loglevel for your environment.

1.6.5 Configuring logging for the Men&Mice Server Controllers
DNS Server Controller
Linux
After installing the DNS Server Controller, create the logging directory (/var/named/mmsuite/ in CentOS or /var/
cache/bind/mmsuite/ in Ubuntu or specify your own):
mkdir /var/named/mmsuite/logs/
Edit the /var/named/mmsuite/preferences.cfg file and add/edit the following:
<LogFileName value="/var/named/mmsuite/logs/mmremote.log" />
<LogDestination value="3"/>
<LogLevel value="5" />
(Amend the directory path as needed.)
Restart the DNS Server Controller:
systemctl restart mmremote
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Windows
1. After installing the DNS Server Controller, create the logging directory (C:\ProgramData\Men and Mice\
DNS Server Controller\logs or specify your own).
2. Edit the C:\ProgramData\Men and Mice\DNS Server Controller\preferences.cfg file and add/edit
the following:
<LogFileName value="C:\ProgramData\Men and Mice\DNS Server Controller\logs\mmDnslog.txt"␣
˓→/>
<LogDestination value="3"/>
<LogLevel value="5" />
(Amend the directory path as needed.)
Restart the DNS Server Controller.
DHCP Server Controller
Linux
After installing the DHCP Server Controller,
create
dhcp_server_controller/logs/ or specify your own):

the

logging

directory

(/var/mmsuite/

mkdir /var/mmsuite/dhcp_server_controller/logs/
Edit the /var/mmsuite/dhcp_server_controller/preferences.cfg file and add/edit the following:
<LogFileName value="/var/mmsuite/dhcp_server_controller/logs/mmremote.log" />
<LogDestination value="3"/>
<LogLevel value="5" />
(Amend the directory path as needed.)
Restart the DHCP Server Controller:
systemctl restart mmremote

Windows
1. After installing the DHCP Server Controller, create the logging directory (C:\ProgramData\Men and Mice\
DHCP Server Controller\logs or specify your own).
2. Edit the C:\ProgramData\Men and Mice\DHCP Server Controller\preferences.cfg file and add/edit
the following:
<LogFileName value="C:\ProgramData\Men and Mice\DHCP Server Controller\mmremote.log" />
<LogDestination value="3"/>
<LogLevel value="5" />
(Amend the directory path as needed.)
Restart the DHCP Server Controller.
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1.6.6 Micetro User Management
Note: Access management has changed in Micetro 10.1. To view the access management used in previous versions,
switch to the appropriate version number using the version selector.
For detailed information, see Access control.

1.6.7 External Authentication
Note: Unless indicated otherwise, instructions here are to be performed in the Management Console.

Overview
This section discusses the available user authentication methods available with Micetro.
In addition to Local User Authentication, Micetro currently supports two methods of AD user authentication using the
Windows Active Directory user database and authentication through a RADIUS server.
Active Directory User Authentication
The Active Directory (AD) User Authentication mechanism allows you to have users authenticate themselves in the
AD login system before allowing them to login to Micetro. In large installations, this system has obvious benefits as the
users do not have to maintain their passwords in multiple locations. The password rules (password expiry, minimum
password length, etc.) that have been applied within the organization automatically apply to Micetro.
Active Directory User Authentication vs. Local User Authentication
Even when you are using AD User Authentication, you must create users in the Management Console and assign
privileges to them using the Men&Mice access system. The only difference between AD vs. local user authentication
is that when AD user authentication is used, users are authenticated using the AD User Authentication system before
they can access the Management Console. When AD User Authentication is used, the user password is not stored in
the Men&Mice software.
Note: Only one authentication method can be used per user, but different users can have different authentication
methods. That means you can have some users log in using AD user authentication, while other users log in using local
user authentication.
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Enabling AD User Authentication Using Active Directory
AD user authentication using Active Directory is only possible when you run Men&Mice Central on a Windows machine. The machine running Men&Mice Central must be a member in an Active Directory domain or forest. No specific
configuration is needed for Men&Mice Central for user authentication using Active Directory.
Configuring Users for AD Authentication
To configure a user to use AD user authentication, do the following:
1. From the menu, select Tools → User management.
2. Select the applicable user from the list. If the desired user is not shown, the user must be added to the application.
Refer to Users.
3. When the Properties dialog box display, move to the Authentication field, click the drop-down list, and select
the applicable authentication method. (If Men&Mice Central is not running on a Windows machine, only the
Micetro authentication method displays.)
4. Click OK.
Note: When the AD authentication method is selected, the Password field is disabled, since the password
is not stored in Micetro.
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Active Directory Single Sign-on

You can enable the Single Sign-on so that Active Directory users do not have to authenticate when logging in through
the Management Console.
To enable Active Directory Single Sign-on, do the following:
1. From the menu bar, select Tools → System Settings.
2. In the System Settings dialog box, click the General Settings tab.
3. Select the Allow Single Sign-on option.
4. Click OK.
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Web Interface
When single sign-on is enabled, it is possible to enable sign-on in the web interface if the web application is running
on a Microsoft Windows Server.
To enable single sign-on in the web application, make sure that Single Sign-on and Single Sign-on for web is enabled
in Micetro.
Application Log In
Logging into Micetro will not change when AD user authentication is used and Single Sign-on is disabled. The only
thing to keep in mind is that the user name that is entered must match the user name stored in Micetro. If a distinguished
user name is used, it must be entered in the same way when logging in.
Group Level Active Directory User Authentication
The Group Level Active Directory (AD) User Authentication mechanism allows you to set user access privileges by
group membership in the AD. In large installations, this system has obvious benefits as the users do not have to maintain
their passwords in multiple locations. The password rules (i.e., password expiry, minimum password length, etc.) that
have been applied within the organization automatically apply to Micetro.
The login sequence is as follows for users with Group Level AD authentication:
1. The user enters his/her user name and password in Micetro
2. Micetro uses the AD authentication mechanism to validate the user name and password. If the user name and
password is correct, Micetro retrieves the group membership of the user from the AD.
3. The AD group list of the user is compared (by group name) to the local group list in Micetro. If a match is found,
the user is logged in with the privileges specified in the local group list. If no match is found, the login fails.
To allow a user to log in to Micetro, you must create a group in the AD that has the same name as a group in Micetro
and place the AD user in that group. You may create multiple groups in the AD that match group names in Micetro.
Configuring Groups for AD Group Level Authentication
When using AD Group level authentication, you must specify which groups in Micetro should be used to verify group
membership.
1. From the menu, select Tools → User Management. The Users and groups management dialog box displays.
2. Click the Groups tab.
3. Select the group to which you want to configure AD and click the Edit button. If the desired group is not shown,
you will need to add the group. See Groups.
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Group Name
Ensure that the group name is prefixed with the name of the owning domain name. Example: The Active Directory domain “MYDOMAIN” contains the group “MM-ReadOnly”. The group name must then be
“MYDOMAIN\MM-ReadOnly”.
5. Click the checkbox for Active Directory Integrated.
6. Click OK.
Note: Group Level Active Directory user authentication is only possible when you run Men&Mice Central on a
Windows machine. The machine running Men&Mice Central must be a member in an Active Directory domain or
forest.
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Configuring Users and Access Privileges
You do not have to create users in Micetro when the Group Level AD authentication is used. Instead, user access is
controlled by the group membership of the user in the AD.
RADIUS User Authentication
Micetro can authenticate using an external RADIUS server. In large installations, this system has obvious benefits as
the users do not have to maintain their passwords in multiple locations. The password rules (i.e., password expiry,
minimum password length, etc.) that have been applied within the organization automatically apply to Micetro.
RADIUS User Authentication vs. Local User Authentication
Even when you are using RADIUS User Authentication, you must create users in the Management Console and assign privileges to them using the Men&Mice access system. The only difference between RADIUS vs. local user
authentication is that when RADIUS user authentication is used, users are authenticated using the RADIUS User Authentication system before they can access the Management Console. When RADIUS User Authentication is used, the
user password is not stored in the Men&Mice software.
Note: Only one authentication method can be used per user, but different users can have different authentication
methods. That means you can have some users log in using RADIUS user authentication, while other users log in
using local user authentication.

Enabling RADIUS User Authentication
To enable RADIUS authentication, you must add several properties to the Men&Mice Central configuration file preferences.cfg. This file is located in the data folder inside the Men&Mice Central data directory:
• Windows: C:\Program Files\Men&Mice\Central\data
• Mac OS X: /var/mmsuite/mmcentral
• All others: set during installation. Usually /var/mmsuite/mmcentral or /chroot/var/mmsuite/
mmcentral, where /chroot is the location used as a chroot jail for named.
The properties to be added are:
RADIUSServer
RADIUSPort
RADIUSSharedSecret
RADIUSAuthentication

Defines the address of the RADIUS server that will do RADIUS authentication.
Defines the port that the RADIUS server is listening on. The default value is 1812,
which is the port normally used by RADIUS.
The shared secret between the RADIUS server and Micetro.
The type of authentication used. 0 = PAP, 1 = CHAP.

Example:
<RADIUSServer value="192.168.1.3"/><RADIUSPort value="1515"/><RADIUSSharedSecret value=
˓→"MyBigSecret"/><RADIUSAuthentication value="1"/>
After editing the file, restart Men&Mice Central.
• Windows: use Administration Tools → Services to restart Men&Mice Central.
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• Mac OS X: Execute the following shell command in a Terminal window (/Applications/Utilities/Terminal):
sudo /Library/StartupItems/mmSuite/mmcentral restart
• All others: Execute the mmcentral init script with the ‘restart’ argument.
Configuring Users
To allow a user to log in to the Men&Mice system, the user must exist in the Men&Mice user database. If the user
does not exist in the Men&Mice user database, they are not allowed to log in, even if they provide a valid user name
and password in the RADIUS login system.
To configure a user to use AD user authentication, do the following:
1. From the menu bar, select Tools → User Management. The User and group management dialog box displays.
2. To add a new user, click the Add button. Refer to Users. Follow the instructions with one exception: in the
Authentication field, click the drop-down list and select RADIUS.
3. To modify an existing user, double-click on the user’s name to display the user Properties dialog box, and in the
Authentication field, click the drop-down list and select RADIUS.
Note: When the RADIUS authentication method is selected, the Password field is disabled, since the password is not
stored in Micetro.
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Logging into Micetro
Logging in to Micetro will not change when RADIUS user authentication is used. The only thing to keep in mind is
that the user name that is entered must match the user name stored in Micetro.
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Configure LDAP authentication
Introduction
This document describes how to configure LDAP authentication in Micetro.
Installation on Centos Linux
1. Download the Python script and signature file from GitHub.
2. To use LDAP authentication and authorization, start by installing mm_ldap.py on the machine where the
Men&Mice Central service is run and install the Python extension used by Central when connecting to an LDAP
directory:
sudo
sudo
sudo
sudo
sudo

yum install python-ldap
mkdir /var/mmsuite/mmcentral/extensions
cp mm_ldap.py /var/mmsuite/mmcentral/extensions
chown -R root:root /var/mmsuite/mmcentral/extensions
chmod 440 /var/mmsuite/mmcentral/extensions/mm_ldap.py

A signature file for the python extension will also have to be installed and placed in the extension directory:
sudo cp mm_ldap.signature /var/mmsuite/mmcentral/extensions

Note: For security reasons, the Central service will not execute mm_ldap.py unless the signature inmm_ldap.
signature matches the signature calculated for mm_ldap.py.

Configuring LDAP
LDAP configurations are stored in a JSON config file that should be stored in the Men&Mice Central service root
directory:
sudo cp ldapconf.json /var/mmsuite/mmcentral
sudo chown root:root /var/mmsuite/mmcentral/ldapconf.json
sudo chmod 440 /var/mmsuite/mmcentral/ldapconf.json
The configuration file has the following schema:
{
"server": {
"uri": str, // e.g. ldaps://example.com:636
"reader_dn": str | null,
"reader_password": str | null,
"skip_cert_verification": bool | null, // Default: false.
"ca_cert_file": str | null,
"disable_referrals": bool | null, // Default: true.
"use_start_tls": bool | null, // Default: false.
},
"user_search_config": {
"base_dn": str,
(continues on next page)
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(continued from previous page)

"search_filter": str,
"scope": "subtree" | "onelevel", // Default: 'subtree'
"email_attribute": str | null,
"group_search_config": null | {
"base_dn": str,
"scope": "subtree" | "onelevel", // Default: 'subtree'
"search_filter": str,
"name_attribute": str // Default: 'name'
}
}
}
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Name

Description

uri
URI for LDAP service.
reader_dn DN or login name for a user that has permissions to search in the directory.
Not needed when all users have permissions to search (for example AD LDAP
service).
reader_password
Password for reader_dn user.
skip_cert_verification
If true, then certificates will not be verified. Set to true when using self signed
certificates.
ca_cert_filePath of file containing all trusted CA certificates.
disSkip referrals when doing LDAP queries. Should be set to true for AD LDAP
able_referrals
services.
user_start_tls
Use TLS when connecting to LDAP service. This is still experimental. Please
use LDAPS instead.
user_search_config.base_dn
DN from where to start searching for a user in the directory.

ExamRe- Deple
quiredfault
ldaps://example.com:636
Yes None
user@example.com
No None
No
No
No

None
false

No None
true
No

false

‘dc=corp, Yes None
dc=example,
dc=com’
user_search_config.search_filter
Filter to use for searching for a user. Username will be inserted into placeholder (&(obYes None
‘{username}’ if specified.
jectClass=user)(userPrincipalName={userna
scope
Scope to use when searching. Should be either ‘subtree’ or ‘onelevel’. Defaults subtree
No subto ‘subtree’.
tree
email_attribute
LDAP attribute used to store users email address.
userNo None
PrincipalName
group_search_config.base_dn
DN from where to start searching for groups in the directory.
‘dc=corp, If
None
dc=example,group
dc=com’ authentication
is
used.
group_search_config.scope
Scope to use when searching. Should be either ‘subtree’ or ‘onelevel’. Defaults subtree
No subto ‘subtree’.
tree
group_search_config.search_filter
Search filter to use when searching for groups. Users DN will be inserted into (&(obIf
None
placeholder ‘{dn}’ if specified. Username will be inserted into placeholder jectgroup
‘{username}’ if specified.
Class=group)(member:={dn}))
authentication
is
used.
group_search_config.name_attribute
Attribute used to store name of group.
name
If
name
group
authentication
is
used.
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Example configuration for connecting to an AD LDAP service:
{
"server": {
"uri": "ldaps://ldap.example.com:636",
"skip_cert_verification": false,
"disable_referrals": true,
"use_start_tls": false
},
"user_search_config": {
"base_dn": "dc=corp, dc=example, dc=com",
"search_filter": "(&(objectClass=user)(userPrincipalName={username}))",
"scope": "subtree",
"email_attribute": "userPrincipalName",
"group_search_config": {
"base_dn": "dc=corp, dc=example, dc=com",
"scope": "subtree",
"search_filter": "(&(objectClass=group)(member:={dn}))",
"name_attribute": "name"
}
}
}

Configuring the Men&Mice Central service to authenticate users using an LDAP service.
To configure the Men&Mice Central service, login as the superuser administrator through the Men&Mice Management Console. In the top left-hand corner select Tools → System Settings → Advanced and check the Enable LDAP
integration checkbox.
Using LDAP with Central running on Windows
To use LDAP with a Men&Mice Central server running on Windows, Python must be installed for all users. See
Installing Python for Men&Mice Central on Windows.
API Authentication methods
There a few options for authenticating against the M&M API:
• Login command
• Authorization Headers
• Single Sign-On
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Login command
This method is available in all versions of M&M, and all the different flavors of the M&M API (SOAP/JSONRPC/REST). In the REST API, this command is available via the URL commands/Login
The Login command takes in server (for the M&M Central server), user name, and password, and returns a session ID,
which should then be used for all other API calls via their session parameter.
The Login command and its parameters is fully documented in the normal SOAP API documentation
Note: Remember to configure HTTPS for the mmws and/or _mmwebext sites for this authentication method, since
the username and password can easily be extracted for anyone listening in on the communication.

Authorization Headers
With the introduction of Men&Mice Web Services and the REST API in version 7.3, it’s now also possible to authenticate via HTTP headers, by adding a Basic Authorization header, or with a Negotiate Authorization header, if the client
supports it.
Note: If AuthorizationMethods is not defined in the preference file mmWS will only accept basic authorization.
By using authorization headers for authentication, the Login command becomes unnecessary, and the session ID is not
used. The “session” parameter for all the commands must be omitted, and not left blank.
With this authentication method, multiple M&M Web Service instances can be deployed and used simultaneously
behind a load balancer to provide a redundancy that is transparent to the API client.
The session IDs, on the other hand, are only valid on the API endpoint (web service) they were created with. So when
an API client that uses a session id gets redirected to another Web Service/API Endpoint, the client will get an error
that the session id is invalid or expired, and then needs to login again to get a new session id before proceeding.
Basic Authentication
For Basic Authentication, simply include a HTTP header like:
Authorization: Basic QWxhZGRpbjpPcGVuU2VzYW1l
where the last part is <user name>:<password>, base64 encoded
For more information on Basic Authorization headers on the client side, see for example here: https://en.wikipedia.
org/wiki/Basic_access_authentication
The authorization header authentication method is only available for JSON-RPC and REST APIs, and only if using
M&M Web Services as an endpoint (i.e. the URL is <server>/mmws/api or <server>/mmws/json)
Note: Remember to configure HTTPS for the mmws site for this authentication method since the username and
password can easily be extracted for anyone listening in on the communication.
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Negotiate Authentication
Negotiate header Authorization (SPNEGO-based Kerberos and NTLM HTTP Authentication) is also supported when
the client supports it, and when it has been enabled for the Men&Mice Web Services.
This way, the user name and password are not provided in the header, and the API call is executed in the security
context of the user that invokes it. In other words, this is the single sign-on authentication option that the Men&Mice
Web Services provides.
To enable the Negotiate header Authorization in M&M Web Services, add the following line to the preferences.cfg,
and restart the mmws service.
<AuthorizationMethods value="Kerberos,NTLM" />
The order of the methods can be changed, e.g. if NTLM is preferred over Kerberos but in general if you don’t want to
allow NTLM (which is less secure) as a fallback only specify Kerberos as a value.
Single Sign-On
To enable single sign-on in the web application, make sure that Single Sign-on and Single Sign-on for web is enabled
in Micetro. See External Authentication.

1.6.8 Adding DNS servers
After installation, Micetro contains no data about DNS servers. These need to be added through the Management
Console.
DNS servers require Server controllers and need to be added using their fully qualified names (such as dns1.europe.
ad.mmdemo.local).
Note: Servers in Microsoft Active Directory environments can be added without installing a server controller. See
Agent-free management of DNS/DHCP servers.
1. Log in to the Web Application.
2. Navigate to Admin → Server Management.
3. Click Add DNS server in the interface.

1.6. Configuration
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4. The Add DNS server modal will display.
5. Fill in the server’s FQDN. Optionally, you can specify its IP address (IPv4 or IPv6).
6. Select the server type from the dropdown.

7. Click Confirm.
If the entered details are correct and the server is accessible, it will show up in the server management and DNS lists.
For further details, refer to DNS in the User Guide.
Note: To add a new DNS server in the Management Console, the administrator will select File → New → DNS Server.
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DNS servers in Active Directory integrated zones
The DNS agent will use two different methods to retrieve information from Microsoft AD integrated zones. First it
will do a zone transfer (both full and incremental) to get the latest records for the zone and then it will use Microsoft
APIs to get detailed information for individual records. Due to this it is important that the DNS agent is allowed to do
a zone transfer from the local server.

The DNS agent on the DNS server must be able to transfer AD integrated zones from the local DNS server.
Note: There is a global setting in the Management Console that allows Micetro to adjust the zone transfer settings for
dynamic or AD integrated zones. It is enabled by default but the administrator can change this setting. See Disable
“Automatic adjustment of Zone Transfer” for details.

1.6.9 Add DHCP Servers
DHCP servers require Server controllers and need to be added using their fully qualified names (such as dns1.europe.
ad.mmdemo.local).
Note: Servers in Microsoft Active Directory environments can be added without installing a server controller. See
Agent-free management of DNS/DHCP servers.

Note: ISC DHCP servers require a DHCP Server Controller to be installed on each DHCP server. Kea servers require
only one DHCP Server Controller installed in the system, either on the machine running Kea, or a machine that can
connect to the Kea Control Agent through the network.
The following table demonstrates the different options when adding a DHCP Server.

1.6. Configuration
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Server type
Microsoft
AgentFree1 (Use proxy not
checked)
Microsoft
AgentFreePage 74, 1
(Use
proxy checked)
Microsoft with Agent
Installed
ISC DHCP
ISC Kea (Agent-free)1
ISC Kea
Cisco (Use proxy not
checked)
Cisco (Use proxy
checked)

Description
The DHCP Server Controller has been installed on the machine running the Men&Mice
Central Component, and that machine will be used as a proxy. Micetro is not able to track
lease history data.
The DHCP Server Controller has been installed on the machine identified in the Use proxy
server field, and that machine will be used as a proxy. Micetro is not able to track lease
history data.
The DHCP Server Controller has been installed on the remote DHCP server. Micetro is
able to track lease history data.
Either a Unix server running the ISC DHCPD or a Men&Mice Appliance with the
mm-dhcpd package installed
A server running ISC Kea with the Kea Control Agent installed and accessible for the
DHCP Server Controller.
A server running ISC Kea with a DHCP Server Controller and Control Agent installed.2
The DHCP Server Controller has been installed on the machine running the Men&Mice
Central Component, and that machine will be used as a proxy.
The DHCP Server Controller has been installed on the machine identified in the Use proxy
server field, and that machine will be used as a proxy.

Important: To add Kea servers to Micetro, they need to be configured with the libdhcp_lease_cmds.so library.
See Adding Kea to Micetro for details.
1. Log in to the Web Application
2. Navigate to Admin → Server Management.
3. Click Add DHCP server in the interface

4. The Add DHCP server modal will display.
5. Fill in the server’s FQDN. Optionally, you can specify its IP address (IPv4 or IPv6).
6. Select the server type from the dropdown.
1
2
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Chapter 1. Table of Contents

Micetro by Menamp;Mice Documentation, Release 10.2

7. Click Confirm.
If the entered details are correct and the server is accessible, it will show up in the server management list and the
Networks context.
For further details, refer to DHCP in the User Guide.
Note: To add a new DHCP server in the Management Console, the administrator will select File → New → DHCP
Server.

1.6.10 IP Address Ranges and devices
Once DHCP servers have been added to Micetro, all the scopes from the DHCP servers will be visible in the interface
in the Networks context. The organization might also have a spreadsheet or a database with other IP address range
(subnet) allocations and details on individual devices (IP addresses). This data can be manually entered in Micetro or
more efficiently, imported in bulk.
You can import IPAM data to Micetro using the Web Application. See Import IPAM data
For importing IPAM data using the Management Console (not recommended), see import-ipam-old.

1.7 Advanced configuration
1.7.1 Advanced System Settings
Starting with version 6.3.2, Micetro allows users to configure Advanced System Settings from within the Management
Console.
To access the Advanced System Settings dialog box, open System Settings and click the Advanced button in the General
tab.
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Note: The Advanced System Settings are only available for the build-in user “administrator”.
Below, you will find a description of the currently available settings.
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System setting name
Require DNS Admin
rights for DNS Analysis
Directory for scripts that
can be run from the SOAP
interface
Log performance of
SOAP queries
Time in minutes between
write-outs of SOAP performance log
Default negative caching
SOA field in new zones
(BIND)
Default expiry SOA field
in new zones
Default hostmaster SOA
field in new zones
Default TTL SOA field in
new zones (MS)
Default refresh SOA field
in new zones
Default retry SOA field in
new zones
Default TTL of SOA
record in new zones
Path to an SSL Root certificate
SSL Certificate policy
Allow Migrate Scope to
create two enabled scopes
Always show discovery
info
Log file for Men&Mice
Central
Logging
level
for
Men&Mice
Central
(1-7)
Check for underscores in
host names
Include derived data from
DNSSEC zones
Enable collection of IP information from routers
Synchronize
DNSSEC
signed zones immediately
after editing
Show DNSSEC Key-Tags
(Key-IDs) for DNSSEC
zones
Disable all health checks
Web app server host

Description
Determines whether users should need DNS Administration rights to use the DNS
Analysis function. If checked, the DNS Analysis button is hidden if the logged-in user
does not have DNS Administration rights.
Specifies the directory that contains scripts that may be run from the SOAP interface.
Determines whether execution time of SOAP queries should be logged. Mainly used
for diagnostic purposes.
If logging of SOAP query performance is enabled, this setting specifies how frequently
the log should be written to disk.
Specifies the default value (in seconds) to use for the Negative Caching field in the
SOA record of new zones. Only applicable for zones on BIND DNS servers.
Specifies the default value (in seconds) to use for the Expiry field in the SOA record
of new zones.
Specifies the default value to use for the Hostmaster field in the SOA record of new
zones.
Specifies the default value (in seconds) to use for the TTL field in the SOA record of
new zones. Only applicable for zones on Microsoft DNS servers.
Specifies the default value (in seconds) to use for the Refresh field in the SOA record
of new zones.
Specifies the default value (in seconds) to use for the Retry field in the SOA record of
new zones.
Specifies the default TTL value (in seconds) to use for the SOA record of new zones.
Specifies the path to an SSL Root certificate is such a certificate is being used for the
Cloud Integration feature.
Specifies the SSL Certificate policy to use for the Cloud Integration feature.
Determines whether the Migrate Scope Wizard can create two enabled scopes.
Determines whether the columns related to host discovery should always be displayed
when viewing contents of subnets or scopes.
Specifies the path and name of the log file to use when you want to log the output of
Men&Mice Central to a file.
Determines the level of detail to log when logging the output of Men&Mice Central
to a file.
Determines whether to check if hosts contain underscores in their names. If checked,
it is not possible to create hosts with underscores in their names.
Determines whether derived data (automatically generated DNSSEC resource records)
from DNSSEC zones should be included when opening DNSSEC signed zones. If
checked, the derived data will be included when opening the zones.1
Determines whether the system can collect IP information from the ARP cache of
routers. If selected, the system can collect this information.
Determines whether DNSSEC signed zones should be synchronized immediately after
they are changed. If selected, the zones are synchronized immediately.2
Determines whether DNSSEC Key-Tags should be displayed in the zone list. If selected, the DNSSEC Key-Tags are displayed.

If checked, all health checks will be disabled.
Used to specify which host the web application is running on in order for auto update to
work for the web application. Default is localhost (same server as Men&Mice Central)77
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Web proxy to use
Specifies a proxy server to be used for outgoing connections for checking for updates
and additionally for AWS cloud services.
Web proxy port (defaults Specifies the port of the proxy server to be used for outgoing connections for checking
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1.7.2 Configure High Availability for Micetro Central
Failover instances of Men&Mice Central can be configured to build a high availability cluster.
Note: To run Micetro in High Availability mode you must be using the MSSQL or PostgreSQL database backend for
Micetro. High Availability mode is not available for other database types.

Note: When there are no HA members defined or if Micetro Central has not been configured for HA, a message will
appear indicating further configuration is necessary. This documentation shows how to configure HA in the web UI for
versions 10.2 and above. If you need to use the management console (thick client), please follow the documentation in
[10.1](https://menandmice.com/docs/10.1/guides/implementation/central_ha)

Note: For fine-tuning the settings for the Central High Availability cluster, see Men&Mice Central HA tweaks.

Linux
1. On the existing (or designated as primary) server running Central, edit the preferences file in /var/mmsuite/
mmcentral/preferences.cfg, adding
<ClusterMemberName value="somename"/>
to the end of the file. somename is the unique name that will identify the Central instance in the high availability cluster.
(E.g. “1”, “primary”, or “central1”)
2. Restart the primary Central application:
systemctl restart mmcentral
3. Login to the web UI as “administrator” and go to Admin then Configuration
4. Select High Availability
5. Type in the name of the first member server to match the name given earlier and set the priority to 10
6. Click Add Member

7. Restart Central:
systemctl restart mmcentral
8. Login to the web UI and verify that the current server is running with state “Active”
9. Repeat steps 3-6 to add another member to the HA configuration, but now use a priority of 20 or higher

1
2
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10. On the just added secondary server, install the Micetro Central application. If it’s already installed, make sure
it’s stopped by using (as root):
systemctl stop mmcentral
systemctl status mmcentral
11. Copy the /var/mmsuite/mmcentral/preferences.cfg file from the first server to the second, and change
the ClusterMemberName value to match the one set up previously. Save the file and exit.
12. Start Central on the secondary server:
systemctl start mmcentral
13. Verify that you now have 2 servers, one primary, one secondary in the HA cluster
14. Create a round robin DNS name for the high availability setup, i.e. two A records with the same name, but each
with the IP address of the primary and secondary server respectively.
Note: Repeat these steps for each high availability failover you’d like to add. The priority for each failover member
should be unique and higher than the primary.
Proceed to Server controllers.

Windows
1. In the existing (or designated as primary) server running Central, edit the preferences file preferences.cfg,
adding
<ClusterMemberName value="somename"/>
to the end of the file. somename is the unique name that will identify the Central instance in the high availability cluster.
(E.g. “1”, “primary”, or “central1”)
2. Restart the primary Central application from the command line:
mmcentral –stop
mmcentral –start
3. Login to the web UI as “administrator” and go to Admin then Configuration
4. Select High Availability
5. Type in the name of the first member server to match the name given earlier and set the priority to 10
6. Click Add Member

7. Restart the Central application from the command line:
mmcentral –stop
mmcentral –start
8. Login to the web UI and verify that the current server is running with state “Active”

1.7. Advanced configuration
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9. Repeat steps 3-6 to add another member to the HA configuration, but now use a priority of 20 or higher

10. On the just added secondary server, install the Micetro Central application. If it’s already installed, make sure
it’s stopped:
mmcentral –stop
11. Copy the /var/mmsuite/mmcentral/preferences.cfg file from the first server to the second, and change
the ClusterMemberName value to match the one set up previously. Save the file and exit.
12. Start Central on the secondary server:
mmcentral –start
13. Verify that you now have 2 servers, one primary, one secondary in Tools → Manage High availability.
14. Create a round robin DNS name for the high availability setup, i.e. two A records with the same name, but each
with the IP address of the primary and secondary server respectively.
Note: Repeat these steps for each high availability failover you’d like to add. The priority for each failover member
should be unique and higher than the primary.

Editing HA member options
1. Log in to the web UI and go to Admin then Configuration
2. Click on High Availability
3. Hover over the server member and click on the ellipsis (or meatball) menu
4. There are three options:
Edit Member
Change the name or priority of the server member in the HA cluster
Set Active
Set the server to be the Active member of the HA cluster manually
Remove Member
Remove the server member from the HA cluster
Proceed to Server controllers.
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Updating Central in High Availability setup

Warning: The Automatic Update feature cannot be used when the Central service is in High Availability setup
The procedure for updating the Central servers in High Availability is as follows:
1. Turn off the Central service on each secondary server
2. Upgrade the primary server manually using an installer. An installer can be downloaded from https://download.
menandmice.com/
3. Upgrade each secondary server manually using an installer. After the upgrade finished successfully, the service
will be started again.
4. Now, both servers should be upgraded and again in High Availability mode.

1.7.3 Men&Mice Central HA tweaks
Changing the default heartbeat timestamp value in Central HA
The local time of the cluster member machines are used to update the heartbeat timestamp in the database. It’s crucial
that the cluster member machines have a synchronized time.
By default the Central instances update the heartbeat timestamp in the database every 10 seconds, as set in the /var/
mmsuite/mmcentral/preferences.cfg file:
<HeartbeatInterval value=“10” />
This can be tweaked between values of 5 and 15.
When a Central instance stops to write the heartbeat timestamp to the DB the HeartbeatMaxAllowedDowntime value
is used to determine if a failover is done to the next valid Central in the list. (Valid meaning, in this case, that the next
Central application is a HA cluster member and is writing its heartbeat timestamp to the database.)
The default maximum downtime is set for 30 seconds. When the current time [UTC – heartbeat timestamp UTC] >
[HeartbeatMaxAllowedDowntime] an automatic failover is triggered.
The default maximum downtime can be overwritten in the /var/mmsuite/mmcentral/preferences.cfg for each
Central instance:
<HeartbeatMaxAllowedDowntime value=“30” />
Values between 20 and 120 are allowed, setting the maximum downtime to 20-120 seconds.

1.7.4 xDNS Zone Redundancy Groups
Overview
Zone redundancy groups can be used to keep different zones in sync. If a DNS record is added, modified or deleted in
a zone that is a member of a zone redundancy group, then the changes will be replicated to other zones in the group.
Any unsigned non-AD integrated master zone can be added to a redundancy group, as long as it is not already a member
of a different group.
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Manage xDNS Zone Redundancy Groups
To manage xDNS Redundancy Groups select Zone → Manage xDNS Zone Redundancy Groups in the Management
Console.
This will open the xDNS Zone Redundancy Groups Dialog. The dialog can be used to add, edit or remove a redundancy group.
Adding a zone redundancy group
To add a redundancy group from within the xDNS Zone Redundancy Groups Dialog, click the Add button to open the
xDNS Zone Redundancy Group Wizard:

Select a unique name for the redundancy group and then click Add to select the zones to use in the group.
The following dialog is displayed:

Select zones to use in the redundancy group. Note that you can use the quick filter to reduce the number of zones
displayed in the list. It is also possible to right click on the list to check or uncheck all zones.
Click the Ok button to close the zone selection dialog once the zones to use in the group have been selected:
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Click Next to select an initial zone to use when syncing the redundancy group:

The initial sync zone is used as a base for determining how to sync the zones. The initial sync zone will only be used
for the first sync, when the group is created. After the zones have been synced for the first time, they will all be checked
for changes that are replicated to other group members.
Note that you will be given a chance to decide how to deal with records that conflict between zones before the redundancy group is created.
Click Next to configure the sync policy for the zones in the redundancy group.
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The sync policy specifies how each zone handles external changes from other zones in the group. The zones selected
here will replicate the changes when other zones in the group are modified externally, outside of Micetro. The zones
not selected will act as “readonly” and only receive updates done through Micetro or when the zone itself is modified
externally, for example through it’s corresponding cloud portal.
Click Next to write a save comment that will saved when the group is created:

Click Next to see a summary of how the group will be configured:

When the Finish button is clicked, a check is made to see if a zone contains any DNS records that are not in the zone
that was selected as the initial sync zone. If there are no conflicts, then the redundancy group will be created and the
wizard will close.
If there are however any conflicts, then they will have to be resolved before the group is created:
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The conflict can either be resolved by replicating the DNS record to other zones in the group or by deleting the record.
Click Next to see a summary of the changes and then click “Finish” to create the zone redundancy group.
It is also possible to create a redundancy group by right clicking selected zones and then click Create xDNS Redundancy
Group:

The xDNS Zone Redundancy Group Wizard will then open with the selected zones.
Edit a zone redundancy group
To edit a redundancy group from within the xDNS Zone Redundancy Groups Dialog, click the Edit button (or double
click the group name) to open the xDNS Zone Redundancy Group Wizard.
It is not possible to change the group name, but zones can be added and removed from the redundancy group.
Here the master zone residing on the Azure Cloud service has been removed and the zone example.menandmice.is on
the DNS server ext1.menandmice.is has been added to the group.
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Click Next to add a save comment.
Click Next to see a summary for the changes that will be made:
When the Finish button is clicked, a check is made to see if a zone being added contains any DNS records that are not
in already in the group. If there are no conflicts, then the redundancy group will be modified and the wizard will close.
If there are however any conflicts, then they will have to be resolved before the changes are applied:

The conflict can either be resolved by replicating the DNS record to other zones in the group or by deleting the record.
Click Next to see a summary of the changes and then click Finish to modify the zone redundancy group.
It is also possible to add and remove a zone from a redundancy group by right clicking on a zone in a zone list:
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The xDNS Zone Redundancy Group Wizard will then open with the selected zones.
Removing a redundancy group
A redundancy group can be removed from within the xDNS Zone Redundancy Groups Dialog.
Select one or more redundancy groups that you want to remove and click Remove.
Confirm the removal, enter a save comment and click Ok to remove the selected zone redundancy groups.
Re-syncing zone redundancy groups when all members are out-of-sync
When a zone in a redundancy group can not be kept in sync with other zones in the group (e.g. if a DNS server is
offline), then its status will be set to “Out Of Sync”. Once the zone comes back online it will automatically be synced
with a different zone in the group that is in sync. The zone state will then be set to “In Sync”. However, if all group
members are out of sync, then the group has to be manually synced again.
If a zone that is out of sync changes, then the changes will not be replicated to other zones in the group, until it is back
in sync. Note that it is still possible to make changes to the zone and manage it in Micetro. The changes will however
not be replicated to other group members.
To re-sync a redundancy group from within the xDNS Zone Redundancy Dialog, click the Edit button (or double click
the group name) to open the xDNS Zone Redundancy Group Wizard:

1.7. Advanced configuration
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Click Next to select an initial sync zone to use:

The initial zone will be used as a base when the group is re-synced. If there are any DNS record in other zones in the
group that are not in the initial zone, then an option will be given on how to resolve the conflicts before the group is
re-synced.
Click Next to add a save comment.
Click Next to see a summary of the changes that will be made:
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When the Finish button is clicked, a check is made to see if a zone in the redundancy group contains a DNS record that
is not in the zone selected as the initial sync zone.
If there are no conflicts, then the redundancy group will be re-synced and the wizard will close. If there are however
any conflicts, then they will have to be resolved before the group can be re-synced.

1.7.5 Custom links in the web application
You can add up to three custom links that show up on the Micetro login page.

To add your custom links (for example internal support channel):
1. Open the preferences.cfg file for Men&Mice Web Services.
• Default location on Windows: C:\ProgramData\Men and Mice\Web Services\preferences.cfg
• Default location on Linux: /var/mmsuite/web_services/preferences.cfg
2. To the end of the file, add the links in the following format:
<LoginFootnote value="Link Text 1[https://www.example.com/link1],Link Text 2[https://www.
˓→example.com/link2],Link Text 3[https://www.example.com/link3]" />
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3. Restart the MMWS service to pick up the changes:
• On Windows: mmws.exe
• On Linux:
systemctl restart mmws

Note: The MMWS service always needs to be restarted after changes to its preferences file.

1.8 Update Guide
The Update Manager notifies you when a new version of Micetro is available and simplifies the update process for
Micetro. Using the Update Manager you can update Men&Mice Central, the Men&Mice Server Controllers and the
Men&Mice Appliances with minimal downtime.

1.8.1 Update paths
If you’re updating Micetro from an older version, refer to the following table:
Origin version
9.x
8.x
7.x
6.x

Target version
10.x
10.x
10.x
10.x

Update to
10.x1
10.xPage 90, 1
10.x1
9.3

1.8.2 Checking and Downloading an Update
When you log into the system using the Management Console, an update notification is displayed when a new version
of Micetro is available.

You can also check if an update is available by selecting Tools → Check for Updates.
Note: To receive update notifications and check for updates, you must be in a group with administration privileges.
Only the Administrator user can perform the actual update.
1
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If you are not interested in receiving notifications for the update, select the Don’t show again for this version checkbox.
When the checkbox is checked, a notification for the specific update is no longer displayed, however, if a later update
becomes available, the dialog box is displayed again.
Click the Details button to get more information on the update. This displays a dialog box that shows all available
updates.

To view the release notes for an update, select the corresponding update and then click the View Release Notes button.
This will show the release notes in a web browser.
To download the new version, select the version and click the Download button. The new version is downloaded and
stored on the Men&Mice Central server. Once the download has completed, you can start the update.
Note: To download and perform the actual update you must be logged in as Administrator. If you are not logged in as
Administrator, the Download button is disabled.

1.8.3 Installing an Update
Once the update has been downloaded, you can start the actual update process. The Update Manager can update
Men&Mice Central, connected Server Controllers and Men&Mice Virtual Appliances. The Men&Mice Web Application must be updated manually.
If you want to perform the update at a later time, you can close the dialog box. To display the dialog box again, select
Tools → Check for Updates.
The following instructions contain information on how to update Micetro after the update has been downloaded using
the Update Manager.
1. To start the update process, click the Start Update button in the update details dialog box. When you click Start
Update the following happens:
• Men&Mice Central and the DNS and DHCP server controllers are updated. (See Updating Central in High
Availability setup for updating Central in HA configuration.)
• If the update contains a new version of the Men&Mice Web Application, a dialog box is displayed where you
can find instructions on manually updating the Men&Mice Web Application.
• If your environment contains a Men&Mice Appliance, the latest version of the Men&Mice Appliance software
is uploaded to the Appliance, but isn’t applied automatically.

1.8. Update Guide
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Updating an Appliance
As an update to the Men&Mice Appliance sometimes requires that the Appliance is restarted, the update is not applied
automatically.
To complete an Appliance update, you must manually initiate the update. To minimize service disruption you might
want to update your Appliances in several batches.
1. From the menu bar, select Tools → Update Status. The Update Status dialog box displays. The dialog box shows
the update status for all DNS and DHCP server controllers as well as all Men&Mice Appliances. If an update
is pending for an Appliance, the status is listed as Update pending and a checkbox is displayed in the Update
column.

2. Click the checkbox to select the Appliance(s) you want to update.
3. Click the Update Appliances button. This will update the selected appliance(s).
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1.8.4 Viewing Update Status
Through the Update Status dialog box, you can always view the update status for Micetro components. To display the
Update Status dialog box, select Tools → Update Status.

The dialog box shows the update status for all DNS and DHCP server controllers as well as all Men&Mice Appliances.
If an update is pending for an Appliance, the status is listed as Update pending and a checkbox is displayed in the
Update column.
Uncheck the Show servers that are up-to-date checkbox to only show servers that need to be updated.
Note: The Auto Updater will update all connected server controllers along with Central.

Note: If some Controllers can’t be updated automatically please check if the M&M Updater daemon or Windows
service is running on the server and if the port 4603/tcp is accessible from the machine that runs Central. See Networking
requirements for more information.

Warning: When Central is in a high availability configuration, the Auto Updater cannot be used. See Updating
Central in High Availability setup for instructions.
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1.8.5 Verifying the updates
In order to verify that the update has propagated to all servers:
1. Log in to the Management Console
2. Navigate to Tools → Update Status
3. Review the version reported for each of the listed components. The listed version number for Micetro is listed
near the top, and should match the version of each component in the list.
4. Log in to the Web Application, click on the User icon in the top menu. Verify that the version listed there matches
the version of the Men&Mice Central that was installed.
Note: If there’s a version mismatch between components, the Management Console and Web Application will report
an error when trying to log in.

1.9 User Manual
What is Micetro by Men&Mice?
Micetro is an orchestration tool for DNS, DHCP, and IP Address Management in diverse network environments.
Using Micetro, you can maintain an overview of your network address space and manage a changing environment with
minimum effort. Micetro provides many tools to minimize your effort, including direct views of server data, logical
views of diverse data, and a number of wizards.

1.10 Micetro user interface(s)
Micetro currently uses two user interfaces: the new, browser-based Web Application and the older, Windows-only
Management Console.
Note: Migrating features from the Management Console to the Web Application is ongoing, and new features are not
added to the Console.

1.10.1 Web Application
User Guide
Introduction
The Web Application is split into five main sections:
1. DNS management
2. Network management
3. Reports Management
4. Workflow Management
5. Admin
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From the DNS section it is possible to:
• Create, delete, and edit DNS zones
• Manage DNS records within the DNS zones
From the Networks section it is possible to:
• Create a new network range or a DHCP scope
• Manage the the IP addresses within a network or a DHCP scope
• Create DHCP reservations
• View related DNS data for IP addresses within a network
• Add DNS hosts for IP addresses
In the Reporting section (activated with a separate license key) it is possible to:
• Create and save new reporting definitions
• Schedule reports to be run at specific times
Note: The Internet Explorer browser is no longer supported as of version 9.3.0.

Using the Web Application
Logging in
Server
The hostname or IP address of the server running Men&Mice Central
Username
The username you want to log in as
Password
The password for the specified user
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Log in with Single Sign-on
You can use existing SSO to log in. Note that the checkbox is only visible when the web server supports SSO.
For more information see Configure Single Sign-On.
Note: If you’re logged in through an SSO service, the Change password operation is disabled in the User menu.

Using the Men&Mice Web Application
The Web Application is split into three main sections: DNS management, Network management, and Reports Management.
For information on elements common to all sections, see General.
Getting help or support
Important information about how to get help and access the documentation can be found in the right sidebar on the
front page of the Web Application.
The help sidebar can also be accessed by clicking on the ? icon in the top menu in all sections.
General
The front page
The front page of the Web Application gives an overview of the available operations.
Note: A persistent help section, (see Getting help or support) is available in all views.
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Working with the list view
Introduction
The web application is centered around the grid listing objects in the system. (For example: DNS zones, DNS records,
IP address ranges, DHCP scopes, IP addresses, etc.)

Operations highlighted in the image:
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Refresh list
Column configuration
Quickfilter
Toggle list or tree view
Refresh list
Add to favorites
Main tasks
Inspector
Filtering sidebar
Quick command

Refreshes the list containing a list of zones, ranges, records or IP addresses
Specifies which columns are visible in the list.
The quickfilter functionality is described in webapp-quickfilter.
Toggles the ‘Networks’ list between list and tree views
Refreshes the contents of the list
Adds the selected item in the list to favorites. The corresponding favorites filter in the
sidebar shows all favorited items.
The main tasks in each section. All available tasks are shown at the top of the Inspector
Shows various information for each selected item in the list. See The Inspector.
Shows a list of possible filters to use for the list. See Filtering sidebar.
Allows for quickly finding and performing actions. See Quick command.

Folders
Folders can be used as containers of objects such as DNS zones and networks.
Note: Currently the Web Application does not support managing folders (creating, editing, deleting), which needs to
be done through the Management Console. See Object folders for further information.
The available folders, along with the folder hierarchy can be viewed in the filtering sidebar. Clicking on a folder will
display the contents of the specific folder.

Selecting an item in the list and running the “Set folder” task from the Actions, will display a dialog where the item
can be moved from one folder to another or removed from a folder.
Selecting multiple items
Selecting multiple items in the list can be done by:
• On Windows: holding down the CTRL or SHIFT button and selecting rows with the mouse
• On OS X: holding down the CMD button and selecting rows with the mouse
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Results
In the list’s footer, the number of results is shown:

If a filter is applied, the filter string is highlighted:

Top menu

The top menu allows to switch between the four main sections of the Web Application (DNS, IPAM, Reports, and
Admin). Additionally, the Quick commands, User menu, and Help is accessible.
Navigating
The navigation bar at the top of the grid interface
• indicates where you are
• allows you to navigate between subsections
You can also quickly check your current location by glancing at the breadcrumbs at the bottom of the interface.
History
The history for the following objects is made available as a task (in the inspector actions) as well as a Quick Command.
• DNS zones
• DNS records
• IP address ranges
• DHCP scopes
• Workflow requests
The history dialog can be used to view past changes. By clicking on the filter icon in the header for the history dialog,
additional options are made available for filtering the history.
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Save comments
For audit trail purposes, saving comments is required after making changes in the system.
After making a change, the following dialog is displayed where users can write a comment that will be included in the
history for that object.
Date and time handling
In certain places like scheduling a change in Workflow and scheduling a report generation in Reporting, the date and
times must be in the same time zone as the Men&Mice Central uses.
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Filtering sidebar
Overview
The filtering sidebar acts as a selector in each context, and allows users to quickly find the zones or networks. Users
can select pre-defined “filters” or selectors (shown in the image on the right, and described in tables below for other
contexts in the system).
The sidebar is open (displaying icon and text) by default, but can be collapsed to an icon-only mode. In case where a
list of clickable items is needed the sidebar is automatically unfolded.
Selecting an item in the filtering sidebar applies the filter for the main work grid. Users can further narrow down results
with quickfilters from the top menu. (See Quickfilter.)
Tip: When you select a filter in the filtering sidebar, and then use the Create operation in the grid, the type of object
will be automatically selected based on the active filter.

1.10. Micetro user interface(s)

101

Micetro by Menamp;Mice Documentation, Release 10.2

Common filters
These are a set of common filters available in all sections for the Web Application.
Name
All <zones, records,
networks, IP addresses>
Favorites
Folders
Recently viewed
Recently created
Recently modified

Description
When selected, all objects (DNS zones, DNS records, networks and IP addresses) are shown
All items that have been flagged as favorite in the system are shown here in each context
All items that have been added to folders in the system are shown here in each context
All items that have been viewed in the last 24 hours
The last 15 items that were created
The last 15 items that were modified

Filters for DNS zones

Name
Zone types
DNS views
DNS services
DNSSEC signed
Reverse zones

Description
Allows users to select between master, slave or other (for example stub, forward or AD
integrated) zones
Shows all existing views that are configured in the system as a list
Shows all DNS servers configured in the system
Shows all DNSSEC signed DNS zones
Shows all reverse zones configured in the system

Filters for DNS records

Name
Record types
DNSSEC records
Dynamic records

Description
Allows users to select between the following record types: A / AAAA, CNAME, NS, MX,
Other
Shows all DNSSEC records in the DNS zone
Shows all dynamic DNS records in the DNS zone

Filters for Network list

Name
IP ranges
DHCP scopes
Containers
Highly utilized
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Description
Shows all IP ranges configured in the system
Shows all DHCP scopes configured in the system
Shows all containers configured in the system and allows users to show the contents from
the container that is selected
Show all networks that have a utilization higher than or equal to 90%
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Filters for Network contents

Name
Recently seen
Status

Description
Show all IP addresses that have been recently discovered by a router or a firewall
Allows users to show all IP addresses based on the following statuses: Free, Assigned,
Claimed, Leased, Reserved

The Inspector
Overview
The inspector, located to the right of the grid in each context, serves as an infobox for the selected objects (such as the
DNS zone list) in the grid, as well as always showing the possible actions for the selected item at the top. In some cases
it is possible to edit the information, such as DNS zone authority or the SOA record, for each zone.
An example of an inspector for a DNS zone is shown in the image on the right.
Actions
All actions for the selected object are shown in the actions section.
Properties
All properties for the selected object are shown in the properties section. These include all custom properties that have
been defined for a specific object type.
For IP addresses, where available, the vendor for the specific MAC address is also shown.
Context specific
DNS zones
The following sections are specific to DNS zones.
SOA
Allows the user to see and edit SOA information for the selected DNS zone.
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Authority
Lists all authoritative servers for the selected DNS zones. Allows for modifying which servers are slave servers for the
DNS zone.
DNS Records
Related DNS Data
Shows all related DNS records. (For example TXT or CNAME records that are associated with a specific A record.)
Allows editing each record by clicking on the menu for each.
Networks
Related DNS Data
Shows all related DNS records. (For example TXT or CNAME records that are associated with an IP address.)
Allows editing each related record by clicking on the menu for each.
Related DHCP Data
Only shown where applicable. (I.e. when there is related DHCP data.)
Shows a list of reservations where each reservation can be edited or deleted through a menu.
DNS management
DNS Zones
Here is an overview of the main functionality for managing DNS zones.
By default, the list shows only master DNS zones, but to see other types of DNS zones, the filtering sidebar offers
options to select different types.
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Viewing the DNS zone list
After entering the DNS section of the Web Application, users are presented with a list of all DNS zones in the system
that they have access to view.
Opening a DNS zone
Opening a DNS zone can either by done by
• selecting the zone in the zone list and clicking on the Open button in the task bar above the zone list; or
• double clicking on the zone.
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Creating a DNS zone
Creating a new DNS zone can be done by clicking on the Create button above the DNS zone list. From the dropdown,
select the zone type (Master, Slave, Stub, or Forward).
The following dialog presents the options for the operation:

Item
Zone name
Master server
Slave servers
Open zone after creating
Save comment
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Description
The name of the DNS zone to be created as a fully qualified domain name (FQDN)
Specifies the server which will act as the master server for the DNS zone
Specify which server(s) should act as slave servers for the DNS zone
If checked, the DNS zone will be opened right after it has been created
Allows users to write a comments to save for audit trail purposes.
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Editing zone Properties
Any custom properties that have been defined for DNS zones can be added and edited here.
Deleting a zone
Select the zone to be deleted and click on the Delete zone action in the action part of the Inspector on the right hand
side.
Migrating a DNS zone
A DNS zone can be migrated between DNS servers.

1. Select the DNS zone in the list and run the Migrate zone action.
2. Specify the destination server. This is the server for which the DNS zone will be migrated to.
3. After migrating, you are presented with a dialog which confirms a successful zone migration.
Promoting a secondary zone
You can select a secondary (slave) DNS zone and promote it to primary (master) using Promote to master from the
selected zone(s)’s ellipsis menu. The confirmation dialog will also offer the ability to automatically update the SOA
record’s master record. (Default: true.)
DNS Records
After having opened a DNS zone, it is possible to:
• Add DNS records
• Edit DNS records
• Delete DNS records
• Disable DNS records
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The Inspector for DNS records allows the following actions and details for each selected DNS record in the DNS zone
list.
Item
Actions
Properties
Related DNS
Data
Related IP address

Description
Lists all available actions for the selected record
Lists the properties for the selected DNS record
Lists all related DNS records for the selected DNS record. Related DNS records all DNS records
that are somehow associated with the specified record.
List the related IP address in case of an A or AAAA DNS record.

Creating a new DNS record

Note: For importing DNS records in bulk, see Import DNS Records.
To create a new DNS record, either click on the Create button in the main task bar or click on Actions → Create new
DNS record from the top menu or in the Inspector.
The following dialog presents the options for the operation:

Available record types are:
• A / AAAA
• MX
• TXT
• NS
• SOA
• SRV
• HINFO
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• CNAME
• TLSA
• CAA
• CERT
• WKS
• RP
• AFSDB
• LOC
• SSHFP
• SPF
• DNSKEY (read only)
• NSEC (read only)
• NSEC3 (read only)
• NSEC3PARAM (read only)
• RRSIG (read only)
• DS
• DLV (read only)
New DNS records can be added by filling out the required data and additionally custom fields if there are any.
For A records, there is useful autocomplete behavior that can help finding a free IP address in a network.
Typing in the first digits of a network will allow you to see a list of networks to choose from.
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Selecting the first item from the list will fill in the Address field with the next free IP address from that network.
Additionally, insights for the specified IP address will be shown.
After typing in an IP address or selecting from the list, an indicator will be given on the state of the IP address, whether
it is Free, Reserved, Claimed or Assigned.

IP Address Insights
The IP address insights feature aims to give details on the IP address and related objects.
Typing in the full IP address in the the Address field will indicate the state of the IP address. Additionally, the IP
insights are shown, which are details on the IP address itself and related objects.
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Hovering over the i icon will list further information or show a list of objects:
• Network will show more details on the network.
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• Properties will show a list of all defined properties for the specified IP address.
• DNS hosts will show a list of all defined DNS hosts for the specified IP address.
• MAC address will show a list of additional MAC information for the specified IP address.

• Last seen will show a list of additional information for the specified IP address.
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Network
Network type
Properties
DHCP client
DNS hosts
MAC address
Last seen

Table 4: IPAM Insights
The network containing the specified IP address
Either an IP address range or a DHCP scope
Various properties including custom properties, if defined.
Lists all DNS hosts that are set for the specified IP address
The MAC address of the discovered device
The date for which the IP address was last seen

Time to live (TTL)
Throughout the system, the TTL value can either be specified in seconds or using the shorthand notation, such as
1s:
1m
1h
1d
1w

1 second
1 minute
1 hour
1 day
1 week
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Editing a DNS record
1. Select the DNS record in the DNS record list
2. Either click Edit in the main task bar, or click on Edit DNS record in the Inspector actions.
3. A dialog is displayed which allows you to modify the DNS record
4. Click Save to persist the changes.
Deleting a DNS record
1. Select the DNS record in the DNS record list
2. Click on Delete in the main task bar or click on Delete DNS record in the Inspector actions.
3. Users will be prompted before the record(s) are deleted
Disabling a DNS record
1. Select the DNS record in the DNS record list
2. Click on Disable DNS record in the Inspector actions.
3. Users will be prompted before the record(s) are disabled
Import DNS Records
DNS Records can be imported in the Micetro Web Application.
Prerequisites
The user importing must have access to edit records in the zones used in the import.
See Access control for further information on access controls.
Import task
The action to import DNS Records is available from the Actions menu in the DNS zones list, that allows importing
records to different zones at the same time.
Actions → Import DNS Records is also available from within a specific zone, which allows importing records to that
zone only.
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DNS bulk import format

Note: When choosing files, only plaintext CSV/TSV/TXT files are accepted. Excel spreadsheets need to be exported
to one of these formats prior to importing.

Header line
The first line of the data must be the header line, containing the name of the fields in the corresponding columns of
the lines after it. Some of the fields refer to built-in system fields, while the rest of the fields are matching the custom
properties that are defined for the object type in question.
Tip: It’s only necessary to include the fields that need to be imported/updated, except for properties that are defined
as mandatory, or required to be able to identify the object to import.
The field names in the header line are not case sensitive. For example, “title” will be correlated to the custom property
“Title”.
Built-in fields
action
(Default: Add) Add, Modify, or Remove.
Tip: The following aliases can be also used:
• Insert/Create = Add
• Update/Change = Modify
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• Delete/Del = Remove
name
zone

(required) Hostname of the record.
The zone containing the record.

authority
If multi-master, the authority of the zone.
view
forest
type
data
TTL

If multi-master, the view containing the zone.
If multi-master, the forest of the zone.
(required) The type (A, CNAME, MX, etc.) of the record.
(required) The data (IP for A/AAAA, the target A/AAAA record for CNAME, etc.) for the record.
The Time-to-Live value of the record. Time value defaults to seconds, but hour (i.e. 1H), day (i.e. 2D), week
(i.e. 3W), or month (i.e. 4M), or year (i.e. 5Y) can be used.

comment
Optional save comment.
newdata
If modifying an existing record, the new data to replace the old value.
Examples
Add records
Import A record ‘viola’ to the zone ‘illyria.coast’:
name,type,data
viola.illyria.coast.,A,16.0.2.2
Import A record ‘viola’ to ‘illyria’ providing a view name:
name,type,data,view
viola.illyria.,A,16.0.2.2,first-folio
Import A record ‘viola’ to ‘illyria.palace’ to the authority of ‘orsino’:
name,type,data,authority
viola.illyria.palace.,A,16.0.2.2,orsino
Import A record ‘cesario’ to ‘olivia.palace’, when zone and authority are specified:
name,type,data,authority,zone
cesario.olivia.palace.,A,16.0.2.2,illyria,orsino.palace
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Modify records
Modify IP address for the A record ‘viola’:
action,name,type,data,newdata
modify,viola.illyria.coast.,A,16.0.2.2, 20.21.9.6
Modify IP address for the A record ‘viola’ but leave the TTL as it was:
action,name,type,data,newdata,ttl
modify,viola.illyria.coast.,A,16.0.2.2, 20.21.9.6,
Modify IP address and TTL for the A record ‘viola’:
action,name,type,data,newdata,ttl
modify,viola.illyria.coast.,A,16.0.2.2, 20.21.9.6, 2H

Remove records
Remove A record ‘malvolio’:
action,name,type,data
remove,malvolio.olivia.palace.,A,16.0.2.2

Network management
Networks
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Viewing the network list
In the Networks section of the Web Application, users are presented with a list of all networks in the system that they
have access to view.
The networks lists shows all IP address ranges and scopes in the system (depending on what is selected in the Filtering
sidebar). The visible columns can be configured by clicking on the “Configure columns” icon above the list.
The utilization of ranges and DHCP scopes is shown in a column called Utilization showing each network’s utilization.
Creating a network
Step 1
Click on the Create button above the list, or click on Actions → Create new network on the top or in the Inspector.
A wizard dialog appears to guide users through the process.

1. Fill in the network along with the subnet mask.
2. When creating a DHCP network, the check box Create a DHCP network should be checked. (See below for
details.)
3. Specify if network and broadcast addresses should be reserved.
4. Click Next.
Step 2 (optional)
If the Create a DHCP network box was checked in Step 1, the following dialog is presented:
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Step 3

1. Fill in the Title and Description.
2. Fill in to any custom fields to be defined in the system.
3. Click Next.
Step 4
Users are presented with summary information about the network before it is created.

1. To open the range after it has been created, check the Open range after creating box.
2. Optionally, add a save comment for audit trail purposes.
3. Click Finish.
The new IP address range or DHCP scope will be created.
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Additional actions
After selecting a network in the list, the available actions are shown in the Inspector on the right.
Action
Create
network
Open network
Edit network
properties
Edit DHCP
options
Delete
network
Enable / disable scope
Set folder
Find next free
IP address
Set discovery
schedule
Convert
to
container
Convert
to
DHCP scope
Convert
to
network
Set
subnet
monitoring
View history
Import

Description
See Creating a network.
Opens up the network and lists all IP addresses.
Displays a dialog where the properties of the network can be configured.
Only for DHCP scopes. See Edit DHCP Options. Displays a dialog where DHCP scope options
can be added and edited.
Allows the network to be deleted from the system.
Only for DHCP scopes. A disabled DHCP scope will be indicated in the list in the Authority column, such as ‘Disabled on <Server name>’. Scopes on Cisco DHCP servers can not be disabled.
Allows for moving the object to a different folder, adding the object to a folder or removing from
a folder.
Opens the network and selects the next free IP address.
Enable and set discovery schedule for a network.
Allows for converting a DHCP scope or IP address range to a container.
Only for IP address ranges.
Only for DHCP scopes.
Allows for enabling and configuring subnet monitoring.
Opens a dialog which shows the history for the selected network.
Opens an import wizard where networks can be imported. See Import IPAM data.

Enabling / Disabling DHCP scopes
To disable a DHCP scope, select the scope in the list and use Actions → Disable scope.
To enable a DHCP scope, select the scope in the list and use Actions → Enable scope.
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Edit DHCP options for a scope
See Edit DHCP Options.
DHCP information
After selecting a DHCP scope in the list, information on DHCP pools can be viewed in the inspector on the right.
The name of the authoritative DHCP servers are shown along with pools and exclusions defined in the scope.
In the case of split and failover DHCP scopes, both authoritative servers are shown and the respective pools and exclusions.
Changing between address spaces
If there are more than one address space defined, it is possible to change between address spaces by going to User
settings → Address space and select a different address space to activate.
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IP Addresses
Viewing a network
To open a network, double click on a network or select the network and click on Open.
An example of a network which is an IP address range can be seen below.
Note: Each IP address in a network can have different states. It depends on whether it is an IP address network or a
DHCP scope.

Column descriptions
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IP Address Ranges

Column
Address
State

Description
An IP address within the IP address range.
For IP address ranges, the possible states for IP addresses
are:
• Free
• Assigned
• Claimed

Last known MAC Address

The last known MAC address associated with the IP address. (Obtained through discovery.)
A list of DNS hostnames associated with the IP address.
Shows the status of the Address (A) record and Pointer
(PTR) record mappings. This column can have three values:
Empty. There are no DNS records for the host. It is
also empty if a PTR record exists where the domain in
the data section of the PTR record is not managed by the
system.
OK. There is a match between the A and the corresponding PTR record(s).
Verify. There is no match between the A and the PTR
records for the host. The most common reasons are:
• There is an A record but the PTR record is missing.
• There is a PTR record but the A record is missing.
• The data section in the PTR record does not correspond to the name of the A record.

DNS names
PTR status

Last seen
Device

The date and time which the IP address was last seen
during discovery.
If the IP address is associated with a device, the name of
the device is shown.

DHCP Scopes

Note: The table below shows only additional columns shown for DHCP scopes. Shared columns are described in the
table above.
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Column
Pool color indicator

Description

State

For DHCP scopes, the possible states for IP addresses
are
• Free
• Assigned
• Claimed
• Leases
• Reserved

Lease name
Lease description
Lease client identifier
Lease expires
DDNS hostname

The name of the DHCP lease
The description of the DHCP lease
The client identifier of the DHCP lease
The expiration time of the DHCP lease
The DDNS hostname associated with the DHCP lease

•
•
•
•

Blue : IP address is in a DHCP pool
Green : IP address has a DHCP reservation
Red : IP address is in an DHCP exclusion range
Grey : IP address is in static part of DHCP scope

An example of a network which is a DHCP scope:
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Creating a DHCP reservation

Note: DHCPv4 and DHCPv6 scopes inherit DHCP and DDNS Options from the parent DHCP server. DHCPv4 and
DHCPv6 reservation inherit DHCP and DDNS options from the DHCP scope. However these options may be changed
by editing the options for the specific scope or reservation.
Inside a DHCP scope, select a specific IP address in the list, and then click on the “Reserve” button above the list.
Creating a DHCPv6 reservation
New identifier information is required for DHCPv6 reservations and these are:
Unique Identifier (DUID)
The globally unique identifier of the client system
Identity Association Identifier (IAID)
The indentifier of the interface on the client system
To create a DHCP reservation:
1. Under :guilable:`IPAM` >> DHCP Scopes double-click on a Scope and click on Reserve
2. Depending on whether an address was already selected from the grid before pressing Reserve choose from
the following options:
Selected
The address which was selected prior to clicking on Reserve
Automatic
A randomly selected IP address in that scope chosen by Micetro
Manual entry
An IP address entered manually by the user
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3. Input the following information:
Name
Unique identifier (DUID)
Identity association identifier (IAID)
Description
4. Click Save
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Editing DHCPv6 Options for Reservations
For more information on configuring DHCPv6 options go to [DHCP Options](https://menandmice.com/docs/10.2/
guides/user-manual/webapp_edit_dhcp)
1. Go to IPAM >> DHCP Scopes and double-click on a scope
2. Select a reservation and click on the ellipsis (or meatball) menu
3. Select Edit Reservation Options
Adding a DNS host
To add a DNS host for a specific IP address within a IP address range or a scope:
1. Select the IP address in the list
2. In the Related DNS data section of the Inspector, click on the + button
3. A dialog will be displayed which allows for adding the record

4. Specify a record name.
5. Specify a zone name. (Typing in the zone name field will start generating a list of potential zone names with
autocomplete.)
6. Fill in other information.
7. Click Create to create the new record.
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Additional actions
After selecting an IP address in the list, the available actions are shown in the Inspector on the right.
Action
Edit
IP
address properties
Find next free
IP address
Create
new
DNS record
Claim IP address
Ping
IP
address
View history
Import IP

Description
Displays a dialog where the properties of the IP address can be configured.
Selects the next free IP address.
Displays a dialog where DNS records associated with the IP address can be created.
Claims the IP address.
Pings the IP address. See Pinging an IP address.
Opens a dialog which shows the history for the selected IP address.
Opens an import wizard where networks can be imported.

Pinging an IP address
An IP address or multiple IP addresses in the list can be pinged by selecting them and then clicking on the Ping IP
address task in the Inspector.
An indicator is shown during the ping. Afterwards a green or red indicator on the left of the IP address indicates a
successful (green) or unsuccessful (red) ping.

Import IPAM data
Overview
To import IP address ranges or IP addresses into Micetro, the Import wizard in Networks can be used.
The Import wizard can be used to import:
• Networks
• IP addresses (and DNS hosts)
• Devices and interfaces
• DHCP reservations
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The data can either be pasted directly into the wizard or by using a file that is uploaded.

Prerequisites
The user importing must have the following permissions:
• Access to IPAM Module
• Access to the Web Application
• Access to IPAM view in Web Application
• Access to “Import Data” web task
(See Permissions reference.)
Importing Data
The lines in the import text, or the contents of the file chosen, must have lines whose columns/fields are separated by
either comma ,, semicolon ;, pipe | or the tab character.
For instance, when cells of a spreadsheet are highlighted and copied to the clipboard, they will be tab separated when
pasted into the text area of the Import Data wizard. When importing a fair amount of lines stored in an excel spreadsheet,
this is probably the easiest method of getting the data into the Import Data wizard.
Note: When choosing files, only plaintext CSV/TSV/TXT files are accepted. Excel spreadsheets need to be exported
to one of these formats prior to importing.
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Clearing values
When the value in a particular column is empty, it is by default not cleared. Instead it is not included in the import.
This makes it possible to update certain fields and leave others as is, in the same import.
To clear values for a custom property, e.g. Responsible Person, use one of these clearing tokens instead of a blank
value: $null, %clear, <none>, <blank>, or <empty>.
These tokens will only be interpreted to clear the field if field contains only the token and nothing else. For example if
the field value is “This is <none>” in the import text, the field would not be cleared, but set to that value instead.
See Example 5.
Header line
The first line of the data must be the header line, containing the name of the fields in the corresponding columns of the
lines after it. Some of the fields refer to built-in system fields, and are different depending on what is being imported.
The rest of the fields are according to the custom properties that are defined for the object type in question. It’s only
necessary to include the fields that need to be imported/updated, except for properties that are defined as mandatory,
or required to be able to identify the object to import.
The field names in the header line are not case sensitive. For example, “title” will be correlated to the custom property
“Title”.
Action field
In addition, there’s an optional column for “Action”, which defines whether the object specified in the line should be
added, removed or modified (defaults to “Add” when not specified)
The action column is identified by one of the following fieldnames: “Action”, “Operation” or “ActionType”. If one of
the custom fields defined conflicts with these names, the custom field has precedence and the column is not identified
as the action column. In that case use one of the provided alternatives for the action column that does not conflict with
a custom property name.
The Action field has three possible values
Add

Default for Range Import. Create, New, and Import are equivalent alternatives.

Update
Default for IP Address Import. Modify and Mod are equivalent alternatives.
Delete
Remove and Del are equivalent alternatives.
Ranges
Range column:
To identify the range to import, there are three options
• Include a “Range” column (alternatives: “Name”, “Network”, “Network range”, “IP range”, “IP Address range”
or “IPRange”) and provide the range in CIDR format (e.g. 192.168.1.0/24) or from-to format (e.g. 192.168.1.0192.168.1.255)
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• Include a “Network_address” and “Network_mask” columns, with the network address (e.g. 192.168.1.0) and
network mask (e.g. 255.255.255.0) as values. This will be converted automatically to the CIDR format, and
displayed in a single Range column in the next step
• Include a “from” and “to” columns, with the from and to address of the range to import
The first option should be preferred. The other two options are provided for convenience when the ranges are stored
across two columns in the source spreadsheet.
Built-in fields:
Container?
Identified in header line by either “isContainer”, “is_Container” or “is Container”
If set to Yes, then the range will be marked as container, or as Range/Scope when set to “No” (or not updated if
blank). See Containers for more information on the Container property.
Locked?
Identified in header line by: “Locked”, “isLocked”, “is_Locked” or “is Locked”
If set to Yes, locks the range. No unlocks it (blank does not update). See Network Configuration for more
information on Locked.
Allow auto-assignment of IP Addresses?
Identified in the header line by: “AutoAssign”, “Auto-Assign”, “Auto_Assign” or “Auto Assign”.
Set to Yes or No to set or unset the property. Leave blank to not update. See Network Configuration for more
information on Allow auto-assignment of IP Addresses.
Reserve Network and Broadcast Address?
Identified in the header line by: “Subnet”, “isSubnet”, “is_Subnet” or “is Subnet”
Set to Yes or No to set or unset the property. Leave blank to not update. See Network Configuration for more
information on Reserve Network and Broadcast Address.
AD site
Identified in the header line by: “ADSite”, “AD Site” or “ADSiteRef”
Associates the Range with the given AD Site, provided either as the name of the AD site (if unique) or the
internal reference id of the AD Site (e.g. “{#12-#1009}”). See AD Sites and Subnets for more information on
this property.
Custom fields:
In addition to the built-in fields for Ranges, all the custom fields that are defined for Ranges can be populated with
values.
If there is a conflict between the custom fields and the built-in fields, the custom field name will have precedence, and
one of the provided alternatives will need to be used for the built-in fields.
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IP addresses
IP addresses can be imported when the Import Data wizard is opened from within a particular Network, or from the
Networks overview page where networks can also be imported in the same wizard.
IP Address column:
To identify which IP address to import, provide a column where the header is one of: “IP Address”, “IPAddress”, “IP”,
“IP-Address” or “Name”, and provide the IP address to import in that column
Built-in fields:
Claimed?
Identified in header line by “Claimed” and “is_Claimed”
If set to “Yes”, the IP is claimed permanently. “No” waives the claim, if claimed.
DNS Hosts
Identified in header line by: “DNS Hosts” or “DNS Records” (plural or singular, space can be removed or replaced
with “_”)
The column should be a list of fully qualified hostnames that should be added to the IP, space or comma separated,
or that need to be removed from the IP. To remove specific hostnames, prefix the hostname with a hyphen “-”. To
clear all DNS records from the IP, use the value “$null” or “%clear”. Otherwise, the hostnames are added to the
IP, if they don’t exist already. This means these DNS records are created in the appropriate DNS Zones during
the import.
Note: At this time, DHCP reservations cannot be imported as part of the IP Address import wizard.

Custom fields:
Same applies here as for Ranges; all the custom properties defined for IP addresses can be imported.
Examples
Example 1
This example creates imports two ranges, 1.2.3.0/24 and 1.2.4.0/24 with the respective titles and descriptions.
Range,Title,Description
1.2.3.0/24, My range, My first range to import
1.2.4.0/24, My range2, My second range to import
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Example 2
This example creates deletes two ranges, 1.2.3.0/24 and 1.2.4.0/24.
Action,Range
Delete,1.2.3.0/24
Delete,1.2.4.0/24

Example 3
This example updates properties on the, 1.2.3.0/24 and 1.2.4.0/24. Notice how the mandatory Title column can be
omitted during update, and will be left as is, whether currently empty or not.
Action,Range,Location
Update,1.2.3.0/24, US
Update,1.2.4.0/24, US

Example 4
This example updates information on two IP addresses.
IP, Responsible Person
1.2.3.10, Jon
1.2.4.11, Snow

Example 5
This example clears Responsible Person property on two IP addresses.
IP, Responsible Person
1.2.3.10, $null
1.2.4.11, $null

Example 6
This example Adds DNS records to two IP addresses, and clears from the third.
IP, DNS Hosts
1.2.3.10, hostname.company.com hostname.company2.com
1.2.4.11, -hostname2.comany.com hostname3.company.com
1.2.4.12, $null
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Reports Management
Introduction
Micetro manages vast amounts of DNS, DHCP, and IPAM data. The first version of reporting in the Web Application
was introduced in version 9.1. To enhance the functionality in version 9.2, a new Reporting module has been created.
Building reports is easy and can be tailor-made by correlating related data in a few steps, and scheduling the results to
be generated daily, weekly or on a custom schedule. There are built-in report definitions that can be used as a reference
to build reports. Using custom fields in Micetro further enhances reports by correlating custom fields with the built-in
ones. The system then allows you to create reporting definitions that can be run either one time only, or scheduled to
run later or at regular intervals.
The reports can be viewed within the Web Application, or downloaded in various formats for further analysis.
When the Reports section is opened in the Web Application, the user is presented with a list of report definitions. Like
every other part of the Web Application, this list can be filtered and searched.
Reporting module
Users can:
• create and save new report definitions
• schedule reports to be generated
• run reports
• download reports in various formats
Main actions
The main actions are shown in the action list above the list of report definitions.
Create
Run
Properties
Schedule
Delete

Creates a new report. For more information, see Creating a new report.
For more information, see Run now.
For more information, see Edit report definition properties
For more information, see Schedule regular report generation
For more information, see Delete a report definition

The “Create” action can be run without selecting a report, but all the other actions require the user to first select a report
from the list.
Additional actions for reports are described in report-actions.
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Viewing the report definition list
A report definition is a recipe for the actual report. It contains the filter criteria used to build the report, along with
scheduling information and other properties.
The list of report definitions is shown when first entering the Reports section.

For help with finding and organizing the reports, use the filtering sidebar on the left-hand side of the list.
All reports
Favorites
Category

Shows all report definitions.
Shows report definitions that have been added to favorites. See Adding a report definition to
favorites.
Shows all report definitions that belong to a specific category.

Creating a new report
A new report definition can be created by clicking on the Create button above the report list, or by selecting the Create
new report in the action list in the Inspector.
With the wizard, the user can:
• change the report definition’s source,
• edit its filter,
• select the columns to be included in the output,
• and then run the report.
Additionally, it is possible to schedule a report to be generated at specific times or intervals.
After running the report, the user is presented with a preview of the results and has the option of saving a copy of the
report in a number of different formats. See Viewing the report results.
A description of each report source is described in Report sources.
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Step 1: Select source
Select one of the existing reports or a data source as the basis of the new report definition.

Step 2: Edit filtering criteria
In the second step, the user has the option of editing the filtering criteria. The user might want to make some adjustments
to the fields in the filter of the selected report definition, for example extending a time span or selecting a different
username. It is also possible to change the filter completely and create a new report definition.

Conditions and parenthesis

Operator
And
Or

Description
All the conditions have to be met
Sufficient that any of the conditions are met

It is possible to add parenthesis to create sub-conditions with a different operator. The report definition shown in the
screenshot above can be read as follows:
“Last seen must be less than one month ago, lost must be true and either claimed or usage must be true”.
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This translates into: “Show me hosts that have not answered during discovery in the last month that are either claimed
or in use.”
Comparison operator
Depending on the type of field the user is presented with different comparison operators.
String
equals
doesn’t equal
contains
doesn’t contain
starts with
doesn’t start with
ends with
doesn’t end with
matches regex
doesn’t match regex

Number,
pan, date
=
!=
<
>
<=
>=

times-

Boolean, pick-list, object
is
is not

Step 3: Select columns
It is possible to select which columns are to be included in the report result.

Note: All available columns are selected by default.
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Step 4: Save or run report definition
By checking the “Run once” box, the report definition will not be saved, and the user will be presented with a dialog
that shows the report results.
Press the Finish button to run the report and get the results.
By checking the “Open scheduling dialog after saving” users can schedule periodic executions of the report.
Step 5: Schedule

In this step, report generation can be scheduled to run periodically. The frequency and the interval can be specified,
and a start date can be set.
For more information, see Schedule regular report generation.
Step 6: Run the report definition
After the report has been created, it can be generated at any time by selecting the report definition in the list and clicking
on the the “Run report” task. (See Viewing the report results.)
Viewing the report results
Viewing the list of reports
To view a list of all reports that have been generated for a particular reporting definition, double click on the reporting
definition in the list.
This lists all reports along with the how much data is in the report (row count) and how long it took to generate the
report (duration).
Double clicking on a report in this list allows you to preview a report.
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Previewing and downloading a report
Previewing the report results can be done in various ways:
• Generating the report instead of saving it after going through the create report wizard.
• Selecting a report definition in the list and clicking on the “Run report” task.
• Preview a report result from a scheduled run:
1. Select a report definition in the list.
2. Find the “Reports” inspector item.
3. Find a scheduled run of a report and click on the timestamp or the ellipsis and selecting “Preview” from
the menu.
Note: The preview only shows up to the first 150 rows in the report. For the full report it needs to be downloaded.

In all cases, users will be presented with a preview of the report in a separate dialog. (As shown above.)
The results can then be downloaded by pressing the download button. The dropdown menu offers a number of file
formats to select from (ie. CSV, XML, JSON or SYLK).
Tip: Sylk and CSV are handy for importing the data into a spreadsheet application for further processing.

Actions for reports
In the actions part of the Inspector, the available actions for each selected reports are shown.
Note: In the case of the reporting module not being enabled, the unavailable actions are greyed out.

Run now
Select a report definition in the list and click on the Run now action.
A dialog is displayed showing a preview of the report results. (See Viewing the report results.)
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Schedule regular report generation
In this dialog a report can be scheduled to be generated at specific intervals. Additionally, it is also possible to specify
a path to a script that will be run after the report is generated and also can scavenging be scheduled.
1. Select a report definition in the list and click on the Schedule action.
2. The following dialog is shown where scheduling and scavenging can be configured.

Settings for schedule.
Enabled
Frequency
Every
Starts on

When checked, scheduling is enabled for this report
Specifies the frequency in which the report is scheduled to run.
Specifies the interval in which the report is scheduled to run.
Specifies the starting date for the report to be run on.

By selecting for example ‘2’ and ‘Weeks’, a new report is generated at the selected start on date/time and then at every
2 weeks afterward.
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Note: All dates and times are according to the time zone setting on the Men&Mice Central server.

Settings for Scavenging
Maximum number of reports to keep
Maximum number of days to keep results

Specifies how many reports will be retained in the system. This helps
with making sure that disk space does not run out in case many large
reports are generated in a small time interval.
Specifies for how many days the reoprts will be retained in the system. This helps with making sure that disk space does not run out
in case many large reports are generated in a small time interval.

Duplicate an existing report definition
Use this option to create a new report definition based upon an existing one.
1. Select a report definition in the list and click on the Duplicate action.
2. The create new report wizard will be shown, and the user will be allowed to edit the filtering criteria for the new
report. (As described in Step 2 in Creating a new report.)
Delete a report definition
1. Select a user defined report definition in the list and click on the Delete action.
2. A dialog is presented prompting the user if they want to delete the report definition.
Edit report definition properties
Both the report definition properties, the filtering criteria for the report and the data columns for the report results can
be edited.
Note: Only user created report definitions can be edited.
1. Select a report definition in the list and click on the Edit report properties action.
2. A dialog is presented which allows for specifying the properties for the report, along with editing the filtering
criteria.
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3. Clicking on “Edit” for the filtering criteria brings up the following dialog:
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Scavenge reports
Report results take up disk space on the Men&Mice Central server. The system allows for specifying the maximum
number of reports (or the maximum number of days to keep each result) for each report definition. Oldest results are
deleted when the limit is reached.
1. Select a report definition in the list and click on the Scavenge reports action.
2. A dialog is presented which allows for specifying the properties for scavenging reports.
Adding a report definition to favorites
1. Select a report in the list and click on the Delete action.
2. Click on the star button to the left of the Quick filter field:

Report sources
There are 24 reports definitions in the list under Reports (not counting user defined reports).
12 base report definition sources: sources that either allow the user to query one particular object type in the system
(e.g. Activity); or sources that give access to a particular data relation in the system (e.g. Host discovery).
12 derivatives of the base report sources showing the specification possibilities they offer. (Zone creation/deletion
building upon Activity and IP reconciliation building upon Host discovery.)
Report types
Activity
Access1
Address space merge conflicts1
DHCP lease activity
Discovered hardware addresses with multiple addresses1
DNS records
DNS zones
Host discovery1
IP ranges
IP addresses
Lease hardware address with multiple IP
addresses1
Men&Mice Suite messages
SOA records

1

Built-in reports
Administrator login New users added Range creation/deletion Zone
creation/deletion

Address records Multi-labeled hosts
Enabled DNS zones of type slave
IP reconciliation Discovered devices

SOA records with abnormal minimum TTL value SOA records with
abnormal refresh value

Specialized report source.
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Filter field types
String, number
Date and time
Timespan
Object, boolean, options

Free text input.
Date time string or current time delta shorthand units, e.g. -2w, +1d.
Timespan shorthand units, e.g. 24h, 2d, 30m
A dropdown is presented with the available options.

Timespan formats
<num><time unit>
<time unit> ::= s (seconds), m (minutes), h (hours), d (days), w (weeks), M (months), y␣
˓→(years)

Date time formats
General date time format consist of date and/or time (separated by a space).
<datetime>
<time> ::=
<date> ::=
|
|

::= <date> <time>
HH:MM[:SS[:TTT]][ AM|PM]
[yy]yy-mm-dd
dd.mm.yy[yy]
mm/dd/yy[yy]

Timestamps formatted according to RFC3339.
YYYY-MM-DDTHH:MM:SS[time-secfrac][time-offset]
Current time deltas, i.e. a date time relative from now, can also be used.
-|+ <num><time unit>
<time unit> ::= s (seconds), m (minutes), h (hours), d (days), w (weeks), M (months), y␣
˓→(years)
To include more than one value for a particular field the field has to be added again to the filter with an “OR” condition.
(For example: the Address records, where the record type field has to be either A or AAAA.)
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Quick command
Introduction
Quick Command is a feature to speed up common operations in the Web Application. It allows users to quickly find
and perform actions on specific objects in the system, using a single, persistent dialog box.
The autocomplete functionality in the interface allows typing in either names or the addresses and dynamically presents
the user options to choose from.
After selecting an object such as a DNS zone or a DNS record, the user can choose from a list of actions, for example
Open, Edit, Delete, Reveal.
Using Quick Command
The quick commands can be accessed by clicking either the lightning icon in the top menu or by using a keyboard
shortcut: Ctrl + Space.

Step 1
Start typing in one of the following
• A network
• A DNS zone name
• A DNS record name
• An IP address
A list of potential results will be displayed:
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Step 2
Select the object to work with.
Step 3
Select the action to perform on the object.

Available actions
The available actions for each object are:
Object
DNS zones

DNS records

Network
IP addresses
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Actions
•
•
•
•

Open DNS zone
Reveal
Edit zone properties
Delete zone

•
•
•
•
•

Add DNS record
Edit DNS record
Reveal
Delete DNS record
Disable DNS record

Open Reveal Edit network properties Delete network
•
•
•
•

Reveal
IP address properties
Claim IP address
Ping IP address
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Examples
Add a DNS record to an existing DNS zone
Adding the www2.example.com DNS record to the example.com DNS zone.
Step 1
Bring up ‘Quick command’ and write www2.ex
Step 2
Select the www.2.example.com from the list
Step 3
Fill in the details for the record in the add record dialog and click “Save”
The DNS record has now been added.
Find an existing DNS zone
Finding the zone corp.company.com and opening it.
Step 1
Bring up ‘Quick Command’ and write corp.com.
Step 2
Select corp.company.com zone from the list
Step 3
Select the action “Open zone”
Quickfilter

Note: Quicksearch
You can toggle the Quickfilter to Quicksearch. Quicksearch will only highlight matching objects in the grid, but still
display all other entries as well.
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Introduction
The Quickfilter can be accessed in all sections of the Web Application that uses a list of items (for example in the DNS
zone list in the DNS section).
The Quickfilter helps users to narrow down the results shown in each list after having selected an item in the filtering
sidebar. Alternatively, it can be used solely by specifying columns and values for each column to be filtered by.

How to use the Quickfilter

Tip: After typing into the Quickfilter or Quicksearch field, the number of results is shown and you can use the < and
> buttons on the right to step through the matches.
The Quickfilter can be used as a free text search by simply entering a some string into the field. Then the value is
matched to all rows that have columns whose value contain the string.
The column to match against can also be specified by providing the name of the column, a condition operator, and the
queried string.
type=slave
name=^example
name=$arpa.

Conditional Operators

Operator
=, ==
>, >=
=@
=^
=$
=~
in(. . . )

is equal
larger than, larger than or equal
contains
starts with
ends with
matches regular expression
is equal to one of the values in the given list

Opposite
operator
!=
<, <=
!@
!^
!$
!~
not
in(. . . )

is not equal
smaller than, smaller than or equal
does not contain
does not start with
does not end with
does not match regular expression
does not match any of the values in the given
list

Two or more conditions can be combined using and, or, and () parenthesis.
Note: Date and time values as well as MAC addresses, need to be enclosed in quotes when using in the quickfilter.
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Behavior in Networks
On the networks page, one way of finding the network which contains a specific IP address is typing the full IP address
into the quickfilter.

Workflow Management
Introduction
This current version of the Workflow module is focused on DNS changes, so a company can have better control over
what changes are done in their DNS infrastructure by approving or rejecting changes. It also helps preventing unintentional changes resulting from human error.
Organizations can give users access within the organization and the ability to request DNS changes, in some or all of
the DNS zones available in the organization.
The Workflow module allows the user to submit ‘change requests’ for creating, modifying or deleting DNS records:
1. The user makes a change in DNS. This can be adding a new DNS record or modifying or deleting an existing
DNS record. Instead of saving the changes or creating the DNS record immediately, users with limited access
have an option of creating a request to approve the change.
2. The request is created and can, be submitted for approval by users with necessary access.
3. User with permission of approving DNS requests can view a list of requests.
4. The request can be either approved or rejected. If the request is approved, the DNS change is made and the DNS
zone is updated automatically with the new data, either immediately or at a time specified in the request. If the
DNS request is rejected, the request is deleted and the DNS request history will indicate a reason for the rejection.
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Getting started
In order to use the DNS requests in the Web application, the Workflow module needs to be purchased and enabled.
The license key is added through the License Management dialog (see Administration Functions) in the Men&Mice
Management Console.
In order to use the Workflow module, there are two new workflow specific roles in Access Management, “Requesters”
and “Approvers” needed to be set. Users have to be added to the “Requesters” role to be able to submit requests.
Administrative users have to be added to the “Approvers” role to be able to see requests made by others and approve
them.
In addition, Approvers are only able to approve requests that involve DNS Zones in which they have access to edit
records.
Requesters also need basic read-only access to the DNS Zones (and the containing DNS server) to be able to request
changes, as well as the IP address ranges (to find available IP addresses).
Overview of DNS Requests in the system
When the Workflow module license key has been added and enabled, a new top menu item is visible.
Open Requests shows an overview of the change requests in the system. (An icon is shown in the top menu to the right
to indicate how many pending changes are in the queue. Clicking on the icon displays a dialog for submitting those
changes as a request.)

Filtering sidebar
The filtering sidebar has the following options for open DNS requests:
Pending
Failed
Closed
My requests
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Lists all DNS requests that are pending approval or rejection
Lists all DNS requests that encountered an error while being applied to the DNS servers
Lists all requests that are closed and have been either Scheduled, Fulfilled, or Rejected
Lists all requests for the current logged in users that are either Open or Closed.
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Actions
The following actions can be performed for a selected request in the list.
Open request
Edit request properties
Delete request
View history

Opens the request in a dialog where changes in it can be viewed and either approved or
rejected
Opens up a dialog where the properties for the request can be edited, if custom properties
for Change Requests have been defined
Allows for cancelling the selected request
Allows for viewing the history of the selected request

Inspector
The following items are listed in the Inspector’s Properties section for a selected request in the list.
Request ID
Type of changes
Requested by
State
Submitted on
Schedule for
Processed on
Comment

The ID of the selected request
Currently only DNS Records
Username of user that submitted the selected request
The current state of the request. Either Pending, Approved (i.e. awaiting scheduling), Rejected, Failed or Applied
Date the request was submitted
Date the request should be fulfilled on
Date the request was fully approved and applied
An optional comment the user provided when submitting the request

Creating a DNS request
In order to create a DNS request, one of the following can be done:
• Create a DNS record
• Edit a DNS record
• Delete a DNS record
Additional options are available when creating, editing or removing a DNS record.
Note: Access restrictions will affect which users have these options available.
Authorized users and approvers can also submit change requests, even if they have full access, in order to make scheduled changes.
Add to
request
Save
now /
Delete
now

Adds the changes to a DNS request. Number in badge on request queue icon in top right corner will
increase accordingly
DNS changes are applied immediately to DNS server(s)
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Note: After a DNS request for a DNS change has been created, the corresponding IP address will be set in to a pending
state and will not be available, for example when requesting the next Free IP address in the subnet.

Submitting a change request
Step 1: Open the pending request.
Open the pending request by clicking on the request queue icon in the top menu.

The following dialog is displayed, where the user can review the DNS changes to submit or remove a DNS change from
the queue.

Step 2: Scheduling
If the user want to make a scheduled change (i.e. the records are applied to the DNS server at a specific date and time)
they need to check “Schedule request” and provide the date and time.
Additionally, if custom properties have been defined for Change Requests, the user will be asked to enter those here,
along with the optional Comment.
Note: All dates and times are according to the time zone setting on the Men&Mice Central server.
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Step 3: Submit the request
Clicking on Submit will submit the request which is followed by an indication of a successful submission, along with
the ID (request number) for the request.
Approving or rejecting a change request
Pending requests are indicated in the top menu.

Clicking on the Workflow item in the top menu displays the Workflow page with an overview of all requests that the
user has access to view.
Double clicking on a pending request opens up the approval dialog:

The approval dialog shows the request to be approved or rejected, as well the following details:
Action
Name
Type
TTL
Data
State

Indicates what action is being performed: Add, Modify or Remove
The fully qualified DNS record name
The DNS record type
The Time To Live of the DNS record
The data being added. Hovering over the field shows the previous value, if being modified
The state of the change request

After clicking on the Approve button, the request is approved, and the data propagated accordingly.
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If the user clicks on the Reject button, they are prompted for a comment and then the request and all changes within
the request is rejected.
Admin Guide
See Admin.

1.10.2 Management Console
Overview
Prior to starting the Men&Mice Management Console, make sure that you have installed and started the other Micetro
components as applicable. Refer to the Implementation Guide for other components.
The Men&Mice Management Console is a rich, Windows-only application that boasts a very intuitive interface. It is a
central organizational tool of Micetro and provides all the tools you need to oversee the management of your DNS and
DHCP servers and IP Addresses.
From the Management Console, you can simultaneously manage DHCP/DNS servers on any supported platform.
Note: Be aware that you will only be able to view the servers to which you have access. The administrator user has
access to all servers.

Launching the Management Console
When logging into the Men&Mice Management Console, you have the option to choose “Single Sign-on.” This allows
those users working on a Microsoft Network with Active Directory to sign on one time only to access all your resources.
Note: If you are the system administrator, you can choose whether to enable this option. In the Management Console,
move to the menu bar and select Tools → System Settings. In the System settings dialog box, click the General tab.
Check in the checkbox next to Allow Single Sign-on to enable this option. Then click OK.
To start the Management Console, do the following:
1. Locate and launch the Men&Mice Management Console. The Men&Mice Management Console login dialog
box displays.
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2. In the Server name field, type the name or IP Address (IPv4 or IPv6) of the workstation on which Men&Mice
Central is running. This is only required the first time you log in. After a successful connection, this field will
be pre-filled with the server name you enter.
3. In the User and Password fields, type the applicable information.
administrator.

The default value for both fields is

4. If you want to enable Single Sign-on, click in the checkbox.
5. Click the Connect button. If this is the first time any user logs into this particular Men&Mice Central, the First
use wizard launches. Otherwise, within a few moments, the Men&Mice Management Console will start, and the
Manager window will display.
First Use Wizard
The First Use Wizard has been improved greatly in version 6.8. It is able to discover
• DNS Servers
• DHCP Server
• AD Subnets
When connecting the Management Console to a newly installed instance of Men&Mice Central or if this is the first
time logging in, you will be presented by the First Use Wizard.
1. Log in using the default credentials (administrator:administrator). You will be presented by the figure below.
Click ‘Next’ after having specified a new password for administrator user.
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2. Complete each screen as you move through the wizard.
3. The wizard will finish after the user clicks the ‘Finish’ button and afterwords the changes will be applied.
Console functions
Management Console Interface
When the Management Console is started up, the Manager Window displays in the center. This window is the heart of
the Men&Mice Management Console, providing a single interface with nearly every feature in Micetro.

This window consists of two main areas: the Object Browser and the Detail View.
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Object Browser
The Object Browser displays on the left side of the Manager window and contains categories of objects that can be
created, modified, and deleted.
Tip: A new feature in version 8.2 is the ability to filter by the type of object in the Object Browser. By clicking on
the respective icon at the top of the Object Browser, the Object Browser will show only that type of object. Clicking
on the “M” icon to the left will show all types of objects. Note that this applies only to Clouds, DNS, IPAM (Subnets
and DHCP), AD Forests and Appliances.
DNS Zones
Selecting the DNS Zones object will cause the Detail View to display all DNS zones configured in the system
and accessible to the current user. This category is accessible with a valid DNS Module License Key.
DNS Servers
Selecting the DNS Servers category will cause the Detail View to display all DNS servers managed by the system
and accessible to the current user. If a DNS server is not reachable, its icon is shown with an exclamation mark.
If the DNS Servers category is expanded, the same list of servers will show as sub-categories to the DNS Servers
category. Selecting a server subcategory will cause the Detail View to display the zones managed by that server
and accessible to the current user. This category is accessible with a valid DNS Module License Key.
DNS Views
The DNS Views category allows you to see zones on DNS servers that are configured with multiple views. If no
views are configured on any server, this category will not appear. The Views feature of the BIND name server
allows one server to return different data to different clients; each view has its own separate list of zones, often
with the same names. This category behaves similarly to the DNS Servers category.
IP Address Ranges
Selecting the IP Address Ranges category will cause the Detail View to display all IP Address Ranges configured
in the system and accessible to the current user. This category is accessible with a valid IP Address Management
Module License Key.
DHCP Scopes
Selecting the DHCP Scopes category will cause the Detail View to display all DHCP scopes configured in the
system and accessible to the current user. This category is accessible with a valid DHCP Module License Key.
DHCP Servers
Selecting the DHCP Servers category causes the Detail View to display all DHCP servers managed by the system
and accessible to the current user. If a DHCP server is not reachable, its icon is shown with an exclamation mark.
If the DHCP Servers category is expanded, the same list of servers will show as sub-categories to the DHCP
Servers category. Selecting a server subcategory causes the Detail View to display the scopes managed by that
server and accessible to the current user. This category is accessible with a valid DHCP Module License Key.
AD Sites
This category is only displayed if you have enabled AD Sites and Subnets integration. Selecting this category
will show all AD sites that have been selected for integration in Micetro.
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Detail View

Note: A new feature in version 7.2 is that the windows are now ‘docked’ and therefore they open up in a tab instead
of a window.
The Detail View displays on the right side of the Manager window and displays the contents of the selected category
in the Object Browser. While in this view, you can do the following:
Sort and filter
to allow a more concise view of the contents. Refer to quickfilter.
Display a shortcut or “context” menu
that gives access to other options. Right-click to view this shortcut menu.
Open an object by simply double-clicking
This opens either a property window (such as in the case of DNS/DHCP Servers), or brings you to a new view of
the data contained within the object (such as in the case of DNS Zones, DHCP Zones, and IP Address Ranges).
Reorder the columns
Click on the column you want to move and, while holding down the mouse key, drag the column to the new
position.
Display or hide columns
Right-click on a column header. All the column names shown with a checkmark are currently displayed. To hide
a column, click on the name to remove the checkmark. To display a hidden column, repeat the process. Reset all
makes all columns display without having to unhide them individually.
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Sorting Records
When viewing information in the Object List – be it DNS zones, Servers, Views, IP Address Ranges, or Scopes – you
can instantly sort the displayed information by clicking on the header of any column shown in that view. For instance,
click on the Name header once to sort the displayed objects alphabetically (A-Z) by name. Clicking on the Name header
again will resort the list in reverse alphabetic order (Z-A). This can be done with any column of data, including Servers,
Addresses, Utilization percentages, etc.
Note: When sorting zone names alphabetically, reverse zones will appear at the bottom of the list (after Z), or at the
top of the list when sorted in reverse alphabetic order.

Menu Bars
The Menu Bar in the Men&Mice Management Console provides access to nearly all of the program’s functionality.
Important: You must have sufficient access privileges in order to use some of the menu items discussed below.

Note: Not every menu option is listed below. Some are detailed in their respective sections. Some of the options
discussed below are global across the whole application (e.g., Cut, Copy, and Paste).

File Menu
Save

Saves any changes that have been made in the currently active window. This is only available when a zone has
been edited and there is some new data to be saved.

Change Password
Use this command to change your login password to the Management Console. Your current password is required
in order to change to a new one.
Page Setup
Opens the Print Setup dialog box, from which you can choose the default printer, paper, page orientation, and
other properties to be used when printing from Management Console.
Print

Exit

Opens the Print dialog box and allows you to print the contents of the currently selected Zone window. This
command is only available when a Zone window is open.
Closes the Management Console window.
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Edit Menu
The commands available from the Edit menu vary, depending on what is currently selected in the Management Console.
When working in the Manager window the following functions are offered:
Undo
Redo

Reverses the last edits that you made, in the reverse-order that you made them.
Reverses the effects of the last Undo command.

Cut Removes the currently selected item(s) and stores them in the Windows clipboard.
Copy
Paste

Makes a copy of the currently selected item(s) and places it into the Windows clipboard.
Copies the contents of the clipboard at the location of the insertion point.

Paste Custom Properties
Allows pasting of custom property contents into multiple objects. To use this command, select one object and
choose Copy. Then select the objects whose custom properties you want to populate and choose Paste Properties.
This will open a dialog box where you can choose which custom properties you want to paste.
Clear

Deletes the currently selected text or record.

Select All
This command selects all of the objects (e.g., zones, servers, scopes, IP Address ranges).
Find

This command initiates a new search.

Find Next
This command repeats the last search you performed. For example, if the last search was for A, this automatically
locates the next occurrence of A in the object list.
Save Filter/Delete Filter
It is possible to save/delete filters for various object types. Saved filters appear in the list on the left hand side of
the Manager Window and in the Create Zone dialog box. Filters can be local or global in scope. Filters created
by the Administrator are global and visible to all users. Filters created by any other user are visible only to that
user.
Preferences
Opens the Options dialog box where you can make default selections for various Management Console functions.
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When working with a zone, the Edit menu changes and includes additional functions.
Enable Record
Makes the currently selected record(s) active in the zone. Use this command to re-enable a zone that
has been disabled. All records are active by default unless they have been manually disabled. You
cannot enable records in dynamic zones.
Disable Record
Makes the currently selected record inactive. When a record is disabled, it is ignored in the zone.
You cannot disable records in dynamic zones.
Insert Record
Opens a popup menu that lets you specify the type of record you want to create. To insert A, CNAME,
MX, NS, or PTR records, choose the corresponding option from the menu. The new record is created
directly below the currently selected record or field. For other types of records, select Insert Record.
This creates a new blank row above the currently selected record or field.
Duplicate Record
Creates a copy of the selected record(s). The new records appear directly underneath the last record
being duplicated.
Delete Record
Deletes the entire record from the zone. Unlike the Clear command, the entire record does not need to
be selected for this command to work. It will delete the entire record in which the cursor is currently
located.
Show TTL
This menu command can be toggled on and off by selecting it repeatedly. This option is enabled by
default. If you disable this option, the TTL column will not be displayed in the zone window. This
command is only available when a zone window is open and active.
Show Comment
This menu command can be toggled on and off by selecting it repeatedly. This option is enabled by
default. If you disable this option, the Comment column will not be displayed in the zone windows.
This command is only available when a Zone window is open and active. This command can only
be used for static zones.
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Query Menu
Lease History
This function can be enabled through System Settings, Logging. When enabled you can search the DHCP lease
history and if desired, export the search results to a file.
Object History
Allows you to query the history throughout the system for all objects or a specific object. Refer to Object Change
History for details. You can search all objects or, using the Only show objects of type drop-down list, you can
select which object type to search. You can only search all object types or one selected object type.
Men&Mice Suite Log
Displays log messages for Micetro.
Search and Update Wizard
Launches the Search and Update Wizard, a utility that allows you to find, create, modify, or delete records in
multiple zones and DHCP Scopes using a single action. Click Next> and follow the instructions onscreen to
specify the type of records you want to search, the action you want to perform (e.g., create, replace, delete, edit),
etc.
User Activity
Users with user administrative privileges can see this menu item. Selecting this menu item displays a window
that shows a list of all users including the user name, authentication type, login status, and last login time.
Window Menu
Cascade
Aligns all currently open windows inside the Console window so that they overlap, showing only their title bars.
This allows you to access all currently open windows.
Show Progress
This window shows the progress of operation that can take some time, such as opening and saving large zones.
When an operation is in progress (and displayed in the progress window) it can be cancelled by clicking in the
progress window and choosing Cancel.
Show Console
Displays errors that may occur during various operations.
Show Manager Window
Displays the Manager Window. Use this function in the event you inadvertently close the Manager window.
Revert to Standard Layout
Returns the program to its standard view, with the Management Console open and the main window displayed
on top of any other open windows. Other windows are not affected by this command. Also, shows the progress
window if the window is hidden.
Active Window List
At the bottom of the Window menu, there will be a list of every window currently open in the Management
Console. You can instantly give a window the focus (i.e., bring it to the top) by selecting it from this list.
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Help Menu
Help

Launches the on-line help features of Micetro.

About Men&Mice Management Console
Opens the About window, which contains the full version number of the Men&Mice Management Console that
you are running.
Toolbars
The toolbar, which runs along the top of the Object Section and Object List, provides fast access to commonly performed
operations. The function of any given button is always in the context of the currently selected object. Some buttons
will not be available (i.e., greyed out) when certain objects are selected.
But- Name
ton

Description

Create

Lets you create a zone, add a name server, a DHCP scope, or a DHCP server based on the currently
selected object.

Delete

Lets you delete a zone, a name server, a DHCP scope, or a DHCP server; based on the currently
selected object.

Options

Display the options dialog box for the currently selected object, if applicable (e.g., Zone options,
Server options, etc.).

Server
Info

Displays a window that provides general information about the selected server—e.g., server
type, IP Address, OS, number of zones, number of requests sent/received, etc. Refer to DNS
Servers—Server Information .

Server
Log

Displays the Server Log window that shows the DNS log of that server.
Servers—Server Log .

History

Opens the History window and displays a log of all changes that have been made to the selected
object, including the date and time of the change, the name of the user who made it, the actions
performed, and any comments entered by the user. Refer to Management Console—Object Change
History .

Zone
Wizard

Launches the Zone Wizard, which helps you create the desired type of zone by prompting you
with a series of questions. Refer to DNS Zones—Zone Migration Wizard .

View
(Hierarchical)

When selected, toggles to hierarchical view for the IP Address range.

View
(Flat)
Quick
Filter

When selected, toggles to flat view for the IP Address range.

Refer to DNS

This text field lets you instantly filter out objects that you do not want to display. For example,
if you type ‘ex’ in the field, only objects that contain ‘ex’ somewhere in their name are displayed
in the Object List. When you clear the contents from this field, all available objects are again
displayed. Refer to Quick Filter .
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Zone toolbar

But- Name
ton

Description

Analyze

Analyzes the contents of the zone. Refer to DNS Zones—Zone Analysis .

History

Displays the history for the selected zone. Refer to the DNS Zones—View History .

Wizard
Zone
Controls
Find

Launches the Record Creation Wizard. Refer to DNS Resource Records.
Only available for static zones on BIND Opens the Zone Controls dialog box. Refer to the DNS
Zones—Zone Controls .

Options
Print
Save

Opens the Zone Options dialog box. Refer to the DNS Zones—Zone Options .
Prints the zone information.
Saves the information as entered in the main zone information window.

Opens the Find Zone dialog box in which you enter criterion to locate specific information for this
zone. Refer to DNS Zones—Search .

IP Address Range toolbar

But- Name
ton

1

Description

Delete

Removes the currently selected host. Refer to IP Address Management.

Edit

Opens the IP Address dialog box in which you can edit details for the IP Address. Refer to IP
Address Management .

Claim

Use this feature to prevent accidental assignment of a reserved address without creating a DNS
entry for it.1

Release
Next
Free
Address in
Range

Use this feature to release assignment of a reserved address.
Finds the first IP Address in the range that is not in use. When clicked, opens the IP Address dialog
box in which you enter the IP Address info.

The workflow is as follows:
• A user with “edit data” privileges can select one or more addresses that have no associated A record(s) and choose “Claim” from the menu.
Going forward, no one can create A records for the address(es) through the zone window (neither auto-assign nor manually assign).
• A user can select one or more claimed addresses and select “Release.” These addresses are then restored to their previous state.
• A user can edit a Claimed record through the IPAM module. When the user opens a IP Address details window for a claimed address, a
dialog prompts, “This address has been claimed. Are you sure you want to edit it?” Yes/No? When Save is selected in the IP Address details
window, one of two things happens: (1) If the user only entered non-DNS data (custom properties, MAC address, name), the “claimed” flag
says in place. (2) If the user entered one or more DNS hosts for the IP Address, the “claimed” flag is cleared.
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Scope toolbar

But- Name
ton

Description

Edit

Allow you to edit the selected host by opening the IP Address dialog box. Refer to DHCP Scopes.

Delete

Deletes the currently selected IP Address. Refer to DHCP Scopes.

Claim

Use this feature to prevent accidental assignment of a reserved address without creating a DNS
entry for it.Page 164, 1

Release

Use this feature to release assignment of a reserved address.

Quick Filter (Management Console, deprecated)

Note: The Quick Filter functionality is also available in the Web Application.
Quick Filters provide a simple way to filter out data records you do not want to see. They can be found in most windows
that contain a number of objects. A Quick Filter works in real time and searches all items in a list by default. It is also
possible to narrow the search by using keywords to specify in which field to search.
Using Keywords
Column Headers
It is possible to use column headers as keywords in the Quick Filter and to specify in which field to search.
For example, if you enter the following filtering criterion when filtering zones - name:myzone - the filter only
searches in the Name field and displays only those results that contain the text myzone. When a column header’s
name contains a space, such as Lease MAC Address, you can enclose the name in quotes –e.g. "Lease MAC
Address":11. See Colons, below.
Colons
Colons are used to separate a column name from a filter. If the filter contains colons, you can either enclose the
filter in quotes or escape the colons with a backslash \. For example, both "Lease MAC Address":"11:22"
and "Lease MAC Address":11\:22 search for a MAC address containing 11:22 in a column with a name
containing with the name Lease MAC Address.
Simultaneous Keywords
You can use several keywords simultaneously simply by leaving a space between each consecutive filtering criterion. An AND condition is used when finding records. For example: name:myzone type:slave.
Custom Properties
When custom properties are used, you can use the name of the custom property as a keyword.

1.10. Micetro user interface(s)

165

Micetro by Menamp;Mice Documentation, Release 10.2

Using Wildcards and Regular Expressions in Filters
When using the Quick Filters, it is possible to use the wildcard characters ^ and $ to narrow the search results.
• The caret symbol ^ means starts with. For example, the search string ^server finds server1.zone.com and
server-north.anotherzone.com, but not myserver.myzone.com.
• The dollar symbol $ means ends with. For example, the search string ‘server$’ finds the.best.server and
good.nameserver, but not slow.servers.
• The ! operator means NOT{*}.
For example, the search string !^a finds entries that don’t start with ‘a’. The exclamation mark can be used with the
other wildcards to find non-empty fields. Entering Description: !^$ finds all entries where the Description field
is not empty.
Warning: The & and | operators only work for the SOAP interface and Web Application, but not currently for the
Management Console. It is a known issue that will be fixed in an upcoming version.
• The & and | operators. The ampersand is interpreted as an AND operator while the vertical bar is used as
an OR operator. Using these operators, you can combine searches for added control. You can use parenthesis
in conjunction with these operators. Examples:
– A | B Finds entries with the text A or the text B
– A & B Find entries containing both A and B
– A & (B | C) Finds entries containing A and either B or C
– (A & B) | C Finds entries containing both A and B or entries containing C
For even more control, you can use regular expressions in filters.
Note: The character . must be escaped if it is to be used as a wildcard character. Otherwise, it will be interpreted
literally. The same applies to following characters: (, ), {, }.

Clearing an Entry
At any time, you can clear the text you have in the Quick Filter field by click the X shown at the end of the field.
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Saving a Filter
It is possible to save filters for various object types. Saved filters appear in the list on the left hand side of the Manager
Window and in the Create Zone dialog box. Filters can be local or global in scope. Filters created by the Administrator
are global and visible to all users. Filters created by any other user are visible only to that user.
To save a filter, do the following:
1. Type the entry you want to filter by in the Quick Filter field.
2. Move to the menu bar, and select Edit → Save Filter.
3. In the dialog box, type the desired name for the filter. Then click OK.
4. The saved filter shows at the bottom of the Object list for the corresponding object type.

Note: You can also create filters that reside in object folders. To create a filter in a folder, start by selecting the folder
before creating the filter. A filter that resides in a folders perform the search within the context of the folder.

Editing a Filter
To edit a filter, do the following:
1. Locate the filter name in the Object list.
2. Right-click the filter and select Edit Filter.
3. Make the desired changes to the filter and click OK to save the changes.
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Deleting a Filter
To delete a filter, do the following:
1. Locate the filter name in the Object list.
2. Right-click the filter and select Delete Filter.
Other actions in the Management Console
Jump to Box
The Jump to Box is a field that can be used to quickly open a single object in Micetro by entering the object name.
Using the ‘Jump to Box’ you can open the following object types:
• DNS Zone
• DNS Record
• IP Address Range
• DHCP Scope
• IP Address in an IP Address Range or a DHCP Scope
The ‘Jump to Box’ is located at the bottom of the sidebar on the left. Additionally the shortcut Shift-J can be used to
move the focus to the ‘Jump to Box’.
To use the ‘Jump to Box’, do the following:
1. Navigate to the Jump to Box or press Ctrl+J.
2. Enter the name of the object you want to open and click the Jump to icon to the right of the field (or press Enter).
If more than one matching object is found, a dialog box displays in which you can select the object instance you
want to open.
Note: You must enter the exact name of the object you want to open. For example, if you want to open a zone by
the name myzone.local, it is not sufficient to enter just ‘myzone’ or ‘myzone.lo’ – you must enter ‘myzone.local’. The
same applies for DNS records, IP Address Ranges, DHCP Scopes and IP Addresses.
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Program Preferences
You can set some default behaviors for the Men&Mice Management Console using the Options dialog box.
On the menu bar, select Edit → Preferences. The Options dialog box displays.

Log Window
Initial log size
The server logs are kept by the servers. When the Management Console connects to a server and the log window
is opened, the Manager downloads the most recent portions of the server’s log. The amount downloaded (in
kilobytes) will be equal to the value set in the Initial log size field.
Max log size
The maximum log size determines how much of a server’s log can be retained by the Management Console at
any one time. Once the maximum size is reached, the Manager will discard old log entries as necessary to make
room for the new ones. Log entries discarded by the Manager Console are retained on the log that the server
maintains. The Max log size field can be set to any value between 1 and 1024 KBs. The default value is 100 KB.
Log interval
Whenever the log window is open, it will continually update itself (the log) from the server. The interval between
sequential updates can be set to any value between one and thirty seconds. The default value is every five seconds.
New Zone Window
Show TTL
This checkbox is enabled by default. If you clear this checkbox, the TTL column will not be included in any new
zones that you create.
Show comment
This checkbox is enabled by default. If you clear this checkbox, the Comment column will not be included in
any new zones that you create.
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Console
You can configure how the Console Window behaves when new entries are added to the window.
Do nothing
If this option is selected, entries are added ‘silently’ to the console window. If the window is hidden, it is not
displayed when new entries are added.
Display Console if hidden
If this option is selected, the console window will be displayed when new entries are added.
Bring Console to front
If this option is selected, the console window will be displayed as the front-most window when new entries are
added.
Search/Update Wizard
This utility allows you to find, create, modify, or delete records in multiple zones and DHCP Scopes using a single
action.
There are three search options available:
DNS Resource Records
Refer to DNS resource records for further information.
DCHP Scope Options
Through this function, you replace, delete or search for option values.
IP Addresses
Through this function, you can find an IP Address in any IP Address range and display the results in the IP
Address range window.
To launch the Search and Update Wizard, do the following:
1. From the menu bar, select Query → Search and Update Wizard. The Search and Update Wizard dialog box
displays.
2. Select the type of search you want to perform.
3. Complete each screen as you move through the wizard.
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Lease History
Through this function, you view the lease history for your MS and ISC DHCP servers.
Note: You must be a member of the DHCP Administrator group to view the DHCP lease history. Lease history
collection must be enabled for this function to work.
To view the DHCP lease history:
1. From the menu bar, select Query → Lease History. The Lease History Query tab displays.

Find DHCP leases where
Select if you want to query by IP Address, MAC Address, Server Address, Hostname or Description.
Starting on/Ending on
To query based upon a date range, type the starting and ending range dates. For example, to find all changes
made in 2007, in the Starting on field type 1/1/2007 and in the Ending on field, type 12/31/07. For example, to
find all changes made in 2007, in the Starting on field type 1/1/2007 and in the Ending on field, type 12/31/07.
2. Click Search. Any matching results are displayed in the lower portion of the window.
Exporting Search Results
To export the results as a CSV file, do the following:
1. Display the lease history.
2. Search for the desired history.
3. When the applicable change history is shown, click the Export button. The Export records to CSV file dialog box
displays.
4. Select the drive, directory, subdirectory, etc. into which you want to save the CSV file.
5. Click Save.
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Object Change History
Through this function, you can display a log of all changes that have been made to any object such as the date and time
of the change, the name of the user who made it, the actions performed, and any comments entered by the user.
There are two ways to search/view the object change history:
• From the Menu Bar. With this option, you select the type of object to search change history for.
• Through the Object Browser. With this option, you select the object first, and then search for the change history.
Accessing via the Menu Bar
1. From the menu bar, select Query → Object History. The History Query tab displays.

Where text contains
Type any words that the text contains.
Made by
Type the user login name.
Starting on/Ending on
To query based upon a date range, type the starting and ending range dates. For example, to find all changes
made in 2007, in the Starting on field type 1/1/2007 and in the Ending on field, type 12/31/07. For example, to
find all changes made in 2007, in the Starting on field type 1/1/2007 and in the Ending on field, type 12/31/07.
Only show objects of type
Click the drop-down list arrow, and select the type of object for which you want to find change history.
Limit to ____ Results
Enter the maximum number of results to display.
2. Click Search. Any matching results are displayed in the lower portion of the tab.
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Accessing via the Object Browser
1. In the Object Browser, open the desired object category (e.g., DNS Zones, DNS Servers, etc.).
2. Locate the object for which you want to view the history.
3. Right-click and, from the shortcut menu, select View History.
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The History window displays showing all the history for the selected object.
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4. If you wish to query the results, click the + in the upper left corner of the dialog box.
5. Following the directions under Accessing via the Menu Bar to enter the query information.
Exporting Search Results
To export the results as a CSV file, do the following:
1. Display the object change history.
2. Display the Query Change History search criteria fields.
3. Search for the desired change history.
4. When the applicable change history is shown, click the Export button. The Export records to CSV file dialog box
displays.
5. Select the drive, directory, subdirectory, etc. into which you want to save the CSV file.
6. Click Save.
Micetro Log
Through this function, you can display log messages generated by Micetro.
Note: You must be a member of an Administrator group to view the log messages.
To view the log messages, do the following:
1. In the main Men&Mice window, move to the menu bar and select Query → MenMice Suite Log. The Men&Mice
Suite Log tab displays.
1.10. Micetro user interface(s)
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Search For
Type the information to query.
Starting on/Ending on
To query based upon a date range, type the starting and ending range dates. For example, to find all changes
made in 2007, in the Starting on field type 1/1/2007 and in the Ending on field, type 12/31/07.
Log level
Click the drop-down list, and select the desired level – e.g., Error, Notice or Warning.
2. When all selections/entries are made, click Search. Any matching results are displayed in the lower portion of
the window.
3. The Quick Filter allows you to further refine the search results. As you type in the field, results that are not
applicable are removed. To export the results as a CSV file, do the following:
• Click the Export button. The Export records to CSV file dialog box displays.
• Select the drive, directory, subdirectory, etc. into which you want to save the CSV file.
• Click Save.
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Health Monitoring Bar
Overview
The Men&Mice Health Monitoring provides the administrator with valuable information he needs to maintain his
systems and services. First, a good overview of the general health of Micetro and related services. More importantly,
it will give the administrator an indication if there is a problem that needs to be acted on and corrected, for example if
there is a slave zone that is expiring or if there is a zone that has not been loaded on a server due to an error. Both cases
can cause outages for users and therefore be a serious impact for the business.
Categories
The health status is displayed to the user from the health bar which is positioned at the bottom of the management
console window. The status indicators are split into five categories
• Micetro
• DNS
• DHCP
• IPAM
• Appliance
A color code is used to represent the severity of the error. If an indicator in any of those categories has a warning
or error, it is shown as yellow or red, respectively; otherwise as green. The health bar can be expanded and then the
indicator subcategories are shown and more details can be obtained about the health indicators. More importantly,
details about each error are given in a separate window where a detailed description about the error is given and also
the administrator is given the opportunity to navigate to the object that is affected and from there, fix the error.

Fig. 1: The health bar has been expanded by clicking the up arrow in the upper right corner of the health bar. There, it
can be seen the there are errors in ‘DNS Zones’ and ‘Server Controllers’ and a warning in ‘Version’.
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Indicator details

Cat- Sub- Description
ecatgory egory
MicetroLiAn indication is given if there is a problem with the license, for example if a module license has been
cens- exceeded.
ing
Database
An indication is given if the database size exceeds a default threshold of 1GB for SQLite.
Server An indication is given if * the server controllers have a problem communicating with Men&Mice cenCon- tral * there is a problem communicating with the update agents running beside the server controllers.
trollers
Ver- An indication is given if there is a new version available, if there are pending upgrades or if any
sion components are out of date.
DNS DNS An indication is given if there is a problem communicating with the servers or if the DNS server is
Serversdown.
DNS An indication is given if * the system is unable to get the zone status * the slave zone will expire in
Zones the next 24 hours * the zone can not load on the server
DHCPDHCP An indication is given if there is a problem communicating with the servers or if the DHCP server is
Serversdown.
DHCP An indication is given if * the system is unable to get the scope status * the static part of scope is
Scopesover utilized * the dynamic part of scope is over utilized * a superscope is over utilized * there is
a scope pool collision * there is a scope reservation mismatch * scope contains inconsistencies that
need reconciling * the system is unable to check whether scope contains inconsistencies * the system
is unable to check whether scope is part of a failover relationship on partner server * the DHCP failover
partner server is unreachable * the system is unable to fetch scope info from the partner server * if a
scope is not part of a failover relationship on the partner server
IPAM Static An indication is given if a subnet is over utilized.
Dis- An indication is given if there are problems with communicating with routers.
covery
Ap- Ap- An indication is given if an appliance is unreachable.
pli- pliance ance
health
In any case of an warning or error above, there will be a detailed description of the error or warning, and a way to
navigate to the proper place to fix an error/warning.
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Ignoring indicators
By right clicking a status indicator in the health bar and selecting ‘ignore’, that status indicator can be ignored.
Viewing error / warning indicators
In this window more details about the status indicator can be seen. Following are descriptions about what each column
shows.
Message
Details about the error / warning for this indicator
Object
Name of the object that the error / warning is related to
First seen
The date of which the error / warning was first seen

Fig. 2: In the figure above, we have clicked on the ‘Discovery’ indicator to get more details about the error.
Right clicking an indicator will show a context menu with the following items (where applicable):
• Show in manager window: Show the specific item in the manager window
• Open: Opens a specific object, for example a scope
• Reconnect: Reconnects to an already disconnected server
Disabling health monitoring
The system health monitoring can be disabled completely by setting an advanced system option. See Advanced System
Settings for more details.
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1.11 Folder management
Folder management is an important organizational tool for objects (through Object folders) and saved filters (through
Smart folders).
The list of folders is located in the ‘Folders’ tab of the Filtering sidebar.
Tip: To switch to the ‘Folders’ tab, click the folder icon on the bottom of the sidebar.

1.11.1 Folders and contexts
Folders are exclusive to their respective contexts, DNS or IPAM. Users cannot place IPAM objects in DNS folders, or
vica versa.
Tip: Any object that has been placed in an object folder has an indicator next to its name in the grid. Hovering over
the icon will display the name of the folder.

1.11.2 Access to folders
Folders are created globally: only users/groups attached to an Administrator role can create object or smart folders.
Folders are visible to all users in the system.
Note: Objects in folders are only visible to those that have the correct role to view them. See Access control for details
on roles and permissions.
Folders are not shared across address spaces and cannot be moved from one address space to another.

1.11.3 Creating folders
1. Locate the parent folder under which you want to create the new folder. (Or the root folder, .)
Note: The “root folder” is called All zones in the DNS context and All ranges in the IPAM context.
2. Click on the ellipsis next to the parent/root folder’s name, and select Create folder (for Object folders) or Create
smart folder (for Smart folders).
3. Fill in the name (for object folders) and the filter query (for smart folders only) and click Create.
Note: Folder names don’t need to be unique.
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1.11.4 Editing folders
You can edit a folder’s name or filter query (for smart folder) by clicking Edit from its ellipsis menu.

1.11.5 Deleting folders
You can delete a folder by clicking Delete from its ellipsis menu.
Warning: Deleting a folder will delete ALL subfolders.

1.11.6 Folder types
Object folders
Object folders can group together the following objects:
DNS

Zones.

IPAM
Ranges, scopes, and networks.
DNS records and IP addresses cannot be placed in object folders. (But can be filtered with Smart folders.)
Note: Objects can be placed in only one object folder.

Access to object folders
See Access to folders.
Adding objects to an object folder
1. Select the object(s) you want to add to a folder.
2. Use the Add to folder action from the top bar or the ellipsis menu.
3. Select the folder from the folder tree.
Moving objects between object folders
1. Open the folder in which the item is located. (Or select the object in the grid.)
2. Use the Change folder action from the top bar or the ellipsis menu.
3. Select the new folder from the folder tree.
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Removing object from an object folder
1. Open the folder in which the item is located. (Or select the object in the grid.)
2. Use the Remove from folder action from the top bar or the ellipsis menu.
3. Confirm with Yes.
Smart folders
Smart folders are saved filters, using the filter query syntax from Quickfilter.
Smart folders can group together the following objects:
DNS

Zones and records.

IPAM
Ranges, scopes, containers, and IP addresses.
Note: DNS records and IP addresses can only be filtered with a smart folder placed in the root folder.

Access to smart folders
See Access to folders.
Combining smart folders
Smart folders placed inside another smart folder will combine the filtering queries.
Example: user creates a smart folder called .com TLD* with the filter query .com (either in the root folder or inside
an object folder). Inside the .com TLD smart folder they create another smart folder called local* with the filter query
authority=example.local..
The smart folder .com TLD will display all zones that contain the string .com, and the smart folder local will display
all zones that contain the string .com and whose authority is example.local..
Tip: Using smart folders within smart folders allows you to create powerful and complex filter combinations while
preserving each filter element on its own as well.
Object folders are represented by a folder icon (full if there are objects or other folders inside, empty otherwise). Smart
folders are represented by a filter icon.
Note: For information on using folders in the Management Console, see console-object-folders and Saving a Filter.
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1.12 DNS
1.12.1 Authoritative DNS Servers
Overview
This section shows you how to perform specific actions in the Men&Mice Management Console associated with maintaining your DNS servers, such as adding, and creating and editing zones and records. The commands associated with
server management are located in the Server menu and several are accessible from the toolbar. The Server menu is
only available when the DNS Servers object is selected in the Object Section of the Management Console.
Note: The functions for this menu option are listed alphabetically after the New DNS Server section.

New DNS Server
You must be logged in as a user with privileges to administer DNS in order to add a DNS server.
Note: For information on adding a DNS server on a Men&Mice Appliance, refer to Appliance management.

To add a new DNS server, do the following:
1. Navigate to Admin → Server Management and click Add DNS Server.
Server Name
Type the name (fully qualified host name) of the DNS server as the name is used for the MNAME field in the SOA
record of new DNS zones. If the name can’t be resolved you want to specify the optional IP address.
Server address (optional)
If desired, type the IPv4 or IPv6 address for the server. This is not required, but doing so allows Micetro to
connect to the server by IP Address instead of by name. The Server name will still be used when displaying
server information and creating NS records.
Server Type
Click the drop-down list, and select the desired server type.
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Microsoft with Agent Installed
connects to a Microsoft DNS server.
BIND
connects to BIND DNS server.
Unbound
connects o an Unbound DNS server.
Generic
connects to a DNS Server Controller that is configured to support a generic DNS server.
Agent-free
Microsoft DNS servers can be attached to Micetro without a Server Controller installed. For further information
regarding this connection method, refer to Server Access on Remote Computers.
Proxy
If you are adding a Microsoft DNS server you can specify the location of the DNS Server Controller by clicking
the Use proxy server checkbox and entering the DNS name or IP Address of the machine running the DNS Server
controller. This option allows the system to connect to DNS servers in different forests where a cross-forest trust
does not exist. It also allows a non-Windows version of Men&Mice Central to manage Microsoft DNS servers.
2. Click Confirm. You are connected to the server. Once connected, the name of the newly added server displays
in the grid of the Server mangagement and DNS contexts.
Note: For adding DNS servers in the Management Console, refer to console-add-dns-server.

Server Access on Remote Computers
To manage DNS servers, each must have a DNS Server Controller installed. For the BIND DNS server, a DNS Server
Controller must be installed on each DNS server you want to manage.
If you plan to use Men&Mice Suite to manage any Microsoft DNS servers, install the DNS Server Controller on a
Windows machine that is a member of the same domain or workgroup as the DNS servers. You may install multiple
copies of the DNS Server Controller, for example if you want to manage Microsoft DNS Servers that reside in different
forests. A single DNS Server Controller for Microsoft DNS Servers can manage multiple DNS servers. The DNS
Server Controller must adhere to whatever restrictions and security standards are set forth in Microsoft Windows.
To configure the DNS Server Controller to access DNS servers on remote computers, do the following:
1. Before you can administer DNS servers, verify that the DNS Controller is running as a Windows User and has
the necessary privileges.
2. To enable DNS Management in Micetro, start the Windows Services program and open the properties dialog box
for Men&Mice DNS Server Controller.
3. Click the Log On tab. The Local System account radio button is most likely selected.
4. Click the This account radio button and enter the name and password of a Windows User that is a member of the
Administrators group.
5. Close the dialog box and restart the Men&Mice DNS Server Controller service.
Note: Some actions for static zones are not available if you are managing Microsoft DNS servers on remote computers
using the DNS Server Controller. The following actions are not available:
• Disable resource record
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• Enable resource record
• View and edit resource record comments
• Disable zone
If you need to be able to perform these actions, you must install the DNS Server Controller on the server and use the
Microsoft with Agent Installed connection method when connecting to the server.

Edit DNS Server Name
This feature allows you to change the name or IP Address used to connect to a DNS server. This is useful if you need
to refer to the server by another name or if you are connecting to the server by an IP Address and the IP Address has
changed. You can also use this feature to change the connection method for MS DNS servers.
To access this feature, do the following:
1. Locate the applicable server in the Server Management context.
2. Select it, and from the ellipsis menu select Edit DNS Server.

3. Change the Server name and/or Server address.
4. Click Confirm.
Note: To edit DNS servers in the the Management Console, see console-edit-dns.

Access
See Access control.
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Define Work Set
It is possible to define a Work Set for servers in the Management Console. A Work Set contains a subset of all of the
servers in the system and when a Work Set is active, only the servers in the Work Set are visible and the zones on the
servers in the Work Set are the only zones visible. This feature is useful when many servers are defined, but you only
work with a small number of them on a day-to-day basis.
To define a Work Set, do the following:
1. Select the server(s) you want to include in the Work Set.
2. Right-click the selected server(s) and choose Define Work Set.
To clear a Work Set, do the following:
1. Click the Clear Work Set button in the Manager window. The Work Set is cleared.
Detach
A server can be disabled by selecting Detach DNS server from the ellipsis menu. When a server is detached, it is not
synchronized with Micetro and excluded from various checks. When a DNS server is detached, it is greyed out in the
Server Management and DNS grids.
Attach
A server that is already detached can be attached again. The ellipsis menu for detached DNS servers displays Attach
DNS Server.
Note: You can also detach/attach DNS servers in the Management Console. See console-disable-enable-dns-server.

Remove
This command is only available with the Administrator account. Use this command to remove a DNS server from
Micetro.
Note: For information on removing a DNS server on a Men&Mice Appliance, refer Appliance management.
1. In the Web Application, navigate to Admin → Server Management.
2. In the grid, select the server(s) from you want to remove. To select multiple servers, hold down the Ctrl (Cmd
on Mac) key while making your selections.
3. In the ellipsis menu, click Remove DNS server. A dialog box prompts you to confirm your decision.
4. To remove the server, click Yes. Otherwise, click No.
Note: For removing DNS servers in the Management Console, see console-delete-dns-server.
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Options (Management Console)
The Management Console’s Server Options dialog box lets you configure settings for each name server individually,
including forwarding servers, logging preferences, transfer and query restrictions, and root servers.
Note: The server options vary depending on the server environment. In the section that follows, the server options are
documented twice: once for those using a Windows DNS server, and again for those using BIND.

Accessing Server Options
1. In the Object Section, select DNS Servers so the servers appear in the Object List.
2. Right-click on the server you want to make changes to and select Options from the context menu. The Server
Options dialog box displays.
3. Choose the desired option (Resolution, Logging, Advanced, Interfaces, Event logging, Root hints) from the menu
on the left. The corresponding options display in the right panel of the dialog box.
4. Refer to the appropriate section and server environment below for each option.
Windows DNS servers
This section describes the Server Options as they display in a Windows Server environment.
Resolution (Windows)
The Resolution panel lets you change the method by which this server resolves queries.
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Three basic modes can be established:
The server can be set to resolve queries entirely by itself.
If you do not want to use any forwarders with this server, leave the Use forwarder(s) checkbox unchecked.
The server can share the task of resolving queries.
If you want to share the task of resolving requests with one or more forwarding servers, select the Use forwarder(s)
checkbox and enter the IP Address of the forwarding servers in the Forwarders list. When you enter the IP
Addresses to multiple forwarders, all the forwarders are queried simultaneously, and the first response is accepted.
Under this shared mode, if a server using a forwarder does not receive a response after a few seconds, it will
attempt to resolve the query itself.
The server can forward all requests to other servers.
If you want to forward all requests to other servers (and never use this server), select the Use forwarder(s) checkbox, enter the IP Address of the forwarding server(s) in the Forwarders list, and check the Only user forwarder(s)
checkbox.
After making the desired changes, you can choose another category from the left column, or click OK to close the
dialog box.
Logging (Windows)
The Logging options consist of a list of checkbox options. Once you enable Log packets for debugging, the other
options in the dialog box become accessible and you can choose which types of information you want the program to
record in the server’s log.

After checking the desired options, you can either choose another category from the left column or click OK to close
the dialog box.
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Advanced (Windows)
Use this panel to set various advanced options for the DNS server. Complete the dialog box based upon the guidelines
below. When all selections/entries are made, click OK.

Disable recursion.
Determines whether or not the DNS server uses recursion.
BIND secondaries.
Disables fast (compressed) zone transfers for compatibility with old BIND servers (older than 4.9.4).
Fail on load if bad zone data.
Prevents the server from loading a zone when bad data is found.
Enable round robin.
Rotates the order of resource record data returned in query answers when multiple resource records of the same
type exist for the queried DNS domain name.
Enable netmask ordering.
Determines whether the DNS server reorders A resource records within the same resource record set in its response to a query based on the IP Address of the source of the query.
Secure cache against pollution.
Determines whether the server attempts to clean up responses to avoid cache pollution.
Name Checking.
Determines the type of name checking used for zones on the server. Click the drop-down list and select from the
options provided.
Load Zone Data on startup.
Determines from where to load the zone data when the server starts up. Click the drop-down list and select from
the options provided.
Enable automatic scavenging of stale records.
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Specifies whether scavenging can occur for the selected server. If automatic scavenging is enabled, the scavenging
period can be specified. Type the duration in the first field. In the second field, click the drop-down list and select
the duration range – e.g., days.
Interfaces (Windows)
Use this panel to specify the IP Addresses this server will use to serve DNS requests. When your selection is made,
click OK.

Event Logging (Windows)
Specifies what event information should be logged and displayed in the Server log.
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Click next to each of the desired items using the guidelines below:
No events.
Specifies that no events will be logged in the DNS Server log.
Errors only.
Specifies that only errors will be logged in the DNS Server log.
Errors and warnings.
Specifies that only errors and warnings will be logged in the DNS Server log.
All events.
Specifies that all events will be logged in the DNS Server log.
When all selections are made, click OK.
Root hints
Allows configuration of suggested root servers for the server to use and refer to in resolving names.
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To Add a Root name server, complete the fields as follows:
1. Click the Add button.
Server fully qualified domain name.
Type the name of the server.
IP Address.
Type the IP Address of this server.
2. Click OK.
To Edit the Root hint name server data, do the following:
1. Select the server definition you want to edit.
2. Click the Edit button.
3. In the Root hint name server dialog box, type the updated information.
4. Click OK.
To Remove a Root hint name server, do the following:
1. Select the server definition you want to remove.
2. Click the Remove button.
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BIND Environment
This section describes the Server Options as they display in a BIND environment.
Resolution (BIND)
The Resolution settings in a BIND environment are the same as in a Windows environment.

Logging (BIND)
The Logging Settings control the type of information that is recorded in a server’s log.
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Channel.
Specifies where your logged data will go. Use the drop-down list to select which log file you want to receive
which categories of data.
Category.
Lists the different types of information that can be logged. The System log typically tracks system-level messages,
while the Men&Mice log is much more comprehensive and includes information about server interactions and
activity. Check the categories you want to include in the log.
Log Level.
The Log Level allows you to filter messages by severity. Select the level of messages that you want to log by
choosing the corresponding radio button. There are eight radio buttons. The top five are the standard severity
levels used by syslog. The remaining two settings areDebug and Dynamic.
Debug.
Provides name server debugging. When you choose this option, a text box displays next to the radio button
allowing you to specify a debug level. If you do not specify a debug level, it is assumed to be 1. If you do specify
a level, you will see messages of that level when name server debugging is turned on.
Dynamic.
Causes the name server to log messages that match the debug level. For example, if you send two trace commands
to the name server, it will log messages from level 1 and level 2.
Print Category.
When selected, the category of the message displays with the log entry.
Print severity.
When selected, the severity of the message displays with the log entry.
Print time.
When selected, the message includes a time stamp.
Max file size (only shown for log file channels).
Determines how many versions of the log file are maintained. The log file will grow to the size specified in the
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Max file size field, after which a new log file is created and the old file is renamed. As this process continues,
each file is systematically renamed until it is finally deleted. For example, if the Version field contained the value
2, there would be the ‘active’ log file, and two older versions. When the active log file becomes too big, a new log
file would be created and the previously active log file would be renamed as the version 1 file. The old version 1
file would be renamed as the version 2 file, and the old version 2 file would be deleted.
Versions (only shown for log file channels).
Enter the maximum size of the log file and the appropriate units. For example, 100K = 100 kilobytes, 2M = 2
megabytes, and 3G = 3 gigabytes. If no value is specified, the default unit bytes are used.
Facility (only shown for syslog channels).
Allows the user to specify a syslog facility to be used.
Note: For remote logging on the DDI appliance, only the local7 facility is configured to be sent to the remote loghost.
See Appliance Management for more information on enabling remote logging on the DDI appliance.

Query Restrictions (BIND)
The Query restrictions panel allows you to restrict recursive DNS queries to only certain IP Addresses or address ranges.

To configure a query restriction, do the following:
1. Click the Add button.
2. Enter an IP Address in the field provided. You can choose a predefined range from the drop down list, which
gives you the option to select any, none, localhost, or localnets.
3. Choose whether you want to allow or deny this server access control for recursive queries by selecting the appropriate radio button.
4. Click OK to add the new restriction to the list.
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Transfer Restrictions (BIND)
The Transfer restrictions panel allows you to restrict zone transfers to only certain IP Addresses or address ranges.
Restricting access to zone transfers is a marginally effective security measure designed to prevent outsiders from seeing
the names and IP Addresses of your hosts. All of this information is available from a reverse zone lookup. However,
security through obscurity will keep out amateurs and the merely curious.

To configure a transfer restriction, do the following:
1. Click the Add button.
2. Enter an IP Address in the field provided. You can choose a predefined range from the drop down list, which
gives you the option to select any, none, localhost, or localnets.
3. Choose whether you want to allow or deny zone transfers to this IP Address by selecting the appropriate radio
button.
4. Click OK to add the new restriction to the list.
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Listen on (BIND)
The Listen on panel allows specify the IP Addresses this server will use to serve DNS requests.

To specify the listening interfaces, select the checkboxes for the interfaces you want to listen on, both for IPv4 and IPv6.
• If you select the any option, the server will listen on all configured IP Addresses.
• If you select the None option, the server will not listen on any IP Address.
Advanced Server Options
DNS Administrators can access the BIND configuration files directly to edit DNS server and zone options that are not
available in the GUI.
To access the advanced options, do the following:
1. Log in to Men&Mice as the DNS administrator.
2. For a DNS zone or DNS server, right-click and select Options from the shortcut menu.
3. When the Options displays, click the Advanced button.
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4. When the Advanced Options dialog box displays, you can edit the options for the zone or server in a text document.
The dialog for editing server options contains four tabs where each tab contains a section of the server options
(logging, user_before, options, user_after). If the DNS server contains one or more views, each view displays in
a separate tab where various settings can be changed for each view.
Note: #include statements are not shown and you cannot add #include statements.

Refer to BIND DNS File Structure for more information on each section.
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5. Click OK. The contents of the files are verified for correctness. If an error is found during verification, an error
message displays and the changes are not saved.
Properties
Applies only when custom properties have been defined for DNS servers. Selecting this menu item will display a dialog
box where the custom property values can be modified.
1. In the Object browser, select the server for which you want to manage properties.
2. From the menu bar, select Server → Properties.
Location
Type a location.
4. Click Apply or OK.
Server Info
This command opens a dialog box that shows information about the history and status of the currently selected server in
the Management Console. This includes such things as the server’s IP Address, operating system, number of requests
& replies received, total uptime, and the number of master and slave zones it has. This command is only available when
a server is selected in the Management Console.
In the Object List, right-click on the desired server name and, from the shortcut menu, select Server Info.

Fig. 3: An Information window opens for the selected server.
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Server Log
To view the activity log for a particular server:
In the Object List, right-click on the desired server and, from the shortcut menu, select Server Log. A Log tab opens
for the selected server that contains a list of activity and maintenance that has occurred on that server since the last time
the log was cleared.

You can clear the server log by clicking the Clear log button in the server log tab.
Note: For Windows DNS servers, it is not possible to view the server log if connected through an agent-free connection.

Note: If the server log window is opened for a caching DNS server, the window will contain additional buttons related
to query logging.

Reload/Reload Zone List (Management Console)
Note: In the Web Application, hitting the browser’s ‘Refresh’ button will reload the data displayed in the context.
There are two reload commands in the Server context and the commands are quite different:
Reload.
This command reloads the DNS server. On Windows this command has the same effect as the Clear Cache
command, but on BIND servers, the command rndc reload is sent to the DNS server.
Reload Zone List.
This command reloads the list of zones from the DNS server. It is useful if a zone has been created outside of
Micetro.
To reload the zone list to include zones that have been added/deleted outside of Micetro, do the following:
1. Select the desired server.
2. From the menu bar, select Server → Reload Zone List. The window grays as the zones are reloaded then displays
with the updated zones.
To reload a DNS server, do the following:
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1. Select the desired server.
2. From the menu bar, select Server → Reload Zone List.
Edit DNS Policies
Note: This functionality is only available for Windows Server 2016
For details on how to configure and use DNS Policies, see DNS policies (Windows).
Clear Cache (Management Console)
It is possible to clear the DNS server cache using the Management console’s ‘Clear Cache’ command. The control you
have over which cache entries you can clear depends on the DNS server type:
• On BIND, you can choose to clear individual cache entries or the entire cache
• On a Windows DNS server you can only clear the entire cache
• On the DNS Caching Appliance you can clear individual cache entries, an entire domain or clear the entire cache
To clear the cache of a BIND DNS server, do the following:
1. Select the desired server.
2. From the menu bar, select Server → Clear Cache. The Clear Cache dialog box displays.

3. To clear the entire server cache, select Clear entire cache. Note that this is the only available option if you are
clearing the cache on a Windows DNS server.
4. To clear a specific name, select the Name to clear radio button and enter the name you want to clear from the
cache. The name is cleared from all views unless you specify the view name after the entry name. Note that this
option is not available for Windows DNS servers.
To clear the cache of a Windows DNS server, do the following:
1. Select the desired server.
2. From the menu bar, select Server → Clear Cache. A confirmation dialog box displays.
3. Click OK to clear the cache of the server.
To clear the cache of a DNS Caching Appliance, do the following:
1. Select the desired server.
1.12. DNS
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2. From the menu bar, select Server → Clear Cache. The Clear Cache dialog box displays.
3. To clear the entire server cache, select Clear entire cache. Note that this is the only available option if you are
clearing the cache on a Windows DNS server.
4. To clear a specific name, select the Name to clear radio button and enter the name you want to clear from the
cache. If you want to clear an entire domain (the name entered and all names below it), select the Recursively
flush the entire domain checkbox.
View Cache Entries (Management Console)
You can view and clear individual DNS cache entries using the View Cache Entries command.
To view the cache of a DNS server, do the following:
1. Select the desired server.
2. From the menu bar, select Server → View Cache Entries. The View Cache Entries tab displays.

3. Enter a name to view and click the View button. The entries found are displayed in a tree view.

4. To clear one or more entries from the DNS server cache, select the checkbox for the entries you want to clear.
5. Click the Clear Selected button.
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Backup and Restore (BIND Only) (Management Console)
Micetro will automatically backup configuration for all BIND DNS servers it manages. The backup can then be used
to restore the DNS server to the backed-up copy of the configuration. The backup is fully automatic and there is no
configuration needed.
Automatic backup can be disabled by setting the property BackupDNSServers value in Men&Mice central preferences
to zero:
<BackupDNSServers value="0" />
If a DNS server machine crashes and has to be replaced with another machine with the same IP Address, Micetro will
detect the new server and consider it to be in an uninitialized state. To be able to work with the server the administrator
needs to initialize the server. To initialize the server right-click on the server and select Initialize. This will display a
dialog box where the user can choose how the server should be initialized:

• If Use data from Micetro is selected, all configurations and DNS zone information on the DNS server will be
overwritten with the backed-up data.
• If Use data from the new server is selected, all data kept in Men&Mice Central will be ignored and overwritten
with current data on the DNS Server.
Basically, the restore scenario is as follows:
1. The DNS server machine crashes and becomes unusable.
2. Configure a new machine to replace the broken machine, using the same IP Address as the old machine.
3. Install the DNS Server Controller on the new machine.
4. When the new machine is up and running, in the Management Console, right-click the server and choose Reconnect.
When a connection has been established, Micetro detects that this is a new, uninitialized server. See above for a
description on what happens next.
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1.12.2 DNS zones
Overview
The commands associated with zone management (located in the DNS context of the Web Application or the Zone
menu in the Management Console) are only available when a specific DNS server or DNS zone is selected. In other
words, actions for the DNS zone are only available when DNS zones are listed. The default for the DNS context is
displaying all zones. (In the Management Console, when DNS Zones is selected in the Object Browser, all DNS zones
are listed on all servers.) However, when a particular name server is selected, only the zones being managed on that
server are listed.
The Web Application’s DNS context displays zone types in the second column.
Indicator
Master (blue)
Master (yellow)
Master (ADintegrated)
Stub
Slave
Forward

Description
A static master zone, which is always the original copy of the zone, and always present on that
zone’s master server.
A dynamic master zone, which is always the original copy of the zone, and always present on that
zone’s master server.
(AD-integrated is displayed in a tooltip) An Active Directory Integrated zone.
A stub zone. The corresponding master zone(s) is displayed in the Inspector window on the left.
A slave zone. The corresponding master zone is displayed in the Inspector window on the left.
A forward zone. The corresponding master zone is displayed in the Inspector window on the left.

Note: For DNS zone indicators in the Management Console, see console-dns-zone-icons.

Zone Viewing
All Zones on All Servers
You can use the Web Application to view all of the existing DNS zones at once, regardless of the server to which they
belong.
In the Web Application, click the DNS on the top. This causes all existing zones (to which you have access) to appear
in the grid.
Single Name Server Zones
In the filtering sidebar or through Admin → Server Management of the Web Application, locate the DNS server that
owns the zones you want to view and click on it. This will list all zones on the server. (In Server Management when a
server is selected, select Show zones from the ellipsis menu to display all zones residing on the server.)
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Tip: The navigation indicator in the bottom left displays the name of the DNS server.

Zone Contents
The Inspector window on the right provides a detailed look at the data inside of a zone. The header record (a.k.a. Start
of Authority or SOA record) displays as a collection of fields above the resource records.
To view the contents of a particular zone, double-click on it. This opens the Zone tab.
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SOA
Since the SOA record is seldom modified after it is created, the Inspector windows has a built-in control to allow you to
hide the SOA data from view. On the right edge of the Inspector, next to the ‘edit’ button, you’ll notice the open/close
button (> and v, respectively) to show/hide the SOA information.
SOA Fields

Field
Master
Hostmaster

Serial

Refresh
Retry
Expire

Neg. caching

Description
This field gives the name of the server that acts as master server for the zone.
This field is properly formatted by giving the e-mail address of the person responsible for zone
with the @ symbol replaced with a period (.). For example, instead of hostmaster@example.com
type hostmaster.example.com. The username part of the e-mail address cannot contain a (verbatim) dot (.). See RFC 1912 ‘Common DNS Operational and Configuration Errors’, Section
2.2 for additional information.
The serial number is a ten-digit number consisting of the year, the month, the day, and a two-digit
daily revision number. (Actually, it is any integer between 0 and ~ 4 billion, but the preceding
is the standard convention.) To create a unique serial number, the Management Console adds 1
to the daily revision number every time the zone is saved.
This is the period (in seconds) that determines how often slave servers will check with the master
server to determine if their zone files are up to date. This is done by checking the serial number.
The default value for this field is 28800, which equates to once every 8 hours.
This determines the period that a slave server will wait before trying to re-contact the master
zone (in the event that an earlier contact attempt is unsuccessful). The default value is 7200
seconds, or once every 2 hours.
This value determines how long a slave server will keep serving a zone after its last successful
contact to the master name server. Once the zone has expired, the slave stops giving information
about the zone because it is deemed unreliable. The default expiration period is 604800 seconds,
or 1 week.
This field is only available when connected to a BIND server. This value specifies how long
a server will retain (cache) the knowledge that something does not exist. The default value is
86400 seconds, 24 hours.

Zone Analysis (Management Console)
Note: Importing DNS data into the Web Application (see Import DNS Records) will automatically validate the data.
The DNS Expert Zone Analysis engine allows zones to be analyzed for correctness in the Management Console.
To analyze a zone, do any of the following:
• Right-click on the zone you want to analyze, and from the shortcut menu select Analyze.
• Choose Zone → Analyze
• Open the zone and click the Analyze button on the toolbar.
The results of the zone analysis are shown in a new window:
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Reanalyze
To perform the analysis again, press F5 or click the Analyze button.
Filtering
It is possible to filter out messages of a certain type. When the checkbox Don’t show filtered messages is selected,
the filtering is active and these messages are not shown in the message list. Deselecting the checkbox disables
the filtering and all messages are shown in the message list.
Quick Filter
The Quick filter works the same as it does in other windows.
Messages
The message list shows the results of the zone analysis. Messages are either warnings or errors (as indicated by
the icon next to the message). Selecting a message will display detailed information about the message at the
bottom of the window.
Fix

When the application can fix an error, the Fix menu item becomes available. Selecting this menu item will
display more information about the fix for the error.

Filter out messages of this type
Selecting this item, will suppress the display of the selected error type unless the Don’t show filtered messages
checkbox is unselected. NOTE: This setting is global and it is applied to all subsequent analysis in all zones. If
you right-click a filtered message, this item will read as Don’t filter out messages of this type.

If the zone you are analyzing is open, an icon with an exclamation mark is shown in the bottom left corner of the
window. Clicking this icon will display the errors found during the analysis in a list at the bottom of the Zone tab.
Closing the analysis window will clear the error message list in the Zone tab.
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Access/Access for Non-Master for Zone(s)
Refer to Access control.
Delete zone
Use this command to delete a zone from one or more servers. Before using this command, select the zone you want to
delete from the Management Console; the Delete Zone dialog box displays and shows a list of servers on which that
zone resides. By default, the zone will be removed from all servers (i.e., all servers are checked). If you want to keep
it on one or more servers, clear the checkbox next to that server. Click the Delete button to remove the zone from the
selected servers.
1. Select the zone(s) to delete.
2. From the ellipsis menu select Delete zone or use Actions → Delete zone. A confirmation dialog appears.
3. To delete the zone(s) from the selected servers, click the Yes button. The zone is removed from the servers.
Warning: The Delete Zone dialog, showing each zone you selected and a list of servers that currently serve that
zone, is only available in the Management Console. There you are able to keep the zone on particular server(s) by
clearing the checkbox next to that server(s).

Note: See console-delete-dns-zone for the zone deletion operation in the Management Console.

Disable/Enable (Management Console)
Note: This function is only available in the Management Console.

Disabling a Zone(s)
This function is only available for static master zones that have no slave zones. (For other types of zones (dynamic
or AD integrated) the command is not visible. The Disable command deactivates the entire zone without deleting it.
When disabled, the server ignores the contents of the zone. The zone can still be edited while disabled, but changes
will not take effect until the zone is re-enabled.
1. In the Object Section, select DNS Zones to view all zones, or under the DNS Servers object, select the server
containing the zone you want to disable. This displays the zones in the Object List.
2. Select the zone(s) that you want to disable. To select more than one zone, hold down the Ctrl key while making
your selections.
3. From the menu bar, select Zone → Disable Zone. A dialog box prompts you to confirm your decision.
4. To disable the selected zone(s), click the Yes button. The zone becomes disabled.
Zones that are disabled appear faded in the Object List. They are still fully accessible and editable, but they will not be
active until you re-enable them.
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Enabling a Zone(s)
Use the following procedure to re-activate a zone that has been disabled.
1. In the Object List, locate the zone(s) that you want to re-enable. To select more than one disabled zone, hold
down the Ctrl key while making your selections.
2. From the menu bar, select Zone → Enable Zone. A dialog box prompts you to confirm your decision.
3. To enable the zone(s), click the Yes button. The Object List refreshes itself and shows that the zone(s) has been
restored to active status.
Duplicate (Management Console)

Tip: In the Web Application, you can duplicate DNS zones by selecting Migrate zone from the ellipsis menu, or using
Actions → Migrate zone and leaving the Remove original zone checkbox unchecked.
In the Management Console, use the following procedure to create a new zone that is an exact duplicate of an existing
one, including master and slave servers, zone data and zone options.
1. In the Object Section, select either DNS Zones, or select a specific server under the DNS Servers object. This
lists the zones in the Object List.
2. In the Object List, right-click on the zone you want to duplicate and select Duplicate from the popup menu. The
Create Zone dialog box displays.
3. Enter a name for the new zone in the Zone Name field.
4. Click the Create button. A new zone is created with the same records, Master server, and Slave servers as the
original.
Zone Migration Wizard
The Zone Migration Wizard allows users to migrate one or more zones from one server to another, including all data
in the zone.
To migrate a zone, do the following:
1. Select one or more zones.
2. Select the ellipsis menu’s Migrate Zone or use Action → Migrate zone. The Migrate Zone(s) Wizard dialog box
displays.
3. For each of the resulting screens, make a selection/entry and move through the wizard.
Note: For DNS zone migration in the Management Console, see console-dns-migration-wizard.
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View Related Servers (Management Console)
This option is used to see on which servers a copy of a particular zone resides.
1. In the Manager window, select one or more zones.
2. Right-click and, from the shortcut menu, select Related Servers. A dialog box with information on where a copy
of the zone resides displays.
3. Click OK to close the dialog box.
Edit Preferred Servers
Note: This option is only available when working with AD integrated zones. (See AD Sites and Subnets.)
DNS administrators can specify the server to use when opening an AD integrated zone, as well as the order of servers
to use if the first preferred server becomes unavailable.
1. Navigate to the DNS context and select the AD Integrated filter from the sidebar on the left.
2. Select the zone(s) you’d like to set preferred servers for.
2. Use Action –> Edit preferred server from the top bar or the ellipsis menu.
3. Change the order of your servers into the preferred order. The server on the top of the list is tried first, then - if
that server is unavailable - the second, and so on.
3. Click Save.
Warning: If you selected multiple zones, they might have different settings for preferred servers. Saving the
configuration will overwrite the previous settings on all selected zones.

Note: To manage preferred servers for an AD integrated zone in the Management Console, see console-ad-preferredservers.

Export (Management Console)
Use this command to export DNS zone files to standard format.
1. Select the zone you want to export and open the Zone tab.
2. From the menu, select File –> Export. The Export zone to text file dialog box displays.
3. Provide a name and destination for the file and click the Save button. All exported files are saved in standard,
readable format.
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Folders
Refer to Object folders for details on this function.
Forward Zone
For creating a forward zone in the Web Application, see Creating a DNS zone.
For creating a forward zone in the Management Console, see console-forward-zone.
Import (Management Console)
Note: This is a function that allows importing DNS zones. To import DNS records see Import DNS Records.)
Through this function, you can import multiple DNS zones at one time.
1. Use File → Import Zone. The Import dialog box displays.
2. Locate the zones to be imported. The zones must within the same folder. To select multiple zones, press/hold
the Ctrl key. Then click on each zone.
3. Click Open. The files are uploaded and the Import zones dialog box displays.

4. Click Import.
If you happen to select an invalid zone, the following error message dialog box displays:

5. Click OK and when you return to the Import zones dialog box, clear the field containing the zone.
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Master Zone
For creating master zones in the Web Application, see Creating a DNS zone.
For creating master zones in the Management Console, see console-create-master-dns-zone.
DNS Response Policy Zones (BIND only) (Management Console)
The ISC BIND name server (9.8 or later) supports DNS Response Policy Zones (RPZ). You can find more information
on RPZ at dnsrpz.info
You can manage RPZ zones from within Micetro with the Management Console. When you open the Options dialog
box for a master zone on a BIND server you will see the Response Policy Zone checkbox. To specify zone as an RPZ
zone, just click the checkbox.

Note: To use RPZ, a response-policy statement must exist in the DNS server options file. The Response Policy Zone
checkbox is disabled if a response-policy statement is not present. For example
options {
...
response-policy {zone "rpzzone.com" ;};
...
};
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DNSSEC Zones (Management Console)
Note: DNSSEC signed zones can be listed in the Web Application by selecting DNSSEC signed in the filtering sidebar
on the left.
Zones containing DNSSEC records are labeled as “Signed” in the DNSSEC column in the zone list.
When DNSSEC zones are opened, the system ignores most DNSSEC records unless the system setting to include
DNSSEC records has been set.

Note: All DNSSEC record types, with the exception of the DS and NSEC3PARAM record types, are read-only.

DNSSEC Management on Windows Server 2012
You can use Micetro to manage DNSSEC on Windows Server 2012. You can sign and unsign zones. You can customize
the zone signing parameters and add, edit and remove Key Signing Keys (KSK) and Zone Signing Keys (ZSK).
The details of DNSSEC are beyond the scope of this documentation. For more information on Windows Server 2012
and DNSSEC, see the Microsoft web site http://www.microsoft.com.
Signing Zones using DNSSEC
To sign a zone on a Windows Server 2012, do the following:
1. With the zones displayed in the Object List, select the zone you wish to sign.
2. Do one of the following to display the Zone Signing dialog box:
• Right-click on the zone record and select Sign Zone.
• From the menu bar, select Zone → Sign Zone.
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3. Select an option for signing the zone:
Customize zone signing parameters.
Signs the zone with a new set of zone signing parameters. When this option is selected you can choose or create
new Key Signing Keys (KSK) and Zone Signing Keys (ZSK).
Sign the zone with parameters of an existing zone.
Signs the zone using parameters from an existing signed zone. To use this option, you must enter the name of
the zone containing the parameters to use.
Use default settings to sign the zone.
Signs the zone with the default zone signing parameters.
4. Click Next. If you chose the Customize zone signing parameters option, the zone signing wizard allows you to
choose KSK and ZSK for signing the zone. If you chose either of the other options, an overview panel displays
in which you can see the zone signing parameters that will be used to sign the zone.
5. Click Finish to complete the zone signing process.
Unsigning Zones using DNSSEC
To unsign a zone on a Windows Server 2012, do the following:
1. With the zones displayed in the Object List, select the zone you wish to unsign.
2. Do one of the following to unsign the zone:
• Right-click on the zone record and select Unsign Zone.
• From the menu bar, select Zone → Unsign Zone.
3. The zone is unsigned and all DNSSEC records are removed from the zone.
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Options (Management Console)
Note: Using the Web Application’s Properties you can edit custom properties that’s been configured for DNS zones.
The Zone Options dialog box is where you can configure individual settings for a specific zone on each server.
Zone Options (Windows and BIND)
To access the zone options for a specific zone only, do the following:
1. With the zones displayed in the Object List, select the zone you wish to configure.
2. Do one of the following to display the Zone Options dialog box:
• Right-click on the zone record and select Options.
• From the menu bar, select Zone → Options.
• On the toolbar, click the Options button.
3. Depending on the type of zone you select, the Option dialog box varies.
Master zones
Allow Zone Transfers.
When enabled, zone transfers will occur according to the method indicated by the radio buttons below. You must
select at least one of these methods.
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To any server.
When selected, the zone transfer will be performed to any requester.
Only to listed name servers in the zone.
When selected, the zone will be transferred from the server to any other name server listed in the zone.
Only to the following servers.
When selected, the zone will only be transferred to the servers you specify in the list below. To enter a server,
click in the first available row and enter its IP Address.
Dynamic updates.
Specifies whether dynamic updates are allowed for the zone
AD Replication.
Displays a dialog box where you can set the AD Replication options for the zone.
Aging/Scavenging.
Displays a dialog box where aging and scavenging options can be set for the zone.

Slave Zones
Allow Zone Transfers.
When enabled, zone transfers will occur according to the method indicated by the radio buttons below. You must
select at least one of these methods.
To any server.
When selected, the zone transfer will be performed to any requester.
Only to listed name servers in the zone.
When selected, the zone will be transferred from the server to any other name server listed in the zone.
Only to the following servers.
When selected, the zone will only be transferred to the servers you specify in the list below. To enter a
server, click in the first available row and enter its IP Address.
IP Addresses of master.
Type the IP Address of the master servers for the zone.
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Stub/Forward Zones
Type the IP Address of the master servers for the zone.

BIND Servers

The Zone Options dialog box lets you specify an IP Address (or an address block) from which zone transfers can be
allowed, or disallowed.
The top section of the Options dialog box lets you designate the zone as either Static or Dynamic. Newly created zones
are static by default, but can be changed to a dynamic zone (and vice versa) using this option. Refer to Dynamic Zones
for more information on dynamic zones versus static zones.
Addresses that have already been setup to handle (i.e., allow or disallow) zone transfers are listed in the lower area of
the Zone Options dialog box. If you want to change the settings associated with an address that is already listed here,
select it and click on the Edit button. To remove the access control completely, select it from the list and click the
Remove button.
To specify a new address (or block) on which you want to implement access controls, do the following:
1. Click the Add button. A small dialog box displays, prompting you to enter the server’s IP Address, an address
block, or to use one of the predefined names from the drop-down list (any, none, localhosts, localnets).
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2. After entering the address, select either Allow or Deny to specify whether to permit or disallow access to/from
this address.
3, Click OK to save the selection. The new address is now listed in the Zone Options dialog box.
Note: BIND uses journal files to keep track of changes to dynamic zones. The data in the journal files is merged with
the zone data file at a designated interval. It is not possible to manually merge the data from the journal files to the
zone data file. This means that if there is data in the zone’s journal file when the zone type is changed to a static zone,
the entries in the journal file will not be visible in the Management Console.

Slave Zones on BIND Servers

When a slave zone is hosted on a BIND server, the Options dialog box will look like the one below.
Besides being able to setup the access control (as described in the previous section), you can also specify the IP Address
of one or more master servers for the zone.
The master servers are specified in the lower half of the Zone Options dialog box. To add a new server to the list, simply
click in the white space and enter the IP Address of the master server you are assigning.
To change the address of an existing server, click on it and make the desired edits.
Advanced Options
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DNS Administrators can now access the BIND configuration files directly to edit DNS server and zone options that are
not available in the GUI. Refer to Advanced Server Options for details.
Options for a zone (Management Console)

If a zone exists on more than one server (e.g., in a master/slave configuration), it is possible to select the zone instance
for which you want to set options.
1. Select the applicable zone.
2. From the menu bar, select Zone → Options for.
3. From the submenu, select the desired zone/zone instance (e.g., Master Zones only, Slave Zone only, etc.). The
Zone Options dialog box displays.
Allow zone transfers
When selected, enables the zone transfer options.
To any server
When selected, the zone transfer will be performed to any requester.
Only to listed name servers in the zone
When selected, the zone will be transferred from the server to any other name server listed in the
zone.
Only to the following servers
When selected, the zone will only be transferred to the servers you specify in the list below. To enter
a server, click in the first available row and enter its IP Address.
Dynamic Updates
Specifies whether dynamic updates are allowed for the zone
Aging/Scavenging
Displays a dialog box where aging and scavenging options can be set for the zone.
4. When all selections/entries are made, click OK.
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Promote Slave to Master
The Promote Zone feature makes it possible to change a slave zone to a master zone. This might be necessary in
emergency situations, for example if the master zone becomes unavailable for an extended period of time. This feature
is only available for DNS Administrators.
When a slave zone is promoted, the following actions are performed:
• Micetro checks whether the most recent copy of the zone is found in its internal database or on the server hosting
the slave zone and uses the copy that is more recent.
• The server hosting the slave zone is configured so that the zone is saved as a master zone on the server.
• The zone history and access privileges from the old master zone are applied to the new master zone.
• The configurations of other instances of the slave zone are modified so that they will get the updates from the
new master zone.
To promote a slave zone to a master zone, do the following:
1. Select the slave zone.
2. Using the ellipsis menu’s Promote to master or using Actions → Promote to master. An information message
displays:

3. Click Save to continue, or Cancel to discontinue the process.
Note: To promote slave zones in the Management Console, see console-dns-promote-secondary-to-primary.

Zone Controls (BIND only) (Management Console)
The Zone Controls feature allows you to create and edit $GENERATE statements in static zones on BIND DNS servers.
1. Open the zone you want to work with.
2. On the Toolbar click the Zone Controls button . The Zone Controls dialog box opens, showing any $GENERATE statements that exist in the zone. The $GENERATE statements are shown in a multiline edit field.
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3. Make the necessary adjustments to the statements and click OK.
Note: The fields for each $GENERATE statement must be separated by a tab.

Reload (Management Console)
Sends a command to the DNS server instructing it to reload the zone data.
Set Folder
Allows you to add or remove zones from folder.
Warning: If you remove a zone from a folder, there is no way to undo this action.
1. Highlight the zone you want to remove from a folder.
2. From ellipsis menu select Set folder or use Actions → Set folder.
Search
For search in the Web Application, see Quick command.
For searching in the DNS zone tab in the Management Console, see console-dns-search.
Slave Zone
For creating slave zones in the Web Application, see Creating a DNS zone.
For creating slave zones in the Management Console, see console-create-slave-zone.
Stub Zone
For creating stub zones in the Web Application, see webapp-create-dns-zones.
For creating stub zones in the Management Console, see console-stub-zone.
View History
Opens the History window and displays a log of all changes that have been made to the zone, including the date and
time of the change, the name of the user who made it, the actions performed, and any comments entered by the user.
Refer to History for the Web Application and Object Change History for the Management Console.
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1.12.3 DNS resource records
Overview
Each zone contains DNS resource records that define how requests are processed or delegated by the zone. The Open
action displays a streamlined interface that makes it easy to view, edit, and manipulate information within a zone.

Types of Resource Records
There are varieties of resources records that actively affect zones, as well as several informational records that can be
used to provide supporting data about a zone. The primary record types are described below.
NS

The Name Server record is used to list a name server for this zone. NS records state the domain name of the
zone’s name servers. The name of an NS record is the fully qualified domain name of a zone. Every zone must
have at least one NS record with the same name as the zone itself.
Example:
Name
example.com.

A

Type
NS

Data
ns1.example.com.

Also known as an Address record, an A record declares the IP Address of a domain name. Defines a Hostnameto-IP Address mapping, or a forward mapping.
Example
Name
example.com.

PTR
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Type
A

Data
192.168.0.1

Also known as Pointer records, PTR records define an IP Address-to-Hostname mapping, known as a reverse
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mapping. A properly configured reverse zone has one PTR record providing the reverse lookup for each IP
Address. All reverse zones are traditionally part of the .in-addr.arpa. zone. The proper formatting for a PTR
record is the 4 octets of the IP Address in reverse order, followed by .in-addr.arpa. A properly formatted
PTR record for the A record (above) is shown in the following example.
In the event that you have multiple A records concerning the same IP Address, choose one for the PTR record. If
one of the host names is used for a mail server, give that hostname preference because a common use of reverse
lookup is to check the source of e-mail.
Example
Name
1.0.168.192.in-addr.arpa.

Type
PTR

Data
example.com.

CNAME
Canonical Name records are used to define an alias. The canonical or primary DNS domain name used in the
data is required and must resolve to a valid DNS domain name in the namespace. The name of the record is the
name of the alias. Thus, if you want www.example.com to bring visitors to example.com, you’d need to add the
line shown in following example:
Example
Name
www.example.com.
MX

Type
Data
CNAME example.com.

Also known as Mail Exchange records, MX records create mail routes. Each exchanger host must have a corresponding host (A) address resource record in a valid zone. The first field in the record data is the preference
number; this is the order in which mail hosts will be used by an outside mail server trying to send mail to a
domain. Mail hosts will be contacted from the lowest preference number and work up to higher preference number. If two MX records have the same preference number, they will be used in random order. Mail servers with
the same preference number will not forward to each other, nor will they forward to a mail server with a higher
preference number.
Example
Name
example.com.

Type
MX

Data
10 mail.example.com.

AAAA
Maps a DNS domain name to an Internet Protocol (IP) version 6 128-bit address.
Example
Name
host.example.com.
WKS

Type
AAAA

Data
4321:0:1:2:3:4:567:89ab

Similar in function to MX records, Well-Known Service (WKS) records describe the well-known IP services
supported by a particular protocol on a specific IP Address. They provide TCP and UDP availability information
for IP servers. Multiple WKS records should be used for servers that support both TCP and UDP for a well-known
service or that have multiple IP Addresses that support a service.
Three fields of data are required: IP Address, protocol, and a service list.
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Example
Name
host.example.com.

Type
WKS

Data
10.0.0.1 TCP (ftp smtp telnet)

Warning: Please note that the record type WKS was deprecated by RFC1123 - please don’t use this record
type.
RP

The Responsible Person record specifies the domain mailbox name for the person responsible for that domain.
This name is then mapped to a domain name in for which (TXT) resource records exist in the same zone. When
RP records are used in DNS queries, subsequent queries are used to retrieve associated text (TXT) resource
record information. Two fields of data are required: the domain name you are searching, the domain where TXT
resource records exist.
Example
Name
my.example.com.

Type
RP

Data
who.example.com txtrec.example.com

AFSDB
The Andrew File System Database resource record maps a DNS domain name to the host name for a server
computer of a server subtype. Two fields of data are required:
The first is a subtype, which can have one of two supported numeric values:
• A 1 indicates that the server is an AFS version 3.0 volume location server for the named AFS cell.
• A 2 indicates that the server is an authenticated name server holding the cell-root directory node for
the server that uses either Open Software Foundation’s (OSF) DCE authenticated cell-naming system or
HP/Apollo’s Network Computing Architecture (NCA).
The second field is the server’s host name.
Example
Name
abc.example.com.
SRV

Type
Data
AFSDB 1 afs-server.example.com.

Service records are intended to provide information on available services. They allow multiple servers providing
a similar TCP/IP-based service to be located using a single DNS query operation.
An SRV record has four fields and a special system for naming. The naming system is an underscore followed
by the name of the service, followed by a period, an underscore, and then the protocol (generally TCP or UDP),
another dot, and then the name of the domain. The four fields are:
Priority
Used the same way as the preference number in MX records.
Weight
This determines the relative capacity between SRV fields with the same priority. Hits will be assigned
proportionately by weight, allowing a powerful and a weak server to share appropriate loads.
Port
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Hostname
The name of the domain.
Example
Name
_http._tcp.example.com.

Type
SRV

Data
10 5 80 www.example.com.

HINFO
The Host information resource record specifies the type of CPU and operating system, respectively, for the host
DNS domain name. This information is used by some application protocols, such as FTP, which use special procedures when communicating with computers of a known CPU and operating system type. Hardware information
belongs in the first data field and OS information in the second field, as shown in the example below.
Example
Name
compname.example.com.
TXT

Type
Data
HINFO Intel-PIII WIN2K

A Text Record allows you to include up to 255 characters of free-form descriptive text in your zone file. The
order of resource records in zone files is not preserved, so it is best to keep messages confined to one record.
Example
Name
random.example.com.

LOC

Type
TXT

Data
The quick brown fox jumped over the lazy dog.”

Geographic Location Records provide exact altitude, latitude, and longitude information. There is not much in
the way of a practical application for this record, though some industries may find it to be of limited value. The
LOC record can accept as few as three or as many as six fields of data:
• Degrees latitude in degrees, minutes, seconds, N or S
• Degrees longitude in degrees, minutes, seconds, E or W
• Altitude in meters. This is single value, you may add an M.
• Size of machine in terms of an enclosing sphere in meters radius. Expressed as a number, or a number
immediately followed by an M. (Optional.)
• Horizontal precision of the data in meters, with or without an M. (Optional, not available if 4 is blank.)
• Vertical precision of data in meters, with or without an M. (Optional, not available if 5 is blank.)
Note: The Microsoft DNS server does not support LOC records.
Example
Name
geo.example.com.

Type
LOC

Data
42 21 43.528 N 71 05 06.284 W 12m

NAPTR
NAPTR stands for Naming Authority Pointer and is a resource record type that supports regular expression based
rewriting. The NAPTR record accepts six fields of data:
1.12. DNS
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Preference
When there are multiple NAPTR records with the same name, the record with the lowest preference number
is picked first.
Weight (Order)
This field specifies the order in which the NAPTR records MUST be processed to accurately represent the
ordered list of Rules. This field is only used when there is more than one record with the same preference
Flags
This field contains flags to control aspects of the rewriting and interpretation of the fields in the record.
Flags are single characters from the set A-Z and 0-9.
Service
This field contains a character-string that specifies the Service Parameters applicable to this delegation path.
Regexp
This field contains a character-string that contains a substitution expression that is applied to the original
string held by the client in order to construct the next domain name to lookup.
Replacement
This field contains a domain name, which is the next domain name to query for, depending on the potential
values found in the flags field.
Example
Name
104

Type
Data
NAPTR 100 10 u sip+E2U !^.*$!sip:info@info.example.test!i .

SSHFP
SSHFP stands for SSH Public Key Fingerprint. This resource record type is used for publishing SSH public host
key fingerprints in the DNS System, in order to aid in verifying the authenticity of the host. The SSHFP record
accepts 3 fields of data:
Algorithm
Specifies the algorithm number to use.
Fingerprint type
Specifies the fingerprint type to use.
Fingerprint
The fingerprint for the record.
For further information on this record type, see RFC 4255.
Example
Name
random.example.com
SPF

Type
SSHFP

Data
1 1 23D3C516AAF4C8E867D0A2968B2EB999B3168216

SPF stands for Sender Policy Framework. This record type is used in an e-mail validation system designed to
prevent e-mail spam. The SPF record accepts a text string that contains the configuration info that should be
used.
For further information on this record type, see RFC 4408.
Example
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Name
example.com

Type
SPF

Data
v=spf1 a mx -all

TLSA
The TLSA DNS record is used to associate a TLS server certificate with the domain name where the record
resides.
For further information on this record type, see RFC 6698
A TLSA record has four fields, which are:
Certificate usage
Specifies the association that will be used to match the certificate.
Selector
Specifies which part of the TLS certificate will be matched against the certificate association data
Matching type
Specifies how the certificate association is presented
Certificate associate data
Specifies the certificate association data to be matched
Example
Name
example.com

CAA

Type
TLSA

Data
3
1
1
d2abde240d7cd3ee6b4b28c54df034b9
7983a1d16e8a410e4561cb106618e971

The CAA (Certification Authority Authorization) DNS record is used to specify which Certification Authorities
(CA) can issue certificates for the domain.
Example
Name
example.com

Type
CAA

Data
0 issue “letsencrypt.org”

In addition to the supported record types in the table, Micetro supports the following DNSSEC resource record types:
• DNSKEY (read-only)
• NSEC (read-only)
• NSEC3 (read-only)
• NSEC3PARAM
• RRSIG (read-only)
• DS
• DLV (read only)
Note: All DNSSEC specific record types, with the exception of the DS and NSEC3PARAM record types, are read
only.
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It is beyond the scope of this documentation to discuss DNSSEC management so these record types are not explained
in detail. For further information on these resource record types and DNSSEC in general, we recommend the DNS
Extensions section on the IETF web site.
Resource Records
To select a single resource record, click on the gray square to the left of the record. This highlights the entire record.
Once a record is selected, you can perform various editing actions on it, such as deleting, cutting, or copying. These are
discussed in more detail later in this section. Many editing action can be performed on multiple records simultaneously.
Simply select the records you want to operate on and perform the editing action as usual.
To select non-consecutive records, do the following:
1. Hold down the Ctrl key and select each record as usual.
2. When you are done selecting records, release the Ctrl key.
To select a contiguous series of records, select the first record in the series as usual, then hold down the [Shift] key and
select the last record in the series. All records in between will automatically be selected.

New Records
If you are comfortable editing the record table directly, you can use this procedure to insert a new record directly in the
zone tab.
1. Open the zone to display the resource records in the zone you want to edit.
2. In the grid, select the record that is directly above where you want to insert the new record.
3. Click on Create. A new, blank record is added.
4. Enter the Record Name.
Warning: If you enter a domain name that is not fully qualified (i.e., does not end in a trailing dot .), Micetro
will assume that you are using a local name and will automatically append the name of the zone onto the end of
the name, making it a fully qualified domain name. That means when adding the name server ns1 to the zone
example.com, you should enter either just ns1 or ns1.example.com. If you leave off the trailing dot Micetro will
interpret your intention as ns1.example.com.example.com. The information automatically filled in by the Web
Application appears greyed out.
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5. In the Type field select the appropriate type from the dropdown. The following types of resource records can be
created: NS, A, PTR, CNAME, MX, AAAA, WKS, RP, SRV, TXT, and SPF.
Warning: If you enter the wrong record type, you will be unable to change it. You must delete the
record, insert a new one, and re-enter the record information.
6. After selecting the type, the relevant fields are automatically displayed.
7. Fill in all apprioriate data fields.
7. Click Create now button to save the new record to the zone, or Add to request to add it to the request queue. (See
Workflow Management for details on the request queue.)
Micetro will not allow you to save the changes until all required information is filled in and the data is validated. In
case of errors or missing information, the relevant fields will highlight in red.

Deleting Records
Deleting a record removes both the data and the physical record from the grid. Records beneath the deleted one are
instantly moved up to fill in the space.
1. Select the record(s) that you want to delete. To select multiple records, hold down the Ctrl (or Cmd on Mac) key
while making you selections.
2. Select Delete. The record is immediately deleted from the zone.
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Clearing Records (Management Console)
When the whole record is selected, the Clear command works the same as the Delete Record command. The Clear
command is really intended for deleting the contents of an individual field of data, leaving the rest of the record’s data
intact.
1. In the Zone window, select the field (cell) whose contents you want to delete.
2. Right-click anywhere in the zone window and select Clear from the context menu. The data is removed from
the field. (The cell is not removed, and the rest of the record is unaffected.)
Disable/Enable Records
You can disable a record without deleting it. The disabled record performs no function; however, it can be instantly
enabled when its services are needed, without having to re-type the record.
Note: You cannot disable and enable records in dynamic zones.

How to Disable a Record
1. Select the record(s) that you want to disable. To select more than one record, hold down the Ctrl (Cmd on Mac)
key while making your selections.
2. From the ellipsis menu select Disable DNS record or use Actions → Disable DNS record.
Note: Disabled records are grayed out in the grid, and will show an Enable DNS record action instead.
3. In the confirmation dialog, click Save now to save the changes, or Add to request to add it to the request queue.
(See Workflow Management for details on the request queue.)
Cut, Copy, and Paste (Management Console)
When working with records in the Management Console, there is no need to enter the same records in different zones.
All records can be copied (or moved) to other zones simply by copying and pasting them between different zone
windows.
To facilitate this, the Copy and Paste functions do not use fully qualified host names, so it is easy to work with records
between zones.
This means that if you copy a record from the domain example.com, such as: www.example.com. CNAME example.
com. and paste the record to sample.com, it displays as: www.sample.com. CNAME sample.com.
To cut, copy, and paste records, do the following:
1. Select the record(s) that you want to move or copy. To select multiple records, hold down the Ctrl key while
making your selections.
2. Right-click anywhere in the Zone window and choose either Cut (to move the record) or Copy (to duplicate the
record elsewhere) from the context menu.
Note: The Cut, Copy, Paste, and Clear commands can also be selected from the Edit menu in the main window.
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3. Open the destination zone in which you want to insert the record(s).
4. In the destination zone, insert a new blank record in the location where you want to paste the records. To do this,
right-click on the record immediately above where you want to paste the new one(s), then select Insert Record
from the popup menu.
5. Select the blank record.
6. Right-click anywhere in the Zone window and choose Paste from the context menu. The new record(s) are pasted
in the destination zone.The Management Console allows you to undo most editing actions, such as deleting,
clearing, cutting, and pasting.
7. When you perform an editing action, the Edit menu’s Undo command is modified to include that action. For
example, if you disable a record, the Undo command changes to Undo Disable. Selecting this command will
reverse the action and restore the previously deleted record. When you perform an Undo action, the Redo command becomes active. Selecting this command reverses the previous Undo action. If you perform multiple
editing actions in a row, the Undo command can be used repeatedly to restore each prior action.
Undo/Redo Commands (Management Console)
The Management Console allows you to undo most editing actions, such as deleting, clearing, cutting, and pasting.
When you perform an editing action, the Edit menu’s Undo command is modified to include that action. For example,
if you disable a record, the Undo command changes to Undo Disable. Selecting this command will reverse the action
and restore the previously deleted record.
When you perform an Undo action, the Redo command becomes active. Selecting this command reverses the previous
Undo action.
If you perform multiple editing actions in a row, the Undo command can be used repeatedly to restore each prior action.

1.12.4 DNS policies (Windows)
Note: Managing DNS policies for Microsoft DNS servers is only available in the Management Console.

DNS Policies and DNS Scopes
DNS policies are processing rules that control DNS operations on the DNS server. Creating a DNS policy enables user
control over the details of these DNS operations: query processing, zone transfer, recursion and dynamic update. A
DNS policy is always specific to one DNS operation and apply either on the server level or the zone level. This control
of DNS operations can, for example, be used to implement the following scenarios:
• High availability of DNS services
• Traffic management
• Split-brain DNS
• Filtering
• Forensics
• Redirection based on date/time
Specific types of policies are:
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Zone transfer policies
Controls how zone transfers are processed, either for the DNS server or a specific DNS zone.
Recursion policies
Control how recursive DNS queries are processed by the DNS server.
Query resolution policies
Controls how queries are processed for the DNS server or a specific zone.
Dynamic update
Controls how dynamic updates are processed
Rate limiting exception list
Controls how rate limiting is configured
DNS policies are used in conjunction with zone scopes and server scopes which are a new concept introduced in
Windows Server 2016. A zone scope represents a specific version of an existing zone while a server scope is a collection
of DNS server settings that is associated with a unique name.
Edit DNS Policies
Editing or adding DNS policies on Windows Server 2016 is done by
1. Right click on the server in the sidebar as shown in the figure.
2. Select Edit DNS Policies.
3. A menu is displayed that offers to do add or edit various types of policies and configure related properties.

Define Client Subnets
This allows the user to specify those subnets that will be used by the DNS policies to identify where a DNS client is
located.
1. Select the Define Client Subnets in the submenu of Edit DNS Policies.
2. Click the Add button to add a new client subnet.
3. Specify the name of the subnet and a list of subnets in CIDR notation, that will be used in the exclusion rules.
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Add DNS Zone scopes
To add a new zone scope:
1. Right click on a DNS zone.

2. Select Add zone Scope after right clicking the zone.
3. A new dialog appears where you can enter the name of the new zone zone.
4. Click the Add button to add the new zone scope.
The newly added zone scope is now shown in the zone list. The name of each zone scope is shown in a separate column.
Edit DNS Server Scopes
This allows the user to add or remove server scopes as well as specifying options for each scope.
1. Select the Edit DNS Server Scopes in the submenu of the Edit DNS Server policies.
2. Click the Add button to add a new server scope. A new dialog is displayed that allows the user to specify a name
of the new server scope.
3. Click the OK button to add the new server scope.
4. For an existing server scope, select the corresponding server scope and then click the Remove button to remove
the server scope.
5. To edit the options for a server scope, highlight the corresponding server scope and click the Options button.
A new dialog window is displayed that allows the user to specify forwarders and select if recursion should be
allowed. To disable the use of forwarders for the server scope leave the forwarders list empty.
Note: The forwarders list for the default server scope can still be edited in the Server Options

Set Response Rate Limiting
The Response Rate Limiting feature of the Microsoft 2016 DNS server can be used to control the rate in which the
server responds to similar requests it will send to clients on the same subnet.

1.12. DNS

233

Micetro by Menamp;Mice Documentation, Release 10.2

Configuring rate limiting
1. Select the ‘Set Response Rate Limiting’ in the submenu of the ‘Edit DNS Server policies’
2. To enable response rate limiting, make sure the checkbox in ‘Enable reponse rate limiting is checked.
For an overview of the configuration and the related fields, see below.
Enable Response Rate Limiting
To enable the Response Rate Limiting
Log only
RRL calculations are performed, but potential actions are logged as if RRL is enabled.
Responses / second
Maximum number of times the servers sends a client the same response within a one second interval.
Errors / seconds
Maximum number of times the servers sends an error response to a client within a one second interval.
Detection window
Specifies the period (in seconds) over which rates are measured and averaged for RRL.
IPv4 prefix length
Specifies the IPv4 prefix length, which indicates the size of the subnet in which the incoming queries are grouped.
IPv6 prefix length
Specifies the IPv6 prefix length, which indicates the size of the IPv6 subnet in which the incoming queries are
grouped
Leak rate
Specifies the rate at which the server responds to dropped queries
Truncate rate
Specifies the rate at which the server responds with truncated responses
Max responses / window
Specifies the maximum number of responses that the server sends to a subnet-domain address in a RRL time
window.
Exception list
Allows for creating policies that control RRL exceptions.
Adding an exception
In the Response Rate Limiting window, click on the Add button.
DNS Policies
To add a DNS policy:
1. Select the type of DNS policy in the submenu of the Edit DNS Server policies.
2. Click the Add button to add the new policy
3. A new dialog window is displayed. It is a generic window for adding a DNS policy. Refer to Adding DNS policies
for more details.
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Adding DNS policies
1. Each DNS policy must have a name that conforms to the rules of filenames. The name should be chosen to be
unique for the zone or among DNS policies on the server level.
Note: In case the name of the DNS policy does conflict with a DNS policy of a different type it is
automatically renamed.
2. A DNS policy can be created enabled or disabled. Policies that are disabled are ignored by the server except for
statistics and logging.
3. Each query that matches the policy can result in three actions:
Allow:
The query is processed and answered from the server or zone scope referred to.
Deny:
The DNS server refuses the query.
Ignore:
The DNS server drops the query without informing the client.
Note: Server level policies other than recursion policies can only have “Deny” and “Ignore” as the action.
Recursion policies and all zone level policies can have “Allow”, “Deny” and “Ignore” as the action. For
the “Allow” action one or more DNS scope must be selected, for a recursion policy these must be sever
scopes and for any policy on a DNS zone these must be DNS scopes created on the zone.
4. If the action is ‘Allow’ select the ‘Edit’ button. This opens a dialog where you can select the target DNS scopes
used for matched queries and the weight for load balancing.
5. Condition decides the condition for matching the Criteria list. Selecting ‘And’ indicates that all of the criteria
should match for the policy to apply and ‘Or’ indicates that one or more of the criteria is sufficient for the policy
to apply.
6. Criteria is a list of rules that the incoming DNS query is compared to. If the query matches the rules the server
takes action in accordance. For more details refer to Add DNS policy criteria section.
Adding DNS policy target scope
When the action for a DNS Policy is ‘Allow’ one or more target DNS scopes must be chosen. Each DNS scope has a
name and a weight for load balancing.
1. To add an DNS scope to the list press Add button.
2. In the Add Target Scope dialog you can select a scope which you want to be used to answer queries that match
the DNS policy criteria list. DNS scopes for the DNS server or the zone will be listed, to create a new DNS
scope, refer to Add server scope and Add zone scope, respectively.
Target scope:
The DNS scope used to answer the query.
Note: The DNS server will always have default scope, the name of the default scope is ‘.’, DNS
zones also have a default scope with the same name as the zone. In some cases the empty string can
be used to referred to the default scope.
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Weight:
Is an integer value used for load balancing.
Note: DNS policies can be used to for DNS based load balancing. For zones this can be achieved
by adding the DNS records that you want to load balance (typically A/AAAA records) to different
DNS scopes and then creating a Query Processing policy that will match the incoming queries and
has ‘Allowed’ as the action, then add the DNS scopes as the target scopes for the DNS policy.
The queries will be answered from the the target scopes in a round-robin fashion based on the weight.
If the target scopes are ‘example.com’ with weight 4 and ‘offload’ with weight ‘2’, then the first 4
queries that match this policy will be answered from the ‘example.com’ scope and the next 2 from
the ‘offload’ scope. Similar load balancing can also be achieved with other types of DNS policies.

Adding DNS policy criteria

Each DNS policy has a list of criteria that with the policy condition define how the DNS policy is matched. Depending
on the policy type different criteria are allowed.
The DNS policy criteria and their descriptions are:
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Type
Client Subnet
Transport Protocol
Network Protocol
Server interface
Domain Name
Query Type
Time of Day

Dsecription
A list of subnet names as they are defined on the server. See Define client subnets for details.
A list of transport protocols used by the incoming query. The possible transport protocols
are UDP and TCP.
A list of network protocol used by the query. The possible network protocols are IPv4 and
IPv6.
A list of the IP address that the DNS server is listening on.
A list of domain names with strict wildcards allowed. For example ‘*.example.com’
A list of DNS record types. For example A, NS, SRV, CNAME
A list of time periods in a 24h format. For example 18:00-23:15. The time of day is rounded
to the next 15 minutes by MS-DNS. Maybe we should put this in a note and absolutely avoid
examples that will be rounded.

Operator:
Supported values are ‘is’ or ‘is not’, where is not negates ALL the values supplied in the ‘Values’ input box.
Values:
The list of values used to match the DNS policy criteria with each item in the list on a newline.
Note: Two criteria of the same type are allowed only if they have a different operator but you can work around this
limitation by using a list of values for each operator. If you want the criteria to match on two domain names you can
select the type as ‘Domain Name’, the operator ‘is’ and enter the two domain name on different lines in the ‘Values’
field.

Apply DNS Policy from
It is possible to copy DNS policies between DNS servers and DNS zones. One or more type of DNS policy list can be
copied at a time to one or more DNS server or DNS zone. DNS policies can not be copied if they refer to any Client
Subnet Lists, DNS scopes or server interfaces that do not exist the targets of the copy operation. The copy operation
results in the DNS policy lists for the chosen types of DNS policy to be overwritten with the copied DNS policy lists.
Note: DNS policies will be renamed if necessary when created or copied. You can avoid this by choosing unique
names.
1. Right click on a DNS Server or DNS zone.
2. Select Apply DNS Policy From. . . ` in the Edit DNS Policy submenu.
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3. Select the DNS policy type to copy.
4. Select the DNS server or DNS zone to copy DNS policies from

1.13 DHCP
1.13.1 DHCP servers
Overview
This section shows you how to perform specific actions in Micetro associated with maintaining your DHCP servers,
such as adding and deleting servers and setting DHCP server options. In order to use the DHCP functionality of Micetro
you need to have a valid DHCP license key.
Note: The functions for this menu option are listed alphabetically after the New DHCP Server section.
This page describes the process for adding new DHCP servers, and generic DHCP management information. For
detailed information about the different DHCP platforms, refer to:
• Microsoft DHCP
• ISC Kea DHCP
• ISC DHCP
• Cisco DHCP
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New DHCP Server
Note: When adding a DHCP server, the system automatically changes existing IP Address ranges to scopes if it finds
IP Address ranges that contain the same start and end address as a scope on the DHCP server being added.
You must be logged in as a user with privileges to administer DHCP in order to add a DHCP server.
Note: For information on adding a DHCP server on a Men&Mice Appliance, refer to Appliance management.
1. Navigate to Admin → Server Management and select Add DHCP server. The Add DHCP Server dialog box is
shown.

Server Name
Type either the (fully qualified) DNS name or the IP Address of the DHCP server.
Server address (optional)
If desired, type the IPv4 or IPv6 address for the server. This is not required, but doing so allows the Management
Console to connect to the server by IP Address instead of by name.
Server Type
Click the drop-down list, and select the desired server type.
Microsoft
connects to a Microsoft DHCP server. If you want to gather the lease history from the DHCP
server, you must install a DHCP Server Controller on the server. See Microsoft DHCP.
ISC

connects to an ISC DHCP server. See ISC DHCP.

Cisco
connects to a Cisco Router that is running DHCP server software. For more information, see
Cisco DHCP.
Kea

connect to a ISC Kea DHCP server. See ISC Kea DHCP.

Manage DHCPv6 service (Microsoft only)
When using DHCPv6 in your Microsoft DHCP environment you may toggle this on to allow management of
DHCPv6 from Micetro
Agent-free (Microsoft and ISC Kea only)
When using the agent-free connection method for Windows DHCP, it is not possible to gather the lease history
from the DHCP server. For further information regarding this connection method, refer to Server Access on
Remote Computers and Microsoft DHCP.
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Proxy
If you are adding a Cisco DHCP or agent-free Microsoft or Kea server, you can specify the location of the DHCP
Server Controller by entering the (fully qualified) DNS name or IP Address of the machine running the DHCP
Server Controller. This option allows the system to connect to DHCP servers in different forests where a crossforest trust does not exist. It also allows a non-Windows version of Men&Mice Central to manage Microsoft
DHCP servers.
2. Click Confirm. Once connected, the name of the newly added server displays in the grid of the Server Management context.
Note: To add a DHCP server in the Management Console, see console-new-dhcp-server.

Server Access on Remote Computers
To manage DHCP servers you must have the DHCP Server Controller installed.
• For the ISC DHCP server, a DHCP Server Controller must be installed on each DHCP server you want to manage.
• For Microsoft DHCP servers, install the DHCP Server Controller on a Windows machine that is a member of
the same domain or workgroup as the DHCP servers. You may install multiple copies of the DHCP Server
Controller, for example if you want to manage Microsoft DHCP Servers that reside in different forests. A single
DHCP Server Controller for Microsoft DHCP Servers can manage multiple DHCP servers. The DHCP Server
Controller must adhere to whatever restrictions and security standards are set forth in Microsoft Windows. See
Server Access on Remote Computers (Microsoft DHCP).
• For Kea DHCP servers, only one DHCP Server Controller needs to be installed, either on the same machine as
the Kea service or on a machine that can access the Kea Control Agent on the network.
Server Access on Remote Computers (Microsoft DHCP)
To configure the DHCP Server Controller to access DHCP servers on remote computers, do the following:
1. Before you can administer DHCP servers, verify that the DHCP Controller is running as a Windows User and
has the necessary privileges.
2. To enable DHCP Management in Micetro, start the Windows Services program and open the properties dialog
box for Men&Mice DHCP Server Controller.
3. Click the Log On tab. The Local System account radio button is most likely selected.
4. Click the This account radio button and enter the name and password of a Windows User that is a member of
either the Administrators role or the DHCP Administrators role.
5. Close the dialog box and restart the Men&Mice DHCP Server Controller service.
Warning: Lease history gathering is not possible if you are managing MS DHCP servers on remote computers
using the DHCP Server Controller. To gather lease history for a MS DHCP server, you must install the DHCP
Server Controller on the server and use the Microsoft with Agent Installed connection method when connecting to
the server.
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Edit DHCP Server Name
This feature allows you to change the name or IP Address used to connect to a DHCP server. This is useful if you need
to refer to the server by another name or if you are connecting to the server by an IP Address and the IP Address has
changed. You can also use this feature to change the connection method for MS DHCP servers.
To access this feature, do the following:
1. Locate the DHCP server.
2. From the ellipsis menu select Edit DHCP server or use Actions → Edit DHCP server. The Edit DHCP server
dialog box displays.
3. Change the Server name, Server address (optional), and Server Type. If applicable, you can edit the Proxy
server’s information.
4. Click Confirm.
Note: To edit a DHCP server’s name in the Management Console, see console-edit-dhcp-server.

Toggle DHCPv6 Management on or off
Note: There is only one DHCP service on a Microsoft DHCP server. DHCPv4 and DHCPv6 are not decoupled in
Microsoft as they are in Micetro. Any action performed on either DHCPv6 or DHCPv4 that requires a restart of the
service will result in a restart of the single DHCP service on the Microsoft server.
1. Go to Admin and click on Server Management
2. Expand DHCP Servers and select Microsoft DHCP
3. Select one or multiple servers, hover over the selection to click on the ellipsis (or meatball) menu and click on
Edit DHCP Server
4. Check :guilabel:`Manage DHCPv6 service to enable DHCPv6 management on the server(s) you’ve selected
5. Press Confirm
Inherited Access (Management Console)
You can manage access to scopes just as you can for other object types in Micetro, but there is one important distinction:
you can set Inherited Access for scopes. When you open the Access dialog box for a scope, the dialog box has an extra
section for inherited access.
Checking the Inherit Access checkbox will have the selected scope inherit all access bits from its parent range. This
means that whenever the access privileges for the parent range are changed, they will be applied to the scope as well.
Clicking the Apply access inheritance in child ranges button will enable access inheritance for all descendants of the
scope. This means that whenever the access privileges in the scope are changed, the changes will be applied of all
descendants of the scope.
Regarding other access settings, refer to Access control.
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Remove
Note: For information on removing a DHCP server on a Men&Mice Appliance, refer to Appliance management.
To remove a DHCP server, do the following:
1. In Admin → Server Management locate the DHCP server.
2. From the ellipsis menu select Remove DHCP server.
4. In the confirmation dialog box, click Yes.
Note: To remove a DHCP server in the Management Console, see console-delete-dhcp-server.

Options
The ISC DHCP, Kea DHCP, Cisco, and MS DHCP servers offer different types of options.

Fig. 4: DHCP server options depend on the server type and previously configured options.
You can set options for multiple servers by selecting all of the servers for which you want to set options.
Note: When setting options for multiple servers all of the servers must be of the same type.
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1. In Admin → Server management select the applicable DHCP server(s) and use Actions → Edit DHCP options.
(Or Edit DHCP options from the ellipsis menu.) The DHCP Server Options window displays.
2. Click the drop-down list to select which options you want to add. Upon selection, the setting is added to the
dialog box for editing.
6. When all selections/entries are made, click Save to save your changes.
Note: To manage DHCP server option in the Management Console, see console-dhcp-options.

Properties (Management Console)
1. From the Object list, expand the DHCP Servers list.
2. Right-click on the server for which you want to manage properties and, from the shortcut menu, select Properties.
The Properties dialog box for the selected server displays. Refer to the applicable section based upon the server
type: console-ms-dhcp-properties, console-isc-dhcp-properties, console-kea-dhcp-poperties or console-ciscodhcp-properties.
Advanced ISC Kea Server Properties
DHCP Administrators can access the ISC Kea DHCP server configuration files directly to edit properties that are not
available in the user interface.
To access the advanced options, do the following:
1. Log in to Micetro as the DHCP administrator.
2. Select a Kea DHCP server, select Edit configuration from the ellipsis menu or use Actions → Edit configuration.
3. When the Edit configuration box displays, you can edit the configuration file for the server.

5. Click Save. The contents of the files are verified for correctness. If an error is found during verification, an error
message displays and the changes are not saved.
Note: To edit advanced DHCP configuration in the Management Console, see console-dhcp-advanced-options.
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Reload Scope List (Management Console)
Reloads the list of scopes to view additions and/or deletions made by another user.

Microsoft DHCP
Defining Options on MS DHCP Servers
1. In Admin → Server Management select the applicable DHCP Server and select Edit DHCP options from the
ellipsis menu or use Actions → Edit DHCP options. The Edit DHCP options box displays. The dialog box
shows all options defined on the DHCP server.
2. Use the drop-down menu to select the option you want to define.

3. To add an option, select the option from the list. The option filed is added to the dialog box.
4. To delete an option, hover over its field and click the trash button next to it.
5. Click Save to save the updated options.
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MS DHCP options (DNS tab)
Enable DNS dynamic updates according to the settings below.
Specifies whether the DHCP server sends DNS dynamic record updates to the DNS server. Updates are sent to
DNS servers configured in TCP/IP client properties for any active network connections at the DHCP server.
Dynamically update DNS A and PTR records.
Specifies that the DHCP server update forward and reverse lookups are based on the type of request made
by the client during the lease process.
Always dynamically update DNS A and PTR records.
Specifies that the DHCP server update forward and reverse DNS lookups when a client acquires a lease,
regardless of the type of request used to acquire it.
Discard A and PTR records when lease is deleted.
Specifies whether the DHCP server discards forward DNS lookups for clients when a lease expires.
Dynamically update DNS A and PTR records for DHCP clients.
Specifies whether the DHCP server sends dynamic updates to the DNS server for DHCP clients that do not
support performing these updates. If selected, clients running earlier versions of Windows are updated by the
DHCP server for both their host (A) and pointer (PTR) resource records.
Disable dynamic updates for DNS PTR records
Turns off dynamic updates for PTR records.
Reconcile Scopes
See console-dhcp-windows-reconcile.
ISC Kea DHCP

Danger: Starting with Micetro 10.0, older versions of the Kea DHCP server are no longer supported. See systemrequirements for a list of supported versions. You need to remove your existing (older) Kea DHCP servers from the
system, and update them to a supported version of Kea before updating to Micetro 10.0 from an older version of
the Men&Mice Suite. Not doing so could result in lost access to and data from the older Kea servers in Micetro.
Kea Control Agent
The Kea Control Agent is a daemon that exposes a RESTful control interface for managing Kea servers. The Control
Agent daemon can receive control commands over HTTP and either forward these commands to the respective Kea
servers or handle them commands on its own.
Note: The default port for the Kea Control Agent is 8000.
Because of the Kea Control Agent, Kea DHCP servers can be added to Micetro without a DHCP Server Controller
running on every machine that runs Kea. A single DHCP Server Controller, installed on a machine that can access the
instances that run Kea services, is sufficient and will communicate with all Kea servers on Micetro’s behalf.
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Adding Kea to Micetro
Because Micetro uses the Kea API to communicate with the DHCP server(s), it requires (in addition to the DHCP
Server Controller) the Kea hook library libdhcp_lease_cmds.so.
Note: On certain distributions (like RHEL) check that the kea-hooks package is also installed.

Configuring the Kea hook library
After installing the Kea hook library, open kea-dhcp4.conf and locate the hooks-libraries array. Add the hook
to libdhcp_lease_cmds.so:
"hooks-libraries":[
{
"library" : "/lib64/kea/hooks/libdhcp_lease_cmds.so",
"parameters" : {}
}
]
The location of the library depends on your distribution, use whereis libdhcp_lease_cmds.so to find it.
After adding the library, restart Kea and the Kea Control Agent.
Kea high availability
Kea DHCP servers need to be configured for high availability before the primary server is added to Micetro. If the
high availability is set up properly, once added to the system Micetro will recognize the failover nodes and the method
(load balancing, hot standby, etc.) and configure the server objects accordingly.
For more information, see Kea DHCP High Availability.
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Split scopes in load balancing mode
When creating scopes on Kea servers configured in load balancing mode for high availability, Micetro will split the
available pool evenly between primary and secondary servers.
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Kea DHCP Server Properties

Default/Maximum/Minimum Valid Lifetime
Specifies the time after which a lease will expire if not renewed.
Renew Timer
Specifies the time when a client will begin a renewal procedure.
Rebind Timer
Specifies the time when a client will begin a rebind procedure.
Match Client ID
Specifies if the server should ignore the client identifier during lease lookups and allocations for a particular
subnet.
Echo Client ID
Specifies if the server should send back client-id options when responding to clients.
Decline Probation Period
Specifies a probation time that will be set on addresses that are in use by some unknown entity.
Next Server
Specifies the server address to use when clients want to obtain configuration from a TFTP server.
Control Socket
Name
The path to the UNIX socket. Cannot be empty.
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Server tag
The name used for this server in a High Availability setup.
Handling external changes with Kea

Warning: You should always edit the Kea DHCP server’s configuration file through Micetro to ensure that the
synchronization between Micetro and the Kea DHCP server is instant and all changes will immediately updated in
the database and reflected in the user interface.

Note: All changes made to the configuration file through Micetro will automatically and instantly be propagated to
the secondary/backup servers in a Kea DHCP High Availability setup.
Micetro uses the in-memory configuration of the Kea server. If external changes must be made to a Kea DHCP server’s
configuration file, the changes to the configuration file aren’t processed by the server until forced to parse the file to its
in-memory structure, so Micetro can be made aware of these changes.
To make the Kea DHCP server process changes to its configuration file a call has to be made to either the Kea Control
Agent or the socket that Kea uses.
An example of the call to the control-agent:
curl -X POST -H "Content-Type: application/json" -d '{ "command": "config-reload",
˓→"service": [ "dhcp4" ] }' localhost:8000
If successful, the result looks like this:
[ { "result": 0, "text": "Configuration successful." } ]
After the changes to the configuration file have been accepted and parsed into the Kea DHCP servers memory structure,
users can display them in Micetro through the Edit Configuration action for the server.
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Resolving conflicts
Micetro synchronizes all data between the Kea DHCP servers and its database regularly.
Setting the
DHCPSyncInterval variable in Central’s preferences.cfg overwrites the default value of 15 minutes.
Note: The values set for DHCPSyncInterval are in seconds.
Synchronization occurs based on the configuration to update the database and the user interface, but to prevent overwriting external changes before synchronization is complete, Micetro will check for conflicts with the Kea server’s
in-memory configuration before writing the changes to the server.
For example, if a scope with subnet 1.3.3.0/29 is manually added to the Kea DHCP servers configuration file, and
config-reload is successfully called, the Kea server will have parsed the change and added the scope to its inmemory data structure. Synchronization with Micetro may not have been executed yet, and the externally added scope
is not yet visible in the user interface. However, if another user would try to add the same or otherwise conflicting scope
through Micetro, they will receive a message stating “A scope with address “1.3.3.0” already exists on the server” as
the configuration file is validated against the Kea DHCP servers in-memory config before each change is applied.
External changes and Kea high availability
See Making external changes to Kea servers in high availability.
Kea DHCP High Availability

Warning: Synchronized clocks are essential for the high availability setup to operate reliably. If a clock skew is
not corrected and exceeds 60 seconds, the high availability service on each of the servers is terminated.

Important: Kea DHCP servers need to be configured for high availability before the primary server is added to
Micetro. Micetro will recognize the high availability relationship and configure accordingly.

High Availability hooks library
Previously only available to paid subscribers, the HA hooks library is now part of the open-source Kea. The library
needs to be loaded before the Kea DHCP servers can be managed in High Availability mode.
Tip: For RedHat-like systems (such as RHEL, CentOS, SUSE, Fedora, etc.), the hook library is usually located at
/usr/lib/x86_64-linux-gnu/kea/hooks/libdhcp_ha.so. For Debian-based systems (such as Ubuntu, Linux
Mint, Raspbian, etc.), the hook library is usually located at /usr/lib64/kea/hooks/libdhcp_ha.so.
Two modes of failover operation are supported:
Load-balancing
One of the servers must be designated as primary and another as secondary. During normal operation they’re
identical. When the two servers are started at (nearly) the same time, and synchronize their lease databases, the
primary server will always synchronize its database first. The secondary will wait for the primary to complete
before it starts its own synchronization.
250

Chapter 1. Table of Contents

Micetro by Menamp;Mice Documentation, Release 10.2

Hot standby
In this configuration, one of the servers is designated as primary and another as secondary. During normal
operation only the primary server will respond to DHCP requests, and the secondary (or standby) receives lease
updates from the primary over the control channel. When the secondary server considers the primary to be
offline, it will start responding to DHCP queries.
Ports and networking
Micetro can only support a Kea High availability setup if it can communicate with each Kea DHCP server through the
correct ports. (This is also necessary for cross-communication between the Kea DHCP servers themselves through the
Kea Control Agent.)
The Kea Control Agent uses port 8000 by default, but that value can be manually defined in its configuration file.
(Usually located at /etc/kea/kea-ctrl-agent.conf.) This port needs to be open and accessible on every server
that hosts a Kea DHCP service and a Kea Control Agent.
Configuring the High Availability setup
Kea DHCP servers in a High Availability environment must be already synced and configured to communicate with
each other before adding them to Micetro. After setting up the HA environment, the configuration file is parsed and
all HA relationships are detected when the primary server is added to Micetro. As a result, these relationships are
successfully imported to Micetro, and replication between servers begins.
Note: If the Configuration Backend section is set and configured, Micetro will assume that the config is shared between
all members and will not replicate the changes between servers.
An example of a hook-libraries section of the configuration where Micetro will successfully detect the setup and
act accordingly:
"hooks-libraries": [{
"library": "/usr/lib/kea/hooks/libdhcp_ha.so",
"parameters": {
"high-availability": [{
"this-server-name": "server1",
"mode": "load-balancing",
"heartbeat-delay": 1000,
"max-response-delay": 10000,
"max-ack-delay": 5000,
"max-unacked-clients": 0,
"peers": [{
"name": "server1",
"url": "http://192.168.56.33:8000/",
"role": "primary",
"auto-failover": true
}, {
"name": "server2",
"url": "http://192.168.56.66:8000/",
"role": "secondary",
"auto-failover": true
}, {
"name": "server3",
(continues on next page)
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(continued from previous page)

"url": "http://192.168.56.99:8000/",
"role": "backup",
"auto-failover": false
}]
}]
}
this-server-name (Server Tag)
This field must reflect the Kea DHCP server where the configuration file resides.
Note: It is only possible to add a primary Kea DHCP server in a preconfigured HA relationship. When the
server is added to Micetro, this-server-name must match the peer with "role": "primary" in the highavailability section.
This setting is also available via Server Properties in Micetro under the name Server tag. See kea-dhcpproperties.
max-response-delay
This value should be greater than the heartbeat-delay, and is usually greater than the duration of multiple
heartbeat-delay values.
When the server detects that communication is interrupted, it may transition to the partner-down state (when
max-unacked-clients is 0) or trigger the failure-detection procedure using the values of the two parameters below. Setting max-unacked-clients to 0 ensures that the Kea servers are vigilant and correctly and immediately
change states if the connection between them is lost. To allow some leniency, change the max-unacked-clients
value to a positive number, for example 5.
The default value of max-response-delay is 60000 ms.
Warning: If max-response-delay is not configured correctly, the servers will not be able to consistently
and efficiently detect downtime between each other, and Micetro won’t be able to ensure the correct replication
and operations of the servers.

Tweaking the DHCP Server Controller
The preferences.cfg file for the DHCP Server Controller can be used to tweak the Kea high availability setup.
keaReplicateConfig
If this value is set to 0, Micetro will not replicate between Kea DHCP servers in a high availability setup. The
default value is 1. Example: <keaReplicateConfig value=”0”/>
keaControlAgentHost
Determines which host to use when connecting to a control agent. The default value is 127.0.0.1 if the Kea
Control Agent is running on the same machine, or the IP address of the server added to Micetro.
keaControlAgentPort
Determines which port to use when connecting to the Kea Control Agent. The default value is 8000.
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Adding a high availability-enabled Kea DHPC server to Micetro
If the Kea high availability environment is set up correctly, system administrators can add the primary Kea DHCP
server just like any other DHCP server.
Important: If the DHCP Server Controller is running on a machine other than the primary Kea DHCP server, a proxy
must be defined in the Add DHCP server dialog in Micetro. In the dialog, enter the IP address or FQDN of the of the
machine running the DHCP Server Controller.

Fallback behavior and indicators
After the primary Kea server has been added to Micetro, it will acts as the primary mode of communication between
Micetro and the high availability cluster. All changes will be written to this primary server and replication will be
handled with regards to it. The single-source-of-truth for the configuration will be the in-memory config on the primary
Kea DHCP server.
When both the primary Kea server and all its secondary/backup partners in the high availability environment are running

and accessible, Micetro will report the Kea DHCP server as OK.

Primary server offline
If the primary server is offline (or unavailable for any reason, such as reporting itself in a disabled state, or becomes
unreachable from Micetro) the secondary/standby server will take its place in Micetro. The user interface will report
the Kea DHCP service Impaired. During this time, the single-source-of-truth will be the in-memory config on the
secondary/standby server, and will remain this way until connection to the primary server is re-established.

Secondary/standby/backup server offline
If any of the secondary/standby/backup servers are offline, replication to all other servers will still take place but Micetro
will report the Kea DHCP service Impaired. When the affected secondary/standby/backup reports itself as active again,
it will be automatically synchronized with the single-source-of-truth configuration. (The in-memory config of the
primary Kea server.)
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Both primary and secondary/standby server offline
If both primary and secondary/standby servers go offline, Micetro will report the Kea DHCP service Service down. All
further operations will result in an error reporting this downtime. All replication is stopped until either the primary or
the secondary/standby servers report themselves as active. The first one to become active will be the single-source-oftruth, but the primary will always overwrite any secondary/backup when it becomes active.

DHCP Server Controller offline
In the unlikely event that the DHCP Server Controller is offline, all Kea high availability information will be momentary
lost. As soon as the Server Controller comes back online, Central will attempt to reconnect to the preconfigured primary
Kea DHCP server. After reconnecting to the primary Kea server, the configuration will be parsed again, the high
availability setup detected, and replication between servers begins again.
Note: If the DHCP Server Controller goes down while using the secondary/backup Kea server (because the primary
was down) the system will not be able to reconnect successfully. Because only the primary Kea server can be added
to Micetro, a system administrator must reestablish the primary Kea server to a working state before the system will be
able to reconnect.

Note: If the DHCP Server Controller goes offline and is brought back up again while the primary Kea server is down,
it will not be able to reconnect until the primary Kea server becomes active again.

Making external changes to Kea servers in high availability

Note: All changes made to the configuration file through Micetro will automatically and instantly be propagated to the
secondary/backup servers in a Kea DHCP High Availability setup. Therefore it is highly recommended to always edit
the Kea DHCP server’s configuration file through Micetro to ensure the immediate synchronization between Micetro
and the Kea DHCP server.
Primary server
As with the stand-alone server, Micetro synchronizes any external changes on the primary Kea server on a defined
schedule. (See Handling external changes with Kea.) Propagation of the changes to the secondary/backup servers
only happens automatically after the servers go out of an active state and then become active again. To manually
propagate the changes, the user has to make a change (any change) to the configuration through a feature in
Micetro. This will trigger a synchronization.
Secondary server(s)
The same rules apply regarding the changes to the configuration and the config-reload command. However,
Micetro will overwrite any external changes with the current in-memory configuration of the primary Kea DHCP
server in the high availability setup.
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ISC DHCP

Note: To manage ISC DHCP servers in the Management console, see console-dhcp-isc.

Defining Options on ISC DHCP Servers
1. In Admin → Server Management select the applicable DHCP Server and select Edit DHCP options from the
ellpisis menu or use Actions → Edit DHCP options. The Edit DHCP Options box displays. The dialog box
shows all custom options defined on the DHCP server. The available ISC DHCP options can be selected from
the dropdown menu.
2. To add an option, select it from the option list. The option field is added to the dialog.
3. To delete an option, hover over its field and click the trash button next to it.
4. Click Save to save the changed option definitions.
ISC Server Properties
Authoritative
Specifies whether the server is authoritative to determine if a DHCP request from a client is valid
DDNS Domain Name
Specifies the DNS domain name to use to store the A record for a DHCP client.
DDNS Reverse Domain Name
Specifies the DNS reverse domain name to use to store the PTR record for a DHCP client.
DDNS Update Style
Specifies how the DHCP server does DNS updates. The available styles are:
None
Dynamic DNS updates are not performed
Ad-hoc
Warning: This update scheme is deprecated
Interim
This is the recommended scheme for dynamic DNS updates
DDNS Updates
Specifies whether to perform DNS updates. This setting has no effect unless DNS updates are enabled globally
with the DDNS Update Style setting.
DDNS TTL
Specifies (in seconds) the TTL value to use when performing a DNS update.
Default Lease Time
Specifies (in seconds) the default lease time to use for DHCP leases.
Log Facility
Specifies which syslog facility to use when logging DHCP server messages. All possible facilities are listed;
however, not all of these facilities are available on all system.
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Max/Min Lease Time
Specifies (in seconds) the maximum/minimum lease time to use for DHCP leases.
Get Lease Hostnames
Specifies whether the DHCP server should perform a reverse DNS lookup for each address assigned to a client
and send the result to the client in the hostname option.
One Lease per Client
Specifies whether the DHCP server should free any existing leases held by a client when the client requests a
new lease.
Ping Check
Specifies whether the DHCP server should send an ICMP echo message to probe an IP Address before offering
it to a DHCP client.
Ping Timeout
Specifies for how many seconds the DHCP server should wait for an ICMP echo response when Ping Check is
active.
Filename
Specifies the name of the initial boot file to be used by a client.
Server Name
Specifies the name of the server from which the client should load its boot file.
Next Server
Specifies the host address of the server from which the initial boot file (that is specified by Filename) is to be
loaded.
Restart
See console-dhcp-isc-restart.
Cisco DHCP

Note: For managing Cisco DHCP servers in the Management Console, see console-dhcp-cisco.

Adding a Cisco DHCP server
When adding a Cisco DHCP server, the following dialog box displays:
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Type the User name and Password that should be used to access the server. This is the user name and password that
is used when normally accessing the Cisco device from the command line prompt. If the server requires a separate
password to enter privilege level 15, enter the required password in the Enable Password field.

1.13.2 DHCP scopes
Note: To manage DHCP scopes in the Management console, see console-dhcp-scopes.

Overview
This section shows you how to perform specific actions in Micetro associated with maintaining your DHCP scopes,
such as creating and modifying reservations, setting scope options and working with split scopes.
Viewing Scopes
All DHCP Scopes on All Servers
You can use the Web Application to view all of the existing DHCP scopes at once, regardless of the server to which
they belong. In Networks select DHCP scopes from the filtering sidebar on the left.
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The Utilization column in the scope list displays the utilization of available addresses within the address pool(s) of each
scope.
Disabled scopes are shown as gray. The number of unassigned addresses is always shown as zero for disabled scopes.
Scopes on a Specific DHCP Server
It is easy to view the DHCP scopes that reside on individual DHCP Servers that are being managed by Micetro. In the
Networks context click the relevant DHCP server in the filtering sidebar’s DHCP servers section.
Selected Scope Menus
When working with scopes, selecting one or more scopes enables an ellipsis menu and relevant actions from the Actions
shortcut button. The available actions change based upon the type of the DHCP server the scope is hosted on.
DHCP scope actions
Open network
Opens the selected scope.
Edit network properties
Enable/disable scope
If you are no longer using a particular scope, but do not want to delete it completely because you may need it in
the future, you can disable the scope instead. A scope that is disabled will be ignored by the DHCP server until
it is re-enabled.
Convert to network
Converts the DHCP scope to a network.
Set folder
Adds the scope to a folder for easier access. See Object folders.
Set discovery schedule
Sets discovery schedule for the scope.
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Set subnet monitoring
Configures subnet monitoring for the scope.
Manage DHCP pools
View and manage DHCP pools.
Add Pool
Creates an address pool for the selected scope. Complete the From and To fields in the dialog box, typing
the range of addresses to be included in the pool. Both of these fields default to the first available address in
the range. If this is a split scope (a scope that exists on more than one server) and the address pool overlaps
a warning message displays.
Edit Address Pool
To edit an existing pool, select it and from the ellipsis menu select Edit.
Delete Address Pool(s)
To delete an existing pool, select it and from the ellipsis menu select Delete.
Create Exclusion
MS DHCP only. Allows you to exclude a single IP Address or an entire range of addresses from being used.
You can only exclude addresses that are already part of an address pool. To create an exclusion, specify the
From and To IP Addresses. All the addresses between and including the ones entered will be excluded.
Edit Exclusion
MS DHCP only. To edit an exclusion, select it and from the ellipsis menu select Edit.
Delete Excluded Range(s)
MS DHCP only. To delete an exclusion, select it and from the ellipsis menu select Delete.
DHCP actions for IP addresses
Open a DHCP scope (by double clicking it in the grid, selecting Open network from the ellipsis menu, or using Actions
→ Open network) to view the IP addresses it contains.
Create DNS record
Creates an A record from the selected IP address. See Creating a new DNS record.
Edit IP address properties
Define values for any custom properties configured in the system.
Claim/release IP address
Claims and releases the IP address(es).
Ping IP address
Performs a ping on the selected IP address(es).
Create DHCP reservation
Reservations can be created in unassigned address space, address pools, and excluded addresses. It is possible
to set options for reserved IP Addresses. To create a reservation, do the following:
Name
Assign a name to identify the reserved address.
Description
(Optional) User defined description.
Reservation method
Hardware address or Client identifier
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Hardware address
Enter the MAC Address (i.e., Media Access Control Address) of the network node for which this
address is being reserved.
Client identifier
Use the Ascii and Hex switch on the right to change input type.
Reservation type
Select whether this reservation should support DHCP, BOOTP (i.e., Bootstrap Protocol), or both (default).
Edit DHCP reservation
Edit an existing reservation.
Edit reservation options
Edit options for a reservation. Refer to dhcp-options for details on this dialog box.
Delete DHCP reservation
To delete an existing reservation, right-click on the reservation you want to remove and select Delete Reservation(s).
View history
Displays the object history for the selected IP address.
Viewing DHCPv6 Scopes
Unlike DHCPv4 scopes which display all the addresses within a scope, a DHCPv6 scope will only display addresses in
use or which have been recently used. At the bottom of the web UI, a message will show how many active IP addresses
are being shown. If there is an IP address with the status of free that IP address has recently been used, which can be
seen by clicking on View History for that address.

New DHCP scope
Note: Creating a scope on a Kea server configured for load balancing high availability, Micetro will automatically
split the scope evenly between primary and secondary servers. See Kea DHCP High Availability.
This section describes how to create and edit DHCP scopes with the new DHCP Scope Creation Wizard.
Whenever you create a new scope, Micetro automatically checks whether the new scope conflicts with an existing scope
or an IPAM range.
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The Wizard has additional steps, or skips over some steps, depending on the type of DHCP server the scope is being
created on, and whether the AD Sites and Subnets integration has been enabled.
To create a new scope on the MS DHCP server, do the following:
1. In Networks use the Create action and select DHCP scope from the dropdown.

2. Click Next.
3. Edit the options for the DHCP scope.
DHCP server
The DHCP server for the scope.
Enabled
If checked, the DHCP scope will start allocating IP addresses immediately. Uncheck it if you want to configure
the scope further.
Start/end of address pool
Adjust the first and last IP address in the pool.
3. Active Directory Site selection. If you have enabled AD Sites and Subnets, the Wizard will ask you which AD
site the new DHCP Scope should be associated to.
Note: Leave it empty for no AD site.
4. Scope properties.
5. Summary. The changes the Wizard will perform are summarized here and applied once the user clicks “Finish”.
6. Save comment.
New DHCPv6 Scope
1. Under IPAM click on Create and select DHCP Scope
2. Enter the network information and click Next
3. Enter the DHCP Server name and the preference, and put a check next to Enabled if you’d like to enable this
scope on this server. Click Next
Note: The preference value is a new parameter required by Microsoft for DHCPv6 scopes. If the scope is assigned to
multiple servers, the lowest preference assignment will be selected by the DHCP client
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4. Enter the title as an identifier for this scope as well as the description and click Next
5. Verify the information is correct and click Finish
Manage DHCPv6 Exclusions
When managing exclusions within a DHCPv6 pool it is possible to specify a percentage of a DHCPv6 scope rather
than specifying a From address and To address
1. Select a DHCP scope while under IPAM >> DHCP scopes
2. Click Action and select Manage DHCP Exclusions
3. Click the Add Exclusion
4. A new pop up will appear. Choose to either create the exclusion range by Manual Entry or Percentage
5a. If you choose manual entry, input the From address and To address for the range you’d like to exclude from the
DHCP scope
5b. If you choose percentage, drag the percentage bar to the correct percentage of addresses you’d like to exclude and
enter a From address only

Note: If the exclusion range doesn’t have the space to accomodate the percentage of IP addresses specified, it will not
allow you to add this exclusion range until you pick an appropriate From address or lower the percentage.
6. Click on Add
Red bar
The exclusion range
Blue bar
Address Pool of dynamic allocation addresses
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7. Click Save
Access
For complete details on this function, refer to Access control.
Scope Migration Wizard (Management Console)
The Scope Migration Wizard allows users to migrate one or more scopes from one server to another, including all data
in the scope.
To migrate a scope, do the following:
1. In the Manager window, select one or more scopes.
2. Right-click and, from the shortcut menu, select Migrate Scope. The Migrate Scope(s) Wizard dialog box displays.
Server
Click the drop-down list and select onto which you want to migrate this scope(s).
4. Click Next. The Migration Options dialog box displays.
5. For each of the resulting screens, make a selection/entry and move through the wizard.
Duplication Wizard (Management Console)
To duplicate a DHCP scope you should use the Duplicate Scope wizard. The duplicate will initially have the exact
same properties as the original, but you will have the option to assign the duplicate to a different DHCP server and
modify the duplicated values.
Within this wizard, you can do the following:
• Create a new scope
• Create a split scope interface
To launch the wizard, do the following:
1. In the Object Section, click on DHCP Scopes.
2. In the Object List, right-click on the DHCP Scope you want to duplicate and, from the shortcut menu, select
Duplicate. The Duplicate scope wizard launches.
3. For each of the resulting screens, make a selection/entry and move through the wizard.
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Folders
Refer to Object folders for details on this function.
Reconcile Scopes
Note: Applies to MS DHCP Servers only.
Use this function to fix inconsistencies between information in the registry and the DHCP database.
1. Go to IPAM in the web UI
2. Select DHCP Scopes
3. Select one or multiple DHCP Scopes from Microsoft Servers
4. Click on the ellipsis (or meatball) menu on the scope(s)
5. Click on Reconcile DHCP Scopes
6. If there are inconsistencies, a list will be presented. Click Fix to fix the inconsistincies.

For more information see the Microsoft documentation.
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Scope Policies (Windows Server 2012 or newer) (Management Console)
If you are managing DHCP servers on Windows Server 2012 or newer, you can use Micetro to set scope policies for
individual scopes.
Activate/Deactivate a Scope Policy
1. In the Scope List, right-click a scope that is stored on a Windows 2012 DHCP server.
2. From the shortcut menu, select Manage Policies. The DHCP Scope Policy Management dialog box displays.
3. The dialog box shows the current status of DHCP scope policies for the selected scope.
4. To activate DHCP scope polices, click the Activate button. If DHCP scope polices are active, the button text
shows Deactivate. To deactivate the DHCP scope policies, click the Deactivate button.
5. Click Close.
Add a New Scope Policy
1. In the Scope List, right-click a scope that is stored on a Windows 2012 DHCP server and, from the shortcut menu,
select Manage Policies. The DHCP Scope Policy Management dialog box displays.
2. Click the Add button. The DHCP Policy dialog box displays.
3. Enter a name and description for the DHCP policy in the corresponding fields.
4. Click the Add button in the Conditions section to add a new condition for the DHCP policy. The DHCP Policy
Condition dialog box displays.
5. Specify the condition you want to use and click OK to save the condition and close the dialog box. Note that you
can enter multiple conditions for a DHCP policy by clicking the Add button in the DHCP Policy dialog box.
6. To edit or delete an existing DHCP Policy condition, select the condition from the list of DHCP Policy conditions,
and click the corresponding button.
7. If there is more than one condition, you need to specify whether to use the OR or AND operator when evaluating
the conditions. Select the corresponding radio button in the DHCP Policy dialog box.
Ranges
1. Click the Add button in the ranges section to specify an IP Address range that should be affected by the policy.
The Range specification dialog box displays.
2. Enter the range using the from and to addresses separated by a hyphen (for example, 192.168.1.10-192.168.1.20).
3. Click the Add button to add the range and close the dialog box. NOTE: You can enter multiple ranges by using
the Add Range dialog box for each range you want to add.
4. To edit or delete an existing range, select the range from the list of ranges, and click the corresponding button.
5. When you have added all conditions and ranges, click the OK button to save the DHCP policy.
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DNS Dynamic Updates
Options specific to dynamic updates are in the field named DNS Dynamic Updates. It can be configured accordingly
for the policy.
Lease duration
The lease duration can be specified per policy in those fields.
DHCP Options
To specify DHCP options for this policy, click the Options button. That will open a dialog which will allow the user to
specify the options.
Note: If this is unconfigured, the options will be inherited from the scope or server.

Change an Existing Scope Policy
You can edit, delete or disable existing DHCP Scope Policies. You can also change the order of DHCP scope policies.
1. In the Scope List, right-click a scope that is stored on a Windows 2012 DHCP server and, from the shortcut menu,
select Manage Policies. The DHCP Scope Policy Management dialog box displays.
2. Select the DHCP Policy you want to work with by clicking it in the list of DHCP Policies.
• To edit the policy, click the Edit button.
• To delete the policy, click the Delete button.
• To disable the policy, click the Disable button. If the policy is already disabled, the button text shows Enable.
To enable the policy, click the button.
• To move the policy up or down in the list of DHCP Policies, click the Move Up or Move Down button.
3. When you have completed your changes, click the Close button.
Other Functions
At any time, you can modify the properties for a scope. Simply locate the item, and from the ellipsis menu select Edit
network properties. For split scopes, the scope contents can be examined individually on each server.
Deleting a Lease
To delete a lease in a DHCP scope, do the following:
1. Open the scope containing the lease you want to delete.
2. Select the lease and from the ellpisis menu select Release DHCP lease or use Actions → Release DHCP lease.
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IP Address Details
The IP Address details window contains all information pertaining to an IP Address in Micetro, including DNS records,
DHCP reservations, and custom properties. To access the IP address details select an IP address in the DHCP scope
dialog, and all information is displayed in the Inspector, including information on any DNS and DHCP data associated
with the IP address. A reservation can be created by clicking the + button in the Related DHCP data section of the
Inspector.
Subranges of Scopes (Management Console)
It is possible to choose whether the contents of ranges that are created under scopes are displayed in a range view or a
scope view. Use the Show DHCP data in subranges of scopes checkbox in the System Settings dialog box to choose the
preferred display mode.
If the scope view is selected, a window similar to the scope window displays when you open a subrange of a scope.
However, the only scope related action available in this window is reservation management. The access dialog box for
these subranges will contain an additional access bit, Edit reservations.
If the range view is selected, the subranges are opened in the range view and no scope related actions are available.
Renaming a Scope
It is very simple to change the name and/or description of a scope in Micetro.
1. Locate and select the DHCP Scope you want to rename.
2. From the ellipsis menu, select Edit network properties.
3. Enter the Title, and any other value you wish to change.
4. Click Save.
Superscopes (Management Console)

Note: Superscopes are only supported on MS DHCP servers on Windows server.
All MS Superscopes are listed in the object section under the heading Superscopes.
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When you click on the Superscope, all scopes within that superscope display. In addition, a new column, Superscope,
is shown in the scope list. It is possible to filter by this column.
To assign an existing scope to a superscope, do the following:
1. In the Object list, select a DHCP Scope for which you want to set a Superscope.
2. Right-click and, from the shortcut menu, select Properties. The scope dialog box displays.
3. Enter the name of the superscope in the Superscope field.
4. Click OK. The scope is placed in the superscope. If the superscope did not exist, the new superscope is created
and now displays as a new item in the object list.
Moving IP Address Information (Management Console)
IP Address information can be moved to a new IP Address. When the IP Address information is moved, all information
about the IP Address is retained, and the associated DNS records are updated. If a reservation is associated with the IP
Address, the reservation information is moved with the IP Address if the destination address is in a DHCP scope that
is hosted on a DHCP server of the same type. If the destination address is in a scope hosted on a different type of a
DHCP server or the destination is in an IP Address range, the reservation information is discarded.
To move IP Address information, do the following:
1. Locate the IP scope containing the IP Address.
2. Double-click on it to display the scope contents.
3. Find the applicable IP Address.
4. Right-click and, from the shortcut menu, select Move.
5. In the Move IP Address Information dialog box, type the new IP Address.
6. Click OK. The IP Address information is moved to the new IP Address.
Host Discovery
With this feature, you can see when hosts were last seen on your network. There are two methods you can use for host
discovery – using ping or querying routers for host information.
When host discovery is enabled, two columns are added to the range or scope view.
Last Seen
This column identifies when a host was last seen on the network and which method was used to discover the host.
Last Known MAC Address
This column shows the MAC address used by the host the last time it was seen on the network. This column is
only populated if the host was seen using a router query.
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Configuring Host Discovery Using Ping
1. Select one or more scopes.
2. From the ellipsis menu select Set Set discovery Schedule.
3. Check the Enable option.
Frequency
Click the drop-down list and select the frequency (e.g., 1, 2, etc.).
Every
Enter the frequency unit for discovery (e.g. days, weeks, etc.).
Next run
Select the start date and time.
4. Click Save.
Once the schedule options have been set and saved, two columns - Last Seen and Last Known MAC Address - are
added to the range or scope grid. The Last Seen column identifies when a host was last seen on the network.
Green
Host responded to the last PING request. The date and time are shown.
Orange
Host has responded in the past, but did not respond to the last PING request. The date and time of last response
is shown.
Red

Host has never responded to a PING request. The text Never is shown.

At any time if you wish to disable host discovery, do the following:
1. Select the object(s) for which you want to disable discovery.
2. From the ellipsis menu, select Set discovery schedule.
3. Uncheck the Enable option.
4. Click Save.
Configuring Host Discovery by Querying Routers (Management Console)
To collect information about hosts by querying routers, you must first enable collection of IP information from routers.
To configure host discovery:
1. Select an IP Address Range.
2. Right-click and, from the shortcut menu, select Configure IP Address Collection. The IP Address Collection
dialog box displays
3. Enter the IP Address of the router(s) that you want to use to collect information about hosts in the range.
4. Click OK.
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Failover Configurations and Split Scopes (Management Console)
Managing Failover Configurations (ISC DHCP)
This function allows you to manage DHCP failover peers on ISC DHCP servers.
Note: When adding a server’s first failover peer, all other address pools on the server will be updated to refer to this
failover peer.
1. On the object menu, select the DHCP Server that contains the scope for which you want to setup failover configuration.
2. From the list of scopes, double-click on the applicable one.
3. From the list of IP Addresses, right-click on the applicable one, and select Create Address Pool from the shortcut
menu. The DHCP Address Pool dialog box displays.
4. Move to the Failover Peer field, and click the drop-down list arrow.
5. Select Add new failover peer.
6. Click OK. The New Failover Peer dialog box displays.
Name
Specifies the name of the failover peer.
Role

Specifies the role of the failover peer. The available roles are Primary and Secondary.

Address
Specifies the IP Address or DNS name on which the server should listen for connections from its
failover peer.
Port

Specifies the port number on which the server should listen for connections from its failover peer.

Peer Address
Specifies the IP Address or DNS name to which the server should connect to reach its failover peer
for failover messages.
Peer Port
Specifies the port number to which the server should connect to reach its failover peer for failover
messages.
Max Response Delay
Specifies the number of seconds that may pass without the server receiving a message from its failover
peer before it assumes that the connection has failed.
Max Unacked Updates
Specifies the number of messages the server can send before receiving an acknowledgement from its
failover peer. According to ISC documentation, 10 seems to be a good value.
Max Client Lead Time
Specifies the number of seconds for which a lease can be renewed by either server without contacting
the other. Only specified on the primary failover peer.
Split Index
Specifies the split between the primary and secondary failover peer for the purposes of load balancing.
According to ISC documentation, 128 is really the only meaningful value. Only specified on the
primary failover peer.

270

Chapter 1. Table of Contents

Micetro by Menamp;Mice Documentation, Release 10.2

Load Balance Max Seconds
Specifies the cutoff in seconds after which load balancing is disabled. According to ISC documentation, a value of 3 or 5 is recommended.
7. Click OK. The DHCP Address Pool dialog box displays and shows the updated information.
8. Click OK.
If you need to EDIT or DELETE an existing failover peer, do the following:
1. Locate the relevant ISC DHCP server.
2. Right-click and, from the shortcut menu, select Manage Failover Peers. The Failover Peers for . . . dialog box
displays. All failover peers are shown.
3. To EDIT a failover peer, select it and click the Edit button. Then modify the Failover Peers . . . properties dialog
box, as needed.
4. To DELETE a failover peer, select it and click the Delete button.
Note: In order to finalize the setup of the failover relationship, the scope needs to be migrated to the failover peer.

Note: When deleting a failover peer through this dialog, if it is the last failover peer defined on the server, any references
to it will be removed from existing address pools on the server. If there is one other failover peer left on the server,
references to the failover peer being deleted will be changed to refer to the remaining failover peer. If, however, there
are two or more other failover peers left on the server, the user will be prompted with a list of the remaining failover
peers where he will have to choose which failover peer should be referenced by address pools currently referring to the
failover peer being deleted.

Note: When changing from one failover peer to another for some specific address pool, if the address pool is the last
one referring to the (old) failover peer, the user will be warned that performing the action will result in the deletion of
the failover peer.

Managing Failover Configurations (Windows Server 2012)
DHCP failover on Windows Server 2012 enables high availability of DHCP services by synchronizing IP Address lease
information between two DHCP servers. It is also possible to use DHCP failover to provide load balancing of DHCP
requests.
You can configure failover for a single scope or for multiple scopes on the same server.
Note: To manage failover between two Windows 2012 Servers, the DHCP Server Controller must be running as a
service account with enough privileges to manage the DHCP service. For more information, refer to the Men&Mice
DHCP Server Controller section in the Installation Guide.
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Setting up a Scope Failover
To setup failover for a scope, do the following:
1. On the object menu, select the DHCP Server that contains the scope(s) for which you want to setup failover
configuration.
2. You have two ways to choose the scopes you want to configure.
• From the list of scopes, select one or more scopes, right-click and select Configure Failover.
• Right-click the DHCP server and select Configure Failover. A dialog box listing all configurable
scopes displays. Select the scopes you want to configure and click Next. The failover configuration
dialog box displays.
Relationship Name
Select the relationship you want to use for the failover configuration or enter a name if you want to
create a new relationship. If you choose an existing relationship, you will not be able to change any
of the relationship properties and you can simply click OK to complete the failover configuration for
the scope.
Partner Server
Enter the name or IP Address of the partner DHCP server with which failover should be configured.
You can select from the list of Windows Server 2012 machines or you can type the host name or IP
Address of the partner server.
Mode
Select the failover mode you want to use. You can choose between Hot standby and Load balance.
Role of Partner Server
If you chose the Hot standby mode, you must choose the role of the partner server. You can choose
between Standby and Active. If you choose Standby the current server will be Active and vice versa.
Maximum Client Lead Time
If you don’t want to use the default values, enter the new values in the hours and minutes edit fields.
Addresses reserved for standby server
If you chose the Hot standby mode, you must enter the percentage of addresses that should be reserved
to the standby server.
Local server load balance percentage
If you chose the Load balance mode, you need to specify the load balance percentage to use on the
local server. The remaining percentage will be used on the partner server.
State Switchover Interval
Select this checkbox if you want to use Automatic State Switchover and specify the interval to use.
Enable Message Authentication
Select this checkbox if you want to use message authentication between the DHCP servers. If the
message authentication is enabled, you must provide a shared secret for the message authentication.
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Removing a Failover Configuration
1. On the object menu, select the DHCP Server that contains the scope(s) for which you want to remove the failover
configuration.
2. Select one or more scopes, right-click the selection and select Deconfigure Failover. A confirmation dialog box
displays.
3. Click Yes to confirm the action. The failover configuration for the selected scope(s) is removed.
Replicating Failover Scopes
When using a failover configuration, it is possible to replicate scope information between servers. This is possible for
individual scopes, all scopes that share a failover relationship or all scopes on a particular DHCP server. When a scope
replication takes place, the scopes on the selected DHCP are considered the source scopes and the entire scope contents
are replaced on the destination server.
To replicate individual scopes:
1. On the object menu, select the DHCP Server that contains the scope(s) you want to replicate.
2. Select one or more scopes, right-click the selection and select Replicate Scope. A confirmation dialog box
displays.
3. Click OK to confirm the action. The selected scope is replicated.
To replicate all scopes that share a failover relationship:
1. On the object menu, select the DHCP Server that contains the scopes you want to replicate.
2. Right-click a scope using the desired relationship, and select Replicate Relationship. A confirmation dialog box
displays.
3. Click OK to confirm the action. The scopes that use the same relationship as the selected scope are replicated.
Note that this action may take some time if multiple scopes use the relationship.
To replicate all failover scopes on a DHCP server:
1. On the object menu, right-click the DHCP Server that contains the scopes you want to replicate and select Replicate Failover Scopes from the menu. A confirmation dialog box displays.
2. Click OK to confirm the action. All failover scopes on the selected server are replicated. Note that this action
may take some time if the server contains multiple failover scopes.
Managing Failover Relationships

Note: In the Web Application, the failover mode, as well as the failover partners, is displayed in the Inspector’s High
availability section when a server or scope is selected that is configured for high availability.
You can view, create, edit and delete existing failover relationships.
Adding a Failover Relationship
1. On the object menu, right-click the DHCP Server and select Manage Failover Relationships from the menu. A
dialog box listing the current failover relationships displays.
2. Click the Add button. A dialog box displays, listing all scopes that are available to be configured for high availability.
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3. Select the scope(s) you want to configure. To select all scopes, click the Select all checkbox. Click Next. The
failover configuration dialog box displays.
4. Setup the failover configuration for the selected scopes.
Editing an Existing Failover Relationship
1. On the object menu, right-click the DHCP Server and select Manage Failover Relationships from the menu. A
dialog box listing the current failover relationships displays.
2. Click the Edit button. The failover configuration dialog box displays. Note that some properties are disabled and
cannot be changed.
3. Edit the failover configuration and click OK to save the settings.
You can delete existing failover relationships. When a failover relationship is deleted, the scopes are not removed from
the DHCP server, but they are no longer in a failover configuration. After removing the failover relationship Micetro
will handle the affected scopes as split scopes.
Deleting a Failover Relationship
1. On the object menu, right-click on the DHCP Server, and select Manage Failover Relationships from the menu.
A dialog box listing the current failover relationships displays.
2. Click the Delete button and click Yes in the confirmation dialog box.
Split Scopes
When a scope is hosted on multiple servers, the scope view lists all the servers that contain a copy of the scope. For
scopes on MS servers, the line says ‘Split Scope’ and then lists the servers. For the ISC DHCP server, the line says
‘Multiple Instances’ and then lists the servers:

Micetro detects when a split scope configuration is in place. Split scopes are handled as follows:
• In the scope list, split scopes are shown with a different icon and in the server column, the text “split scope”
displays
• When performing various actions on scopes (for example enable/disable, scope option changes, scope deletion),
a dialog box displays where the user is asked to specify to which instances of the split scope the action should
be applied.
• The DHCP scope window will show every instance of the split scope in a separate tab, making it possible to
work with all instances of the split scope in a single window.
• The Overview and Statistics tab in the DHCP scope window will show a graphical overview for all of the split
scope instances.
• Reservations are managed automatically. All changes to reservations (creation, modification, and deletion) are
applied to all instances of the split scope.
The servers listed in this dialog box all contain the scope to which the user was applying the change. By pressing the
Enable button, all instances of the scope would be enabled.
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Note: Split scopes are only supported on MS DHCP and ISC Kea servers.

Managing Split Scopes for DHCPv6
1. Select a DHCPv6 scope under IPAM >> DHCP Scopes
2. Click on Action and Manage Scope Instances
3. From the drop-down menu select a second server to manage the DHCP scope and click Add and enable the
servers on which the split-scope should reside
Note: You can change the preference of the servers by clicking and dragging on the hamburger icon (three lines to
the left of the server) to change the order of the servers. The second server will always have a preference of the First
Server Preference + 1 and each additional server will increment by 1.
4. Click Save

5. On the same scope, click the Action menu and then select Manage DHCP Exclusions
6. Click on Add Exclusion for the first server and select the percentage for which you’d like to exclude from the first
server and click Add
7. Click on Add Exclusion for the second server and select the percentage for which you’d like to exclude from the
second server and click Add

1.13. DHCP

275

Micetro by Menamp;Mice Documentation, Release 10.2

8. Click Save
Note: DHCPv4 and DHCPv6 scopes inherit DHCP and DDNS Options from the parent DHCP server. DHCPv4 and
DHCPv6 reservation inherit DHCP and DDNS options from the DHCP scope. However these options may be changed
by editing the options for the specific scope or reservation.

1.13.3 Edit DHCP Options
View the configured DHCP options for a DHCP scope
1. Select the DHCP scope in the network list
2. Click on the Edit DHCP options task.
3. A dialog is displayed. Note that in order to see the options that have inherited values, the Show inherited options
checkbox needs to be checked.
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Add a new DHCP option
1. Start typing into the Add an option field. Either type in the name of the option or the option number.
2. A list of available options will be displayed as you type.
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3. Select the option you want to add.
4. The option is now shown in the list and you can add values to the option.
Configuring DHCPv6 and DDNS Options (Microsoft Only)
1. Go to :guilable:`Admin` in the web UI and click on :gulabel:`Server Management`
2. Expand DHCP Servers and select Microsoft DHCP
3. Select one or multiple servers, hover over the selected server(s) and click on the ellipsis (or meatball) menu
4. Click on the Edit DHCPv6 Options task
5. Under the Options tab, select the appropriate options
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6. Click on the DNS tab and select whether you’d like to Enable DNS dynamic updates according to the settings
below
i. Always dynamically update DNS records
ii. Discard AAAA and PTR records when lease is deleted

7. Click Save to save your settings
Removing a DHCP option
Hovering over an option will display a trashcan icon to the right of the option.
Clicking on the trashcan will remove the option.
HEX and ASCII representation
Some DHCP options, such as DHCP option 43 (Vendor specific info) require the value to be in HEX format. In this
case the UI offers the value to be viewed both as HEX and ASCII by selecting each option in tabs above the field, as
seen in the figure below.
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1.14 IP address management
Note: To manage IP addresses in the Management Console, see console-ipam.

1.14.1 Overview
Managing IP Addresses entails being able to create assignable ranges within the available address space and determining
which users and groups have usage rights to that space. The IP ranges can be created with specific properties that also
determine the properties of the IP Addresses contained within them.
Note: In order to use the IP Address Management features in Micetro, you must have entered the license key for the
IPAM module.

1.14.2 Multiple Address Spaces
Note: For managing address spaces through the Management Console, see console-address-spaces.
Micetro supports multiple address spaces.
Each address space instance contains its own set of DNS servers, DNS zones, DHCP servers, DHCP scopes, IP Address
ranges (including the IPv4 and IPv6 root ranges), IP address entries, and folders.
Note: Changes to data in one address space do not affect data in any other address space.
Items shared between address spaces are:
• users, groups, and roles
• custom property definitions (see Custom Properties)
Address Space Management
Users with sufficient permissions are allowed to create, modify or delete address spaces as well as set access privileges
for existing address spaces.
Navigate to Admin → Configuration → Address Spaces
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To create a new address space, click the Add button in the top bar and enter the name and description for the address
space.
Note: The first address space is always named <default>. It is not possible to rename or delete the <default> address
space.
The <default> address space is the only address space that shows AD sites if AD Site and Subnet integration is enabled.
To edit the name or description for an address space, select the address space and click the Action –> Edit address
space button in the top bar or ellipsis menu.
To delete an address space, select the address space and click the Action –> Remove address space button in the top
bar or ellipsis menu.
Danger: When you delete an address space, all objects contained within the address space are removed (DNS
servers, DHCP servers, IP address ranges, IP address entries, and folders). This action cannot be undone.

Note: You cannot delete the <default> address space or the address space you are currently working in.
To see and edit the access controls for an address space, select the address space and click the Action –> Access button
in the top bar or ellipsis menu.
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Switching to a Different Address Space
You can only work in one address space at a time. You can see the current address space in the Manager window, above
the object list.
To switch to a different address space:
1. Click the User icon in the top right corner of the Web Application.
2. Select Address Space and select the address space you want to use.

Moving Objects to a Different Address Space (Management Console)
See console-address-spaces.

1.14.3 Address (A) Records in DNS Zone Windows
When the IP Address management component is enabled, you may notice some differences when working with Address
(A) records in DNS zone windows, such as:
Restriction on allowed IP Addresses
When IPAM is enabled, the system administrator may restrict which IP Addresses you are allowed to use. The
system administrator can determine an IP Address range that you are allowed to work with. In addition, he/she
can choose whether you can use an IP Address that has already been assigned in DNS.
Automatic assignment of IP Addresses
The system administrator can configure Micetro so that you can create address (A) records without entering IP
Addresses. When the zone is saved, the IP Addresses are automatically assigned using free IP Addresses in your
IP Address range. If you want to enter an IP Address manually, you can type it in the IP Address field, but if you
leave the field unchanged, the IP Address will be automatically assigned when you save the zone. If you have
access to more than one IP Address range, a dialog box will be displayed at save time where you can choose the
IP Address range for your new address records.
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Range Access (Management Console)
You can manage access to scopes just as you can for other object types in Micetro, but there is one important distinction:
you can set Inherited Access for scopes. When you open the Access dialog box for a scope, the dialog box has an extra
section for inherited access.
Checking the Inherit Access checkbox will have the selected scope inherit all access bits from its parent range. This
means that whenever the access privileges for the parent range are changed, they will be applied to the scope as well.
Clicking the Apply access inheritance in child ranges button will enable access inheritance for all descendants of the
scope. This means that whenever the access privileges in the scope are changed, the changes will be applied of all
descendants of the scope.
Regarding other access settings, refer to Access control.

1.14.4 Containers
A Container is a section of the address space that has been reserved but not yet allocated. Containers can contain
address ranges and scopes and you can set address privileges for containers that can be applied to the enclosed ranges
and scopes through access inheritance. You cannot allocate IP addresses from within a container unless you have
enabled that functionality in System Settings.
New container
A range that exists on network boundaries (a subnet) can be converted to a Container. Likewise, a Container can be
converted to a range.
1. In the Networks context select the range(s).
2. From the ellipsis menu select Convert to container or use Actions → Convert to container.
3. Confirm that you want to convert the selected range(s) and add a save comment.
Note: In the Management Console, you can set Inherited Access for Containers.
When you open the Access dialog box for a Container, the dialog box has an extra section for inherited access.
• Checking the Inherit Access checkbox will have the selected Container inherit all access bits from its parent.
This means that whenever the access privileges for the parent are changed, they will be applied to the Container
as well.
• Clicking the Apply access inheritance in child ranges button will enable access inheritance for all descendants
of the Container. This means that whenever the access privileges in the Container are changed, the changes will
be applied of all descendants of the Container.
Regarding other access settings, refer to Access control.
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1.14.5 Viewing IP Address Ranges
The Networks context shows the section of the IP address space that is accessible to the current user of the system.
Micetro allows administrators to manage the IP Address space by dividing it into any number of named sub ranges that
can be assigned to specific groups for use by its members.

In the filtering sidebar, click on IP Ranges.
You can choose between a flat and a hierarchical view for the Address Ranges scopes by selecting an appropriate button
on the top right of the grid.
If an Address range has no subranges, the utilization for the range is shown in the range list.
While viewing the IP ranges, the webapp-quickfilter is available. When using the tree view while a filter is active, any
parent ranges that don’t fulfill the search criteria are faded out and the matches highlighted. For example, in the image
below, we searched for the string 1.4.
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1.14.6 New Networks
To create a new network, do the following:
1. Open the Networks context.
2. Click the Create button.
3. Select what type of network (new network, New DHCP scope, New container) you’d like to create.
4. Enter the appropriate values, grouped on pages depending on the type.
Note: The Create dialog is different depending on the type selected through the dropdown:
• For a network, you can reserve network and broadcast address, and lock the range if needed. You can also assign
it to an AD site. (See AD Sites and Subnets)
• A DHCP scope can be created with the network and broadcast address automatically configured. See New DHCP
scope.
• A container has no network or broadcast address. See Containers.
5. Click Finish.
Once a non-reserved IP Address range has been created, it is considered to be managed. A managed IP Address range
is being managed by the Networks component of Micetro. When the range is managed, Micetro will allow users with
appropriate privileges to work with IP Addresses from the range.
It is possible to create subranges of existing ranges and DHCP scopes.
Note: When you create a new IP Address range, Micetro checks to see if the new range can be logically grouped with
other address ranges, and adds the new range in the appropriate address range group.
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Network Configuration
When creating a new network, DHCP scope, or container, you must complete the Properties dialog box in the final
step.
These properties are defined in Custom Properties.
Network Modifications
Once you have created a network, it is easy to make changes.
1. Select the range in the grid.
2. From the ellipsis menu select Edit network properties or use Actions → Edit network properties.
3. Make the desired changes.
4. Click Save.
Network Deletions
You can always delete a network definition. If you delete a network, the IP addresses that belonged to it will get
the attributes of the parent network. If the network you are deleting has subranges, they will become children of the
unassigned networks’ parent.
Use the following procedure to delete a network definition:
1. Select network(s) you want to remove.
2. From the ellipsis menu select Delete network or use Actions → Delete network. A dialog prompts you to confirm
your decision to delete the(se) network(s).
3. Click Yes to delete the range, or No to leave it.

1.14.7 IP Address List
To view a list of host entries in a particular network, double-click on the network. This opens the grid where you can
view and edit the properties of individual IP address entries.
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The filtering sidebar’s State section can be used to show only Free, Assigned, Claimed.
The PTR Status column shows the status of the Address (A) record and Pointer (PTR) record mappings. This column
can have three values:
Empty
The status is empty if there are no DNS records for the host. It is also empty if a PTR record exists
where the domain in the data section of the PTR record is not managed by the system.
OK

If there is a match between the A and the corresponding PTR record(s) the status is listed as OK.

Verify
If there is not a match between the A and the PTR records for the host, the status is listed as Verify.
The most common reasons are:
• There is an A record but the PTR record is missing.
• There is a PTR record but the A record is missing.
• The data section in the PTR record does not correspond to the name of the A record.
When the PTR Status for a host entry shows Verify, you can open the IP Address dialog box for the host to see more
detailed information on which DNS host entry is generating this status message.
Note: When working with large IP Address ranges (ranges that contain more than 4096 IP Addresses) the Show unassigned addresses will no longer be available and the IP Address List window will only display assigned IP Addresses.

1.14.8 IP Address Inspector
When you add or modify an existing IP address entry, the IP Address dialog box displays. The entries in Inspector can
vary, depending on the custom properties defined in Micetro (e.g., “Owner” is a custom property in the example shown
below), if DNS or DHCP related data exists, etc.
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Adding a DNS Host
While viewing the IP Address Inspector, click the + button in the Related DNS data.

The Address field is automatically filled with the selected IP address. Fill in the other information and click Create
now or Add to request. (See Workflow Management.)
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Editing a DNS Host
1. In the Inspector, in the ellipsis menu in the Related DNS data section click Edit.
2. Make the desired changes and click Save. The dialog box closes and the details are updated.
Removing a DNS Host
1. In the Inspector, in the ellipsis menu in the Related DNS data section click Delete. The host details are deleted
and removed from the Inspector.

1.14.9 Moving IP Address Information (Management Console)
IP Address information can be moved to a new IP Address. When the IP Address information is moved, all information
about the IP Address is retained and the associated DNS records are updated.
To move a IP Address information, do the following:
1. Locate the IP Address Range containing the IP Address.
2. Double-click on it to display the list window.
3. Find the applicable IP Address.
4. Right-click and, from the shortcut menu, select Move.

5. In the Move IP Address Information dialog box, type the new IP Address.
6. Click OK. The IP Address information is moved to the new IP Address.

1.14.10 Split/Allocate Range Wizard
This wizard allows you to create multiple subranges from an existing range. The wizard can only be used on ranges
that exist on subnet boundaries and have no subranges already in place.
1. Open the IPAM context and select the range you’d like to split.
2. Use the Action –> Allocate Subranges action from the top bar or the ellipsis menu.
3. Configure the new subranges. If you choose fewer subnets that fit in the parent, you can also set the offset from
where you want to start allocating. Click Next when finished configuring.
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4. Define the title and custom properties for the new subranges. Click Next when done.
5. On the summary page verify the new subranges and click Finish.
Note: In the web application, the Split Range and Allocate Range wizards are merged together. For information on
these wizards in the Management Console, see console-split-range and console-allocate-ranges.

1.14.11 Update Reverse Records Wizard (Management Console)
This wizard allows you to create reverse DNS zones for selected ranges.
Note: The wizard can only be used on ranges that exist on subnet boundaries and contain 254 or more IP Addresses
(/24 or larger)
1. From the object list, click on IP Address Ranges.
2. From the list of ranges displayed, select the ranges, right-click and, from the shortcut menu, select Update Reverse
Records. The Reverse zone generation wizard displays.
3. For each of the resulting screens, make a selection/entry and move through the wizard.
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1.14.12 Join Ranges
1. In the IPAM context, select the ranges that you want to join.
2. Use the Action –> Join Ranges action from the top bar or ellipsis menu.

3. Set the properties for the joined range:
Use Access from
Click the drop-down list and specify from which range you will gain access.
Use Properties from
Click the drop-down list and specify from which range you will use the properties.
Title

Enter a title for the new range.

Description
Type a description.
4. Click Join.
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1.14.13 Select Parent (Management Console)

This function allows you to view the hierarchy for subnets when filtering is active.
1. Locate the subrange for which you want to view the hierarchy.
2. Right-click on the subrange and, from the shortcut menu, selects Parent. All available parent(s) are shown.
3. Click on the parent and the system automatically moves you to that parent range.

1.14.14 Host Discovery
With this feature, you can see when hosts were last seen on your network. There are two methods you can use for host
discovery – using ping or querying routers for host information.
Configuring Host Discovery Using Ping
1. Select one or more IP ranges.
2. From the ellipsis menu select Set discovery schedule or use Actions → Set discovery schedule.
3. Check the Enable option.
Frequency
Click the drop-down list and select the frequency (e.g., 1, 2, etc.).
Every
Enter the frequency unit for discovery (e.g. days, weeks, etc.).
Next run
Select the start date and time.
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4. Click Save.
Once the schedule options have been set and saved, two columns - Last Seen and Last Known MAC Address - are
added to the range grid. The Last Seen column identifies when a host was last seen on the network.
Green
Host responded to the last PING request. The date and time are shown.
Orange
Host has responded in the past, but did not respond to the last PING request. The date and time of last response
is shown.
Red

Host has never responded to a PING request. The text Never is shown.

At any time if you wish to disable host discovery, do the following:
1. Select the object(s) for which you want to disable discovery.
2. From the ellipsis menu, select Set discovery schedule.
3. Uncheck the Enable option.
4. Click Save.
Configuring Host Discovery by Querying Routers
See SNMP profiles.

1.14.15 Subnet Discovery
The subnet discovery features enables Micetro to obtain information about the subnets on the network through SNMP
on the routers. The process is the same as in configuring host discovery, but to enable this feature, make sure the
Synchronize subnets . . . is checked in the SNMP profile. See SNMP profiles.

1.14.16 Add to/remove from Folder
Adds or removes the currently selected IP Address Range from folders.
Danger: Once you remove a range from a folder, there is no “undo” option available.
1. Highlight the range you want to remove.
2. From the ellipsis menu, select Set folder and add or remove the range from folders.

1.14.17 Subnet Monitoring and Utilization History (Management Console)
The Subnet Monitoring is used to monitor the free addresses in subnets and DHCP address pools and perform an
action if the number of free addresses goes below a user-definable threshold. In addition, the utilization history for the
monitored subnets and scopes is collected and you can view and export the historical utilization data.
When Subnet Monitoring is enabled a global monitoring setting is applied to all subnets in the system. You can change
the subnet monitoring settings for individual subnets and scopes, for example if you want to disable monitoring for a
certain subnet or if you want to use a different threshold for the free addresses in a DHCP scope. NOTE: Only DHCP
scopes that are enabled are monitored. Disabled scopes are ignored.
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Note: The Subnet Monitoring needs to be enabled in the System Settings before continuing. See Monitoring.

Set Subnet Monitoring
To change the monitoring settings for a subnet:
1. Select the subnet(s) for which you want to change the monitoring setting.

2. Right-click and, from the shortcut menu, select Set Subnet Monitoring. The Subnet Monitoring dialog box displays.
Enabled
When checked, the subnet will be monitored.
Script to invoke
Enter the path of the script to run when the number of free addresses goes below the set threshold. Refer to
External Scripts , for information on the script interface and the format for calling the script.
E-mail addresses
Enter one or more e-mail addresses (separated by comma, e.g. email@example.com,email@example.net). An
e-mail will be sent to the specified addresses when the number of free addresses goes below the set threshold.
Dynamic Threshold
Enter the threshold for the free addresses in a DHCP scope address pool. NOTE: For split scopes and scopes in a
superscope (on MS DHCP servers) and address pools using the shared-network feature on ISC DHCP servers, the
total number of free addresses in all of the scope instances is used when calculating the number of free addresses.
Static Threshold
Enter the threshold for the free addresses in a subnet.
Only perform action once (until fixed)
When checked, the action is performed only once when the number of free addresses goes below the threshold.
Perform action when fixed
When checked, the action is performed when the number of free addresses is no longer below the threshold.
3. Click OK to confirm your settings.
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Removing Subnet Monitoring
You can clear the monitor setting for individual subnets if you want to use the global subnet monitoring setting. To
clear a monitoring setting for a subnet:
1. Select the subnet(s) for which you want to clear the monitoring setting.
2. Right-click and, from the shortcut menu, select Remove Subnet Monitoring. The custom subnet monitoring
setting is removed and the global monitoring setting is used instead.

1.14.18 View Utilization History (Management Console)
You can view the utilization history for a subnet or scope that is being monitored.
To view the utilization history:
1. Select the subnet for which you want to view the utilization history.
2. Right-click and, from the shortcut menu, select View Address Utilization. The Address Utilization window
displays.

• The left drop-down box allows you to choose the time period to view. You can choose between 30 days, 7 days
or 24 hours.
• Use the middle drop-down box to choose whether you want to view utilization by the actual address count or by
percentage.
• If you are viewing the utilization of a scope, a dropdown box is displayed where you can choose whether you
want to view the dynamic part of the scope (the address pool(s)) or the static part of the scope.
• The blue Addresses line shows the number of used addresses in the subnet.
• The red Threshold line shows the utilization threshold that is currently in effect for the subnet.
• If the 30 day or 24 hour view is active, a gray ‘envelope’ is shown around the Addresses line. This shows the
maximum and minimum utilization of addresses during the time period.
• Moving the mouse cursor over the graph shows the actual data points, and if the 30 day or 24 hour view is active,
the minimum, average and maximum values are shown for each data point.
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• You can view the address utilization for a superscope. When viewing the address utilization for a superscope,
the total number of addresses in all of the scopes in the superscope are used for the utilization calculation.
Export Utilization History
You can export the utilization history for one or more subnets to the Clipboard or into a CSV file.
• To export the utilization history for a single subnet from the Address Utilization Window, right-click the graph
and select the time period you want to export. The data is copied to the Clipboard.
• To export the utilization for multiple subnets, select the subnets, right-click and from the shortcut menu select
Export Address Utilization. The data is saved in a CSV file.

1.15 Devices
1.15.1 Overview
Using the Devices feature, you can create devices, assign interfaces to each device and attach IP addresses to the
interfaces.

1.15.2 What is a Device?
A Device is any item that can have an IP address linked to it. A device can, for example, be a computer, a router, a
firewall, a phone or a virtual machine. A device has one or more interfaces and each device can have any number of IP
addresses linked to it.
It is common to assign multiple properties to devices. As a default, a device in Micetro only has one property - the
device name. However, you can create any number of properties for the devices. To create a property for a device, use
the Define Custom Properties feature. For more information on this feature, refer to Custom Properties.

1.15.3 Adding a Device
When you add a Device, you start by entering the basic Device information and then you create the relevant interface(s)
and optionally link one or more IP Addresses to each interface.
To add a new device:
1. From the menu bar, select Device → New Device. A dialog box is displayed where you enter the name of the
device. The information you enter is based on the properties that have been defined for the device.
2. Enter the name and click Add to create the device.
3. Once the device has been created, the Device Properties tab displays. Use this tab to manage interfaces for the
device and link IP addresses to the device.
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To Add an interface click the Add button in the Interfaces section and enter the required information for the interface.
The Name field is mandatory.
The Hardware Address field contains the MAC address for the interface. This field is not required. However, if you
enter a Hardware Address it must be a valid MAC address and it must be unique – no other device can have an interface
with the same Hardware Address.
To add an IP Address to the device, you must first create an interface as the IP Address is attached to an interface on
the device. Once an interface has been created, click the Add button in the IP Address section and enter the required
information for the IP Address.

1.15.4 Deleting a Device
When you delete a Device, all information about the device is deleted, including the interfaces defined for the device,
and all IP addresses linked to the device are unlinked from the device.
To remove a Device:
1. Locate the device you want to remove and open the Device Properties window.
2. Click the Delete button in the Device Details section.
3. Click OK in the confirmation box that appears. The device and its associated data is removed.
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1.15.5 Linking/Unlinking IP Addresses
Linking an IP Address
You can link an IP Address to a device using two different methods.
Linking an IP Address using the Device Properties window:
1. Locate the device you want to link the address to and open the Device Properties window.
2. Click the Add button in the IP Address section. Note that before you can link and IP Address to a device, you
must first create an interface for the device.
3. Enter the required information and click OK.
Linking an IP address using the IP Address List window
1. Locate the IP Address Range containing the IP Address you want to link.
2. Double-click on it to display the list window.
3. Find the applicable IP Address.
4. Right-click and, from the shortcut menu, select Link to Device. The Device Linking Wizard displays.
5. For each of the resulting screens, make a selection/entry and move through the wizard.
Unlinking an IP Address
You can unlink an IP Address from a device using two different methods.
Unlinking an IP Address using the Device Properties window:
1. Locate the device you want to unlink the address from and open the Device Properties window.
2. Select the IP Address you want to unlink and click Delete in the IP Address section. The Unlink IP Address
confirmation dialog box displays.
3. Select whether you want to only unlink the IP Address or whether you want to delete all data associated with the
IP Address.
Unlinking an IP address using the IP Address List window
1. Locate the IP Address Range containing the IP Address you wan to unlink.
2. Double-click on it to display the list window.
3. Find the applicable IP Address.
4. Right-click and, from the shortcut menu, select Unlink from Device.
5. Click OK in the confirmation dialog box.
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1.15.6 Searching for Devices
You can quickly find the device you want to work with using the Find Device command.
To search for a device:
1. From the menu bar, select Device → Find Device. The Device Search dialog box displays.
2. Enter the search criteria for the device you want to find.
3. To add a new search criterion, click the button with the + sign next to the search entry field
4. To remove a search criterion, click the button with the - sign next to the criterion you want to remove
5. Click OK to start the search. If the search result only contains one device, the Device Properties window displays.
If multiple devices are found, the search result is displayed in the Device List window.

1.15.7 Device List tab
The Device List tab is displayed when you choose Device → Show All Devices from the menu bar. The tab is also used
to display search results when there is more than one device that matches the search criteria.
The Device List tab shows all relevant info for the Devices found.
The tab contains a Quick Filter entry field that allows you to refine the search results. As you type in the field, results
that are not applicable are removed. The Quick Filter searches within the entries that are displayed in the Device List
tab.
Clicking the button with the + sign in the top left of the tab will expand the search panel. Using the search panel,
you can search for devices based on multiple criteria. A search performed using the search panel will search the entire
device list.
• To add a new search criterion, click the button with the + sign next to the search entry field.
• To remove a search criterion, click the button with the - sign next to the criterion you want to remove.
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1.16 AD Sites and Subnets
1.16.1 Overview
Micetro allows administrators to integrate Active Directory (AD) sites into the IPAM context, view subnets within
these sites and add, remove, and move subnets between the sites.
Note: AD sites and subnets integration is only available when Men&Mice Central is running on a Windows server,
and it is enabled by default. See General.
AD sites are only assigned to and visible in the Default address space.
To add/remove a subnet to/from a site, the user must be assigned to a role with the Edit range properties permission
set and the role applied to the object. See Access control for more details.
AD sites and subnets are displayed in the IPAM context:
• subnets in the main IPAM → Networks grid, along with all other subnets in Micetro (if any). The AD Site column
displays the site the subnet belongs to.
• sites in a separate IPAM → AD sites grid, grouped by Forests. The Inspector box on the right displays the subnets
(if any) belonging to the selected AD site.

1.16.2 AD Forests
To manage sites and subnets, Micetro needs to be configured with AD Forest(s).
Note: You can manage sites and subnets from multiple forests.

Adding an AD Forest
1. In the web application, navigate to IPAM → AD sites.
2. Use the Add Forest action from the top bar. A dialog box displays.
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Use same Global Catalog as the Men&Mice Central server
If checked, Micetro will use the same Global Catalog server as the Men&Mice Central server is using. If you
unselect this checkbox, you must specify the Global Catalog server’s FQDN or IP address in the Global Catalog
Server field.
Global Catalog Server
If you want to specify a Global Catalog server, enter the server’s FQDN or IP address in this field. (To unlock
this field, the Use same Global Catalog as the MenMice Central server checkbox needs to be unchecked.)
Use the same credentials as the Men&Mice Central server
If checked, Micetro uses the same credentials as the Men&Mice Central server when accessing the site information.
User and Password
If you don’t want to use the default credentials for the machine running Men&Mice Central, enter the desired
user name and password in these fields. (To unlock these fields, the Use the same credentials as the MenMice
Central server checkbox needs to be unchecked.)
Set as read only
If checked, users will be able to display data from Active Directory, but unable to make any modifications.
3. Click OK to save the changes. The forest is added and the sites belonging to the forest are displayed.
Edit AD Forest
To edit an existing AD Forest (to, for example, change the read-only status):
1. In the web application, navigate to IPAM → AD sites.
2. Use the Edit AD Forest action from the top bar or the ellipsis menu.
3. Update the settings in the dialog box.
4. Click OK to save your changes.
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Removing an AD Forest
To remove an AD Forest from Micetro:
1. In the web application, navigate to IPAM → AD sites.
2. Select the AD Forest(s) you want to remove.
2. Use the Remove AD Forest action from the top bar or the ellipsis menu.
3. Click OK in the confirmation box to remove the Forest(s).
Reloading the Sites in an AD Forest
Data from AD Forests is synchronized by Men&Mice Central regularly. To manually synchronize forests and reload
the data for sites and subnets:
1. In the web application, navigate to IPAM → AD sites.
2. Select the AD Forest(s) you want to synchronize.
3. Use the Synchronize action from the top bar.
3. Click OK in the confirmation box to synchronize the Forests.

1.16.3 AD Subnets
View subnets in a site
To view subnets within a specific site:
1. In the web application, navigate to IPAM → AD sites.
2. Select the AD Forest the site is in, or use the Quickfilter to find it by name.
3. Use the View networks action with the site selected from the top bar or the ellipsis menu.
This will open the IPAM → Networks context with a filter applied to show all subnets that belong to the site.
Note: You can also use the -> View button in the Inspector of the selected AD site to open the subnet view.

Moving subnets between AD sites
To add subnet(s) to a site, or move between sites:
1. Select the subnet(s) in the IPAM → Networks grid.
2. Use the Set AD Site action from the top bar or the ellipsis menu.
3. Set the (new) AD Site in the dropdown and click Save.
Note:
Child subnets cannot be moved to a different site than the parent subnet unless the Enforce site
inheritance checkbox is unchecked in the System Settings dialog box.
Subnets whose AD site settings are inherited from a parent range will have a <AD Site Name> (inherited) notation
added.
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See General.

Remove subnet from AD site
1. Select the subnet(s) in the IPAM → Networks grid.
2. Use the Remove from AD Site action from the top bar or the ellipsis menu.
3. Click Yes to confirm the removal.
Subnets outside of sites
To view subnets that don’t belong to any AD site:
1. In the web application, navigate to IPAM → AD sites.
2. Click on the Flat view button (see Quickfilter) next to the Quick Filter to change the view.
3. Sort the IP address ranges by the AD Site column in ascending order:

1.17 Automation
1.17.1 REST API for Micetro
Introduction
The REST API allows administrators and software developers to create custom scripts and applications on top of
Micetro to manage DNS, DHCP and IP address infrastructures of all sizes. Most features available in Micetro are
available through the REST API.
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Installation
To use the REST API, you must install the Men&Mice Web Application and make sure you have the correct access
permission. See Web Application.
REST API documentation
The online REST API documentation can be viewed on api.menandmice.com.
Tip: Documentation for the REST API is bundled with the Web Application, and can be viewed on http(s)://
micetro.yourdomain.tld/mmws/api/doc where micetro.yourdomain.tld is the url for the Web Application.

Tip: You can import the swagger.js component into 3rd party applications (such as Postman) using the url
http(s)://micetro.yourdomain.tld/mmws/api/swagger.json.

1.17.2 SOAP API for Micetro
Introduction
The SOAP interface was introduced in Version 6.2 of the (then) Men&Mice Suite. The web service allows administrators and software developers to create custom scripts and applications on top of Micetro to manage DNS, DHCP and IP
address infrastructures of all sizes. Most features available in Micetro are available through the web service interface.
The web service can be used to perform tasks such as:
• Configure and work with Bind, Microsoft and Unbound DNS servers,
• work with DNS zones and records,
• configure ISC and Microsoft DHCP servers,
• work with DHCP scopes, pools and reservations,
• IP address management (IPAM),
• and much more.
SOAP API documentation
The SOAP command reference can be viewed online on api.menandmice.com.
Tip: Documentation for the SOAP API is bundled with the Web Application, and can be viewed on http(s)://
micetro.yourdomain.tld/mmws/wsdldoc where micetro.yourdomain.tld is the url for the Web Application.
If Men&Mice Central is running on a different server from the Web Application, the url to use is http(s)://micetro.
yourdomain.tld/mmws/wsdldoc?server=your.central.server.com.

304

Chapter 1. Table of Contents

Micetro by Menamp;Mice Documentation, Release 10.2

1.17.3 Ansible
With the Ansible setup for Micetro by Men&Mice you can manage a Micetro installation through Ansible. The Ansible
modules and plugins connect to the Micetro API and perform all needed actions.
See Ansible configuration example for an example configuration that you can use with the Ansible modules and plugins
for Micetro.
Installation
The modules and plugins need to be installed on the Ansible control node, often called the Ansible controller and
Ansible needs to be configured so that the modules and plugins can be found by Ansible.
Installing the Ansible modules and plugins is a straight forward process. Copy the Ansible modules and plugins to a
directory on the Ansible control node, let us assume /tmp/mandm. Later on these files are copied to the destination
directories on the control node.
Requirements
The Ansible integration modules and plugins do not need anything beyond a standard Ansible installation. The minimum Ansible version is 2.7 and up and the required Python version is 2.7+ or 3.5+.
Ansible modules
The Ansible modules can than be placed in a number of directories, depending on your installation and requirements.
/usr/share/ansible/
plugins/modules/
~/.ansible/plugins/
modules/
/etc/ansible/library/

System wide installation, modules available to all users
Modules available only to the current user, as the modules are installed in the
users home-directory
Local installation. As most Ansible installations use the /etc/ansible directory as the Ansible top-directory (as this is the default in an Ansible installation), this is probably the best installation option. When installing the modules
in this directory, the Ansible library path needs to be set in the /etc/ansible/
ansible.cfg file, pointing to the module directory.

library = /etc/ansible/library
After installing the Ansible modules a check can be made to determine if the modules are installed correctly. Run the
command:
ansible-doc -l | grep '^mm_'
This should produce a list with all the Micetro Ansible modules.
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Ansible lookup plugins
The set of Ansible Integration modules consists of multiple sets (lookup and inventory) and these should be installed
in their own directories.
The lookup plugins can be installed in:
/usr/share/ansible/
plugins/lookup
~/.ansible/plugins/
lookup
/etc/ansible/plugins/
lookup

System wide installation, modules available to all users
Plugins available only to the current user, as the plugins are installed in the users
home-directory
Local installation. As most Ansible installations use the /etc/ansible directory as the Ansible top-directory (as this is the default in an Ansible installation)
this is probably the best installation option. When installing the lookup plugins
in this directory, the Ansible lookup path needs to be set in the /etc/ansible/
ansible.cfg file, pointing to the lookup plugin directory.

lookup_plugins = /usr/share/ansible/plugins/lookup:\
/etc/ansible/plugins/lookup
To check if the modules are installed correctly and are available to Ansible, issue the command:
ansible-doc -t lookup -l | grep '^mm_'
Which should produce a list with all the Micetro Ansible lookup plugins.
Ansible inventory plugins
The inventory plugins can be installed in:
/usr/share/ansible/
plugins/inventory
~/.ansible/plugins/
inventory
/etc/ansible/plugins/
inventory

System wide installation, modules available to all users
Plugins available only to the current user, as the plugins are installed in the users
home-directory
Local installation. As most Ansible installations use the /etc/ansible directory as the Ansible top-directory (as this is the default in an Ansible installation) this is probably the best installation option. When installing the inventory
plugins in this directory, the Ansible lookup path needs to be set in the /etc/
ansible/ansible.cfg file, pointing to the lookup plugin directory.

inventory_plugins = /usr/share/ansible/plugins/inventory:\
/etc/ansible/plugins/inventory
To check if the modules are installed correctly and are available to Ansible, issue the command:
ansible-doc -t inventory -l | grep '^mm_'
Which should produce a list with all the Micetro Ansible inventory plugins.
The mm_inventory plugin also needs some extra configuration, see mm_inventory plugin for more information.

306

Chapter 1. Table of Contents

Micetro by Menamp;Mice Documentation, Release 10.2

API user
As the Ansible modules and plugins connect to a Micetro installation, a connection between Ansible and Micetro needs
to be made.
API user for Micetro
In Micetro a user needs to be defined that has all rights in Micetro (administrator) so it is able to perform all needed
tasks. It is also possible to delegate only certain tasks to certain API users. Credential matrix gives an overview which
rights a required for every module.
API Provider in Ansible
For the Ansible modules and plugins to function correctly a provider has to be defined. This provider consist of a user,
password and connection url (mmurl) and this provider needs to be defined in the Ansible setup, either through Ansible
Tower/AWX or in the Ansible directory.
As the modules and plugins can be used by all systems under Ansible control, it is advised to define the API provider
for the all group. Create a file all in the /etc/ansible/group_vars directory, or the /etc/ansible/inventory/
group_vars directory (if your inventory is a directory instead of a file) which contains something similar to:
--provider:
mmurl: http://micetro.example.net
user: apiuser
password: apipasswd

Note: Encrypt the apipasswd with ansible-vault to prevent plaintext passwords in the Ansible tree.
An example to achieve this is:
printf "apipasswd"
| \
ansible-vault
\
encrypt_string
\
--stdin-name="password"
Which results in:
password: !vault |
$ANSIBLE_VAULT;1.1;AES256
3464653838326533616266653.....643434316266666430
6139656636383537336365313.....336161393439666431
3539313065656531313838356.....613861623135656634
6332393063643531390a34366.....323631613034356565
6138
If an Ansible vault with multiple vault ID’s is needed, please have a look at http://www.tonkersten.com/2019/07/
151-ansible-with-multiple-vault-ids/ for more information.
The defined provider can be used in Ansible playbooks like:
Run ansible playbook for another host and delegate to the control node
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- name: Claim IP address
mm_claimip:
state: present
ipaddress: 172.16.12.14
provider: "{{ provider }}"
delegate_to: localhost
The reason for the delegate_to: localhost option, is that all commands can be performed on the Ansible control
node. So, it is possible to protect the Micetro API to only accept commands from the Ansible control node and not
from everywhere. This can also be achieved by creating a playbook that has localhost as the hosts-setting and is specific
for the interaction with Micetro.
Run ansible playbook on the Ansible Control node
--- name: host connection example
hosts: localhost
connection: local
become: false
tasks:
- name: Claim IP address
mm_claimip:
state: present
ipaddress: 172.16.12.14
provider: "{{ provider }}"

Ansible configuration example
Beneath is an example Ansible configuration file (ansible.cfg) with the assumption that all Micetro plugins and
modules are installed in the /etc/ansible directory. Some lines end with a backslash \, which indicates that the
following should be appended, but these are split for code clarity.
# ==============================================
[defaults]
remote_tmp
= $HOME/.ansible/tmp
inventory
= inventory
pattern
= *
forks
= 5
poll_interval
= 15
ask_pass
= False
remote_port
= 22
remote_user
= ansible
gathering
= implicit
host_key_checking
= False
interpreter_python
= auto_silent
force_valid_group_names = true
retry_files_enabled
= False
callback_whitelist
= minimal, dense, oneline
stdout_callback
= default
nocows
= 0
library
= /etc/ansible/library
(continues on next page)

308

Chapter 1. Table of Contents

Micetro by Menamp;Mice Documentation, Release 10.2

(continued from previous page)

action_plugins
callback_plugins
connection_plugins
filter_plugins
vars_plugins
inventory_plugins

=
=
=
=
=
=

/usr/share/ansible_plugins/action_plugins
/etc/ansible/plugins/callback_plugins
/usr/share/ansible_plugins/connection_plugins
/usr/share/ansible_plugins/filter_plugins
/usr/share/ansible_plugins/vars_plugins
/usr/share/ansible_plugins/inventory_plugins:\
/etc/ansible/plugins/inventory
= /usr/share/ansible_plugins/lookup_plugins:\
/etc/ansible/plugins/lookup

lookup_plugins

[inventory]
enable_plugins
cache
cache_plugin
cache_prefix
cache_timeout
cache_connection

=
=
=
=
=
=

mm_inventory, host_list, auto
no
pickle
mm_inv
60
/tmp/mm_inventory_cache

[privilege_escalation]
become
= False
become_method
= sudo
become_user
= root
become_ask_pass = False

Credential matrix
Table 5: Module and plugin credentials needed
Page 309, 1

mm_claimip.py
mm_dhcp
mm_dnsrecord
mm_group
mm_ipprops
mm_props
mm_role
mm_user
mm_zone
mm_inventory
mm_freeip
mm_ipinfo

2

*
*

*
*

3

4

*

*
*

*
*

5

6

7

*
*

*
*
*

*
*
*

Note: The mm_props module manages custom properties for all types, like DNS servers, DHCP servers, zones, IP
ranges etc. When using the module for a type when no modify rights are granted, an error will occur. It is possible to
1
2
3
4
5
6
7

Administrators (built-in)
DNS Administrators (built-in)
DHCP Administrators (built-in)
IPAM Administrators (built-in)
User Administrators (built-in)
Approvers (built-in)
Requesters (built-in)
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grant less rights and allow only to modify a subset of the record types.

Ansible modules
mm_user
Manage user accounts and user properties in Micetro.
Options
authentication_type:
Authentication type to use. e.g. Internal, AD. Required if state=present.
descr:
Description of the user.
email:
The users email address.
groups:
Make the user a member of these groups.
name:
(required) Name of the user to create, remove or modify.
password:
Users password (plaintext). Required if state=present.
provider:
(required) Definition of the Micetro API provider.
roles:
state:

Make the user a member of these roles.
Should the users account exist or not. (absent, present)

Examples
- name: Add the user 'mauricem' as an admin
mm_user:
username: mauricem
password: password
full_name: John Doe
state: present
authentication_type: internal
roles:
- Administrators (built-in)
- DNS Administrators (built-in)
- DHCP Administrators (built-in)
- IPAM Administrators (built-in)
- User Administrators (built-in)
- Approvers (built-in)
(continues on next page)
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(continued from previous page)

- Requesters (built-in)
provider:
mmurl: http://micetro.example.net
user: apiuser
password: apipasswd
delegate_to: localhost
- name: Remove user 'mauricem'
mm_user:
username: mauricem
state: absent
provider:
mmurl: http://micetro.example.net
user: apiuser
password: apipasswd
delegate_to: localhost

mm_group
Manage groups in Micetro.
Options
descr:
Description of the group.
name:
(required) Name of the group to create, remove or modify.
provider:
(required) Definition of the Micetro API provider.
roles:
state:

List of roles to add to this group.
Should the role exist or not. (absent, present)

users:
List of users to add to this group.
Examples
- name: Add the 'local' group
mm_group:
name: local
desc: A local group
state: present
users:
- mauricemoss
(continues on next page)

1.17. Automation

311

Micetro by Menamp;Mice Documentation, Release 10.2

(continued from previous page)

roles:
- IPAM Administrators (built-in)
provider:
mmurl: http://micetro.example.net
user: apiuser
password: apipasswd
delegate_to: localhost
- name: Remove the 'local' group
mm_group:
name: local
state: absent
provider:
mmurl: http://micetro.example.net
user: apiuser
password: apipasswd
delegate_to: localhost

mm_role
Manage roles in Micetro.
Options
descr:
Description of the role.
groups:
List of groups to add to this role
name:
(required) Name of the role to create, remove or modify.
provider:
(required) Definition of the Micetro API provider.
state:

Should the role exist or not. (absent, present)

users:
List of users to add to this role
Examples
- name: Add the 'local' role
mm_role:
name: local
desc: A local role
state: present
provider:
(continues on next page)
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mmurl: http://micetro.example.net
user: apiuser
password: apipasswd
delegate_to: localhost
- name: Remove the 'local' role
mm_role:
name: local
state: absent
provider:
mmurl: http://micetro.example.net
user: apiuser
password: apipasswd
delegate_to: localhost

mm_props
Manage custom properties (see Custom Properties) in Micetro.
Options
cloudtags:
Associated cloud tags.
defaultvalue:
Default value of the property.
dest:

(required) The section where to define the custom property.

listitems:
The items in the selection list.
mandatory:
Is the property mandatory.
multiline:
Is the property multiline.
name:
(required) Name of the property.
proptype:
Type of the property. These are not the types as described in the API, but the types as you can see them in the
Men&Mice Management Console.
provider:
(required) Definition of the Micetro provider.
readonly:
Is the property read only.
state:

The state of the properties or properties. (absent, present)
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system:
Is the property system defined.
updateexisting:
Should objects be updated with the new values. Only valid when updating a property, otherwise ignored.
Examples
- name: Set definition for custom properties
mm_props:
name: location
state: present
proptype: text
dest: zone
provider:
mmurl: http://micetro.example.net
user: apiuser
password: apipasswd
delegate_to: localhost

mm_claimip
Claim IP addresses in DHCP in Micetro.
Options
customproperties:
Custom properties for the IP address. These properties must already exist. See also mm_props.
ipaddress:
(required) The IP address(es) to work on.
provider:
(required) Definition of the Micetro API provider.
state:

The state of the claim. (absent, present)

Examples
- name: Claim IP address
mm_claimip:
state: present
ipaddress: 172.16.12.14
provider:
mmurl: http://micetro.example.net
user: apiuser
password: apipasswd
delegate_to: localhost
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- name: Release claim on IP addresses
mm_claimip:
state: present
ipaddress:
- 172.16.12.14
- 172.16.12.15
- 172.16.12.16
provider:
mmurl: http://micetro.example.net
user: apiuser
password: apipasswd
delegate_to: localhost

mm_ipprops
Set properties on an IP address in Micetro.
Options
deleteunspecified:
Clmicetroperties that are not explicitly set.
ipaddress:
(required) The IP address(es) to work on.
properties:
(required) Custom properties for the IP address. These properties must already be defined.
provider:
(required) Definition of the Micetro API provider.
state:

Property present or not. (absent, present)

Examples
- name: Set properties on IP
mm_ipprops:
state: present
ipaddress: 172.16.12.14
properties:
claimed: false
location: London
provider:
mmurl: http://micetro.example.net
user: apiuser
password: apipasswd
delegate_to: localhost
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mm_dhcp
Manage DHCP reservations in Micetro.
Options
ddnshost:
The dynamic DNS host to place the entry in.
deleteunspecified:
Clear properties that are not explicitly set.
filename:
Filename to place the entry in.
ipaddress:
(required) The IP address(es) to make a reservation on. When the IP address is changed a new reservation is
made. It is not allowed to make reservations in DHCP blocks.
macaddress:
(required) MAC address for the IP address.
name:
(required) Name of the reservation
nextserver:
Next server as DHCP option (bootp).
provider:
(required) Definition of the Micetro API provider.
servername:
Server to place the entry in.
state:

The state of the reservation. (absent, present)

Examples
- name: Add a reservation for an IP address
mm_dhcp:
state: present
name: myreservation
ipaddress: 172.16.17.8
macaddress: 44:55:66:77:88:99
provider:
mmurl: http://micetro.example.net
user: apiuser
password: apipasswd
delegate_to: localhost
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mm_zone
Manage DNS zones in Micetro.
Options
adintegrated:
True if the zone is Active Directory integrated.
adpartition:
The AD partition if the zone is Active Directory integrated.
adreplicationtype:
Type of the AD replication.
authority:
Name of the DNS server that contains the zone or the string [Active Directory] if the zone is integrated in
the Active Directory.
customproperties:
Custom properties for the zone. These properties must already exist. See also mm_props.
dnssecsigned:
True if the zone is a DNSSEC signed zone.
dynamic:
Dynamic DNS zone.
kskids:
A comma separated string of IDs of KSKs, starting with active keys, then inactive keys in parenthesis
masters:
The IP addresses of the primary servers if the new zone is not a primary zone.
name:
(required) Name of the zone.
nameserver:
Nameserver to define the zone on. Required if state=present.
provider:
(required) Definition of the Micetro API provider.
servtype:
Type of server.
state:

The state of the zone. (absent, present)

zskids:
A comma separated string of IDs of ZSKs, starting with active keys, then inactive keys in parenthesis.
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Examples
- name: Create a new zone
mm_zone:
state: present
name: example.com
nameserver: ns1.example.com
authority: micetro.example.net
customproperties:
location: London
provider:
mmurl: http://micetro.example.net
user: apiuser
password: apipasswd
delegate_to: localhost
- name: Release a zone
mm_zone:
state: absent
name: example.com
provider:
mmurl: http://micetro.example.net
user: apiuser
password: apipasswd
delegate_to: localhost

mm_dnsrecord
Manage DNS records in Micetro.
In DNS it is very common to have multiple entries with the same name, as the example below shows.
mail01.example.net.
mail01.example.net.
mail01.example.net.
mail01.example.net.

7200
7200
7200
7200

IN
IN
IN
IN

A
A
AAAA
AAAA

192.0.2.25
192.0.2.143
2001:db8::25
2001:db8::587

Tip: To enable multiple records with the same name in the Ansible modules, there is no possibility to change a record,
the only way is to add the new record with the updated data and remove the old one after that.
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Options
aging:
The aging timestamp of dynamic records in AD integrated zones. Hours since January 1, 1601, UTC. Providing
a non-zero value creates a dynamic record.
comment:
Comment string for the record. Note that only records in static DNS zones can have a comment string
data:

(required) The data that is added to the DNS record. The record data is a space-separated list, when the resource
type is one of: MX, SRV, NAPTR, CAA, CERT, HINFO or TLSA.
Example: data: "100 10 U E2U+sip !^.*$!sip:customer-service@example.com! ."

dnszone:
(required) The DNS zone where the action should take place.
enabled:
True if the record is enabled. If the record is disabled the value is false
name:
(required) The name of the DNS record. Can either be partially or fully qualified.
provider:
(required) Definition of the Micetro API provider.
rrtype:
Resource Record Type for this DNS record. Default is A.
state:
ttl:

The state of the properties. (absent, present)
The Time-To-Live of the DNS record.

Examples
- name: Set DNS record in zone for a defined name
mm_dnsrecord:
state: present
name: reynholm
data: 172.16.17.2
rrtype: A
dnszone: example.net.
provider:
mmurl: http://micetro.example.net
user: apiuser
password: apipasswd
delegate_to: localhost
- name: Set PTR record in zone for a defined name
mm_dnsrecord:
state: present
name: "2.17.16.172.in-addr.arpa."
data: reynholm.example.net.
(continues on next page)
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rrtype: PTR
dnszone: "17.16.172.in-addr.arpa."
provider:
mmurl: http://micetro.example.net
user: apiuser
password: apipasswd
delegate_to: localhost

mm_freeip plugin
This Men&Mice FreeIP lookup plugin finds one or more free IP addresses in a certain network, defined in Micetro.
Options
claim:
Claim the IP address(es) for the specified amount of time in seconds
excludedhcp:
exclude DHCP reserved ranges from result
filter:

Micetro filter statement. Filter validation is done by Micetro, not in the plugin. More filter info: quickfilter

multi:
Get a list of x number of free IP addresses from the requested zones.
network:
(required) Network zone(s) from which the first free IP address is to be found. This is either a single network or
a list of networks
ping:

ping the address found before returning.

provider:
(required) Definition of the Micetro API provider.
Usage
When using the Men&Mice FreeIP plugin something needs to be taken into account. When running an Ansible lookup
plugin, this lookup action takes place every time the variable is referenced. So it will not be possible to claim an IP
address for further reference, this way. This has to do with the way Ansible works. A solution for this is to assign all
collected IP addresses to an Ansible fact, but here you need to make sure the factname is not used over multiple hosts.
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Example usage
Claim IP addresses in one or more ranges
--- name: Men&Mice FreeIP test play
hosts: localhost
connection: local
become: false
vars:
provider:
mmurl: http://micetro.example.net
user: apiuser
password: apipassword
network: examplenet
tasks:
- name: Set free IP addresses as a fact
set_fact:
freeips: "{{ query('mm_freeip',
provider,
network,
multi=15,
claim=60,
startaddress='192.168.63.100',
excludedhcp=True,
ping=True)
}}"
- name: Get the free IP address
debug:
msg:
- "Free IPs
: {{
- "Queried network
: {{
- "Ansible version
: {{
- "Python version
: {{
- "Python executable : {{

and show info

freeips }}"
network }}"
ansible_version.full }}"
ansible_facts['python_version'] }}"
ansible_facts['python']['executable'] }}"

- name: Loop over IP addresses
debug:
msg:
- "Next free IP
: {{ item }}"
loop: "{{ freeips }}"
# ansible-playbook mmtest.yml
PLAY [Men&Mice FreeIP test play] *************************************
TASK [Gathering Facts] ***********************************************
ok: [localhost]
TASK [Set free IP addresses as a fact] *******************************
(continues on next page)
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ok: [localhost]
TASK [Get the free IP address and show info] *************************
ok: [localhost] => {
"msg": [
"Free IPs
: ['192.168.63.203', '192.168.63.204']",
"Queried network
: nononet",
"Ansible version
: 2.9.7",
"Python version
: 3.6.8",
"Python executable : /usr/libexec/platform-python"
]
}
TASK [Loop over IP
ok: [localhost] =>
"msg": [
"Next free
]
}
ok: [localhost] =>
"msg": [
"Next free
]
}

addresses] ****************************************
(item=192.168.63.203) => {
IP

: 192.168.63.203"

(item=192.168.63.204) => {
IP

: 192.168.63.204"

PLAY RECAP ***********************************************************
localhost : ok=4 changed=0 unreachable=0 failed=0 skipped=0 rescued=0

ignored=0

mm_inventory plugin
This plugin generates the inventory from Micetro. It supports reading configuration from both a YAML configuration file and environment variables. If reading from the YAML file, the filename must end with mm_inventory.
(yml|yaml), the path in the command would be /path/to/mm_inventory.(yml|yaml). If some arguments in
the configuration file are missing, this plugin will try to fill in the missing arguments by reading from environment
variables. If reading configurations from environment variables, the path in the command must be @mm_inventory.
Valid configuration filenames are:
• mm_inventory
• mmsuite
• mandm
• menandmice
• mandmsuite
• mm_suite
• mandm_suite
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Options
There are two sets of configuration options, the options for the inventory plugin to function correctly and for Ansible
to know how to use the plugin.
Plugin configuration
The mm_inventory plugin is configured through a configuration file, named mm_inventory.yml and the options are:
plugin
Name of the plugin (mm_inventory)
host
user

Micetro to connect to (http://micetro.example.net)
UserID to connect with (apiuser)

password
The password to connect with (apipasswd)
filters

Filter on custom properties, can be more than 1 and should be a list. If multiple filters are given, they act as an
and function

ranges
What IP ranges to examine (172.16.17.0/24) Multiple ranges can be given, they act as an or function
Note: When both ranges and filters are supplied that will result in an and function.
Example:
filters:
- location: home
- owner: tonk
ranges:
- 192.168.4.0/24
- 172.16.17.0/24
Would result in an inventory for all host that have the location: home and owner:
and are either a member of the 192.168.4.0/24 or 172.16.17.0/24 range.

tonk custom properties set

An example of the mm_inventory.yml file:
plugin: mm_inventory
host: "http://micetro.example.net"
user: apiuser
password: apipasswd
filters:
- location: London
ranges:
- 172.16.17.0/24
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Environment variables:
The mm_inventory plugin can also be configured through environment variables
export
export
export
export
export

MM_HOST=YOUR_MM_HOST_ADDRESS
MM_USER=YOUR_MM_USER
MM_PASSWORD=YOUR_MM_PASSWORD
MM_FILTERS=YOUR_MM_FILTERS
MM_RANGES=YOUR_MM_RANGES

When reading configuration from the environment, the inventory path must always be @mm_inventory.
ansible-inventory -i @mm_inventory --list

Ansible configuration
Ansible needs to know about the mm_inventory plugin and also has some extra configuration options. First the
mm_inventory plugin needs to be enabled, so Ansible can use it. This is done in the [inventory] section in the
ansible.cfg file.
[inventory]
enable_plugins
cache
cache_plugin
cache_prefix
cache_timeout
cache_connection

=
=
=
=
=
=

mm_inventory, host_list, auto
yes
jsonfile
mm_inv
3600
/tmp/mm_inventory_cache

With the following meaning:
cache:
Switch caching on and off
cache_plugin:
Which caching plugin to use
• jsonfile
• yaml
• pickle
• ...
cache_prefix:
User defined prefix to use when creating the cache files
cache_connection:
Path in which the cache plugin will save the cache files
cache_timeout:
Timeout for the cache in seconds
Now the inventory plugin can be used with Ansible, like:
ansible-inventory -i /path/to/mm_inventory.yml --list
Or set the mm_inventory.yml as the Ansible inventory in the ansible.cfg file.
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inventory = mm_inventory.yml

mm_ipinfo plugin
This Men&Mice IPInfo lookup plugin finds a lot of info about a specified IP address, defined in Micetro.
Options
ipaddress:
(required) The IP address that is examined
provider:
(required) Definition of the Micetro API provider.
Usage
The mm_ipinfo plugin delivers a complete set of information about an IP address, as it is delivered by the Micetro
API.
Example usage:
Get information on an IP address
- name: Get all info for this IP address
debug:
var: ipinfo
vars:
ipinfo: "{{ query('mm_ipinfo', provider, '172.16.17.2') | to_nice_json }}"
With output like (output shortened):
ok: [localhost] => {
"ipinfo": {
"addrRef": "IPAMRecords/11",
"address": "172.16.17.2",
"claimed": false,
"customProperties": {
"location": "In the basement"
},
}
}
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Example playbooks
To use the Micetro Ansible Integration you need to create Ansible playbooks that utilize the functionality of Micetro.
Following are a couple of example playbooks for inspiration. These playbooks have been tested extensively with
different operating systems, versions of Ansible and Python.
Contents
• Example playbooks
– play-user
– play-group
– play-role
– play-props
– play-claimip
– play-dhcp
– play-zone
– play-dnsrecord
– play-freeip
– play-ipinfo
– play_it_all

play-user
--#
# Add, delete and change users in Micetro example
#
# The file <ansible_topdir>/group_vars/all contains:
#
#
--#
provider:
#
mmurl: http://micetro.example.net
#
user: apiuser
#
password: apipasswd
#
- name: Men&Mice users test play
hosts: localhost
connection: local
become: false
tasks:
- name: Get the free IP address and show info
debug:
msg:
(continues on next page)

326

Chapter 1. Table of Contents

Micetro by Menamp;Mice Documentation, Release 10.2

(continued from previous page)

- "Ansible version
- "Python version
- "Python executable

: {{ ansible_version.full }}"
: {{ ansible_facts['python_version'] }}"
: {{ ansible_facts['python']['executable'] }}"

- name: Add the user 'mauricem' as an admin
mm_user:
username: mauricem
password: password
full_name: Maurice Moss
state: present
authentication_type: internal
roles:
- Administrators (built-in)
- DNS Administrators (built-in)
- DHCP Administrators (built-in)
- IPAM Administrators (built-in)
- User Administrators (built-in)
- Approvers (built-in)
- Requesters (built-in)
provider: "{{ provider }}"
- name: Check idempotency
mm_user:
username: mauricem
password: password
full_name: Maurice Moss
state: present
authentication_type: internal
roles:
- Administrators (built-in)
- DNS Administrators (built-in)
- DHCP Administrators (built-in)
- IPAM Administrators (built-in)
- User Administrators (built-in)
- Approvers (built-in)
- Requesters (built-in)
provider: "{{ provider }}"
- name: Change the groups
mm_user:
username: mauricem
password: password
full_name: Maurice Moss
state: present
authentication_type: internal
roles:
- Administrators (built-in)
- User Administrators (built-in)
- Approvers (built-in)
- Requesters (built-in)
provider: "{{ provider }}"
(continues on next page)
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- name: Check idempotency again
mm_user:
username: mauricem
password: password
full_name: Maurice Moss
state: present
authentication_type: internal
roles:
- Administrators (built-in)
- User Administrators (built-in)
- Approvers (built-in)
- Requesters (built-in)
provider: "{{ provider }}"
- name: Remove the user again
mm_user:
username: mauricem
state: absent
provider: "{{ provider }}"

play-group
--#
# Add, delete and change groups in Micetro example
#
# The file <ansible_topdir>/group_vars/all contains:
#
#
--#
provider:
#
mmurl: http://micetro.example.net
#
user: apiuser
#
password: apipasswd
#
- name: Men&Mice users test play
hosts: localhost
connection: local
become: false
tasks:
- name: Get the free IP address and show info
debug:
msg:
- "Ansible version
: {{ ansible_version.full }}"
- "Python version
: {{ ansible_facts['python_version'] }}"
- "Python executable : {{ ansible_facts['python']['executable'] }}"
- name: Add the 'local' group
mm_group:
name: local
(continues on next page)
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desc: A local rgroup
state: present
users:
- mauricemoss
- jenbarber
provider: "{{ provider }}"
- name: Check idempotency
mm_group:
name: local
desc: A local group
state: present
users:
- mauricemoss
- jenbarber
provider: "{{ provider }}"
- name: Add nonexisting user to group
mm_group:
name: local
desc: A local group
state: present
users:
- roy
provider: "{{ provider }}"
ignore_errors: true
- name: Remove the 'local' group
mm_group:
name: local
state: absent
provider: "{{ provider }}"

play-role
--#
# Add, delete and change roles in Micetro example
#
# The file <ansible_topdir>/group_vars/all contains:
#
#
--#
provider:
#
mmurl: http://micetro.example.net
#
user: apiuser
#
password: apipasswd
#
- name: Men&Mice users test play
hosts: localhost
connection: local
(continues on next page)
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become: false
tasks:
- name: Get the free IP address and show info
debug:
msg:
- "Ansible version
: {{ ansible_version.full }}"
- "Python version
: {{ ansible_facts['python_version'] }}"
- "Python executable : {{ ansible_facts['python']['executable'] }}"
- name: Add the 'local' role
mm_role:
name: local
desc: A local role
state: present
users:
- mauricemoss
- jenbarber
provider: "{{ provider }}"
- name: Check idempotency
mm_role:
name: local
desc: A local role
state: present
users:
- mauricemoss
- jenbarber
provider: "{{ provider }}"
- name: Add nonexisting user to role
mm_role:
name: local
desc: A local role
state: present
users:
- roy
provider: "{{ provider }}"
ignore_errors: true
- name: Remove the 'local' role
mm_role:
name: local
state: absent
provider: "{{ provider }}"
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play-props
--#
# Set, delete and change custom properties in Micetro example
#
# The file <ansible_topdir>/group_vars/all contains:
#
#
--#
provider:
#
mmurl: http://micetro.example.net
#
user: apiuser
#
password: apipasswd
#
- name: Men&Mice Custom Properties test play
hosts: localhost
connection: local
become: false
tasks:
- name: Ansible information
debug:
msg:
- "Ansible version
: {{ ansible_version.full }}"
- "Python version
: {{ ansible_facts['python_version'] }}"
- "Python executable : {{ ansible_facts['python']['executable'] }}"
- name: Set text property
mm_props:
state: present
name: MyProperty
proptype: text
dest: dnsserver
listitems:
- Paul
- Daniel
- April
- Nolan
provider: "{{ provider }}"
delegate_to: localhost
- name: Check idempotentie
mm_props:
state: present
name: MyProperty
proptype: text
dest: dnsserver
listitems:
- Paul
- Daniel
- April
- Nolan
(continues on next page)
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provider: "{{ provider }}"
delegate_to: localhost
- name: Change type - not allowed
mm_props:
state: present
name: MyProperty
proptype: yesno
dest: dnsserver
listitems:
- Paul
- Daniel
- April
- Nolan
provider: "{{ provider }}"
delegate_to: localhost
- name: Change list around
mm_props:
state: present
name: MyProperty
proptype: text
dest: dnsserver
listitems:
- Paul
- Daniel
- April
- Nolan
provider: "{{ provider }}"
delegate_to: localhost
- name: Remove property
mm_props:
state: absent
name: MyProperty
proptype: text
dest: dnsserver
provider: "{{ provider }}"
delegate_to: localhost
- name: Remove property - again
mm_props:
state: absent
name: MyProperty
proptype: yesno
dest: dnsserver
provider: "{{ provider }}"
delegate_to: localhost
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play-claimip
--#
# Claim and release an IP address in Micetro example
#
# The file <ansible_topdir>/group_vars/all contains:
#
#
--#
provider:
#
mmurl: http://micetro.example.net
#
user: apiuser
#
password: apipasswd
#
#
- name: Men&Mice ClaimIP test play
hosts: localhost
connection: local
become: false
tasks:
- name: Ansible information
debug:
msg:
- "Ansible version
: {{ ansible_version.full }}"
- "Python version
: {{ ansible_facts['python_version'] }}"
- "Python executable : {{ ansible_facts['python']['executable'] }}"
- name: Claim IP address
mm_claimip:
state: present
ipaddress: 172.16.12.14
provider: "{{ provider }}"
- name: Check idempotentie
mm_claimip:
state: present
ipaddress: 172.16.12.14
provider: "{{ provider }}"
- name: Unclaim IP address
mm_claimip:
state: present
ipaddress: 172.16.12.14
provider: "{{ provider }}"
# This task claims an IP address that cannot exit
# and returns a warning because of that
- name: Claim erroneous IP address
mm_claimip:
state: present
ipaddress: 456.978.12.14
provider: "{{ provider }}"
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play-dhcp
--#
# Make a DHCP reservation and release it in Micetro example
#
# The file <ansible_topdir>/group_vars/all contains:
#
#
--#
provider:
#
mmurl: http://micetro.example.net
#
user: apiuser
#
password: apipasswd
#
- name: Men&Mice DHCP test play
hosts: localhost
connection: local
become: false
tasks:
- name: Ansible information
debug:
msg:
- "Ansible version
: {{ ansible_version.full }}"
- "Python version
: {{ ansible_facts['python_version'] }}"
- "Python executable : {{ ansible_facts['python']['executable'] }}"
- name: Add a reservation for an IP address
mm_dhcp:
state: present
name: myreservation
ipaddress: 172.16.17.8
macaddress: 44:55:66:77:88:00
provider: "{{ provider }}"
delegate_to: localhost
- name: check idempotentie
mm_dhcp:
state: present
name: myreservation
ipaddress: 172.16.17.8
macaddress: 44:55:66:77:88:00
provider: "{{ provider }}"
delegate_to: localhost
#
#
#
-

Changing the MAC address of a reservation is not allowed, as this
would alter the reservation. To achieve this, release the reservation
and reclaim it.
name: change mac
mm_dhcp:
state: present
name: myreservation
(continues on next page)
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ipaddress: 172.16.17.8
macaddress: 44:55:66:77:88:99
provider: "{{ provider }}"
delegate_to: localhost
- name: change ip
mm_dhcp:
state: present
name: myreservation
ipaddress: 172.16.17.9
macaddress: 44:55:66:77:88:99
provider: "{{ provider }}"
delegate_to: localhost
- name: change name
mm_dhcp:
state: present
name: movemyreservation
ipaddress: 172.16.17.9
macaddress: 44:55:66:77:88:99
provider: "{{ provider }}"
delegate_to: localhost
- name: delete reservation (wrong one)
mm_dhcp:
state: absent
name: movemyreservation
ipaddress: 172.16.17.9
macaddress: 44:55:66:77:88:99
provider: "{{ provider }}"
delegate_to: localhost
- name: delete reservation (correct one)
mm_dhcp:
state: absent
name: myreservation
ipaddress: 172.16.17.8
macaddress: 44:55:66:77:88:99
provider: "{{ provider }}"
delegate_to: localhost
- name: create reservation in invalid range
mm_dhcp:
state: present
name: reservationnonet
ipaddress: 172.16.17.58
macaddress: 44:55:66:77:88:99
provider: "{{ provider }}"
delegate_to: localhost
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play-zone
--#
# The file <ansible_topdir>/group_vars/all contains:
#
#
--#
provider:
#
mmurl: http://micetro.example.net
#
user: apiuser
#
password: apipasswd
#
- name: Men&Mice DHCP test play
hosts: localhost
connection: local
become: false
tasks:
- name: Ansible information
debug:
msg:
- "Ansible version
: {{ ansible_version.full }}"
- "Python version
: {{ ansible_facts['python_version'] }}"
- "Python executable : {{ ansible_facts['python']['executable'] }}"
- name: Ensure the zone
mm_zone:
state: present
name: example.com
nameserver: mandm.example.com
authority: mandm.example.net
masters: mandm.example.net
servtype: master
customproperties:
owner: Reynholm Industries
place: London
provider: "{{ provider }}"
delegate_to: localhost
- name: Remove the zone
mm_zone:
state: absent
name: example.com
provider: "{{ provider }}"
delegate_to: localhost
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play-dnsrecord
--#
# Set and change a DNS record in Micetro example
#
# The file <ansible_topdir>/group_vars/all contains:
#
#
--#
provider:
#
mmurl: http://micetro.example.net
#
user: apiuser
#
password: apipasswd
#
- name: Men&Mice DNSRecord test play
hosts: localhost
connection: local
become: false
tasks:
- name: Ansible information
debug:
msg:
- "Ansible version
: {{ ansible_version.full }}"
- "Python version
: {{ ansible_facts['python_version'] }}"
- "Python executable : {{ ansible_facts['python']['executable'] }}"
- name: Set DNS record
mm_dnsrecord:
state: present
name: reynholm
rrtype: A
dnszone: testzone
data: 192.168.10.12
comment: From The API side
ttl: 86400
provider: "{{ provider }}"
delegate_to: localhost
- name: Check idempotentie
mm_dnsrecord:
state: present
name: reynholm
rrtype: A
dnszone: testzone
data: 192.168.10.12
comment: From The API side
ttl: 86400
provider: "{{ provider }}"
delegate_to: localhost
- name: Set DNS record with erroneous values
(continues on next page)
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mm_dnsrecord:
state: present
name: reynholm
rrtype: AAAA
dnszone: testzone
data: 192.168.10.127
comment: From The API side
ttl: apple
provider: "{{ provider }}"
delegate_to: localhost
ignore_errors: true
- name: Change record
mm_dnsrecord:
state: present
name: reynholm
rrtype: A
dnszone: testzone
data: 192.168.10.14
comment: From The API side
provider: "{{ provider }}"
delegate_to: localhost
- name: Do something stupid
mm_dnsrecord:
state: present
name: reynholm
rrtype: A
dnszone: notthetestzone
data: 192.168.90.14
comment: Welcome to the error
provider: "{{ provider }}"
delegate_to: localhost
ignore_errors: true
- name: Do more something stupid things
mm_dnsrecord:
state: present
name: reynholm
rrtype: A
dnszone: testzone
data: 192.168.390.14
comment: Welcome to the error
provider: "{{ provider }}"
delegate_to: localhost
ignore_errors: true
- name: Remove record
mm_dnsrecord:
state: absent
name: reynholm
dnszone: notthetestzone
(continues on next page)
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data: 192.168.90.14
provider: "{{ provider }}"
delegate_to: localhost
- name: Remove record - again
mm_dnsrecord:
state: absent
name: reynholm
dnszone: notthetestzone
data: 192.168.90.14
provider: "{{ provider }}"
delegate_to: localhost

play-freeip
--#
# Find a set of free IP addresses in a range in Micetro example
#
# The file <ansible_topdir>/group_vars/all contains:
#
#
--#
provider:
#
mmurl: http://micetro.example.net
#
user: apiuser
#
password: apipasswd
#
- name: Men&Mice FreeIP test play
hosts: localhost
connection: local
become: false
vars:
network:
- examplenet
tasks:
- name: Set free IP addresses as a fact
set_fact:
freeips: "{{ query('mm_freeip',
provider,
network,
multi=25,
claim=60,
excludedhcp=True,
ping=True)
}}"
- name: Get the free IP address and show info
debug:
(continues on next page)
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msg:
- "Free IPs
- "Queried network(s)
- "Ansible version
- "Python version
- "Python executable

:
:
:
:
:

{{
{{
{{
{{
{{

freeips }}"
network }}"
ansible_version.full }}"
ansible_facts['python_version'] }}"
ansible_facts['python']['executable'] }}"

- name: Loop over IP addresses
debug:
msg:
- "Next free IP
: {{ item }}"
loop: "{{ freeips }}"

play-ipinfo
--#
# Get all info for an IP address in Micetro example
#
# The file <ansible_topdir>/group_vars/all contains:
#
#
--#
provider:
#
mmurl: http://micetro.example.net
#
user: apiuser
#
password: apipasswd
#
- name: Men&Mice IP Info test play
hosts: localhost
connection: local
become: false
tasks:
- name: Get get IP info
set_fact:
ipinfo: "{{ query('mm_ipinfo', provider, '172.16.17.2') | to_nice_json }}"
- name: Show Ansible and Python information
debug:
msg:
- "Ansible version
: {{ ansible_version.full }}"
- "Python version
: {{ ansible_facts['python_version'] }}"
- "Python executable : {{ ansible_facts['python']['executable'] }}"
- name: Show all infor for this IP address
debug:
var: ipinfo
# This task tries to get the information for a non-existing IP address
# which results in a fatal `Object not found for reference` error
(continues on next page)
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- name: Get get IP info for a non existing IP address
set_fact:
ipinfo: "{{ query('mm_ipinfo', provider, '390.916.17.2') | to_nice_json }}"
ignore_errors: true

play_it_all
Example of a playbook that combines functionality
--- name: Men&Mice test play
hosts: localhost
connection: local
become: false
vars:
network: examplenet
tasks:
# Some extra information about Ansible and the used
# Python version
- name: Ansible information
debug:
msg:
- "Ansible version
: {{ ansible_version.full }}"
- "Python version
: {{ ansible_facts['python_version'] }}"
- "Python executable : {{ ansible_facts['python']['executable'] }}"
#
#
#
#
#
#
#
#
#
#
#
#
#
#

The `ipaddr` filter needs the Python `netaddr` module, so make sure
this is installed
The `ipaddr` is used to determine the reverse IP address
For example:
vars:
ipa4: "172.16.17.2"
ipa6: "2001:785:beef:1:f2c4:8f9d:b554:e614"
-

"Forward
"Forward
"Reverse
"Reverse
"Reverse

IPv4
IPv4
IPv4
IPv6
IPv4

address
address
address
address
zone

:
:
:
:
:

{{
{{
{{
{{
{{

ipa4 }}"
ipa4 }}"
ipa4 | ipaddr('revdns') }}"
ipa6 | ipaddr('revdns') }}"
(ipa4 | ipaddr('revdns')).split('.')[1:]

| join('.') }}

"

˓→

#

- "Reverse IPv6 zone

: {{ (ipa6 | ipaddr('revdns')).split('.')[16:] | join('.') }}

"

˓→

#
#
#
#
#

The reverse zones are split on '.' and only the last part is
used (in this example). The reverse for IPv4 assumes a '/24' network
and the '16' in the IPv6 zone conversion is for a '/64' network. Adapt these to your
own needs (e.g. '2' for a '/16' network on IPv4 or '20' for an IPv6 '/48' net.
(continues on next page)
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- name: Ensure the netaddr module is installed for Python 2
pip:
name: netaddr
state: present
when: ansible_facts['python_version'] is version('3', '<')
become: true
- name: Ensure the netaddr module is installed for Python 3
pip:
name: netaddr
state: present
executable: pip3
when: ansible_facts['python_version'] is version('3', '>=')
become: true
- name: define custom properties for IP addresses
mm_props:
name: location
state: present
proptype: text
dest: ipaddress
provider: "{{ provider }}"
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#

The above example defines just a single property.
Defining multiple properties can be achieved by using
the Ansible loop functionality.

#
#
#
#
#
#
#
-

When running an Ansible lookup plugin, this lookup action takes
place every time the variable is referenced. So it will not be
possible to claim an IP address for further reference, this way.
This has to do with the way Ansible works. A solution for this
is to assign all collected free IP addresses to an Ansible fact,
but here you need to make sure the factname is not used over
multiple hosts.
name: get free IP addresses and set it as a fact
set_fact:

- name: Example of multiple properties
mm_props:
name: "{{ item.name }}"
state: "{{ item.state }}"
proptype: "{{ item.proptype }}"
dest: "{{ item.dest }}"
loop:
- name: location
state: present
proptype: text
dest: ipaddress
- name: owner
state: present
proptype: text
dest: ipaddress

(continues on next page)
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freeips: "{{ query('mm_freeip', provider, network, claim=60, excludedhcp=True) }}
"

˓→

- name: Get the free IP address and show info
debug:
msg:
- "Free IPs
: {{ freeips }}"
- "Queried network(s) : {{ network }}"
# Make a DHCP reservation for this address
# So claim it after DNS setting.
- name: Reservation on IP address
mm_dhcp:
state: present
name: testhost
ipaddress: "{{ freeips }}"
macaddress: "de:ad:be:ef:16:10"
provider: "{{ provider }}"
delegate_to: localhost
- name: Set properties on IP
mm_ipprops:
state: present
ipaddress: "{{ freeips }}"
properties:
claimed: false
location: London
provider: "{{ provider }}"
delegate_to: localhost
- name: Ensure the zone
mm_zone:
state: present
name: thetestzone.com
nameserver: mandm.example.com
authority: mandm.example.net
masters: mandm.example.net
servtype: master
provider: "{{ provider }}"
delegate_to: localhost
#
#
#
-

The `mm_freeip` plugin always returns a list, but the request was for just 1
IP address. The `mm_dnsrecord` only needs a single IP address. That's why the
list-slice `[0]` is used.
name: Set a DNS record for the claimed IP
mm_dnsrecord:
dnszone: testzone
name: testhost
data: "{{ freeips[0] }}"
provider: "{{ provider }}"
delegate_to: localhost
(continues on next page)
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- name: Set a PTR DNS record for the claimed IP
mm_dnsrecord:
dnszone: "{{ (freeips[0] | ipaddr('revdns')).split('.')[1:]
name: "{{ freeips[0] | ipaddr('revdns') }}"
data: "testhost.testzone."
rrtype: PTR
provider: "{{ provider }}"
delegate_to: localhost
#
#
#
-

| join('.') }}"

The `mm_ipinfo` returns all known information of an IP
address. This can be used to query certain properties, or
for debugging.
name: Get all info for this IP address
debug:
var: freeipinfo
vars:
freeipinfo: "{{ query('mm_ipinfo', provider, freeips[0]) | to_nice_json }}"

- name: Renew properties on IP
mm_ipprops:
state: present
ipaddress: "{{ freeips }}"
properties:
claimed: false
location: Madrid
provider: "{{ provider }}"
delegate_to: localhost
- name: Get all info for this IP address
debug:
var: freeipinfo
vars:
freeipinfo: "{{ query('mm_ipinfo', provider, freeips[0]) | to_nice_json }}"
- name: Remove properties of IP
mm_ipprops:
state: present
ipaddress: "{{ freeips }}"
deleteunspecified: true
properties:
claimed: false
provider: "{{ provider }}"
delegate_to: localhost
- name: Get all info for this IP address
debug:
var: freeipinfo
vars:
freeipinfo: "{{ query('mm_ipinfo', provider, freeips[0]) | to_nice_json }}"
- name: Remove reservation on IP address
mm_dhcp:
(continues on next page)
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state: absent
name: testhost
ipaddress: "{{ freeips }}"
macaddress: "de:ad:be:ef:16:10"
provider: "{{ provider }}"
delegate_to: localhost
- name: Get all info for this IP address
debug:
var: freeipinfo
vars:
freeipinfo: "{{ query('mm_ipinfo', provider, freeips[0]) | to_nice_json }}"
- name: Remove DNS record for the claimed IP
mm_dnsrecord:
state: absent
dnszone: testzone
name: testhost
data: "{{ freeips[0] }}"
provider: "{{ provider }}"
delegate_to: localhost
- name: Remove the PTR DNS record for the claimed IP
mm_dnsrecord:
state: absent
dnszone: "{{ (freeips[0] | ipaddr('revdns')).split('.')[1:]
name: "{{ freeips[0] | ipaddr('revdns') }}"
data: "testhost.testzone."
rrtype: PTR
provider: "{{ provider }}"
delegate_to: localhost

| join('.') }}"

- name: Get all info for this IP address
debug:
var: freeipinfo
vars:
freeipinfo: "{{ query('mm_ipinfo', provider, freeips[0]) | to_nice_json }}"
- name: Ensure the zone absent
mm_zone:
state: absent
name: thetestzone.com
nameserver: mandm.example.com
authority: mandm.example.net
masters: mandm.example.net
servtype: master
provider: "{{ provider }}"
delegate_to: localhost
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1.17.4 Terraform
Installing the Micetro provider for Terraform
Download compiled binaries
Precompiled binaries for Windows and Linux are available on the Men&Mice download server.
Manual Build and Install
Mac or Linux
make install
Windows
1. Build and install the provider:
go build -o terraform-provider-menandmice.exe
2. Copy the terraform-provider-menandmice.exe to:
• for Terraform 0.12: %APPDATA%\terraform.d\plugins\windows_amd64\
• for Terraform 0.14: %APPDATA%\terraform.d\plugins\registry.terraform.io\local\menandmice\
0.2.0\windows_amd64\
3. Initialize:
terraform.exe init

Run acceptation test
Define the Micetro server:
dnsserver: micetro.example.net. micetro.example.com.
dhcpserver: micetro.example.net.
ipam-properties: location
Set provider settings that are not set in main.tf:
export MENANDMICE_ENDPOINT=<api-endpoint>
export MENANDMICE_USERNAME=<your username>
export MENANDMICE_PASSWORD=<your password>
And make a test account:
make testacc
For using the Micetro provider, see Using the Micetro provider with Terraform.
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Using the Micetro provider with Terraform
menandmice_dhcp_reservation
Schema
Required
name

(String) The name of DHCP reservation you want to query.

Optional
id

(String) The ID of this resource.

Read-Only
addresses
(List of String) A list of IP addresses used for the reservation.
client_identifier
(String) The client_identifier of this reservation.
ddns_hostname
(String) Dynamic DNS host name for reservation.
Note: Only applicable for ISC DHCP servers.
description
(String) Description for the reservation.
Note: Only applicable for MS DHCP servers.
filename
(String) The filename DHCP option.
Note: Only applicable for ISC DHCP servers.
next_server
(String) The next-server ISC DHCP option.
Note: Only applicable for ISC DHCP servers.
reservation_method
(String) DHCP reservation method, For example: HardwareAddress, ClientIdentifier.
HardwareAddress.

1.17. Automation

Default:

347

Micetro by Menamp;Mice Documentation, Release 10.2

servername
(String) The server-name DHCP option.
Note: Only applicable for ISC DHCP servers.
type

(String) The type of this DHCP reservation. For example: DHCP, BOOTP, BOTH.

owner_ref
(String) Internal reference to the DHCP group scope or server where this reservation is made.
ref

(String) Internal reference to this DHCP reservation.

Example
terraform {
required_providers {
menandmice = {
# uncomment for terraform 0.13 and higher
version = "~> 0.2",
source = "local/menandmice",
}
}
}
data menandmice_dhcp_reservation reservation1 {
name = "reserved1"
}

menandmice_dhcp_scope
Schema
Required
cidr

(String) The cidr of the DHCP scope.

Optional
dhcp_server
(String) The DHCP server of this scope.
id

348

(String) The ID of this resource.

Chapter 1. Table of Contents

Micetro by Menamp;Mice Documentation, Release 10.2

Read-Only
available
(Number) Number of available addresses in the address pool(s) of the scope.
description
(String) A description for the DHCP scope.
enabled
(Boolean) If this scope is enabled.
name
ref

(String) The name of the DHCP scope you want to query.
(String) Internal reference to this DHCP reservation.

superscope
(String) The name of the superscope for the DHCP scope.
Note: Only applicable for MS DHCP servers.

Example
terraform {
required_providers {
menandmice = {
# uncomment for terraform 0.13 and higher
version = "~> 0.2",
source = "local/menandmice",
}
}
}
data menandmice_dhcp_scope scope1{
dhcp_server= "micetro.example.net."
cidr = "192.168.2.0/24"
}

menandmice_dns_zone
Schema
Required
name

(String) Fully qualified (with the trailing dot .) name of DNS zone.

server
(String) Fully qualified name of the DNS server where the record is stored, ending with the trailing dot ..
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Optional
id
view

(String) The ID of this resource.
(String) Name of the view this DNS zone is in.

Read-Only
adintegrated
(Boolean) If the DNS zone is AD integrated. Default: False.
authority
(String) The authoritative DNS server for this zone. Requires FQDN with the trailing dot ..
custom_properties
(Map of String) Map of custom properties associated with this DNS zone.
displayname
(String) A name that can distinguish the zone from other zone instances with the same name.
dnssecsigned
(Boolean) If DNS signing is enabled.
dnsviewref
(String) Internal references to views.
dnsviewrefs
(Set of String) Internal references to views.
Note: Only used with Active Directory.
dynamic
(Boolean) If DNS zone Dynamic, default: False.
kskids
(String) A comma separated string of IDs of KSKs, starting with active keys, then inactive keys in parenthesis
().
lastmodified
(String) Date when zone was last modified Micetro.
ref
type

(String) Internal references to this DNS zone.
(String) the DNS zone type. For example: Master, Slave, Hint, Stub, Forward.

zskids
(String) A comma separated string of IDs of ZSKs, starting with active keys, then inactive keys in parenthesis
().
masters
(List of String) List of all masters IP address, for slave zones.
adpartition
(String) The Active Directory partition if the zone is AD-integrated.
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adreplicationtype
(String) Replication types for an AD-integrated zone.
created
(String) Date when zone was created in Micetro.
Import
Import is supported using the following syntax:
# import with dnszone ref
terraform import menandmice_dns_zone.resourcename DNSZones/659
# import with readable name
terraform import menandmice_dns_zone.resourcename micetro.example.net::zone1
˓→<view>:<dnszone name>

#<server>:

Example
terraform {
required_providers {
menandmice = {
# uncomment for terraform 0.13 and higher
version = "~> 0.2",
source = "local/menandmice",
}
}
}
data menandmice_dns_zone zone1 {
name = "zone1.net."
server = "micetro.example.net."

menandmice_dns_record
Schema
Required
name

(String) The name of the DNS record.

server
(String) The DNS server where this DNS record is stored.
Note: Requires FQDN, with the trailing dot ..
zone

(String) The DNS zone where the record is stored.
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Note: Requires FQDN, with the trailing dot ..
type

(String) The DNS recod type. This can be: A, AAAA, CNAME, DNAME, DLV, DNSKEY, DS, HINFO, LOC, MX, NAPTR,
NS, NSEC3PARAM, PTR, RP, SOA, SPF, SRV, SSHFP, TLSA, TXT. Default: A.

Optional
id
view

(String) The ID of this resource.
(String) The optional view where this DNS record is in. For example: internal.

Read-Only
ttl
aging

(Number) The DNS record’s Time To Live value in seconds, setting how long the record is allowed to be cached.
(Number) The aging timestamp of dynamic records in AD integrated zones. Hours since January 1, 1601, UTC.
Note: Providing a non-zero value creates a dynamic record.

comment
(String) Comment string for this record.
Note: Only records in static DNS zones can have a comment string.
Some cloud DNS provides do not support comments.
enabled
(Boolean) If this DNS record should enabled. Default: True.
data

(String) The data stored in the DNS record.

dns_zone_ref
(String) Internal reference to the zone where this DNS record is stored.
ref
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Example
terraform {
required_providers {
menandmice = {
# uncomment for terraform 0.13 and higher
version = "~> 0.2",
source = "local/menandmice",
}
}
}
data menandmice_dns_zone zone1 {
name = "zone1.net."
server = "micetro.example.net."
}
data menandmice_dns_record rec1 {
name = "test"
zone = data.menandmice_dns_zone.zone1.name
server = "micetro.example.net."
type = "A"
}

# "zone1.net."

menandmice_ipam_record
Schema
Required
address
(String) The IP address.
Optional
id

(String) The ID of this resource.

Read-Only
claimed
(Boolean) If the IP address is claimed. Default: true.
custom_properties
(Map of String) Map of custom properties associated with this IP address.
Note: You can only assign properties that are already defined in Micetro.
device
(String) The device associated with the object.
1.17. Automation
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discovery_type
(String) The discovery method of the IP address. For example: None, Ping, ARP, Lease, Custom.
extraneous_ptr
(Boolean) Contains true if there are extraneous PTR records for the record.
hold_info
(List of Object) Contains information about who holds the otherwise free IP, and for how long. (See Nested
Schema for hold_info.)
interface
(String) The interface associated with the object.
last_discovery_date
(String) The date when the system last performed IP address discovery for this IP address.
last_known_client_identifier
(String) The last known MAC address associated with the IP address discovery information.
last_seen_date
(String) The date when the address was last seen during IP address discovery.
ptr_status
(String) PTR record status. For example: Unknown, OK, Verify.
ref
state
usage

(String) Internal reference for the IP address.
(String) state of IP address. For example: Free, Assigned, Claimed, Pending, Held.
(Number) IP address usage bitmask.

Nested Schema for hold_info
Read-Only:
expiry_time
(String)
username
(String)
Example
terraform {
required_providers {
menandmice = {
# uncomment for terraform 0.13 and higher
version = "~> 0.2",
source = "local/menandmice",
}
}
}
data menandmice_ipam_record ipam1 {
(continues on next page)
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address = "192.168.2.2"
}
With the Micetro plugin for Terraform (via the menandmice provider), you can automate Micetro operations via Terraform.

1.18 System Settings
From the menu bar, select Tools, System Settings.
The System Settings dialog box displays and includes these tabs:
• General
• Logging
• Error Checking
• Save Comments
• External Commands
• DNS
• IPAM
• Monitoring

1.18.1 General
Through this function, you can specify the following:
• Whether to allow single sign-on
• Settings for AD Sites and Subnets integration
• Rules to determine when an IP address is considered as being in use
• Advanced system settings
To display the General Settings dialog box, do the following:
1. From the menu bar, select Tools → System Settings.
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2. In the System settings dialog box, click the General tab.
Allow Single Sign-on.
When selected, Active Directory users do not have to authenticate when logging in through the Management
Console or the Command Line Interface. See External Authentication.
Allow single sign-on through web interface on IIS.
To enable single sign-on in the web interface, the web server needs to be configured. Refer to External Authentication.
Enable AD sites and subnets integration.
Check this checkbox to enable the integration feature. When the integration is active, all sites and their corresponding subnets in Active Directory displays in Micetro and you can add and remove subnets in sites and move
subnets to different sites. Once Sites and Subnets integration has been enabled, an AD Sites object displays in
the object list on the left hand side of the Manager window and a new column, AD Site displays in the range list
in the Manager window. If you want to synchronize the Location and Description fields of the subnets in Active
Directory against custom properties in Micetro, choose the custom properties to synchronize against. When synchronization is active, any changes made to the fields in Active Directory will update the corresponding fields in
Micetro and vice versa. See AD Sites and Subnets.
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Enforce AD site inheritance.
Select this checkbox if you want to enforce site inheritance in AD. When site inheritance is enforced, child
subnets must reside in the same site as the parent subnet. If site inheritance is not enforced, child subnets can be
placed in different sites than the parent subnet. See AD Sites and Subnets.
Determine Address in use.
This section contains several checkboxes that determine whether an IP Address should be considered as being in
use. Check the appropriate checkboxes to specify which rules should be applied to the IP Addresses.
Advanced system settings.
Click this button to display the dialog box for entering advanced system settings. For more information about
the contents of this dialog box, see the Men&Mice Knowledge Base.
3. When the desired selections/entries are made, click OK.

1.18.2 Logging
Through this function, you specify when log messages should be purged and whether lease history for DHCP servers
should be collected.
1. From the menu, select Tools → System Settings.

2. In the System Settings dialog box, click the Logging tab.
1.18. System Settings
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Purge log message after ____ days.
When selected a number is typed in the field indicating the number of days the logs should be kept.
Log extra information when address collection is triggered.
When selected, information about the start and duration of the address collection is written in the Micetro log
file.
Lease History.
Through this function, you configure the setting that allows for viewing the history of DHCP leases.
• Collect lease history for DHCP servers. Click the checkbox to begin history collection for DHCP servers.
• Purge lease history after ___ days. Click the checkbox to select this option. Then, in the field, type the
number of days to retain the history.
• Flush lease history to file before purging. To save the lease history to a comma separated text file before it
is purged, click the checkbox, and then type the name of the file.
3. When all selections/entries are made, click OK.

1.18.3 Error Checking
The Error Checking tab allows you to specify how the system reports certain errors related to DHCP and DNS. This
tab is also used to enable or disable DHCP scope monitoring.
1. From the menu bar, select Tools → System Settings.
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2. In the System Settings dialog box, click the Error Checking tab.
Ignore missing reverse zones.
An error message displays when Micetro is unable to update a reverse record for a changed address record. It
is possible to suppress this error message if no reverse zone exists for the given address record by selecting the
Ignore missing reverse zones checkbox.
Warn when creating A/AAAA records with name that already exists.
When enabled, a warning message displays if a user creates an address (A or AAAA) record using the name of
an existing record of the same type.
Inconsistencies in DHCP lease names and DNS names.
When enabled, an icon displays for each DHCP lease for which the DNS name does not match the lease name.
The user can click on the icon and display a dialog box showing details about the error and (if applicable) how
to fix it.
Address pool collisions.
When enabled, an icon displays in split scope entries if the address pool in the scope collides with the address
pool of another split scope instance. The user can click on the icon and display a dialog box showing details
about the error and (if applicable) how to fix it.
Inconsistencies between reservation names in split scopes.
When enabled, an icon displays in split scope entries if a reservation name in a split scope differs from the
reservation name in another split scope instance. The user can click on the icon and display a dialog box showing

1.18. System Settings

359

Micetro by Menamp;Mice Documentation, Release 10.2

details about the error and (if applicable) how to fix it.
Inconsistencies between reservation descriptions in split scopes.
When enabled, an icon displays in split scope entries if a reservation description in a split scope differs from the
reservation description in another split scope instance. The user can click on the icon and display a dialog box
showing details about the error and (if applicable) how to fix it.
When all selections/entries are made, click OK.

1.18.4 Save Comments
When saving changes to various objects, the Save Comment window may display. When this window displays is
determined by the selections you make on this tab. The user simply types comments into the dialog box, explaining a
reason for any actions taken (e.g., delete object as it was a duplicate). Then the user clicks OK.
To define when comments can be entered (and this can only be when logged on as a System Administrator), do the
following:
1. From the menu bar, select Tools → System Settings.

2. In the System settings dialog box, click the Save Comments tab.
3. Click in the checkbox next to all the instances in which you want the Save Comment dialog box to display.
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4. When all selections are made, click OK.

1.18.5 External Commands
Refer to External scripts.

1.18.6 DNS
Use the DNS settings dialog box to specify various DNS related settings. To display the DNS Settings dialog box, do
the following:
1. From the menu bar, select Tools –> System Settings.

2. In the System Settings dialog box, click the DNS tab.
Delegation records.
When automatically create delegation records when creating new zones is selected, delegation records (NS
records) are automatically created in the corresponding parent zones when subzones are created, maintaining
a correct delegation chain between parent and subzones.
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Adjust Zone Transfer.
Select the checkbox to allow Micetro to automatically adjust zone transfer settings on Microsoft DNS servers to
enable management of dynamic and Active Directory integrated zones.
DNSSEC.
Select the checkbox to include derived DNSSEC records when viewing DNSSEC signed zones in Micetro. Note
that this will increase the size of the Micetro database significantly and may affect overall system performance.
3. When the desired selections/entries are made, click OK.

1.18.7 IPAM
The IPAM tab allows you to specify various IPAM related settings:
• How the system should handle new subranges if the parent range is in a folder.
• How the system should behave if DHCP scopes are removed outside Micetro.
• How the system should behave when naming conflicts between existing IP Address ranges and DHCP scopes
occur.
• Whether the system should allow reservations inside address pools on ISC DHCP servers.
1. From the menu bar, select Tools → System Settings.
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2. In the System Settings dialog box, click the IPAM tab.
Subranges.
The selection made here determines what happens when a user creates a subrange of a range in a folder. Click
the desired action.
DHCP Scope Deletion.
If a scope is removed directly from a DHCP server (instead of using Micetro), you can select whether to convert
it to an IP Address range or remove it completely.
Name conflicts between ranges and scopes.
The selection made her determines what happens if the name of an MS DHCP scope does not match the name
of an existing IP Address range.
Apply same rule for scope description as for scope name above.
When selected, the system will use the same rules to update scope description as it does for updating scope
names.
Allow reservations inside pools on ISC DHCP servers.
When selected, the system allows users to create reservations inside pools on ISC DHCP servers. When a reservation is created inside a pool, the pool is split to make space for the reservation.
Warning: If a reservation that has been created inside a pool is deleted, the address is not made a part of
the pool again.
Show DHCP data in subranges of scopes.
When selected, the system will display contents of subranges of scopes in the same view that is used for scopes
and users with the required privileges will be able to work with reservations in these subranges. If the checkbox
is not selected, contents of subranges of scopes will be displayed in the regular range view.
Allow allocation of IP Addresses from IP Address Containers.
When selected, the system will allow allocation of IP Addresses that reside in IP Address Containers. For more
information on IP Address Containers, refer to IPAM Settings.
Enable Cloud integration.
Check this checkbox to enable the Cloud integration feature. When Cloud integration is active you can add
OpenStack clouds to Micetro. You can manage cloud networks and and you can add and remove subnets from
cloud networks and move subnets to cloud networks. Cloud integration has been enabled, a Cloud object displays
in the object list on the left hand side of the Manager window and a new column, Cloud Network displays in the
range list in the Manager window.
3. When all selections/entries are made, click OK.

1.18.8 Monitoring
Use the Monitoring settings dialog box to specify various monitoring related settings.
To display the Monitoring Settings dialog box, do the following:
1. From the menu bar, select Tools → System Settings.
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1. In the System Settings dialog box, click the Monitoring tab.
Ping before automatic assignment.
When selected, when an IP Address is being auto-assigned, the system checks as to whether the IP Address is
responding to a ping request before it is allocated to a new host. If the IP Address responds to the ping request,
it is not used for auto-assignment.
Automatic assignment ping timeout _____ ms.
Specifies how long the system should wait (in milliseconds) for a response to the ping request. If a response is
not received within the specified time, the system considers this to be a non-responding IP Address.
Enable subnet monitoring.
When enabled, the system monitors the free addresses in DHCP address pools and subnets, and performs an
action if the number of free addresses goes below a user-definable threshold. When subnet monitoring has been
enabled, it is possible to configure the global settings for this feature by clicking the Details button.
Note: The global subnet monitoring setting can be overridden for individual subnets by changing the setting
explicitly for the subnet. Refer to IP Address Management—Subnet Monitoring and Utilization History for
information on how to change monitoring settings for individual subnets.
To change the subnet monitoring settings, do the following:
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1. Click the Defaults. . . button. The Subnet Monitoring dialog box displays.

Enabled.
When checked, all subnets are monitored by default. If you only want to monitor a subset of the
subnets in the system, leave this checkbox unchecked and enable monitoring for the individual
subnets instead by selecting the subnet and then selecting Set Subnet Monitoring from the Range
menu.
Script to invoke.
Enter the path of the script to run when the number of free addresses goes below the set threshold.
Refer to External Scripts for information on the script interface and the format for calling the
script.
Dynamic Threshold.
Enter the threshold for the free addresses in a DHCP scope address pool.
Note: For split scopes and scopes in a superscope (on MS DHCP servers) and address pools
using the shared-network feature on ISC DHCP servers, the total number of free addresses in all
of the scope instances is used when calculating the number of free addresses.
Static Threshold.
Enter the threshold for the free addresses in a subnet.
Only perform action once (until fixed).
When checked, the action is performed only once when the number of free addresses goes below
the threshold.
Perform action when fixed.
When checked, the action is performed when the number of free addresses is no longer below
the threshold.
When subnet monitoring is enabled, a new column, Monitoring, displays when viewing the subnet list. To quickly
see all subnets that are monitored, you can use the Quick Filter and filter by this column by entering “Monitor:
Yes” in the Quick Filter search field.
Note: Only DHCP scopes that are enabled are monitored. Disabled scopes are ignored.
When subnet monitoring is enabled, you must specify the mail server and the sender e-mail address to use if you
want the subnet monitor to send an e-mail. Place the appropriate information in the SMTP Server and Mail from
fields.
Enable sending SNMP traps.
When enabled, the system will send SNMP traps when certain events occur:
• When the number of free IP Addresses in monitored subnets goes below a user-definable threshold.
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• When a log event of type Error or Notice occurs. Refer to Logging for more information on log events.
When enabling sending of SNMP traps, you must provide additional information:
Manager name.
Enter the host name of the computer that should receive the SNMP traps.
Manager port.
Enter the port number the Manager uses for the SNMP traps.
Community.
Enter the community string (password) to use for the SNMP traps.
Enable collection of IP information from routers.
When enabled, the system will query hosts that have been specified as routers for IP information. This feature is
used along with the host discovery Ping feature to find active IP Addresses on the network. Refer to IP Address
Management—Host Discovery for more information on how to specify hosts as routers.
When this feature is enabled, some additional information must be provided:
SNMP query interval.
Determines how frequently the routers are queried for IP information.
Router SNMP community.
Enter the SNMP community string (password) to use when querying the routers for IP information.

1.19 Access control
Important: Micetro 10.1 (released in September 2021) brought changes to the access management in order to make it
more streamlined and easier to use, while keeping the flexibility. This page describes the new access control. If you’re
using an older version, or would like information on the legacy access control model, see access-control-legacy.

1.19.1 Overview
Access control in Micetro is role-based.
Objects (servers, zones, scopes, IP addresses, etc.) in Micetro are accessed through Roles configured with Permissions.
Users and Groups do not have direct access to objects, only if they’re assigned to roles. Administrators can control a
user or group’s access by assigning or removing them from roles.

366

Chapter 1. Table of Contents

Micetro by Menamp;Mice Documentation, Release 10.2

1.19. Access control

367

Micetro by Menamp;Mice Documentation, Release 10.2

A set of Built-in roles are available that should cover most use cases. These are General roles, applied to all objects
(present and future) in Micetro. Specific roles exist for use cases where per-object permissions are required.

1.19.2 Groups, users, and roles
The relationship between Groups, Users, and Roles is as follows:
• Users and groups can be assigned to roles.
• Groups can contain users.
• Groups cannot contain groups.
• Users from externally managed groups, such as Active Directory, cannot be added to local groups.
• Users and groups can be assigned to any number of roles.

1.19.3 The administrator user
The built-in, local administrator user exists outside of regular access controls. All permissions are enabled for this
user (even if not attached to any role) and its permissions cannot be edited or overriden (see Block permission) by any
role.
The password for the administrator user is configured during the first-run-wizard.
The administrator user cannot be removed from Micetro, and is always local (cannot be authenticated by SSO).

1.19.4 New objects
When a user imports or creates a new object (such as DNS zone, record, DHCP scope, IPAM range, etc.) in Micetro, the
object is configured for a certain default access based on the permissions for the object type. General roles configured
with permissions for the object type will have automatic access to the object.

1.19.5 Access control management
Because Micetro’s access controls are role-based, permissions are configured on the role, and propagated to any user
or group attached to the role.
To grant restricted access on a per-object basis, see Specific roles.
To check access to a specific object and troubleshoot access control issues, see Effective access.

Permissions
Permissions are access flags, configured on roles and pertaining to types of objects.
Permissions determine what type of objects the role has access to, and what kind of access it has to them.
For a full list of available permissions see Permissions reference.
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Setting permissions

Note: Permissions for built-in-roles cannot be modified.
1. Navigate to Admin → Configuration → Roles in the web application.
2. Select the role you want to edit, and double click it. (Or use the Edit role properties action from the top bar or
ellipsis menu.)
Note: Permissions can only be edited on individual roles.
3. Switch to the Access tab.
4. Edit the permissions as needed.
5. Click Save.
Note: When setting access on a role, adding a permission will automatically enable all dependent permissions as well
to prevent access problems.
An information button will appear on the top right of the dialog box, providing a summary of dependent permissions
enables if hovered over.
Turning off the permission(s) will not disable the automatically enabled dependent permissions. Turning off the dependent permission(s) will still allow the role to be saved.

Block permission
When a permission is enabled, it’ll set the access flag to allow. When you block a permission on a role, it is set as
deny and prevent any other role to overwrite that permission.
Example: The role Worfklow Blocked has the “Access to Workflow module” permission blocked. The built-in role
“DNS approvers” has this permission enabled. Attaching user janedoe to both roles will result in the user not being
able to access the Workflow module. Even though the DNS approvers role would allow it, the permission block set in
Workflow Blocked will prevent it to take effect.
Note: Permissions that are not set are simply returned as “null.” These empty access flags are not equivalent to ‘deny’
and can be overwritten by access flags configured in other roles.

Roles
Through roles you can manage access control in Micetro.
Objects (servers, zones, scopes, IP addresses, etc.) in Micetro are accessed through Roles configured with Permissions.
Users and Groups do not have direct access to objects, only if they’re assigned to roles. Administrators can control a
user or group’s access by assigning or removing them from roles.
Note: This page is for generic management of roles. See General roles, Specific roles, and Legacy roles for the
particularities of the different role types.
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Adding a new role
Through this function, you add new roles to Micetro.
1. Navigate to Admin → Configuration and select Roles in the filtering sidebar. The built-in roles are displayed
here, as well as all other roles that have been added to Micetro already.
2. Click the Create button. The Create role dialog box displays.

Role name
Give the new role a name.
Description
Brief description for the role.
Tip: Using clear and descriptive names and descriptions makes access management easier.
3. Switch over to the Access tab and set the permissions. (See Permissions.)
4. When all necessary information and permissions are configured, click Save.
Note: The default for new roles is General roles.

Tip: See Example role configuration: DHCP read-only for an example process for creating a role anew.
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Editing a role
Through this function, you can edit the role’s name, description, permissions, and attached users/groups.
1. Navigate to Admin → Configuration and select Roles in the filtering sidebar.
2. To select a single role, click on the role’s name. To select multiple roles, press/hold the Ctrl (Cmd on Mac) key
and then click on each role’s name.
3. From the ellipsis menu, select Edit role properties or use Actions → Edit role properties.
4. Make the desired changes to the role’s information. In the Users and Groups tabs you can remove users/groups
from the role.
5. Click Save to save the changes.
Deleting a role
Through this function, you remove a role from Micetro.
Note: Built-in roles cannot be removed.
1. Navigate to Admin → Configuration and select Roles in the filtering sidebar.
2. To remove a single role, click on the role’s name. To remove multiple roles, press/hold the Ctrl (Cmd on Mac)
key and then click on each role’s name.
3. From the ellipsis menu, select Remove role or use Actions → Remove role.
4. To remove the role, click the Yes button. The role is removed.
Duplicating a role
It is possible to duplicate roles and copy the original’s configured permissions, users, and groups to a new role.
1. Navigate to Admin → Configuration → Roles in the web application.
2. Use the + Create –> From existing role action from the top bar.

3. Select the role to duplicate, and name the new role.
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4. Select which properties (permissions, groups, roles) to copy.
5. Click Create.
Tip: See Example role configuration: DNS zone read-write for an example process for creating a role from an existing
template.

General roles
General roles* are the default role type, whose permissions are automatically applied (if applicable) to all objects in
Micetro, present and future.
To create a General role, follow the instructions on Roles, and select the General type from the dropdown in the role
creation dialog. (The default type is General.)
Example: The general role DNS editor has the Edit zone options permission enabled. Any ‘DNS zone’ type object
in Micetro, whether already existing or added in the future, will be accessible to users/groups attached to this role.
Built-in roles
Micetro has seven built-in general roles that will likely cover most use cases for access control.
The built-in roles are the following:
Administrators
Full access to all objects
DNS Administrators
Full access to DNS objects, including zones, DNS servers, etc.
DHCP Administrators
Full access to DHCP objects, including scopes, DHCP servers, etc.
IPAM Administrators
Full access to IPAM objects, including IPAM ranges, etc.
User Administrators
Full access to User and Group objects.
DNS viewers
Can view DNS objects and information, but not make changes.
IPAM viewers
Can view IPAM and DHCP objects and information, but not make changes.
Requesters
Able to make and queue DNS change requests. (See Workflow Management.)
Approvers
Able to see and approve/deny submitted DNS change requests. (See Workflow Management.)
Note: Built-in roles cannot be deleted.
Permissions for built-in roles cannot be modified.
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Note: General roles can be restricted from accessing single objects. See Object access.

Specific roles
Specific roles are a role type whose permissions are not automatically applied to objects in Micetro. They’re intended
to allow managing access on a per-object basis.
To create a Specific role, follow the instructions on Roles, and uncheck the General checkbox in the role creation
dialog. (The default value is checked.)
Example: The specific role example.com editor has the Edit zone options permission enabled. No ‘DNS zone’
type object in Micetro, whether already existing or added in the future, will be accessible to users/groups attached to
this role unless specifically added to the object.
Warning: Specific roles are only intended for edge use cases, and should not be regarded as the preferred method
of access control in Micetro.

Using specific roles
Access defined through specific roles isn’t applied until explicitly configured on objects.
To use a Specific role and control access to an object:
1. Open the context (DNS or IPAM) and select the object to which you’d like to restrict access.
Note: Using specific roles on an object is only possible individually, per object.
2. Use the Access action from the top bar or the ellipsis menu.
3. On the top of the dialog, remove all unneeded General roles and/or users (legacy only) configured.
3. On the bottom of the dialog, search for the Specific role and click + Add.
4. Click Save.
This will restrict access to that particular object to the selected users/groups assigned to the Specific role.
Note: Situations may arise that adding a specific role to an object would not take effect because of missing permissions
on parent objects. Micetro will calculate the necessary permissions needed, and can automatically add them to the
relevant objects.
A notification will display on the Save comment dialog, detailing the additional changes. If the user doesn’t have the
necessary access to set permissions of these objects, an advisory will display.

Note: General roles can be restricted from accessing single objects. See Object access.
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Legacy roles
Legacy roles were created to maintain backwards compatibility with older Micetro versions and facilitate migration to
the new access management model.
Roles (and certain groups and users) in existing Micetro installations (before 10.1) are automatically converted to a
legacy role during updating Micetro to 10.1 or later. They will be configured with the same permissions as before.
Legacy roles are treated as Specific roles, in that all existing objects will have their respective legacy roles associated
with them, but no newly added objects will be automatically assigned to a legacy role.
After familiarizing yourself with the new access model, you can convert legacy roles to either a General roles or Specific
roles.
Note: Permissions for legacy roles can be edited.
Legacy roles can be removed from Micetro.

Effective access
The Effective access dialog is useful for checking access for a user/group, and to troubleshoot access control problems.
Administrator with access to managing users/groups in Micetro can check the effective access of a user or group based
on the role(s) the user/group is assigned to.
1. Navigate to Admin → Configuration in the web application.
2. Select Users or Groups, depending on whose access you want to check.
3. Select the user/group in the grid, and use the Effective access action from the top bar or the ellipsis menu.
Micetro access
It shows all enabled permissions for the user/group.
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Object access
Here you can select an object type and search for a specific object to check the access the selected user/group
has, as well as where the access comes from.
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Note: The Effective access dialog will display detailed warnings if permissions to the selected object are set, but a
parent permission is not.
Example: examining effective access on a DNS zone might reveal that the user is attached to a role that has permission
to view DNS zones, but no permission to use the DNS module.

Tip: By hovering over the i icon in the permissions list, the role(s) where the permission was set is displayed.

Users
Users represent the individual people working with Micetro.
Note: In order to manage users, you have to be logged in as a user who has user management privileges. (Is attached
to a role with the access_adminUser/”Administer users/groups/roles” permission enabled.)

Note: At least one user, the administrator, is always configured for Micetro. See The administrator user.
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Adding User Accounts
Through this function, you add new users who can then be assigned to groups.
1. Navigate to Admin → Configuration and select Users in the filtering sidebar. The default administrator account
displays here, as well as any other users you have already added.
2. Click the Create button. The Create user dialog box displays.

Name

Type the username that you want to as assign to this person.
Warning: Once you have created the user name, it is not possible to change it.

Full Name and Description
(Optional) Type the user’s first and last name and a description of their duties (i.e., job title, department, etc.),
respectively.
Authentication type
Click the drop-down list and specify whether the user’s login will be authenticated by Micetro or by an external
authentication service (such as existing Active Directory account on the network). See External Authentication.
Email address
The user’s email address. Used for sending notifications such as scheduled reports, subnet monitoring updates,
etc. Disabled with external authentication.
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Password/Confirm Password
If the Authentication type selected is Men&Mice internal, you need to provide a password for the user in the
Password field. Passwords must be at least four characters in length and no longer than 20 characters. Passwords
can contain any combination of letters and numbers, but cannot include spaces or special characters. In the
Confirm Password field, re-enter the password exactly as you did in the Password field above. Disabled with
external authentication.
In the Groups and Roles tabs, select the user group(s) and role(s) to which you want to assign this user. Each user can
be assigned to none or to multiple groups and roles.
Note: If you have not created your groups, you can always come back and edit the user accounts anytime and change
the group assignments.
3. When all selections/entries are made, click Create. The new user is added to the Users list and can now use
Micetro.
Editing User Accounts
1. Navigate to Admin → Configuration and select Users in the filtering sidebar.
2. To select a single user, click on the user’s name. To select multiple users, press/hold the Ctrl (Cmd on Mac) key
and then click on each user name.
3. From the ellipsis menu, select Edit user properties or use Actions → Edit user properties.
4. Make the desired changes to the user’s information.
5. Click Save to save the changes.
Removing User Accounts
1. Navigate to Admin → Configuration and select Users in the filtering sidebar.
2. To remove a single user, click on the user’s name. To remove multiple users, press/hold the Ctrl (Cmd on Mac)
key and then click on each user name.
3. From the ellipsis menu, select Remove user or use Actions → Remove user.
4. To remove the user, click the Yes button. The user is removed.
User Inspector
Selecting an user displays a list of information in the Inspector, including the user name, authentication type, roles, etc.
Only users with user administrative privileges can see this information.
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Groups
Groups allow you to manage multiple individual users, based on needs for the same access across the system.
Adding a New Group
1. Navigate to Admin → Configuration and select Groups in the filtering sidebar. The default groups are displayed
here, as well as any other groups you have already created.
2. Click the Add button and select whether to add an external (authenticated and managed through an external
source such as Active Directory or LDAP) or create a local group (authenticated and managed through Micetro
only).
For local group the following dialog box displays:
Group name
The name for the group you are creating.
Description field
(Optional) Some information that describes the function of this group.
AD Integrated
Check this box to define this group as an Active Directory Integrated group. When checked this
group name will be matched against groups defined in Active Directory. For more information how
on this works refer to External Authentication.
Roles
Any roles that members of this group will automatically assume.
Users
Any users that you want to add to this group. (Users can be added/removed at any time.)

3. When all selections/entries are made, click Save.

1.19. Access control
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Editing a Group
Through this function, you can edit the group name and/or description, and indicate whether this group is Active
Directory integrated.
1. Navigate to Admin → Configuration and select Groups in the filtering sidebar.
2. To select a single group, click on the group’s name. To select multiple groups, press/hold the Ctrl (Cmd on Mac)
key and then click on each group’s name.
3. From the ellipsis menu, select Edit group properties or use Actions → Edit group properties.
4. Make the desired changes to the group’s information. In the Users tab you can remove users from the group.
5. Click Save to save the changes.
Deleting a Group
Through this function, you delete a group.
1. Navigate to Admin → Configuration and select Groups in the filtering sidebar.
2. To remove a single group, click on the group’s name. To remove multiple groups, press/hold the Ctrl (Cmd on
Mac) key and then click on each group’s name.
3. From the ellipsis menu, select Remove user or use Actions → Remove user.
4. To remove the group, click the Yes button. The group is removed.
External groups (Active Directory, LDAP)
For external groups, such as those managed in Active Directory, use the Add –> AD Group or Add –> LDAP group.
The group name field must match the name in the external authentication. See External Authentication.
Note: External groups do not have a Users tab when adding the group to Micetro.
After the external group is added to Micetro, it will not contain users. Users are only added to the external group after
their first login.
For more information, see AD Sites and Subnets and External Authentication.
Object access
Single objects in the DNS, IPAM, and Admin contexts can be selected to examine and adjust access with the Action
–> Access task from the top bar or the ellipsis menu.
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Here you can add Specific roles to the object using the dropdown menu.
Note: Only specific roles that have the necessary access enabled are shown in the list.

Exclude roles from object access
If needed, General roles can be excluded from access to the single object.

1.19. Access control
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The excluded role will still be shown in the list, but greyed out and struck through.
Note: Specific roles cannot be excluded, as they’re set on single objects. The ‘exclude role’ function is available to
manage (restrict) object access on a case-by-case basis for general roles.
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Access inheritance

Note: Access inheritance is enabled for all applicable IPAM objects by default. You can change this in System Settings
in the Management Console.
For containers, scopes, and ranges in the IPAM context, users with IPAM administration permissions can configure
access inheritance. Access for objects set to inherit access from their parent cannot be edited. Editing access on the
parent object will be applied to all child objects.
If disabled, it can be enabled by using the Action –> Set access inheritance action from the top bar or ellipsis menu.
This will enable access inheritance to all existing and new child objects.

Using the Action –> Access action from the top bar or ellipsis menu allows you to disable or enable access inheritance
by checking the Inherit access from parent range checkbox.

Important: Existing access settings are not modified by disabling inheritance, but it is overwritten when enabling
it.

Note: Access inheritance honors all roles added to the parent object, including legacy and specific roles. Adding a
specific role to a parent object will apply the change to all child objects that have access inheritance enabled.

1.19. Access control
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1.20 License Management
The different functionalities of Micetro can be activated by specific license keys.
There are five different keys, one each for:
• DNS
• IPAM
Note: The IPAM license key unlocks both the DHCP and IPAM functionality of Micetro.
• Men&Mice Virtual Appliances
• Workflow module
• Reporting module

1.20.1 Viewing license keys
The Admin –> Configuration –> Licenses page shows detailed information about every key configured in Micetro,
including utilization by showing the number of DNS zones and IP Addresses in use.
The License Management page displays cards for active modules with a list of associated license keys, either active or
expired. The usage of the license (for example the number of DNS zones used, compared to the license limit) is shown
in a usage bar in the upper right of the license card. The bottom right of the card shows the expiry date for the currently
active license key.
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1.20.2 Expired keys
A notification will be shown when a license key is expired and when a license key is about to expire. This will only be
shown to members in the administrators group.

1.20.3 Adding a License Key
Adding license keys for the first time
When logging into a system that has no active licenses, the system will prompt the user and indicate that not active
license keys are in the system and offer the user to enter new license keys through the license management page.
Additional keys can be added by pasting text containing valid license keys to the textbox at the bottom of the license
management page.
1. Navigate to Admin → Configuration → Licenses.
2. To add new key(s), scroll down to the “Import license keys” section and paste in the license key(s).
Tip: You can paste in the email you received from Men&Mice, Micetro will parse the keys from the surrounding text
automatically.

3. Click +Import.

1.20.4 Removing a License Key
A license key can be removed by clicking on the trashcan icon on the the right.
A confirmation dialog will display, click Yes to confirm.
Removing expired license keys
Old, expired license keys can be cleaned up and removed using the Remove expired keys action.

1.20.5 Export license data
Active license keys and usage data can be exported from Micetro using the Export license data action. This will compile
the active keys and usage information into a single text block that can be copied.
See Update Guide.

1.20. License Management
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1.21 Admin
1.21.1 Server management
Managing DNS and DHCP servers in the system is done by navigating to Admin.
A list of all servers configured in the system is shown by default.
In the left sidebar it is possible to choose from viewing DNS servers, DHCP servers, or Appliances (if configured in
the system).

In the right hand sidebar, the properties of a selected server is shown. Any custom fields defined will also be displayed
there.
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Server Management actions
Any actions that can be performed on a selected server can either be accessed in the Actions above the list or by hovering
over a menu at the right hand side of the list.
Action
Add
DNS
server
Add DHCP
server
Add appliance
Edit
DNS
server
Attach server
Detach server
View history
Remove
server

Description
Adds a DNS server to the system.
Adds a DHCP server to the system.
Adds an Appliance to the system.
Allows to edit the server name and server properties.
Attaches a previously detached server.
Detaches or disables the server. The server can be attached again for it to be part of the server
synchronization again.
Allows to view history for the selected server.
Removes the selected server from the system.

Server states
See server-states.

1.21.2 Access Management
Access Management involves both creating groups as well as creating Users to associate with Groups.

For more information refer to Access control.

1.21.3 Configure Single Sign-On
The single sign-on feature in the Men&Mice Web Application allows users to sign in to the web using their active
directory credentials.
Note: This article assumes that both an Active Directory group has already been added to Micetro and Kerberos/NTLM has been added to the preferences file for Men&Mice Web Services.

Note: Please refer to External Authentication for help for adding active directory groups to Micetro.

1.21. Admin
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Note: Please refer to API Authentication methods for help adding Kerberos/NTLM to preferences for Men&Mice Web
Services.

Configuration
1. Make sure the user is a member of the Active Directory group already added to Micetro.
2. Log in to the workstation as the user.
3. Open up Internet Explorer, click the cogwheel and select Internet options.
4. Under the Security tab, select Trusted Sites and open up the Sites window.
5. Enter the URL (i.e. https://micetro.example.com) of the Men&Mice Web Application into the Add
this website to the zone field and click Add.
Note: It is necessary to uncheck the Require server verification for all sides in this zone if the Men&Mice
Web Application is not running on https.
6. In Internet Options click Custom Level to open Security Settings → Trusted Sites Zone.
7. Make sure that under User Authentication → Logon the Automatic logon with current username and
password is selected.
8. Open a web browser1 that supports Single Sign-On (SSO) and navigate to the Men&Mice Web Application.
9. Enter the FQDN/IP Address of the Men&Mice Central server.
10. Check the Log in with Single Sign-on and click Log In.
1

Single Sign-On is only supported in Google Chrome.
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1.22 SNMP profiles
The SNMP protocol provides a common mechanism for devices on networks to relay management information. Micetro
uses SNMP profiles to determine whether devices that have been discovered on networks are active.

Note: For configuring SNMP profiles using the Management Console, see console-snmp-profiles.

1.22.1 Create a new SNMP profile
Before a router can be queried it must be placed in an SNMP profile containing the parameters necessary to access the
SNMP information on the router.
Note: Multiple routers can share the same SNMP profile.
To create an SNMP profile:
1. Navigate to Admin –> Configuration –> SNMP Profiles.
2. Use the Add Profile action from the top bar.

1.22. SNMP profiles
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3. Enter a profile name and choose the SNMP version to use. (Supported versions are SNMP v1, v2c, and v3.) You
can also specify a non-standard port to use for SNMP.
4. Enter the necessary information to access the router using SNMP. The information is different depending on the
SNMP version selected:
For SNMP v1 and v2c:
Community

Enter the SNMP community string (password) to use to access the routers using the
profile.

For SNMP v3:
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Username
Authentication
Protocol
Password
Encryption
Protocol
Password

Enter a user name for accessing the routers using the profile.
Choose the authentication protocol to use. The available protocols are MD5 and SHA.
Enter the authentication password for the routers using the profile.
Choose the encryption protocol to use. The available protocols are AES and DES.
Enter the authentication password for the routers using the profile.

5. If needed, disable IP address and subnet synchronization.
6. Click Next.
6. Paste or enter the IPv4 address of the router(s) that you want to query using this profile.
Note: Each router’s IP address needs to be on a separate line in the text area.
6. Click Add profile to save the settings and create the profile.

1.22.2 Edit existing SNMP profile
You can edit an existing SNMP profile, to change settings or modify the routers using it.
1. Navigate to Admin → Configuration → SNMP Profiles.
2. Use the Action –> Edit SNMP Profile action from the top bar or the ellipsis menu to edit a profile’s settings. Use
the Edit routers action to modify the list of routers using the profile.

1.22.3 Scanning profiles
SNMP scanning is done automatically in the background by Micetro. Users can initiate a manual scan of all configured
profiles to pull ARP cache from the routers if needed.
Use the Scan profiles action from the top bar to manually scan all profiles.
Warning: This might take a long time and can result in higher volumes of traffic.

1.23 Custom Properties
As an administrator, you may find that it is necessary to create some custom properties. These properties are used for
entry of any data that you feel is relevant for an object. For example, if you want to specify a server is in a specific
location, or indicate who is responsible for a particular server, etc. Custom properties can be defined for various object
types.
There are two Default Custom Properties built in to the Range object, Title and Description, which may not be changed.

1.23. Custom Properties
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In addition, various properties can be set when working with custom properties objects under DNS, DHCP, and IPAM.

1.23.1 Adding a Custom Property
1. Go to Admin
2. Click on Configuration
3. Select Custom Properties
4. Select the object type for which you’d like to create a new custom property
5. Click the action button on the right or the Add Custom Property button at the bottom of the property list
6. Specify the name of the new property
7. Fill in the details:
Name:
Type a name for this custom property.
Property Type:
Set the type for the property. By default, “Text” is selected. Click the drop-down list and select the desired
property type - e.g., Text, Multiline, Select List, Yes/No, IP Address, or Number.
Required:
When selected, a user must enter a value in this field. If you select this option, you cannot select “Read only.”
Read only:
When selected, the field is locked for editing. If you select this option, you cannot select “Required”
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8. Enter the appropriate list options and values depending on the property type.
9. Click Save

1.23.2 Adding a Cascading List to an Existing List
In some situations nested lists will be necessary, for example when requesting location identity information.
1. Go to Admin
2. Click on Configuration
3. Select Custom Properties
4. Hover over the parent custom property
5. Select Add Cascading List Property
6. Fill in the appropriate details in the proper format, where the parent option comes first.
For example:
Site1:DC2

1.23. Custom Properties
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Site1:DC3
Site2:DC1
Site2:DC2

1.23.3 Reordering Custom Properties
The order in which the custom properties appear in this list will determine the order in which the property fields are
displayed in the dialog box when creating or editing the respective object. You may get a preview of the order of fields
which will appear in the dialog box by clicking on the preview button (or the eye icon) in the upper right corner as
shown in the top picture below.

After clicking on the eye icon, you will see the preview such as the following image
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1. Go to Admin
2. Click on Configuration
3. Select Custom Properties
4. Click on the object type for which you’d like to change the property order
5. Click on the pencil (edit) icon on the right
6. Drag the custom properties to the appropriate order

1.23.4 Editing a Custom Property
1. Go to Admin
2. Click on Configuration
3. Select Custom Properties
4. Hover over the Custom Property to change
5. Click the ellipsis (meatball) menu and select Edit Property

1.23.5 Deleting a Custom Property
!DANGER!
When a custom property is removed that data will be lost for all of the objects on which it was configured.

1.23. Custom Properties
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1. Go to Admin
2. Click on Configuration
3. Select Custom Properties
4. Hover over the Custom Property to change
5. Click on the ellipsis (meatball) menu and select Remove Property

1.23.6 Adding a Custom Property (Management Console)
1. From the menu bar, select Tools → Define Custom Properties. The Define Custom Properties dialog box displays.

2. Select the object type to which you want to add a custom property.
3. Click the Add button. The Custom Property dialog box displays.
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4. Fill in the details:
Name.
Type a name for this custom property.
Type.
Set the type for the property. By default, “Text” is selected. Click the drop-down list and select the
desired property type - e.g., Text, Yes/No, IP Address, or Number.
Mandatory.
When selected, a user must enter a value in this field. If you select this option, you cannot select
“Read only.”
Read only.
When selected, the field is locked for editing. If you select this option, you cannot select “Mandatory.”
Multiline.
When selected, the edit field contains multiple lines for entry. If you select this option, you cannot
select “List.”
Predefined Values.
When selected, the field displays as a drop-down list. Click the checkbox for List. Then click the
Edit List button. The Custom Property List Items dialog box through which you can add, edit, and
remove custom properties displays.
Note: If you select this option, you cannot select “Multiline”.
• To ADD an item for this property, click Add. The Custom Property List Items dialog box displays.

1.23. Custom Properties
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• Type the item in the field provided.
• Add any additional items. You can move items Up and/or Down in the list, as desired. This
designates the order in which they appear in the list.
• Then click OK. When you return to the Custom Property List Items dialog box, the items entered
are shown.

• To edit/remove any values, click Edit List and make the necessary changes.
• When all selections are made, click OK.
Default value.
Specifies the default field value to use when an object is created. This field is only a drop-down list
if the ‘List’ checkbox is selected; otherwise, it is an edit field.
5. When all selections/entries are made, click OK. When you return to the Define Custom Properties dialog box,
the new field is shown.
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6. If there are multiple custom properties for an object, use the Move Up/Move Down arrows to change the order
in which this display in the object window.
7. When all fields are added, click the Save button.

1.23.7 Editing a Custom Property (Management Console)
To edit a custom property, do the following:
1. From the menu, select Tools → Define Custom Properties.
2. Locate and highlight the property to be edited.
3. Click the Edit button.
4. Make the necessary changes.
5. Click OK.

1.23.8 Deleting a Custom Property (Management Console)
To delete a custom property, do the following:
1. From the menu, select Tools → Define Custom Properties.
2. Locate and highlight the property to be deleted.
3. Click the Delete button.
4. When the confirmation message displays, click Yes.
5. Click OK.

1.23.9 Displaying a Custom Property (Management Console)
Once a custom property has been defined, it is possible to view and edit its contents by opening the Properties dialog
for any object of the type for which the custom property has been defined.

1.23.10 Opening a Custom Property URL (Management Console)
Anytime you have specified a URL within a custom property, you can use this option to open the URL.
1. Locate the item containing the URL.
2. Right-click and, from the shortcut menu, select Properties.
3. In the Properties dialog box, move to the field containing the URL.
4. Place the cursor anywhere in the field and right-click.
5. From the shortcut menu, select Open URL.

1.23. Custom Properties
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6. Your browser will open and the web site for the URL displays.

1.24 Scheduled Scripts
The administrator can configure the system to run scripts in a schedule – e.g., to back up the database every night at
3:00 AM, perform changes early in the morning, etc.
To configure this option, do the following:
1. From the menu bar, select Tools → Scheduled Scripts. The Scheduled Scripts dialog box displays. Any already
defined scripts are displayed.

2. To add a new script, click the Add button. The Schedule Script dialog box displays.
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Script name.
In the applicable Script name field, type the script name and necessary startup parameters. You must enter all
information for the script as you would when invoking the script from the command line. It is assumed that the
script is located in the same directory as the Men&Mice Central database file (mmsuite.db); however, if the script
is stored in a different location, the path for the script must be entered.
Example 1: Running a script named mytest.vb. To run a script named mytest.vb that is located in the Men&Mice
Central directory using the scripting host cscript, the following would be placed in the appropriate field: cscript /B
mytest.vb.
Example 2: Running an executable named checkdata.exe. To run an executable named checkdata.exe that is located in
the Men&Mice Central directory the following would be placed in the appropriate field: checkdata.exe.
It is possible to create a special user that has permissions to run scripts. When this user exists, it is possible to execute
scripts that access Micetro without having to enter a user name and password in the script itself.
To enable this feature, create a user named ScriptRunner. This user must use the Men&Mice Internal authentication
method. When this user has been created, you only have to enter $u as a user name and $p as a password when logging
in to Micetro through the script.
Note: This method only works if the script scheduler invokes the script. When running the script, Micetro uses a
temporary password that changes every time the script runs.
Example 1: The following example shows how the command line interface can be invoked by the scheduler to execute
a backup. This statement can be entered directly into the Script name field:
mmcmd -s 127.0.0.1 -u $u -p $p backup;exit
Example 2: The following Visual Basic script checks which users are logged in and writes the list of logged in users
to the file logger.txt. To invoke the script you would enter the following statement into the Script name field:
cscript /B scripts\test.vbs $u $p
' Script starts here
Option Explicit
Dim objArgs, objFSO, objShell, objFile, objTextFile
Dim strFile, strUser, strPassword, i
strFile = "logger.txt"
strUser = ""strPassword = ""
(continues on next page)

1.24. Scheduled Scripts
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(continued from previous page)

' We should get username and password as arguments
Set objArgs = WScript.Arguments
If objArgs.Count > 0 Then str
User = objArgs(0)
End If
If objArgs.Count > 1 Then
strPassword = objArgs(1)
End If
' First we move into the right directory
set objShell = createobject("wscript.shell")
Set objFSO = CreateObject("Scripting.FileSystemObject")
objShell.CurrentDirectory = objShell.CurrentDirectory & "\scripts"
' write extra info into the log file
If Not objFSO.FileExists(strFile) Then
Set objFile = objFSO.CreateTextFile(strFile)
End If
set objFile = nothing
Set objTextFile = objFSO.OpenTextFile(strFile, 8, True)
objTextFile.WriteLine("*****")
objTextFile.WriteLine("Date/Time: " & Now())
objTextFile.Close
objShell.Run "cmd /c mmcmd.exe -s 127.0.0.1 -u " & strUser & " -p " & strPassword & "␣
˓→who; exit >> " & strFile, 0, true
set objShell = nothing
WScript.Quit
Enabled.
Click the checkbox to enable the scheduling process for the script. Likewise, at any time if you wish to disable
the script, return to this dialog box and uncheck this option.
Run on.
Either type the date the script should run, or click the drop-down list field and select the date from the calendar.
At.

Type or use the up/down arrows to select the time.

Repeat every.
If this script should repeat at a designed frequency, click in the checkbox. Then, in the next two fields, select the
interval – e.g., 1 week, 1 month, etc.
3. When all selections/entries are made, click OK.
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1.25 Maintenance
Micetro contains several options for cleaning up the network space. To access the network maintenance functions,
select Tools → Maintenance and then the maintenance operation you want to perform.

1.25.1 Find Orphaned PTR Records
The Find Orphaned PTR Records maintenance operation allows you to see and remove orphaned PTR records in reverse
zones. PTR records that have no corresponding address (A) records in the system are considered orphaned.
To find and remove orphaned PTR records, do the following:
1. Select Tools → Maintenance → Find Orphaned PTR Records. A dialog box displays.
2. Click Start to start looking for orphaned PTR records.
Note: Due to the fact that the result could be a large number of records, there is now a limit of 1000
records being shown.

3. Select the PTR records you want to remove, and click the Delete button. The selected PTR records are removed.

1.25.2 Find Concurrent Leases
The Find Concurrent Leases maintenance operation allows you to see and release concurrent DHCP leases. Concurrent
DHCP leases are multiple active leases that are assigned to the same MAC address.
To see and remove concurrent DHCP leases, do the following:
1. Select Tools → Maintenance → Find Concurrent Leases. A dialog box opens.
2. Click Start to start looking for concurrent DHCP leases.
Note: Finding all concurrent leases might take a while in large environments.

1.25. Maintenance
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3. Select the leases you want to release, and click the Release button. The selected leases are released.

1.25.3 Show Round Robin Records
The Show Round Robin Records maintenance operation allows you to see and delete round robin DNS records. Round
robin records are multiple address (A / AAAA) records with the same name.
To see and remove round robin records, do the following:
1. Select Tools → Maintenance → Show Round Robin Records. A dialog box displays.
2. Click Start to start looking for round robin records.
Note: Finding all round robin records might take a while in large environments.

3. Select the records you want to delete and click the Delete button. The selected records are deleted.
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1.25.4 Show Multiply Defined PTR Records
The Show Multiply Defined Records maintenance operation allows you to see and delete multiply defined PTR records.
Multiply defined PTR records are multiple PTR records with the same name.
To see and remove multiply defined PTR records, do the following:
1. Select Tools → Maintenance → Show Multiply Defined PTR Records. A dialog box displays.
2. Click Start to start looking for multiply defined PTR records.
Note: Finding all multiply defined PTR records might take a while in large environments.

3. Select the records you want to delete, and click the Delete button. The selected records are deleted.

1.26 Appliance management
1.26.1 Overview
There are two types of Men&Mice Appliances: a DNS/DHCP Appliance and a DNS Caching Appliance.
DNS/DHCP Appliance
Can be used as a DNS and a DHCP server. Once the DNS/DHCP appliance has been configured and added to in
Server management, you work with the DNS and DHCP server just as you would work with the BIND and ISC
DHCP servers.
DNS Caching Appliance
Contains a high-performance Caching-only DNS server. See Caching DNS Servers for information on managing
the DNS server on the DNS Caching appliance.
Note: Separate activation keys are required to add and manage a Men&Mice Appliance. The DNS/DHCP Appliance
and the DNS Caching Appliance use different activation keys.
Unless otherwise stated, the information in this chapter applies to both the DNS/DHCP Appliance and the DNS Caching
Appliance.

1.26. Appliance management
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1.26.2 New Appliance
You must be logged in as a user with administrator privileges to add a new Men&Mice Appliance.
To add a new Men&Mice Appliance, do the following:
1. From the menu bar, select File → New → Appliance. The Add Appliance dialog box displays.

Appliance Name
Type the name (host name) of the Men&Mice Appliance. Note that his name is also used for the DNS and DHCP
servers hosted on the Appliance.
Appliance address (optional)
If desired, type the IPv4 address for the Appliance. This is not required, but doing so allows the Management
Console to connect to the Appliance by IP Address instead of by name. The Appliance name will still be used
when displaying Appliance information.
2. Click OK. The Men&Mice Appliance is added and the Appliance Properties dialog box opens. Once added, the
name of the newly added Appliance displays under Appliances in the Object Section. (You may need to click the
+ sign next to Appliances to see it.)

1.26.3 Appliance Properties
You can use the Appliance Properties dialog box to configure various settings for the Men&Mice Appliance.
To open the Appliance Properties dialog box, do the following:
1. Locate the applicable Appliance.
2. Right-click and, from the shortcut menu, select Properties. The Men&Mice Appliance Properties dialog box
displays.
The settings in the following sections are all available from within the Appliance Properties dialog box.
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1.26.4 Enabling/Disabling DNS/DHCP Service (DNS/DHCP Appliance only)
You can choose whether you use the Men&Mice Appliance as a DNS server, DHCP server or both.
To enable or disable DNS and DHCP service on the Appliance:
1. Select the General tab in the Appliance Properties dialog box.
2. Click the Configure button in the Server Status section. The Service Status dialog box displays.
3. Select the services you want to run on the Appliance and click Save. If you enable a service, a server that has the
same name as the appliance is displayed in the appropriate section in the object list in the Manager window. To
disable a service, unselect the corresponding checkbox in the dialog box.

1.26. Appliance management
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1.26.5 Enabling Remote Logging (DNS/DHCP Appliance only)
The DNS/DHCP appliance can be configured such that specific logging channel can be logged to a remote syslog server.
1. Select the General tab in the Appliance Properties dialog box.
2. Click the Configure button in the Remote Logging section and you will be presented with the following dialog:

3. To enable remote logging
• check the Enable Remote Logging checkbox.
• Specify the remote Syslog Server that will receive the logs.
• Optionally specify a Port Number and protocol that the remote syslog listens on. Default is 514/UDP.
4. To finalize the configuration, configure in the DNS server options/logging a logging channel and a logging facility
that will be logged to this remote server. For more information see the BIND logging section in Authoritative
DNS Servers.
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1.26.6 Using a Time Server
You can configure the Appliance to synchronize its time with a time server. This ensures that the time on the Appliance
is always correct. By default, the appliance synchronizes its time using servers in the NTP pool.
To configure the Appliance to use a Time Server:
1. Select the Services tab in the Appliance Properties dialog box.
2. Click the Configure button in the Network Time Protocol section. The Time Server configuration dialog box
displays.

4. Use the dialog box to add, modify or delete the time servers to use. If no time server is configured, the Appliance
will not synchronize its time.

1.26.7 Enabling Remote Access
For troubleshooting purposes, it is possible to enable Remote Access for the Men&Mice Appliance. When Remote
Access is enabled, SSH access is granted on the Men&Mice Appliance for the user name mmadmin.
To enable Remote Access on the Men&Mice Appliance:
1. Select the Services tab in the Appliance Properties dialog box.
2. Click the Configure button in the Remote Access section. The Remote Access configuration dialog box displays.
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3. Select the Enable access checkbox to enable Remote Access.
4. Enter a login password. Note that the password must be entered twice.
5. Click OK to save the changes and close the dialog box.

1.26.8 Configuring SNMP Monitoring
You can use SNMP monitoring to get various information about the Men&Mice Appliance and receive SNMP traps if
certain events occur on the Appliance.
To configure SNMP Monitoring on the Men&Mice Appliance:
1. Select the Services tab in the Appliance Properties dialog box.
2. Click the Configure button in the SNMP section. The SNMP configuration dialog box displays.
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3. Check the SNMP Agent Enabled checkbox to enable the SNMP agent. When the SNMP agent is enabled, you
can retrieve information about the system using SNMP.
4. In the Community field, enter The community string (password) to use for the SNMP agent.
5. In the System Contact field, enter the email address of a contact person for the system.
6. Check the SNMP Traps Enabled checkbox to enable sending of SNMP traps. When sending SNMP traps is
enabled, the appliances will send SNMP traps when certain events occur.
7. In the Trap Manager field, enter the host name of the computer that should receive the SNMP traps.
8. In the Trap Manager Port field, enter the port number the Manager uses for the SNMP traps.
9. In the Trap Community field, enter the community string (password) to use for the SNMP traps.
10. Click Save to save your settings and close the dialog box.

1.26.9 Configuring Anycast
The Men&Mice Appliance supports Anycast network configuration through two routing protocols, BGP (Border Gateway Protocol) and OSPF (Open Shortest Path First).
Configuring Anycast using BGP
To configure Anycast using BGP on the Men&Mice Appliance:
1. Select the Services tab in the Appliance Properties dialog box.
2. Click the Configure button in the Anycast section. The Anycast configuration dialog box is displayed with the
BGP tab selected.
3. Check the Enable BGP Anycast checkbox to enable BGP.
4. In the Local AS field enter the local Autonomous System number for the Men&Mice Appliance.
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5. In the Router ID field enter a unique ID for the Men&Mice Appliance in dotted-decimal form (A.B.C.D). It can
be any (unique) value, but it is recommended to use a number that represents the Appliance, such as its eth0 IP
address.
6. In the Anycast Addresses list add the IP addresses that the Men&Mice Appliance shall advertise through the
routing protocol. The Appliance will also automatically configure a loopback adapter with this address and
provide DNS service. To add an anycast address, click the Add button and enter the required information. To
modify an existing anycast address entry, select the address and click the Edit button. To delete an anycast
address, select the address in the list and click the Delete button.
7. In the Neighbor Configuration list, add the IP addresses of the routers that the Appliance shall form a neighbor
relationship with. These routers must be capable of using the BGP protocol and they must also be configured to
form a relationship with the Appliance. To add a neighbor address, click the Add button and enter the required
information. To modify an existing neighbor address entry, select the address and click the Edit button. To delete
a neighbor address, select the address in the list and click the Delete button.
8. Click OK to save the changes.
Configuring Anycast using OSPF
To configure Anycast using OSPF on the Men&Mice Appliance:
1. Select the Services tab in the Appliance Properties dialog box.
2. Click the Configure button in the Anycast section. The Anycast configuration dialog box is displayed with the
BGP tab selected.
3. Click the OSPF tab to activate it.
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4. Check the Enable OSPF Anycast checkbox to enable OSPF.
5. In the OSPF Area field enter the OSPF Area that the Men&Mice Appliance will participate in in dotted-decimal
form (A.B.C.D). Each OSPF network must contain at least a backbone area (area 0 or 0.0.0.0), but can also contain
other areas by through Area Border Routers (ABRs). The Area ID is only configured once for all networks since
the Appliance never acts as an ABR and uses the same Area ID on all adapters.
6. In the Router ID field enter a unique ID for the Men&Mice Appliance in dotted-decimal form (A.B.C.D). It can
be any (unique) value, but it is recommended to use a number that represents the Appliance, such as its eth0 IP
address.
7. In the Anycast Addresses list add the IP addresses that the Men&Mice Appliance shall advertise through the
routing protocol. The Appliance will also automatically configure a loopback adapter with this address and
provide DNS service. To add an anycast address, click the Add button and enter the required information. To
modify an existing anycast address entry, select the address and click the Edit button. To delete an anycast
address, select the address in the list and click the Delete button.
8. In the Neighbor Configuration list, add the networks that should participate in the OSPF routing protocol.
Normally this will be the networks that are configured on the eth0 or eth1 network interfaces. To successfully
form neighbor relationships in OSPF, the Men&Mice Appliance and the routers must be located on the same
network prefix and be configured with the same area ID. To add a neighbor network, click the Add button and
enter the required information. To modify an existing neighbor network entry, select the address and click the
Edit button. To delete a neighbor network, select the entry in the list and click the Delete button.
9. Click OK to save the changes.
1.26. Appliance management
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1.26.10 Configuring Network Settings
Using the network settings, you can enable or disable IPv6 and change the IP address, network mask and routing information for the Appliance. You can also enable and configure the secondary network interface (eth1) on the Appliance.
Enabling/disabling the secondary network interface (eth1)
The Men&Mice Appliance has two network interfaces. The primary network interface (eth0) is enabled by default.
To enable or disable the secondary network interface (eth1):
1. Select the Network tab in the Appliance Properties dialog box.
2. Click the Configure button in the Interface eth1 section. The interface configuration dialog box displays.

3. Check the Enabled checkbox to enable the eth1 interface. To disable the interface, uncheck the checkbox.
4. Click Save to save your settings.
Enabling/disabling IPv6 addresses on the primary/secondary network interface
IPv6 can be enabled on either or both of the network interfaces on the Men&Mice Appliance.
To enable or disable IPv6 on the Men&Mice Appliance do the following:
1. Select the Network tab in the Appliance Properties dialog box.
2. Click the Configure button in the Interface section for the interface you want to configure. The interface configuration dialog box displays.
3. Click the IPv6 tab in the interface configuration dialog box.
4. Check the IPv6 Enabled checkbox to enable IPv6 on the selected interface. To disable IPv6 on the interface
interface, uncheck the checkbox.
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5. Click Save to save your settings.
When IPv6 is enabled, the Link-local address and any dynamically assigned addresses for the interface are displayed
in the dialog box.
Configuring IPv4 addresses on the primary/secondary network interface
Each interface on the Men&Mice Appliance can have one or more IPv4 addresses assigned to it.
To configure IPv4 addresses on the Appliance, do the following:
1. Select the Network tab in the Appliance Properties dialog box.
2. Click the Configure button in the Interface section for the interface you want to configure. The interface configuration dialog box is displayed with the IPv4 tab selected.

3. In the IPv4 Address field enter the IPv4 IP address for the Men&Mice Appliance. NOTE: The main IPv4 address
on the primary network interface (eth0) is used by Micetro to communicate with the Appliance. If you change
the main IPv4 address of the primary network interface, you will lose the connection to the Appliance once the
changes are saved, and you must update the connection information for the Appliance. Refer to Edit Appliance
Name for details on how to change the connection information.
4. In the Subnet Mask field, enter the subnet mask to use.
5. In the Default Route field, enter the default IPv4 route.
6. If you want to add more IPv4 IP addresses for the Men&Mice Appliance, click the Add button next to the IPv4
Aliases list and enter the relevant IP address information.
To edit or delete additional IPv4 addresses, use the Edit and Delete buttons next to the IPv4 Aliases list.
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Configuring IPv6 addresses on the primary/secondary network interface
Each interface on the Men&Mice Appliance can have one or more addresses assigned to it.
To configure IPv6 addresses on the Appliance, do the following:
1. Select the Network tab in the Appliance Properties dialog box.
2. Click the Configure button in the Interface section for the interface you want to configure. The interface configuration dialog box is displayed with the IPv4 tab selected.
3. Click the IPv6 tab in the interface configuration dialog box

4. Select the IPv6 Enabled checkbox to enable IPv6
5. Click the Add button to add a new IPv6 address.

6. Enter the IPv6 address and the Prefix length.
7. Click OK to add the IPv6 address.
To edit or delete IPv6 addresses, use the Edit and Delete buttons next to the IPv4 Addresses list.
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Configuring the Network Mode on the primary/secondary network interface
It is possible to change the network speed and duplex mode for the network interfaces on the Men&Mice Appliance.
To change the Network Mode on the Men&Mice Appliance do the following:
1. Select the Network tab in the Appliance Properties dialog box.
2. Click the Configure button in the Interface section for the interface you want to configure. The interface configuration dialog box displays.
3. Click the Hardware tab in the interface configuration dialog box. The MAC address of the interface is shown
and a drop-down box with the available network modes displays.

Configuring IPv4 routing information
To configure IPv4 routing on the Appliance, do the following:
1. Select the Network tab in the Appliance Properties dialog box.
2. Click the Configure button in the Routing section. The routing configuration dialog box is displayed with the
IPv4 tab selected.

3. Enter the default route to use for IPv4.
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4. If needed, click the Add button to add a new IPv4 route.

5. Enter the destination, prefix, and gateway.
6. Click OK to add the route.
To edit or delete routes, use the Edit and Delete buttons next to the IPv4 Routes list.
Configuring IPv6 routing information
To configure IPv6 routing on the Appliance, do the following:
1. Select the Network tab in the Appliance Properties dialog box.
2. Click the Configure button in the Routing section. The routing configuration dialog box is displayed with the
IPv4 tab selected.
3. Click the IPv6 tab in the routing configuration dialog box.

4. Enter the default route to use for IPv6 and choose the interface for the route. You can choose the enabled
interfaces or Auto.
5. If needed, click the Add button to add a new IPv6 route.
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6. Enter the destination, prefix and gateway and choose the interface for the route. Click OK to add the route.
To edit or delete routes, use the Edit and Delete buttons next to the IPv6 Routes list.

1.26.11 Shutting down or Restarting the Men&Mice Appliance
You can shut down or restart the Men&Mice Appliance from the Maintenance tab in the Appliance Properties dialog
box.
Danger: If you shutdown the Men&Mice Appliance, it will be turned off and you will need physical access to the
Men&Mice Appliance to turn it on again.
To shut down or restart the Men&Mice Appliance:
1. Select the Maintenance tab in the Appliance Properties dialog box.
2. Click the Shutdown or Restart button and click OK in the confirmation dialog box. The Men&Mice Appliance
shuts down or restarts, depending on your selection.

1.26.12 Support Information
To help in troubleshooting, it is possible to generate and save support information for a Men&Mice Appliance. The
support information file contains various information on the Men&Mice Appliance setup and helps the Men&Mice
Support team diagnose problems you might have with the Appliance.
To generate a support information file:
1. Locate the applicable Appliance.
2. Right-click and, from the shortcut menu, select Support Info. A Save File dialog box displays. A default name
for the support information file is mmSupportInfo.tgz. Click Save to save the support information file.
Note: The support information file contains various text files in a .tgz archive. If you are interested in seeing the
contents of the support information file, you can use any tool that can extract data from .tgz archives and look at the
text files.
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1.26.13 Edit Appliance Name
This feature allows you to change the name or IP Address used to connect to a Men&Mice Appliance. This is useful if
you need to refer to the Appliance by another name or if you are connecting to the Appliance by an IP Address and the
IP Address has changed.
To access this feature, do the following:
1. Locate the applicable Appliance.
2. Right-click and, from the shortcut menu, select Edit Appliance Name. The Edit Appliance name dialog box
displays.

3. Change the Appliance name, and/or Appliance address (optional).
Note: This will only change the name or IP address used to connect to the Men&Mice Appliance. The
actual IP address on the Appliance is not changed. For information on changing the IP address on the
Men&Mice Appliance itself, refer to Appliance Properties.
4. Click OK.

1.26.14 Delete Appliance
Note: This command is only available with the Administrator account.
Use this command to remove a Men&Mice Appliance from Micetro.
1. In the Object browser of the Management Console, click on Appliances.
2. In the Object List, select the Appliance(s) you want to remove. To select multiple Appliances, hold down the
Ctrl key while making your selection
3. On the toolbar, click the Remove button. A dialog box prompts you to confirm your decision. To remove the
Appliance, click Yes. Otherwise, click No to keep the Appliance.
Warning: When you remove an Appliance from Micetro, the DNS and DHCP servers hosted on the Appliance
are removed from Micetro as well.
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1.26.15 Backup and Restore
Micetro will automatically backup configuration for all appliances it manages. The backup can then be used to restore
the appliance to the backed-up copy of the configuration. The backup is fully automatic and there is no configuration
needed.
If an appliance crashes and has to be replaced with another appliance with the same IP Address, Micetro will detect
the new server and consider it to be in an uninitialized state. To be able to work with the server the administrator needs
to initialize the server. To initialize the server right-click on the server and select Initialize. This will display a dialog
box where the user can choose how the server should be initialized:

• If Restore Backup is selected, all configurations on the appliance will be overwritten with the backed-up data.
• If Use appliance without backup is selected, all data kept in Men&Mice Central will be ignored and overwritten
with current data on the appliance.
Basically, the restore scenario is as follows:
1. The appliance crashes and becomes unusable.
2. A new appliance is configured to replace the broken appliance, using the same IP Address as the old appliance.
3. When the new appliance is up and running, in the Management Console, right-click the appliance and choose
Reconnect.
When a connection has been established, Micetro detects that this is a new, uninitialized appliance. See above for a
description on what happens next.

1.27 Caching DNS Servers
1.27.1 Overview
This section shows you how to perform specific actions in the Men&Mice Management Console associated with maintaining your Caching DNS servers on a Men&Mice DNS Caching Appliance. For some more general options and
features of DNS servers in general, please see Authoritative DNS Servers.
Note: The contents of this section are only relevant if you are using the Men&Mice DNS Caching Appliance.
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1.27.2 Options
The Server Options dialog box lets you configure settings for each caching DNS server individually. It is also possible
to select multiple caching DNS servers and set specific options for all of the selected servers.
To open the caching DNS server Options dialog box, do the following:
1. In the Object Section, select DNS Servers so the servers appear in the Object List.
2. Right-click on the caching DNS server you want to make changes to and select Options from the context menu.
The Server Options dialog box displays.
The settings in the following sections are all available from within the caching DNS server options dialog box.
Setting Network and Transfer Protocols
You can choose which network protocols (IPv4, IPv6 or both) and transport protocols (TCP, UDP or both) you want to
use and you can also set the EDNS Buffer size.
To set the network and transfer protocols for the caching DNS server, do the following:
1. Select the Network tab in the caching DNS server Options dialog box.

2. Select the Network Protocols to use. You can specify whether you want to enable DNS on IPv4, IPv6 or both.
3. Select the Transport Protocols to use. You can specify whether you want to enable DNS on TCP, UDP or both.
4. Set the EDNS Buffer size. This is the number of bytes to advertise as the EDNS reassembly buffer size. This is
the value put into datagrams over UDP towards peers. The default is 4096 which is RFC recommended.
Tip: If you have fragmentation reassembly problems, usually seen as timeouts, then a value of 1480 can fix it. Setting
to 512 bypasses even the most stringent path MTU problems, but is seen as extreme, since the amount of TCP fallback
generated is excessive (probably also for this resolver, consider tuning the outgoing TCP number).
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Setting Access Control for the Caching DNS Server
Access control for the caching DNS server is used to specify who can query the server. You can specify access based
on individual IP addresses or address blocks and you can create multiple access control entries.
To set access control for the caching DNS server, do the following:
1. Select the Access Control tab in the caching DNS server Options dialog box.

2. Click the Add button to create a new access control entry.

3. Enter the address or subnet in the field provided and choose the access type for the subnet from the drop-down
list. There are four access types available:
refuse
Stops all queries from the specified host or network and sends the DNS rcode REFUSED error message back.
deny

Stops all queries from the specified host or network.

allow
Allows the specified host or network to query the server using non-recursive queries.
1.27. Caching DNS Servers
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allow-snoop
Allows the specified host or network to query the server using both non-recursive and recursive
queries.
4. Click OK to save the access control entry.
Setting Private Addresses and Private Domains
It is possible to specify private addresses and private domains on the caching DNS server.
• Private addresses are addresses on your private network, and are not allowed to be returned for public Internet
names. Any occurrences of such addresses are removed from DNS answers.
• Private domains are domains that may contain private addresses.
To specify private addresses, do the following:
1. Select the Filtering tab in the caching DNS server Options dialog box.

2. Click the Add button in the Private Addresses section to create a new private address entry.
3. Enter the address or subnet in the field provided, and click OK to save the private address entry.
To specify private domains:
1. Select the Filtering tab in the caching DNS server Options dialog box.
2. Click the Add button in the Private Domains section to create a new private domain entry.
3. Enter the domain name in the field provided, and click OK to save the private domain entry.
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Specifying Addresses not to Query
It is possible to specify IPv4 or IPv6 addresses or subnets that the caching DNS server should not use when querying
for DNS information.
To specify addresses that should not be queried, do the following:
1. Select the Filtering tab in the caching DNS server Options dialog box.

2. Click the Add button in the Addresses not to Query section to create a new address entry.
3. Enter the address or subnet in the field provided, and click OK to save the address entry.
Configuring DNSSEC Settings
Use the DNSSEC section to specify DNSSEC Trust Anchors, DLV Anchors and Insecure Domains
To configure DNSSEC settings, do the following:
1. Select the DNSSEC tab in the caching DNS server Options dialog box.
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2. Click the Add button in the Trust Anchors section to create a new trust anchor entry. A trust anchor A is a DS or
DNSKEY RR for a key to use for validation.
3. Click the Add button in the Insecure Domains section to create a new insecure domain entry. This sets the
specified domain name to be insecure. The DNSSEC chain of trust is ignored towards the domain name. A trust
anchor above the domain name cannot make the domain secure with a DS record and such a DS record is ignored.
Also, keys from DLV are ignored for the domain. This can be useful if you want to make sure a trust anchor
for external lookups does not affect an (unsigned) internal domain. DS record externally can create validation
failures for that internal domain.
4. Enter the relevant DLV Anchor data in the DLV Anchor edit field to create a DLV anchor entry. Much like a
trust anchor, a DLV anchor is a DS or DNSKEY RR for a key to use for validation. You can only create one DLV
anchor entry.
Configuring Advanced Settings
The caching DNS server Options dialog box contains an Advanced tab where you can configure various advanced
settings for the server.
To configure advanced settings, do the following:
1. Select the Advanced tab in the caching DNS server Options dialog box.
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2. Configure the desired advanced settings.
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Pre-fetch
DNSSEC Keys
Harden Referral
Path

Jostle Timeout

Maximum TTL

Minimum TTL

Infra-Host TTL
Pre-fetch expiring
cache data

If checked, fetches the DNSKEYs earlier in the validation process when a DS
record is encountered. This lowers the latency of requests but uses a little more
CPU.
If checked, hardens the referral path by performing additional queries for infrastructure data. Validates the replies if trust anchors are configured and the zones are
signed. This enforces DNSSEC validation on name server NS sets and the name
server addresses that are encountered on the referral path to the answer. Default
off, because it burdens the authority servers, and it is not RFC standard, and could
lead to performance problems because of the extra query load that is generated.
Timeout used (in milliseconds) when the server is very busy. The default is 200
milliseconds. Set to a value that usually results in one roundtrip to the authority
servers. If too many queries arrive, then 50% of the queries are allowed to run to
completion, and the other 50% are replaced with the new incoming query if they
have already spent more than their allowed time. This protects against denial of
service by slow queries or high query rates. The effect is that the qps for longlasting queries is about (numqueriesperthread / 2) / (average time for such long
queries) qps. The qps for short queries can be about (numqueriesperthread / 2)
/(jostletimeout in whole seconds) qps per thread, about (1024/2)*5 = 2560 qps by
default.
Maximum time to live (in seconds) for RRsets and messages in the cache. Default
is 86400 seconds (1 day). If the maximum kicks in, responses to clients still get
decrementing TTLs based on the original (larger) values. When the internal TTL
expires, the cache item has expired. The Maximum TTL can be set lower to force
the resolver to query for data often, and not trust (very large) TTL values.
Minimum time to live (in seconds) for RRsets and messages in the cache. Default
is 0. If the minimum kicks in, the data is cached for longer than the domain owner
intended, and thus, fewer queries are made to look up the data. Zero makes sure
the data in the cache is as the domain owner intended; higher values, especially
more than an hour or so, can lead to trouble as the data in the cache does not match
up with the actual data any more.
Time to live (in seconds) for entries in the host cache. The host cache contains
roundtrip timing, lameness, and EDNS support information. Default is 900.
If checked, fetches the DNSKEYs earlier in the validation process when a DS
record is encountered. This lowers the latency of requests but uses a little more
CPU.

Working with Root Hints
The Root Hints file contains information on the root DNS servers. If needed, you can change the contents of this file.
After making changes to the Root Hints file you can revert to the built-in Root Hints file.
To configure Root Hints, do the following:
1. Click the Root Hints button in the caching DNS server Options dialog box. The Root Hints dialog box displays.
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2. Select the Customized Root Hints radio button if it isn’t already selected. The contents of the Root Hints edit
field become editable.
3. Make the desired changes to the Root Hints file and click OK to save the changes.
To use the built-in Root Hints file, do the following:
1. Click the Root Hints button in the caching DNS server Options dialog box. The Root Hints dialog box displays.
2. Select the Built In Root Hints radio button. The contents of the Root Hints edit field become read-only.
3. Click OK to save the changes.

1.27.3 Server Log and Query Logging
To view the activity log for a particular server, in the Object List, right-click on the desired server and, from the shortcut
menu, select Server Log. A Log tab opens for the selected server that contains a list of activity and maintenance that
has occurred on that server since the last time the log was cleared.
You can clear the server log by clicking the Clear log button in the server log tab. You can start logging all queries by
clicking the Start button in the Query Logging section in the server log window. If query logging is enabled, the Start
button changes to a Stop button and clicking the button will stop query logging.
Warning: Query logging may impact server performance significantly and should only be used for troubleshooting
purposes.
You can save the contents of the server log tab by clicking the Save button.
1.27. Caching DNS Servers
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To download the last server log file directly from the DNS Caching Appliance click the Download button.

1.27.4 Stopping the DNS Server
The Men&Mice DNS Caching Appliance is configured to keep the DNS service running at all times. This means
that if the DNS server is stopped for some reason, it is restarted automatically. However, it is possible to override this
setting and stop the DNS server from the Server menu. When the DNS server is stopped, the Men&Mice DNS Caching
Appliance withdraws itself from the Anycast setup if Anycast has been configured on the Appliance. When the DNS
server is started again, the Appliance re-enables the Anycast configuration. The stopped state for the DNS server is
not persistent. If the Appliance is restarted while the DNS server is stopped, the DNS server will be started once the
Appliance has restarted.
To stop the DNS server, select the caching DNS server in the DNS Server list and on the Server menu select Stop DNS
Server.
To start the DNS server, on the Server menu select Start DNS Server.

1.27.5 Stub and Forward Zones
You can create stub and forward zones on the caching DNS server. See Forward Zone and Stub Zone for more information on creating stub and forward zones.
Note: When creating stub and forward zones on a caching DNS server, some additional settings are available for the
zones.
For forward zones, the Forward only checkbox displays. Select this checkbox if you want the zone to be a forward only
zone.
For stub zones, two additional settings are available:
Prime NS set
If checked, the server performs NS set priming, which is similar to root hints, where it starts using the list of
name servers currently published by the zone. Thus, if the hint list is slightly outdated, the resolver picks up a
correct list online.
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Stub-First
If checked, a query is attempted without the stub clause if it fails.

1.27.6 Managing Local Zones
Using the Local Zone management dialog box, you can add, modify and delete local zones and records. Local zones
and records are only displayed in the Local Zone management dialog box.
To open the Local Zone management dialog box, do the following:
1. In the Object Section, select DNS Servers so the servers appear in the Object List.
2. Right-click on the caching DNS server you want to work with and select Manage Local Zones from the context
menu. The Manage Local Zones dialog box displays.

The dialog box is used to work with local zones and records.
After making changes to the local zone data, click Save to save and apply the changes.
The actions in the following sections are all available from within the Local Zone management dialog box.
Adding a Local Zone
To add a new local zone:
1. Click the Add zone button. A zone properties dialog box displays.

2. Enter the zone name in the field provided and choose the zone type from the drop-down list. There are several
zone types available:
deny

Do not send an answer and drop the query. If there is a match from local data, the query is answered.
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refuse
Send an error message reply, with rcode REFUSED. If there is a match from local data, the query is
answered.
static
If there is a match from local data, the query is answered. Otherwise, the query is answered with
nodata or nxdomain. For a negative answer a SOA is included in the answer if present as local-data
for the zone apex domain.
transparent
If there is a match from local data, the query is answered. Otherwise, if the query has a different
name, the query is resolved normally. If the query is for a name given in localdata but no such type
of data is given in localdata, then a noerror nodata answer is returned.
typetransparent
If there is a match from local data, the query is answered. If the query is for a different name, or for
the same name but for a different type, the query is resolved normally. So, similar to transparent but
types that are not listed in local data are resolved normally, so if an A record is in the local data that
does not cause a nodata reply for AAAA queries.
redirect
The query is answered from the local data for the zone name. There may be no local data beneath
the zone name. This answers queries for the zone, and all subdomains of the zone with the local
data for the zone. It can be used to redirect a domain to return a different address record to the end
user, with local-zone: “example.com.” redirect and local-data: “example.com. A 127.0.0.1” queries
for www.example.com and www.foo.example.com are redirected, so that users with web browsers
cannot access sites with suffix example.com.
3. Click OK to save the zone entry.
Editing/Deleting a Local Zone
To edit an existing local zone:
1. Select the zone and click the Edit button. The zone properties dialog box displays. Note that the server name is
disabled and you can only change the zone type.

2. Make the necessary changes and click OK.
To delete a local zone:
1. Select the zone.
2. Click the Remove button. A confirmation box displays.
3. Click OK to delete the zone and all of the zone data.
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Adding a Record
You can add a record to an existing local zone. It is also possible to add a record that does not belong to a specific local
zone. Records that do not belong to any local zones are placed in the <no zone> section in the Local Zone management
dialog box.
To add a new record:
1. Click the Add record button. A record properties dialog box displays. If you selected a zone before clicking the
Add record button, the name of the selected zone has been added to the Name field.

2. Enter a fully qualified record name including the zone name in the Name field.
3. Select the record type from the Type drop-down list.
4. Enter a TTL for the record in the TTL field (optional).
5. Enter the data for the record in the Data field.
6. Click OK to save the changes.
Editing/Deleting a Record
To edit an existing record:
1. Select the record.
2. Click the Edit button. The Edit Record dialog box displays.

3. Make the necessary changes and click OK.
To delete a record:
1. Select the record.
2. Click the Remove button. A confirmation box displays.
3. Click OK to delete the record.
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1.28 Micetro reference articles
1.28.1 Permissions reference
Note: License management has no associated permission, and can only be accessed by The administrator user.
The following tables list all the permissions in Micetro, as defined in the API and the web application.

API
Web application
access_adminUser
Administer users/groups
access_adminIPAM
Administer IP address
ranges
access_adminDNS
Administer DNS servers
access_adminDHCP
Administer
DHCP
servers
access_adminAppliance
Administer appliances
access_adminDevice
Administer devices
access_IPAMModule
Access IPAM module
access_DNSModule
Access DNS module
access_DHCPModule
Access DHCP module
access_consoleAccess to the Management Console
access_commandLine
Access to the CLI
Access to the web interface
access_basicZoneView
Access to basic zone view
in web interface
access_advancedZoneView
Access to advanced zone
view in web interface
access_IPAMView
Access to IPAM view in
web interface
access_basicReporting
Access to basic reporting
access_tasksView
Access to task list view in
web interface
access_viewHistory
Access to view history
access_webHostEditor
Access to Host editor
access_adminADSites
Access to manage AD
Sites and Site Links
access_adminClouds
Access to manage clouds
access_workflowModule
Access Workflow module
access_advancedReporting
Access to advanced reporting
access_importDataCustom
Access to ‘Import Data’
web task
access_web
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Table 6: Micetro
Notes
Needed to manage Roles.

Needed to access DHCP functionality in the IPAM view. License
for the IPAM module also unlocks the DHCP module.
Legacy permission, the CLI (Command Line Interface) is no longer
in use.
Needed to access the web application.
Legacy permission, not available in the web application.
Needed to access DNS functionality in the web application.
Needed to access IPAM functionality in the web application.
Manually run built-in reports.
Legacy permission, not available in the web application.
Legacy permission, not available in the web application.

Build custom reports, and schedule reports.
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API
Web application
access_editAccess
Edit DNS server access
access_list List (or view) DNS
server
access_viewHistory
View DNS server history
access_optionsEdit DNS server options
access_addMaster
Add master zones
access_addNonMaster
Add non-master zones
access_viewLogView DNS server log
access_clearLog
Clear DNS server log
access_editProperties
Edit DNS server properties
access_manageLocalZones
Manage local zones

API
Web application
access_editAccess
Edit DHCP server access
access_list List (or view) DHCP
server
access_viewHistory
View DHCP server history
access_readOptions
Read DHCP server options
access_optionsRead/write
DHCP
server options
access_addScope
Add a scope
access_editProperties
Edit DHCP server properties
access_reservations
Edit reservations
access_addGroup
Add a group
access_readClassData
Read DHCP class data
access_classData
Read/write DHCP class
data
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Table 7: DNS servers
Notes

Table 8: DHCP servers
Notes
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API
Web application
access_editAccess
Edit zone access
access_list List (or view) zone
access_viewHistory
View zone history
access_enable Enable/disable zone
access_optionsEdit zone options
access_delete Delete zone
access_enableApex
Enable/disable
apex
records
access_editApex
Edit apex records
access_enableWildcard
Enable/disable wildcard
records
access_editWildcard
Edit wildcard records
access_enableOther
Enable/disable
other
records
access_editOther
Edit other records
access_editProperties
Edit zone properties

Table 9: DNS zones
Notes

Table 10: Ranges and DHCP scopes
API
Web application
Notes
access_editAccess
Edit range access
access_list List (or view) range
access_viewHistory
View range history
access_delete Delete range
access_editProperties
Edit range properties
access_editDeviceProperties
Edit IP Address properties
access_editDNSHosts
Use IP addresses in DNS
access_createSubrange
Create subrange
access_reuseAddress
Create multiple hosts
per IP address
access_pingAddresses
Ping IP addresses
access_siteAssociation
Edit AD site association
access_enable Enable/disable scope
access_readOptions
Read scope options
access_optionsRead/write scope options
access_reservations
Edit reservations
access_addressPools
Edit address pools
access_exclusions
Edit exclusions
access_releaseLeases
Release leases
access_addGroup
Add a group
Legacy permission for DHCP groups.
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Table 11: DHCP groups (legacy only)
API
Web application
Notes
access_editAccess
Edit DHCP group access
access_list List (or view) DHCP
group
access_viewHistory
View DHCP group history
access_reservations
Edit reservations
access_readOptions
Read DHCP group options
access_optionsRead/write DHCP group
options
access_delete Delete DHCP group

API
Web application
access_editAccess
Edit address space access
access_list List (or view) address
space
access_viewHistory
View address space history

API
Web application
access_editAccess
Edit cloud network access
access_list List (or view) cloud network
access_viewHistory
View cloud network history
access_editProperties
Edit cloud network
properties
access_delete Delete cloud network

API
Web application
access_editAccess
Edit cloud access
access_list List (or view) cloud
access_viewHistory
View cloud history
access_editProperties
Edit cloud properties
access_createCloudNetwork
Create cloud network
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Table 12: Address spaces
Notes

Only needed to switch to an address space other than Default.

Table 13: Cloud networks
Notes

Table 14: Cloud services
Notes
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1.28.2 Converting existing access control configurations in Micetro 10.1
Micetro 10.1 updated access control management from an object-based to a role-based model. This page is intended
to provide a recommendation for handling access controls in existing environments.
Upgrading to Micetro 10.1
Important: Men&Mice recommends performing a database backup before updating to 10.1.
Environments using a version of Micetro prior to 10.1 will be converted to the new model when you upgrade your
Micetro components (see Update Guide). The database is migrated automatically. All existing access control configuration is preserved, but will use the new model:
• built-in roles are converted into their new General roles equivalents
• custom roles previously used for access control are converted into Legacy roles
• access settings for legacy roles on objects are preserved, using the Specific roles mechanism (i.e. configured on
existing objects, and not applied automatically to new objects)
Automatically created Legacy roles
Legacy roles are a transitional role type to help migration and preserve backward compatibility.
Legacy roles are generated for any user or group previously configured with Initial access that had general access for
an object type. The legacy roles have the same permissions as their initial access.
The generated legacy roles are named after their original name. E.g. the user Viola will become the legacy role Viola
(converted user) while the group Illyria will become the legacy role Illyria (converted group).
Note: Creating legacy roles based on users and groups will leave the existing user and group intact, and automatically
assigned to their respective legacy roles.

Converting Legacy roles
If needed, legacy roles can be converted into a general or specific role, using the dropdown in the Edit role properties
action.
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Danger: Changing the type of a legacy role cannot be reverted.

Converting legacy roles into General roles
Converting a legacy role into a general role removes all object-specific access and makes the legacy role’s configured
permissions applicable to all objects in the system. If the legacy role had general access exclusions on specific objects,
these exclusions are also removed.
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Converting to Specific roles
If the legacy role was general for some object types it will not have access to any of the objects of that type after
converting to specific.
Any object-specific overrides will inherit the access from the role.

Example of converting legacy role into specific
A legacy role had initial access on DNS servers previously (e.g. list/view) but not on zones, but was granted the role
access to select zones.
After conversion:
• the role will not have access to any servers (even if some servers had overridden/different permissions or were
excluded)
• the role will have access to the same zones as before, with consistent permissions across these zones
Note: Because of the complicated nature of matching access controls between the old and new models, Men&Mice
recommends re-creating the configuration of legacy roles as specific roles, instead of changing the type.
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1.28.3 Virtual Appliance Guide
Virtual DNS - DHCP Appliance Setup Guide
Introduction
Overview
The Virtual DNS/DHCP Appliance System is an integrated DNS and DHCP server focusing on performance and
reliability.
This document contains information about installation and initial configuration of the Virtual DNS/DHCP Appliance.
Software Requirements
• VMWare Workstation 6.5 or higher
• VMWare ESX/ESXi 4 or higher
• VMWare Fusion 2 or higher
• VirtualBox 4.2.18 or higher
Hardware Requirements
Minimal requirements:
• 20 GB of disk space
• 4 GB RAM.
• 1 Processor Core
Recommended:
• 8 GB RAM.
• 4 Processor Cores
Installation
Setting Up the Virtual Machine
Importing the Virtual Appliance
VMWare Fusion/Workstation
1. First, download the OVA file (http://appliance.is/ddi.ova) or use http://download.menandmice.com/Appliance/
for a specific version
2. To setup the Virtual Appliance in VMWare Fusion, either double click the OVA file, or navigate to File → Import.
3. A dialog box appears that will allow you to specify the location of the OVA file. Confirm by clicking the Open
button.
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4. After specifying the name of the new virtual appliance, clicking Import will finalize the importing of the virtual
appliance.
5. The Virtual Appliance is now ready to be started up.
VMWare ESX/ESXi
The Virtual Appliance can be imported through a template on the ESX server. As seen in figure 1, the Deploy OVF
template is selected, and in figure 2, the deployment URL is pasted in. The next steps in the importing wizard should
be self-explanatory.

Fig. 5: Select ‘Deploy OVF template from the File menu.

VirtualBox
1. First, download the OVA file use http://download.menandmice.com/Appliance/ for a specific version
2. In the VirtualBox Manager open the File menu and select Import Appliance.
3. Click on the Open appliance button and select the Men&Mice Virtual appliance OVA file and click on the
Continue button.
4. The next dialog page shows an overview of the settings. It’s recommended to select the option to re-initialize the
MAC addresses of the two virtual interfaces eth0 (Management Interface) and eth1 (Service Interface) as shown
in figure 3.
Finally press the File –> Import Virtual Appliance button to load the Men&Mice virtual machine into your the VirtualBox environment.
Note:
Change the Guest OS Type to Other Linux (64-bit)
It’s important to change the Guest OS Type to “Other Linux(64-bit). Otherwise the VM might get stuck during
startup.
The Virtual Appliance only contains two virtual ethernet interfaces, eth0 and eth1. The eth0 interface serves as a
management interface, while the eth1 interface serves as an external interface.
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Fig. 6: Paste in the deployment URL (http://appliance.is/caching.ova) as shown and press Next.

Fig. 7: Importing the Men&Mice Virtual DNS OVA image.
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Configuration
Entering Appliance Network Information
This section contains instructions on how to configure the network on the appliance. That is performed through the
console on the virtual host.
Once the network information has been entered, you can add the appliance to Micetro. For further information refer to
Appliance management in the Micetro User’s Guide.
Follow these instructions to configure the network settings:
1. Access the Appliance menu by pressing the Escape button and then press the Enter button on the keyboard.
2. From the main menu, select 1. Network.
3. From the menu, select 1.1IP Address.
4. Enter the IPv4 address for the Appliance.
5. From the menu, select 1.2 Netmask.
6. Enter the network mask using a CIDR notation.
7. From the menu, select 1.3 Gateway.
8. Enter the IP Address of the gateway for the network.
Adding the Appliance to Micetro
Please refer to the Appliance management chapter in the manual for instructions on how to add the appliance to Micetro.
Virtual Caching Appliance Setup Guide
Introduction
Overview
The Virtual Caching Appliance System is an integrated Caching server focusing on performance and reliability.
This document contains information about installation and initial configuration of the Virtual Caching Appliance.
Software Requirements
• VMWare Workstation 6.5 or higher
• VMWare ESX/ESXi 4 or higher
• VMWare Fusion 2 or higher
• VirtualBox 4.2.18 or higher
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Hardware Requirements
Minimal requirements
• 20 GB of disk space
• 4 GB RAM.
• 1 Processor Core
Recommended
• 8 GB RAM.
• 4 Processor Cores
Installation
Setting Up the Virtual Machine
Importing the Virtual Appliance
VMWare Fusion/Workstation
1. First, download the OVA file (http://appliance.is/caching.ova) or use http://download.menandmice.com/
Appliance/ for a specific version
2. To setup the Virtual Appliance in VMWare Fusion, either double click the OVA file, or navigate to File and select
Import.
3. A dialog box appears that will allow you to specify the location of the OVA file. Confirm by clicking the Open
button.
4. After specifying the name of the new virtual appliance, clicking Import will finalize the importing of the virtual
appliance.
5. The Virtual Appliance is now ready to be started up.
VMWare ESX/ESXi
The Virtual Appliance can be imported through a template on the ESX server. As seen in figure 1, the Deploy OVF
template is selected, and in figure 2, the deployment URL is pasted in. The next steps in the importing wizard should
be self-explanatory.
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Fig. 8: Select ‘Deploy OVF template from the File menu.

Fig. 9: Paste in the deployment URL (http://appliance.is/caching.ova) as shown and press ‘Next’

446

Chapter 1. Table of Contents

Micetro by Menamp;Mice Documentation, Release 10.2

VirtualBox
1. First, download the OVA file (http://appliance.is/caching.ova) or use http://download.menandmice.com/
Appliance/ for a specific version
2. In the VirtualBox Manager open the File menu and select Import Appliance.
3. Click on the Open appliance button and select the Men&Mice Virtual appliance OVA file and click on the
Continue button (see figure 3).
4. The next dialog page shows an overview of the settings. It’s recommended to select the option to re-initialize the
MAC addresses of the two virtual interfaces eth0 (Management Interface) and eth1 (Service Interface) as shown
in figure 4.
Finally press the File → Import Virtual Appliance button to load the Men&Mice virtual machine into your the VirtualBox environment.

Fig. 10: Importing the Men&Mice Virtual Caching Appliance .ova image.
The Virtual Appliance only contains two virtual ethernet interfaces, eth0 and eth1. The eth0 interface serves as a
management interface, while the eth1 interface serves as an external interface.
Configuration
Entering Appliance Network Information
This section contains instructions on how to configure the network on the appliance. That is performed through the
console on the virtual host.
Once the network information has been entered, you can add the appliance to Micetro. For further information refer to
Appliance management in the Micetro User’s Guide.
Follow these instructions to configure the network settings
1.28. Micetro reference articles
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Fig. 11: Importing the Men&Mice Virtual Caching Appliance .ova image.
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1. Access the Appliance menu by pressing the Escape button and then press the Enter button on the keyboard.
2. From the main menu, select 1. Network.
3. From the menu, select 1.1IP Address.
4. Enter the IPv4 address for the Appliance.
5. From the menu, select 1.2 Netmask.
6. Enter the network mask using a CIDR notation.
7. From the menu, select 1.3 Gateway.
8. Enter the IP Address of the gateway for the network.
Adding the Appliance to Micetro
Please refer to the Appliance management chapter in the manual for instructions on how to add the appliance to Micetro.

1.28.4 How to export and send license information
Micetro version 10.1 and above
See Export license data.
Micetro version below 10.1 (10.0, 9.3, 9.2, etc.)
1. Log into the Management console as administrator.
2. Open Tools –> License Management.
3. Take a screenshot or note down the usage numbers, and send it in an email to finance@menandmice.com.

1.28.5 Health Bar information (Management Console)
On this page, the errors / warnings from the Health Monitoring Bar in the Management Console are made available.
The user is able to click a link from the Management Console to get more details about each error / warning that is
shown there.
Component out of date
This warning is shown when a Men&Mice component is out of date in the system. This can be confirmed by going to
Tools → Update Status. It will show all components that are out of date in the system. From this window, they can also
be updated.

1.28. Micetro reference articles

449

Micetro by Menamp;Mice Documentation, Release 10.2

Component unreachable
This error is shown when the Men&Mice Central cannot communicate with the specified component. It can be due to
one of the following reasons:
• The network connection is not functional between the component and the central server. That can be due to
firewall issues. See Networking requirements.
• The component is not turned on or has been shut down
Database has multiple schemas
This error is displayed when it has been detected that the database has multiple schemas. This can happen if the database
has been migrated and not configured properly. Contact Men&Mice Support for further assistance. (See Contacting
Support.)
Database size exceeded the recommended value
When the database is the default one (SQLite) and the size of the database is higher than the threshold of 1 GB, then
this warning is shown. Collecting lease history for DHCP is one of the factors that can increase the size of the database.
In cases of that and also when the network environment is considered to be large, it is recommended to use SQL Server
or PostgreSQL as a database backend for Micetro. See Microsoft SQL Server and PostgreSQL for more details.
DHCP failover partner server unreachable
This error is displayed when the defined failover partner server for a DHCP server is not reachable. The reason could
be a networking issue or that the DHCP service on the server is down.
Error loading zone
This warning is shown when DNS server (e.g. BIND) is unable to load its zones. This warning is also posted if the
server has not successfully finished checking all zones for errors.
Failed to do a SOA request for zone
This error is shown when the Men&Mice DNS Server Controller is able to query the server, but SOA request for the
zone failed.
Failed to load ODBC Driver for SQL Server
The preferred version of the Microsoft ODBD Driver for SQL Server failed to load. The latest version can be downloaded from https://www.microsoft.com/en-us/download/details.aspx?id=53339.
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Failover partner Down
High availability failure state
This warning is shown when the active Central server went down and a standby Central server took over the service.
For some reasons active server didn’t report and therefore the standby server was activated. The Standby server is
updated and becomes the active server and vice versa. The former active server will be in failed state until it is fixed or
restarted.
License exceeded
This warning is shown when the current license for Men&Mice component has been exceeded. For example, if the
appliance license is only valid for a single appliance, and another appliance is added, then the additional appliance is
not shown. Please contact sales@menandmice.com to resolve the matter.
Multiple PTR records in zone
Orphaned PTR records in zone
Outdated database server version
For Men&Mice Suite version 8.1 and higher we recommend to use only SQL Server 2014 or higher. Support for older
versions will be dropped in version 8.2 of the Men&Mice Suite.
Scope contains inconsistencies that need reconciling
This warning is shown when scope contains inconsistencies and it needs reconciling. See console-dhcp-windowsreconcile and https://technet.microsoft.com/en-us/library/dd183579(v=ws.10).aspx about reconciling a DHCP scope.
Scope is not part of a failover relationship on partner server
This warning is shown when scope is not a part of a failover relationship on partner server, but should be.
Scope pool collision
This warning is shown when one of the following situations occur:
• Scopes in a failover relationship have mismatching address pools or exclusions. Failover scopes should be identical.
• An address pool conflict was detected. Addresses exist in multiple pools without exclusions.
• An address pool conflict was detected. The address pool is not identical across the split scope.
• An address pool conflict was detected.
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Cloud Subnet Collision
Scope reservation mismatch
This warning is shown when DHCP reservations do not match, that is name, MAC address and description are not
identical.
Slave zone not updated from master or is about to expire
This warning is shown when a slave zone is not receiving an update from its master. This warning could also be shown
when a slave zone is not receiving update from its master and is about to expire.
Superscope, subnet, static or dynamic part of scope over utilized
This warning is shown when a specific threshold is reached, that is, not enough IP addresses is available in this range.
To fix this issue remove the scope and create a larger one instead or create a super scope which will join together two
or more scopes for larger one.
Unable to check whether scope contains inconsistencies
This warning is shown when Men&Mice Central can’t connect to the DHCP Server Controller service to check whether
scope contains inconsistencies. The reason could be if the DHCP Server Controller is offline or not turned on.
Unable to check whether scope is part of a failover relationship on partner server
This warning is shown when Men&Mice Central can’t connect to the DHCP Server Controller service to see if a scope
is a part of a failover relationship on partner server. The reason could be if the DHCP Server Controller is offline or
not turned on.
Unable to fetch scope info from partner server
This warning is shown when Men&Mice Central can’t connect to the DHCP Server Controller service to gather scope
info from partner server. The reason could be if the DHCP Server Controller is offline or not turned on.
Unable to get status for DNS or DHCP server
This warning is shown when Men&Mice Central is unable to connect to DNS or DHCP Server Controller to do a status
check for the server. This occurs if the Server Controller is offline, not turned on or has been shut down (in some case
not installed). To fix this issue get the server online again and turn on the remote or (re)install.
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Unable to get status for scope
This error is shown when Men&Mice Central can’t connect to the DHCP Server Controller service to get scope status
from DHCP server. The reason could be if the DHCP Server Controller is offline or not turned on.
Unable to get status for zones
This warning is shown when Men&Mice Central can’t connect to the DNS Server Controller service to get status on
the zones. The reason could be if the DNS Server Controller service is turned off or is offline.
Update available
This warning is shown when new version of Micetro is available. To get this new version go to Tools → Check for
updates in the menu bar and run the update wizard.
Update server unreachable
This warning is shown when Men&Mice Central has lost its connection to Men&Mice update server. It is not mandatory
to have this connection and it can be turned off. To fix this issue make sure that machine running the Men&Mice Update
service and the machine running the Men&Mice Central are listening to the same TCP port. TCP port 4603 is reserved
for the update service but it can be changed if there is another software using that TCP port. See Changing the TCP
port for the Men&Mice Update Service about changing the TCP port.
Zone replication group out of sync
This error is shown when a member of a zone replication group is out of sync.
Zone serial out of date

1.28.6 Dynamic Zones
Overview
Micetro allows you to work with dynamic zones on BIND and the Windows DNS server.
This section describes how Micetro handles dynamic zones and how to configure your DNS server to allow the program
to work with dynamic zones.
Static vs. Dynamic Zones
Due to the nature of dynamic zones, the Management Console must handle such zones differently from static zones.
Below, you will find information on how the software handles dynamic zones compared to static zones.
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Static zones
The zone content is read from disk on the server.
Records can be enabled and disabled. Disabled records
are commented out in the zone files.
Specifying a TTL value for individual records is optional.
Every resource record can have a comment associated
with it.

Dynamic Zones
The zone content is retrieved from the server via a zone
transfer.
Disabling records is not possible.
Every record must have a TTL explicitly set.
Comments are not supported for records.

BIND Server Configuration
The Management Console only supports TSIG signed dynamic updates. Therefore, you will have to create a TSIG key
on each of your master DNS servers. If a TSIG key already exists, the program will use the first key it finds in the server
configuration files (usually in /var/named/conf/user_before)
To create a TSIG key to use with BIND:
1. Check if there is a key already created in /etc/rndc.key (or its equivalent). If there is, simply copy its contents
into the file user_before. Then skip the rest of these instructions.
2. Create a new key using the command rndc-confgen, like this: rndc-confgen -a This will create a file named
rndc.key, typically in either /etc or /etc/bind. The contents of the file will look something like this:
key rndc-key { algorithm hmac-md5; secret "Qqn05iUpjzmNoXxLJi5vXw=="; };
3. (Re)start named (or signal it with either kill –HUP <pid> or rndc reconfig) in order to have it reload its configuration files.
4. Restart mmremoted:
/etc/init.d/mmremote stop /etc/init.d/mmremote start
When you have configured the server, you can change the zone type from static to dynamic by opening the zone options
in the Management Console and changing the zone type to dynamic.
As dynamic zones are transferred from the DNS server using a zone transfer, you should make sure that zone transfers
are allowed to localhost.
Windows DNS Server Configuration
• The Men&Mice Management Console can work with dynamic zones on the Windows DNS server, both AD
integrated zones and file-based zones.
• A new column, Record timestamp, is shown for dynamic zones that are hosted on Windows DNS servers. The
Record timestamp column will show the creation time for records that are added dynamically (dynamic records).
Static records will not have a record timestamp.
• Dynamic zones are transferred from the DNS server using a zone transfer. If you restrict zone transfers from your
DNS server, you should make sure that zone transfers are allowed to the IP Address of the DNS server itself.
• It is not possible to disable dynamic zones that are hosted on the Windows DNS server. This is the only limitation.
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1.28.7 Configuring Amazon Route53
Note: Since the addition of native Route53 support for AWS DNS, the recommended way of adding a Route53 server
to Micetro is through Cloud integration.

1.28.8 Configuring PowerDNS
The PowerDNS connector script connects directly to the MySQL backend and allows management of zones in PowerDNS. Native mode and Master/Slave mode in the authoritative PowerDNS are currently supported.
The installation works as described above. On Linux use the --generic-dns-controller parameter when executing
the installer.
It will then install the base Generic DNS Server Controller, but there are two things you want to tweak:
1. Create working directory and connector script config:
mkdir /var/mmsuite/dns_server_controller
and set the correct ownership.
2. Create a file preferences.cfg in the mmsuite directory and configure the connector script with a XML-tag
as described in Generic DNS Server Controller.
E.g. on Linux:
<GenericDNSScript value="python /your/script/directory/genericDNSPowerDNS.py" />
Download the script from GitHub.
4. Edit the systemd/init script of the controller. Open with an editor, e.g. vi the mmremote init script, which
should be /etc/init.d/mmremote.
5. Search for the line PARAMS="....".
6. Add to the begin of the parameter list your created controller working directory with the -d parameter, .i.e.:
PARAMS="-d /var/mmsuite/dns_server_controller

...rest of the params"

1.28.9 External scripts
Overview
The system can be configured to run external scripts under several conditions:
• When object properties are modified.
• When zone contents are changed.
• When the number of free addresses in subnets go below a set threshold.
Scripts associated with object types are often used to perform lookups in external data sources and return data from
these sources. To configure the system to run a script when properties for an object are modified or when zone contents
are changed, do the following:
1. Log in as Administrator.
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2. From the menu, select Tools, System Settings.
3. In the System settings dialog box, click the External Commands tab.
4. In the applicable field (e.g., Range script, IP Address script, etc.), type the script name and necessary startup parameters. You must enter all information for the script as you would when invoking the script from the command
line. It is assumed that the script is located in the same directory as Men&Mice Central; however, if the script is
stored in a different location, the path for the script must be entered.
Example 1:
Running a script named mytest.vb. To run a script named mytest.vb that is located in the Men&Mice Central
directory using the scripting host cscript, the following would be placed in the appropriate field: cscript /B
mytest.vb
Example 2:
Running an executable named checkdata.exe. To run an executable named checkdata.exe that is located in the
Men&Mice Central directory the following would be placed in the appropriate field: checkdata.exe.
5. Click OK.
To configure the system to run a script when the number of free addresses in a subnet goes below a user-definable
threshold, refer to IP Address Management—Subnet Monitoring and Utilization History.

Script Interfaces
When Men&Mice Central runs an external script, it sends an XML structure as an argument to the script being called.
The XML structure contains information about all custom properties that are defined for the object type. The XML
structure also contains the login name of the user that triggered the script.
The XML structures differs a little depending on the type of script (property change, zone contents change, scope
monitoring).
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Property Change Script Interface
The XML schema for a property change script is as follows:
<?xml version="1.0" encoding="ISO-8859-1"?>
<xs:schema targetNamespace="http://tempuri.org/XMLSchema.xsd" elementFormDefault=
˓→"qualified" xmlns="http://tempuri.org/XMLSchema.xsd" xmlns:mstns="http://tempuri.org/
˓→XMLSchema.xsd" xmlns:xs="http://www.w3.org/2001/XMLSchema">
<xs:element name="externalScriptParameters">
<xs:complexType>
<xs:sequence>
<xs:element ref="customFields" minOccurs="1" maxOccurs="1" />
</xs:sequence>
<xs:attribute name="userName" type="xs:string" />
</xs:complexType>
</xs:element>
<xs:element name="customFields">
<xs:complexType>
<xs:sequence>
<xs:element ref="customField" minOccurs="1" maxOccurs="unbounded" />
</xs:sequence>
</xs:complexType>
</xs:element>
<xs:element name="customField">
<xs:complexType>
<xs:sequence>
</xs:sequence>
<xs:attribute name="customFieldID" type="xs:string" />
<xs:attribute name="customFieldName" type="xs:string" />
<xs:attribute name="objectID" type="xs:string" />
<xs:attribute name="objectType" type="xs:string" />
<xs:attribute name="value" type="xs:string" />
</xs:complexType>
</xs:element>
</xs:schema>
An example XML structure with three custom properties named Location, Country and Region might look as follows:
<?xml version="1.0"?>
<externalScriptParameters username="administrator">
<customFields>
<customField customFieldID="24" customFieldName="Location"
objectID="27" objectType="4" value="location1"></customField>
<customField customFieldID="25" customFieldName="Country"
objectID="27" objectType="4" value=""></customField>
<customField customFieldID="26" customFieldName="Region"
objectID="27" objectType="4" value=""></customField>
</customFields>
</externalScriptParameters>
Upon completion, the script must create a new XML structure and return it to Men&Mice Central. The schema for the
XML structure that is returned is as follows:

1.28. Micetro reference articles

457

Micetro by Menamp;Mice Documentation, Release 10.2

<?xml version="1.0" encoding="ISO-8859-1"?>
<xs:schema targetNamespace="http://tempuri.org/XMLSchema.xsd"
elementFormDefault="qualified" xmlns="http://tempuri.org/
XMLSchema.xsd" xmlns:mstns="http://tempuri.org/XMLSchema.xsd"
xmlns:xs="http://www.w3.org/2001/XMLSchema">
<xs:element name="result">
<xs:complexType>
<xs:choice minOccurs="1" maxOccurs="2">
<xs:element ref="customFields" />
<xs:element ref="error" />
</xs:choice>
<xs:attribute name="success" type="xs:string" />
</xs:complexType>
</xs:element>
<xs:element name="customFields">
<xs:complexType>
<xs:sequence>
<xs:element ref="customField" minOccurs="0" maxOccurs="unbounded"/>
</xs:sequence>
</xs:complexType>
</xs:element>
<xs:element name="customField">
<xs:complexType>
<xs:sequence>
</xs:sequence>
<xs:attribute name="customFieldID" type="xs:string" />
<xs:attribute name="customFieldName" type="xs:string" />
<xs:attribute name="objectID" type="xs:string" />
<xs:attribute name="objectType" type="xs:string" />
<xs:attribute name="value" type="xs:string" />
</xs:complexType>
</xs:element>
<xs:element name="error">
<xs:complexType>
<xs:sequence>
</xs:sequence>
<xs:attribute name="code" type="xs:string" />
<xs:attribute name="message" type="xs:string" />
</xs:complexType>
</xs:element>
</xs:schema>
An example XML structure with three custom properties named Location, Country and region might look as follows:
<?xml version="1.0"?>
<result success="1">
<customFields>
<customField customFieldID="24" customFieldName="loc" objectID="27" objectType="4" value=
˓→"location1"></customField>
<customField customFieldID="25" customFieldName="Country" objectID="27" objectType="4"␣
˓→value="USA"></customField>
<customField customFieldID="26" customFieldName="Region" objectID="27" objectType="4"␣
˓→value="Texas"></customField>
(continues on next page)
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</customFields>
</result>
Men&Mice Central uses the information in the XML structure to update other custom properties or to display an error
message if the success attribute on the result element is set to 0. The following XML example shows how an error
message can be returned by the external script.
<?xml version="1.0"?><result success="0"><error code="1"message="The error message."></
˓→error></result>
The XML structure is not required to return information about all custom properties, only fields that the script has
changed. Unknown property fields are ignored by Men&Mice Central.
Zone Content Change Script Interface
The XML schema for a zone content change script is as follows:
<?xml version="1.0" encoding="ISO-8859-1"?>
<xs:schema targetNamespace="http://tempuri.org/XMLSchema.xsd" elementFormDefault=
˓→"qualified" xmlns="http://tempuri.org/XMLSchema.xsd" xmlns:mstns="http://tempuri.org/
˓→XMLSchema.xsd" xmlns:xs="http://www.w3.org/2001/XMLSchema">
<xs:element name="externalScriptParameters">
<xs:complexType>
<xs:sequence>
<xs:element ref="object" minOccurs="1" maxOccurs="1" />
</xs:sequence>
<xs:attribute name="userName" type="xs:string" />
</xs:complexType>
</xs:element>
<xs:element name="object">
<xs:complexType>
<xs:sequence>
<xs:element name="id" type="xs:integer" minOccurs="1" maxOccurs="1" />
<xs:element name="type" type="xs:integer" minOccurs="1" maxOccurs="1" />
<xs:element name="server" type="xs:string" minOccurs="1" maxOccurs="1" />
<xs:element name="view" type="xs:string" minOccurs="1" maxOccurs="1" />
<xs:element name="zone" type="xs:string" minOccurs="1" maxOccurs="1" />
<xs:element name="fqName" type="xs:string" minOccurs="1" maxOccurs="1" />
</xs:sequence>
</xs:complexType>
</xs:element>
</xs:schema>
An example XML structure for a zone change script might look as follows for a zone that exists in a view:
<?xml version="1.0" encoding="ISO-8859-1"?>
<externalScriptParameters userName="administrator">
<object>
<id>2534</id>
<type>13</type>
<server>bind1.corp.net.</server>
<view>internal</view>
(continues on next page)
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<zone>zone.com.</zone>
<fqName>bind1.corp.net.:internal:zone.com.</fqName>
</object>
</externalScriptParameters>
An example XML structure for a zone change script might look as follows for a zone that is not in a view:
<?xml version="1.0" encoding="ISO-8859-1"?>
<externalScriptParameters userName="administrator">
<object>
<id>2635</id>
<type>13</type>
<server>dns1.corp.net.</server>
<view />
<zone>my.zone.com.</zone>
<fqName>dns1.corp.net.::my.zone.com.</fqName>
</object>
</externalScriptParameters>
A zone content change script does not have any return value.
Subnet Monitoring Script Interface
The XML schema for a subnet monitoring script is as follows:
<?xml version="1.0" encoding="ISO-8859-1"?>
<xs:schema targetNamespace="http://tempuri.org/XMLSchema.xsd" elementFormDefault=
˓→"qualified" xmlns="http://tempuri.org/XMLSchema.xsd" xmlns:mstns="http://tempuri.org/
˓→XMLSchema.xsd" xmlns:xs="http://www.w3.org/2001/XMLSchema">
<xs:element name="scopeMonitor">
<xs:complexType>
<xs:sequence>
<xs:element name="scope" type="xs:string" minOccurs="0" maxOccurs="1" />
<xs:element name="server" type="xs:string" minOccurs="0" maxOccurs="1" />
<xs:element name="superscope" type="xs:string" minOccurs="0" maxOccurs="1" />
<xs:element name="threshold" type="xs:integer" minOccurs="1" maxOccurs="1" />
<xs:element name="available" type="xs:integer" minOccurs="1" maxOccurs="1" />
<xs:element name="fixed" type="xs:boolean" minOccurs="1" maxOccurs="1" />
<xs:element name="thresholdType" type="xs:string" minOccurs="1" maxOccurs="1" />
</xs:sequence>
</xs:complexType>
</xs:element>
</xs:schema>
The value of the thresholdType element will be either static or dynamic depending on whether the threshold being
crossed is one of dynamically allocatable addresses (i.e., available addresses in address pools) or if it is a threshold set
for static addresses (i.e., available addresses outside of address pools).
Note: The global subnet monitor, set through the system settings dialog, is the only one that takes superscopes into
account. When the global subnet monitor actions are performed, due to the conditions being met for a superscope, the
XML generated will contain a <server> tag and a <superscope> tag.
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An example XML structure for a subnet monitoring script might look as follows for scope:
<?xml version="1.0" encoding="ISO-8859-1"?>
<scopeMonitor>
<scope>123.45.67.0/24</scope>
<threshold>20</threshold>
<available>8</available>
<fixed>0</fixed>
<thresholdType>dynamic</thresholdType>
<customFields>
<customField customFieldID="1" customFieldName="Title" objectID="526" objectType="6"␣
˓→value="Your subnet title"></customField>
<customField customFieldID="2" customFieldName="Description" objectID="526" objectType="6
˓→" value="You subnet description"></customField>
<customFields>
</scopeMonitor>
The XML structure is slightly different if a superscope (MS DHCP) or a shared-network (ISC DHCP) configuration is
used. An example XML structure for a scope monitoring script might look as follows for a superscope / shared-network
configuration:
<?xml version="1.0" encoding="ISO-8859-1"?>
<scopeMonitor>
<server>dhcp1.corp.net.</server>
<superscope>office</superscope>
<threshold>20</threshold>
<available>22</available>
<fixed>1</fixed>
<thresholdType>dynamic</thresholdType>
</scopeMonitor>
A subnet monitoring script does not have any return value.
Example Visual Basic Script
The following example script, written in Visual Basic, shows how a script could return different values depending on
the user that is running the script. The script is called when an object property changes.
Dim fso, stdin, stdout, stderr, xmlDoc
'The next four lines connect the script and the "Men&Mice Suite"
Set fso = CreateObject ("Scripting.FileSystemObject")
Set stdin = fso.GetStandardStream (0)
Set stdout = fso.GetStandardStream (1)
Set stderr = fso.GetStandardStream (2)
Set xmlDoc=CreateObject("Microsoft.XMLDOM") xmlDoc.async="false" 'read xml
from MMSuite xmlDoc.loadXml(stdin.ReadAll)
Dim xElLocationCodeField, theCode, xElCustomFields, theUser
'Get the username
theUser = xmlDoc.selectSingleNode("/externalScriptParameters").getAttribute("userName")
'Select all the customfields
(continues on next page)
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Set xElCustomFields = xmlDoc.selectSingleNode("/externalScriptParameters/customFields")
'Get the current value of the location code field
Set xElLocationCodeField = xElCustomFields.selectSingleNode(
˓→"customField[@customFieldName='Location']")
theCode = xElLocationCodeField.getAttribute("value")
Dim success, retVal1, retVal2 success = false
' Very simple logic, here a DB query could be performed or some other lookup
if theCode = "l1" then
retVal1="USA"
retVal2="Washington"
success = true
elseif theCode = "l2" then
retVal1="UK"
retVal2="London"
success = true
end if
' logic ends
Dim xReturnDoc, xElResult
'create return document
Set xReturnDoc = CreateObject("Microsoft.XMLDOM")
Set xElResult = xReturnDoc.createElement("result")
if success then
xElResult.setAttribute "success", "1"
'set the value of xml that we return. It is OK to omit fields that are not changed by␣
˓→script
xElResult.appendChild xElCustomFields.cloneNode(true)
Dim xElChange
Set xElChange = xElResult.selectSingleNode("/customFields/customField[@customFieldName=
˓→'Country']")
xElChange.setAttribute "value", retVal1
Set xElChange = xElResult.selectSingleNode("/customFields/customField[@customFieldName=
˓→'City']")
xElChange.setAttribute "value", retVal2
else
xElResult.setAttribute "success", "0"
'add error element
Dim xElError
Set xElError = xReturnDoc.createElement("error")
xElError.setAttribute "code", "1"
xElError.setAttribute "message", "Unknown location."
xElResult.appendChild xElError
end if
xReturnDoc.appendChild xElResult
(continues on next page)

462

Chapter 1. Table of Contents

Micetro by Menamp;Mice Documentation, Release 10.2

(continued from previous page)

'finally return the xml
stdout.WriteLine xReturnDoc.xml

Example PowerShell Script

Note: Powershell scripts can be run natively by Men&Mice by starting the command with “powershell”, “powershell.exe” or simply with the path to the .ps1 file. Powershell can then read the stdin with [Console]::In.ReadToEnd()

Instructions
1. Copy the psExec.vbs and the ScopeMonScript.ps1 to the c:ProgramDataMen and MiceCentral directory.
2. In Tools->System Settings->Monitoring, add it in the Default scope monitoring settings as follows:
cscript /B /T:120 ./psExec.vbs ScopeMonScript.ps1 ignore ignore
And then configure a dynamic threshold. The monitor will be executed every 10 minutes during the DHCP synchronization interval.
param([Parameter(Mandatory=$false,ValueFromPipeLine=$false)]$UserName = "",
[Parameter(Mandatory=$false,ValueFromPipeLine=$false)]$Password = "",
[Parameter(Mandatory=$false,ValueFromPipeLine=$false)]$xmlFileName = "")
$strInput = get-content $xmlFileName
#$strInput = $args
# write output for troubleshooting in file:
#Add-Content -Path .\monitoroutput.xml $strInput
$strXML = [string]::Join(" ", $strInput)
$objXML = [xml]$strXML
$subnetMonitor = (Select-Xml -XML $objXML -XPath "/subnetMonitor").Node
# Check if it's an alert or fixed message
# The script only cares about alerts
if ($subnetMonitor.fixed -eq "0")
{
$strAlert = "Alert: The following scope or subnet has fewer IPs available than the␣
˓→configured threshold."
# We could send here an email or generate a trap or...
#Send-MailMessage -SmtpServer "smpt.example.com" -From "subnetmonitor@example.com" ˓→To "alert1@example.com;alert2@example.net" -Subject "Subnet Monitor Message" -Body
˓→$strOutput
# First handle the superscopes
if ($subnetMonitor.superscope -ne $null -and $subnetMonitor.superscope -ne "")
{
$strOutput = @"
(continues on next page)
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$strAlert
Superscope: $($subnetMonitor.superscope)
Alert Date:
$(Get-Date -Format G)
Server:
$($subnetMonitor.server)
Threshold:
$($subnetMonitor.threshold)
IPs Available:
$($subnetMonitor.available)
Subnet Type:
$($subnetMonitor.thresholdType)
"@
New-EventLog -Source SubnetMonitor -LogName Application
Write-EventLog -LogName Application -Source SubnetMonitor -EventID 1063 ˓→EntryType Warning -message "$strOutput"
#Add-Content -Path .\superscopemonitor_msg.txt $strOutput
}
else
{
# then in the else clause the normal scopes
$strOutput = @"
$strAlert
Alert Date:
$(Get-Date -Format G)
Scope:
$($subnetMonitor.subnet)
Threshold:
$($subnetMonitor.threshold)
IPs Available:
$($subnetMonitor.available)
Subnet Type:
$($subnetMonitor.thresholdType)
"@
New-EventLog -Source SubnetMonitor -LogName Application
Write-EventLog -LogName Application -Source SubnetMonitor -EventID 1064 ˓→EntryType Warning -message "$strOutput"
#Add-Content -Path .\scopemonitor_msg.txt $strOutput
}
}
else
{
# possible issue fixed message
}

1.28.10 named.conf validation
The Men&Mice DNS Server Controller (mmremote) relies on the BIND tool named-checkconf to verify if the BIND
configuration named.conf is valid.
If the named-checkconf is not found on any of the standard directories during installation (or if the installation is
inside a CHROOT), the Advanced button is not shown.
To fix this, add a configuration parameter pointing to the named-checkconf tool to the DNS Server Controller configuration file preferences.cfg (usually in /var/named/mmsuite/preferences.cfg)
<fingerprint value="<some-hex-values>"/>
<named-checkconf value="/usr/sbin/named-checkconf"/>
Make sure that the named-checkconf tool is executable and reachable for the DNS Server Controller (if the DNSServer
Controller is inside a CHROOT environment, the named-checkconf must also be inside that CHROOT as well as all
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dynamic libraries needed).
Note: After changing the configuration file for the DNS Server Controller, the DNS Server Controller process
(mmremoted) must be started.

1.28.11 Updating timeout value for named-checkconf
To ensure the system runs smoothly, use the Management Console to update the default timeout value for the
named-checkconf files.
1. Log in to the Management Console
2. Navigate to Tools → System Settings → Advanced.
3. Filter the options with “timeout”, and locate the “Timeout in seconds for named-checkconf ” line.
4. Set the value to 300.
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1.28.12 Changing the TCP port for the Men&Mice Update Service
The Men&Mice update service is listening by default on port 4603/TCP. Although the port 4603/TCP is reserved for
the Men&Mice Update service in the IANA database, there might be a different software already running on that port.
The TCP port for the updater service can be changed. It must be changed on the mmupdate service and also on
Men&Mice Central (mmcentral). All remote servers must listen on the same TCP port for update messages from
Men&Mice Central. It is not possible to run the Men&Mice Update service on different ports for different servers.
1. Stop both services, the Men&Mice Central service and the remote Men&Mice updater service.
2. On the machine running the Men&Mice Update service, append the following line to the Men&Mice Updater’s
preferences.cfg file (create the file if it does not exist):
<Arguments value="-p 12345" />
Where 12345 is the TCP port number the Men&Mice update service should use.
3. Start the Men&Mice Update service and check that the process in listening on the new port (using netstat -na
or lsof -i).
4. On the machine running the Men&Mice Central service, append the following line to the Men&Mice Central
preferences.cfg file (create the file if it does not exist):
<UpdateAgentPortNumber value="12345" />
Where 12345 is the TCP port number the Men&Mice update service is using on the remote system(s).
5. Start the Men&Mice Central service.

1.28.13 Setting up a Managed Service Account to run M&M DNS/DHCP Server Controllers
Managed Service Account was introduced in Windows Server 2008 R2. Managed Service Account is managed domain
account that provides the following features to simplify service administration:
• Automatic password management.
• Simplified SPN management, including delegation of management to other administrators. Additional automatic
SPN management is available at the Windows Server 2008 R2 domain functional level.
Managed Service Account is good addition to Local Services to run M&M DNS/DHCP Server Controllers. When
using MSA you gain managed domain account with isolated privileges to run the application.
Step-by-step guide
1. If you are running Windows Server 2012 or newer then the first step is to run:
Add-KdsRootKey -EffectiveTime ((Get-Date).AddHours(-10))
This is because Manage Service Account feature came with Windows Server 2008. But in Windows Server 2012 a new
service called the Key Distribution Service (KDS) came also and needs to be running to create and use Group Manage
Service Accounts.
2. Create new ADServiceAccount:
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New-ADServiceAccount -DNSHostName "yourserver" -Name "name of the service account" ˓→PrincipalsAllowedToRetrieveManagedPassword "here you list your servers ending with '$'␣
˓→and separated with ',' for example: TESTSERVER$, TESTESERVER2$"
3. Install the service account:
Install-ADServiceAccount "name of the service account"
4. Add the right authority to the Managed Service Account:
In Server Manager dashboard click on Tools and choose Active Directory Users and Computers. Click on Users, right
click on the group to add the Managed Service Account to. For example DNSAdmins or DHCP Admins.
5. Add the Managed Service Account to M&M DNS/DHCP Server Controllers:
Go to Services and locate the M&M controllers, right click on them and choose Properties. In the Properties window
click on Log On tab and choose This Account. Fill in the name of the service that was made in step 2. That is
DOMAINServiceAccountName ending with ‘$’ sign. Click OK and restart the M&M DNS/DHCP Server Controller.
To remove Managed Service Account from M&M DND/DHCP Server Controllers run cmd and write in the command:
sc.exe managedaccount "Men&Mice DNS/DHCP Server Controller" false
Information gathered from this Microsoft article.

1.28.14 BIND DNS File Structure
Overview
When Micetro is installed on a server running BIND, it needs to perform several changes to the server configuration file structure. This section describes these changes and includes an overview diagram that shows how the server
configuration files are processed after Micetro has updated the structure.
named.conf
named.conf is split into several files. A new named.conf file that includes statements for all the new files is created.
When named.conf is split up, a new file is created for each zone statement (see Zone Options Files files, below).
The options statement goes into a separate file. That file is modified when the user makes changes to the server options
in the Men&Mice Management Console.
The current version of the Men&Mice Management Console has no interface to change the values of the following
statements: key, acl, controls, server, trusted-keys. Therefore, they are kept in separate files, user_before
and user_after. Micetro does not modify these files.
The hint zone is copied to /var/named/conf/root.hint. That file is modified when the user makes changes in the
Root servers tab in the server options in the Men&Mice Management Console.
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Zone Options Files
A new file, /var/named/conf/zones is created. It contains a list of includes for zone option files which are stored
in the directory /var/named/conf/zoneopt/, one for each zone. The zone options (or definitions) files are called
<zonename>.opt.
Zone Files
No changes are made to the zone files themselves. The installer copies the zone files to different directories, depending
on their types:
• master and forward zones are copied to /var/named/hosts/masters/
• slave and stub zones are copied to /var/named/hosts/slaves/
The new zone file is named <zonename>-hosts.
Configuration Files Diagram
The following diagram provides an overview on how the configuration files are processed after the file structure has
been updated by Micetro.
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1.28.15 Disable “Automatic adjustment of Zone Transfer”
By default, Micetro automatically adjusts zone transfer settings for slave zones. If this is not a desired behavior for your
environment, you can disable it:
1. Log in to the Management Console
2. Navigate to Tools → System Settings → Advanced.
3. Filter the options with “automatically”, and locate the “Automatically adjust local zone transfer settings for
BIND” line.
4. Uncheck the box to disable.

1.28.16 Men&Mice DNS Server Controller and $INCLUDE Directives
BIND supports several extensions to the standard zone file format, known as directives or control statements; all directives start with $. With one exception, the $TTL directive, Micetro doesn’t display these directives in the zone
window.
Instead, when directives other than $TTL are present, the Management Console zone window displays an extra button in
the button bar, on the right end. This button, labeled Zone control statements, brings up a window showing all of these
statements in raw form. The Management Console does not allow these statements to be edited; instead, all editing of
such statements must be done by editing the zone file directly, on the server.
The $INCLUDE directive
This directive tells named to load the contents of another file as part of the zone, using the current origin and default
TTL. Unfortunately, they often cause problems with Men&Mice Suite.
$INCLUDE statements are usually present only if they were present before the DNS Server Controller was installed,
since Men&Mice Management Console doesn’t provide a way to create them. The Men&Mice DNS Server Controller
installer doesn’t parse all of the zone files during installation, so it’s not aware of $INCLUDE directives; therefore, they
usually get left behind in the old copy of the data directory (which is renamed to add “.bak” to the end of its name).
Furthermore, while most affected users realize this, the common mistake is to copy or move the included file into the
same location as the zone file. This is not correct.
Instead, since an included file is usually only specified by name, it must be placed into the root of the data directory tree.
For example, if the zone file is in /var/named/hosts/masters, the included file must be placed in /var/named.
Lastly, it’s possible to use an include file in a way that, while perfectly valid as far as named is concerned, makes the
zone look invalid to Men&Mice Management Console’s syntax check. If the zone’s authority NS records and/or SOA
record are located in an include file, the Management Console will not allow you to save the file. This can be solved
by configuring the DNS Server Controller to (permanently) expand control statements.
Using the $INCLUDE directive with Micetro
The Men&Mice DNS Server Controller can be configured to expand $INCLUDE statements, so that you see the entire
contents of the zone in the zone window.
Note: If you configure Men&Mice DNS Server Controller to expand $INCLUDE statements, it will do so globally, for
all zones. It will also expand all other control statements (not counting the $TTL directive at the top of each zone). The
expansion is permanent, meaning the zone file is actually changed to reflect the effect of the control statement, and the
control statement is removed.
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To follow these instructions, you’ll need to figure out where your named data directory is, which we’ll refer to as
$NAMED. This can be done by examining named.conf. If you’re not sure where named.conf is, examine your DNS
Server Controller (mmremoted) command line (in the output of the appropriate ps command) - it should show the
location of named.conf after -c; if there’s a -t option as well, the named.conf location will be relative to this chroot
jail path. If you don’t see either of these options, the location is /etc/named.conf. (And if this sounds like gibberish
to you, please contact us for help.)
named.conf contains a set of 5 include statements, referring to the absolute path of files in $NAMED/conf/. So if
your $NAMED directory is /var/named, the include statements will look like this:
include
include
include
include
include

"/var/named/conf/logging";
"/var/named/conf/user_before";
"/var/named/conf/options";
"/var/named/conf/user_after";
"/var/named/conf/zones";

Edit the file $NAMED/mmsuite/preferences.cfg. Add the following line:
<ExpandControlStatements value="1"/>
Save the file and restart the DNS Server Controller, using its init script (a file named mmremoted, such as /etc/
init.d/mmremoted, or /Library/StartupItems/mmServerController/mmServerController - the location
is platform-specific). You can then log in with the Management Console to see the effects of this process.
On Mac OS X, use the following shell commands to complete these instructions:
To edit the file:
sudo nano /var/named/mmsuite/preferences.cfg
Within nano, use the keyboard arrow keys to move around, since there’s no mouse support. When you’re done editing,
type control-o to save, followed by the return or enter key to confirm the filename. Then type control-x to exit.
To restart DNS Server Controller:
sudo /Library/StartupItems/mmServerController/mmServerController start

1.28.17 Expanding $GENERATE directives into records
BIND supports several extensions to the standard zone file format, known as directives or control statements; all directives start with $. With one exception, the $TTL directive, Micetro doesn’t display these directives in the zone
window.
Instead, when directives other than $TTL are present, the Management Console zone window displays an extra button in
the button bar, on the right end. This button, labeled Zone control statements, brings up a window showing all of these
statements in raw form. The Management Console does not allow these statements to be edited; instead, all editing of
such statements must be done by editing the zone file directly, on the server.
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The $GENERATE directive
This directive is a shorthand way of entering multiple similar records. The directive is a line that looks like this:
$GENERATE range template
Where “range” is a numeric range such as “1-254” and “template” is a record template. A record template looks like
a normal record (except it doesn’t start on the beginning of a line), but in places where a number from the range is
desired, a “$” is used as a placeholder.
For example:
$GENERATE 1-254 $.0.168.192.in-addr.arpa. PTR host-$.dsl.example.net.
This would create 254 PTR records, all of similar format, looking like this:
1.0.168.192.in-addr.arpa. PTR host-1.dsl.example.net.
2.0.168.192.in-addr.arpa. PTR host-2.dsl.example.net.
[...]
254.0.168.192.in-addr.arpa. PTR host-254.dsl.example.net.
Of course, while these records are generated by named when the zone is loaded, you won’t see them in the zone file.
All you’ll see is the $GENERATE directive.
Using the $GENERATE directive with Micetro
The Men&Mice DNS Server Controller can be configured to expand $GENERATE statements, so that you see the records
thus generated in the zone window. These will be ordinary records, so you can edit them freely.
Note: If you configure Men&Mice DNS Server Controller to expand $GENERATE statements, it will do so globally,
for all zones. It will also expand all other control statements (not counting the $TTL directive at the top of each zone).
The expansion is permanent, meaning the zone file is actually changed to reflect the effect of the control statement, and
the control statement is removed.
To follow these instructions, you’ll need to figure out where your named data directory is, which we’ll refer to as
$NAMED. This can be done by examining named.conf. If you’re not sure where named.conf is, examine your DNS
Server Controller (mmremoted) command line (in the output of the appropriate ps command) - it should show the
location of named.conf after -c; if there’s a -t option as well, the named.conf location will be relative to this chroot
jail path. If you don’t see either of these options, the location is /etc/named.conf. (And if this sounds like gibberish
to you, please contact us for help.)
named.conf contains a set of 5 include statements, referring to the absolute path of files in $NAMED/conf/. So if
your $NAMED directory is /var/named, the include statements will look like this:
include
include
include
include
include

"/var/named/conf/logging";
"/var/named/conf/user_before";
"/var/named/conf/options";
"/var/named/conf/user_after";
"/var/named/conf/zones";

Edit the file $NAMED/mmsuite/preferences.cfg. Add the following line:
<ExpandControlStatements value="1"/>
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Save the file and restart the DNS Server Controller, using its init script (a file named mmremoted, such as /etc/
init.d/mmremoted, or /Library/StartupItems/mmServerController/mmServerController - the location
is platform-specific). You can then log in with the Management Console to see the effects of this process.
On Mac OS X, use the following shell commands to complete these instructions:
To edit the file:
sudo nano /var/named/mmsuite/preferences.cfg
Within nano, use the keyboard arrow keys to move around, since there’s no mouse support. When you’re done editing,
type control-o to save, followed by the return or enter key to confirm the filename. Then type control-x to exit.
To restart DNS Server Controller:
sudo /Library/StartupItems/mmServerController/mmServerController start

1.28.18 Installing Python for Men&Mice Central on Windows
Using LDAP (see Configure LDAP authentication) with Men&Mice Central on a Windows server requires Python to
be installed for all users.
If you haven’t yet installed Python, or just for the current user, follow these steps:
1. Download and run the installer for Python from https://www.python.org/downloads/windows/.
2. On the first screen, select Add Python 3.x to PATH and click Customize installation.

3. Select the optional features. Central only requires pip to be installed.
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4. On Advanced features, enable Install for all users. (Leave the rest unchanged.)

5. Proceed with the installation.
6. Restart Central, if it’s already running.
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1.28.19 Which SNMP OIDs are used by Micetro in IP address and Subnet Discovery
Micetro has the capability to scan a defined list of routers and retrieve the ARP tables and/or the subnets and their
information found on the routers.
To perform this scanning, the following suite of SNMP OIDs are used:
IP-MIB:
• ipNetToMediaPhysAddress: .1.3.6.1.2.1.4.22.1.2
• ipAdEntAddr: .1.3.6.1.2.1.4.20.1.1
• ipAdEntIfIndex: .1.3.6.1.2.1.4.20.1.2
• ipAdEntNetMask: .1.3.6.1.2.1.4.20.1.3
ENTITY-MIB:
• entPhysicalSerialNum: .1.3.6.1.2.1.47.1.1.1.1.11
SNMPv2-MIB:
• sysName: .1.3.6.1.2.1.1.5
CISCO-VLAN-IFTABLE-RELATIONSHIP-MIB:
• cviRoutedVlanIfIndex: .1.3.6.1.4.1.9.9.128.1.1.1.1.3
CISCO-VRF-MIB:
• cvVrfInterfaceType: .1.3.6.1.4.1.9.9.711.1.2.1.1.2
• cvVrfName: .1.3.6.1.4.1.9.9.711.1.1.1.1.2
Note: Each device is only queried once, as the system checks the serial number and the sysName to discover both
physical and virtual switches.
For detailed information on the preferred method of access management, see Access control.

1.28.20 Managing access control in the Management Console
Access control management in the Management Console uses the new access control model, but its features are slightly
different than those available in the Web Application.
Note: Men&Mice recommends configuring and managing access through the Web Application, as the preferred
method. Functionality in the Management Console is mostly implemented in a transitional capacity.
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Key differences between the Web Application and the Management Console
Effective access
In the Management Console’s Tools → User Management, the functionality for Effective access is not available.
Users and groups
In the Management Console’s Tools → User Management, users and groups cannot be edited to assign roles. Instead,
roles need to be configured with users and groups.
Roles
In the Management Console’s Tools → User Management, adding a new role doesn’t allow configuring access for it.
Configuring access in the Management Console
Adding a new role
1. Open Tools → User Management and switch to the Roles tab.
2. Click Add.
3. Fill in the name and description for the role. Optionally, you can add users and groups to the role.
4. Click Ok.
Important: The function for creating the role doesn’t contain options to set access for it in the Management Console.
For configuring access, follow the steps in Configuring access for a role.

Configuring access for a role

Note: Unlike the in Web Application, configuring access for roles is sectioned by object type (i.e. DNS servers, zones,
clouds, etc.).
1. Open Tools → Role access for and select the object type from the menu.
Note: To manage access for Micetro (module access, setting user admins, etc.) use Tools → Micetro access.
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2. In the Access control dialog, you’ll see all roles that have relevant access configured on them.
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3. To configure access for the selected object type to a role:
3/1. Select the role in the top window, or click Add. . . to add a role that doesn’t have access configured
for the object type yet.
3/2. In the bottom panel, select all checkboxes for the access permissions you’d like to enable.
Note: Selecting Deny is the equivalent of Block in the Web Application. See Block permission for more
details. Setting ‘deny’ on a permission will block any other role to overwrite this setting.
4. Click OK when all the desired access permissions are set.
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Removing a role
To remove a role’s access permissions from an object type use the Tools → Role access for menu. Select the role in
the top panel and click on Remove. This will remove all configured access permissions from the role, but not the role
itself.
To remove a role from Micetro use Tools → User Management and click on the Roles tab. Select the role(s) to remove,
and click Remove. This will remove the role and all its configured access permissions from Micetro completely.
Adding users and groups to a role
To add users or groups to a role:
1. Open Tools → User Management.
2. Select the user(s) and/or group(s), click Edit and in the bottom panel select the roles to attach the user(s)/group(s)
to.

3. Click OK to save the new membership settings.
Note: Using the Roles tab of Tools → User Management, examining a role will display the users and groups attached
to the role, but cannot be used for adding users/groups to it.
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1.28.21 Role-based access example
Note: Access management has changed in Micetro 10.1. To view the access management example used in previous
versions, switch to the appropriate version number using the version selector.

Introduction
This article aims to provide practical information on Roles and detailed, step-by-step breakdowns for two scenarios:
creating a new, read-only role for DHCP scopes, and using the built-in DNS viewers role to set up a DNS read-write
role.
The information on this page, and the how-tos presented, will provide a blueprint to customize Micetro to your requirements.
Built-in roles
The seven built-in-roles have been designed to cover most use cases for access control in Micetro. The access settings
for the built-in roles can’t be modified.
Tip: Built-in roles are all General roles and applied to all objects in Micetro, existing or future.
Example: adding a user or group to the Administrators (built-in) role, the user (or group members) automatically gain
administrative access to all objects in Micetro.
User defined roles
As all DDI environments are different, Micetro allows creating flexible user-defined roles.
Tip: Creating new roles requires the Administer users/groups permission.
There are two ways of creating new roles in Micetro:
1. (Preferred) Duplicate an existing role and edit the permissions. See Duplicating a role.
2. Create a completely new role. See Adding a new role.
Tip: Men&Mice recommends using the built-in roles as templates and modifying the permission set for the duplicate
roles.
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Example role configuration: DNS zone read-write
The following steps illustrate how to create a read-write role in Micetro for DNS zones, using a built-in role as a
template.
Tip: Using existing roles as templates makes refining access controls easier, as you can both copy over permissions
and users / groups.
1. Log in to the Web Application.

2. Navigate to Admin → Configuration → Access Management and select Roles.
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3. Press the Create button and select From existing role.

4. From the dropdown Select an existing role, click on DNS Viewers (built-in).
Tip: If you have the role selected in the grid, From existing role will automatically fill in the value for convenience.

5. Edit the Role name.
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Note: When duplicating a role, editing the Description is not available until the new role is created.
6. Select what to copy from the existing role: Permissions (default), Groups, and/or Users.

Note: Duplicating roles will automatically set the role type to General.
7. Click Create to save the new role.
After saving the new role, Micetro will automatically display the Edit role properties dialog for it.
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8. Switch over to the Access tab and enable the following permission:
Group
DNS servers
DNS servers
DNS zones
DNS zones
DNS zones
DNS zones
DNS zones
DNS zones
DNS zones
DNS zones
DNS zones
DNS zones
DNS zones
DNS zones
DNS zones

Permission
Add master zones
Add non-master zones
Edit zone access
List (or view) zone
View zone history
Enable/disable zone
Edit zone options
Delete zone
Enable/disable apex records
Edit apex records
Enable/disable wildcard records
Edit wildcard records
Enable/disable other records
Edit other records
Edit zone properties
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Tip: Clicking the checkbox next to the DNS zones group will automatically select all permissions within the group.

Tip: For a handy reference for available permissions, see Permissions reference.
9. (Optional) Switch to the Groups tab and select the group(s) you’d like to assign to the role.

10. (Optional) Switch to the Users tab and select the user(s) you’d like to assign to the role.
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Tip: Users and groups can be assigned to and removed from roles at any time.
11. Click Save to update the role settings.

Example role configuration: DHCP read-only
This
The following steps illustrate how to create a new, read-only role in Micetro for DHCP scopes only, without using the
built-in role templates.
1. Log in to the Web Application.

2. Navigate to Admin → Configuration → Access Management and select Roles.
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3. Press the Create button and select New role

4. Specify the Role name, e.g. DHCP Read-Only and add a Description.
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Tip: Using descriptive names and clear text for the description makes access management easier.
5. Choose between the General or Specific role types.

Note: The preferred role type in Micetro is the General roles. Specific roles exist to preserve backwards compatibility
and added flexibility to edge use cases.
6. Switch over to the Access tab and enable the following permission:
Group
Ranges and DHCP scopes

Permission
Read scope options
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7. Notice that a blue (i) indicator appears on the top right. Hovering over will show that in order for the selected
permissions to take effect, additional permissions will be set:
Group
Micetro
Micetro
Micetro
DHCP servers
Ranges and DHCP scopes
Address spaces
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Access to IPAM view in web interface
List (or view) DHCP server
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Tip: Micetro will automatically enable these permissions upon saving the new role. You can check the permissions
granted to the role by switching to View defined using the radio button.

Tip: For a handy reference for available permissions, see Permissions reference.
8. (Optional) Switch to the Groups tab and select the group(s) you’d like to assign to the role.

9. (Optional) Switch to the Users tab and select the user(s) you’d like to assign to the role.
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Tip: Users and groups can be assigned to and removed from roles any time.
10. Click Create to create the role.

1.28.22 Discontinuation of support for Internet Explorer
As of the 9.3.0 version of Micetro, Internet Explorer will no longer be supported for the Web Application. Customers
currently using Internet Explorer to access the Web Application will be redirected to the old Web UI.
Microsoft has discouraged users from using Internet Explorer as their browser. While security and reliability updates are
and will be still available for Internet Explorer, in sync with its respective OS version, functionality updates have been
discontinued in favor of Edge. Modern web technologies have passed Internet Explorer and are now either unsupported
or completely incompatible with it.
Men&Mice has been supporting Internet Explorer to cover environments where legacy systems need to be managed
or used. The development to the new Web Application, however, reached a point where Internet Explorer is simply
no longer available for reliable use. The Men&Mice Web Application uses web technologies that IE isn’t compatible
with.
To ensure that your Men&Mice installation can take advantage of all the features Men&Mice offers, please update to
Edge or a similar modern browser.
Alternatives
The Men&Mice Web Application supports modern web browsers:
• Microsoft Edge
• Mozilla Firefox
• Google Chrome
• Apple Safari
See system-requirements for a full list of supported systems and applications.
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1.28.23 Setting up the PostgreSQL High Availability environment
Important: Configuring high availability for the database is the responsibility of your database team. The following
information illustrates a possible setup using pg_auto_failover to create a high availability database cluster.
While all possible steps were taken to verify its accuracy, Men&Mice assumes no responsibility for the setup herein.

Install pg_auto-failover
Note: The setup presented here will establish resilience against losing any one of the configured three nodes. Refer
to the pg_auto_failover documentation for more details about different configurations.

Table 15: Variables
Description
The port number that will be used for communication between
database nodes
[monitor]
The monitor node’s machine hostname
[node-1]
The primary node’s machine hostname
[node-2]
The secondary node’s machine hostname
[ip-address-monitor-machine]
The monitor node’s machine IP address
[ip-address-node-1]
The machine’s IP address of node-1
[ip-address-node-2]
The machine’s IP address of node-2
[monitor_node_password]
The monitor node’s password to its database. This password cannot
contain the *@* character.
[replication-password]
The password used for replication between nodes
[postgres-password]
The password used to access the mmsuite database
[ip-address-of-central-primary]
The IP address of the primary machine running Central
[ip-address-of-central-secondary]
The IP address of the machine running the secondary Central
[pre-existing-database-port]
The port of the pre-existing database (if any)
Name
[port]

Example value
5000
postgresql-node-0
postgresql-node-1
postgresql-node-2
172.17.0.2
172.17.0.3
172.17.0.4
test123
vg8@urenHfhk
postgres
172.17.0.5
172.17.0.6
5432

Make sure that the hostnames are resolvable between all three machines along with the machine running Central (and the
second instance if Central is running in HA mode). If that is not possible, using the ip-addresses instead of hostnames
is allowed.
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Install requirements
Install sudo and which:
yum install sudo
yum install which
Enable the package repository that distributes pg_auto_failover:
curl https://install.citusdata.com/community/rpm.sh | sudo bash
Install pg_auto_failover for PostgreSQL 12:
sudo yum install -y pg-auto-failover10_12
If you will be using hostnames, edit /etc/hosts:
echo "[ip-address-monitor-machine] [monitor]" >> /etc/hosts
echo "[ip-address-node-1] [node-1]" >> /etc/hosts
echo "[ip-address-node-2] [node-2]" >> /etc/hosts

Note: You can use the commands pg_autoctl stop and pg_autoctl drop node --destroy to start with a clean
slate and get rid of everything that might have been set up previously.

Machine: monitor
Switch to user postgres and export pgsql path:
sudo su - postgres
export PATH="$PATH:/usr/pgsql-12/bin"
Set up a monitor node:
pg_autoctl create monitor --pgdata ./[monitor] --pgport [port] --nodename [monitor]
--auth scram-sha-256
Next, the pg_hba.conf file needs to be edited to allow connection in from the two nodes:
echo "host pg_auto_failover autoctl_node [ip-address-node-1]/32 scram-sha-256" >> ./
[monitor]/pg_hba.conf
echo "host pg_auto_failover autoctl_node [ip-address-node-2]/32 scram-sha-256" >> ./
[monitor]/pg_hba.conf
Edit the postgresql.conf file to allow scram-sha-256 authentication:
vi ./[monitor]/postgresql.conf
# uncomment the line and set
# password_encryption = 'scram-sha-256'
# uncomment the line and set
# listen_addresses = '*'
# save the file and restart
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pg_ctl restart -D ./[monitor]
Still running as user postgres, set the database user password in the monitor database:
psql -p [port] -d pg_auto_failover
ALTER USER autoctl_node PASSWORD '[monitor_node_password]';
\q

Machine: node-1
Switch to user postgres and export pgsql path:
sudo su - postgres
export PATH="$PATH:/usr/pgsql-12/bin"
Set up a primary node:
pg_autoctl create postgres --pgdata ./[node-1] --pgport [port] --pgctl `which pg_ctl`
--nodename [node-1] --monitor postgres://autoctl_node:[monitor_node_password]@[monitor]:[port]/
pg_auto_failover --auth scram-sha-256
Set up a replication password
pg_autoctl config set replication.password [replication-password] --pgdata ./[node-1]
Edit the postgresql.conf file to allow scram-sha-256 authentication:
vi ./[node-1]/postgresql.conf
# uncomment the line and set
# password_encryption = 'scram-sha-256'
# uncomment the line and set
# listen_addresses = '*'
# save the file and restart
pg_ctl restart -D ./[node-1]
Still running as user postgres, set the database user password in the database:
psql -p [port]
ALTER USER pgautofailover_replicator PASSWORD [replication-password];
ALTER USER postgres PASSWORD [postgres-password];
\q
Run the primary node in the background:
pg_autoctl run --pgdata ./[node-1]/ &
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Machine: node-2
sudo su - postgres
export PATH="$PATH:/usr/pgsql-12/bin"
pg_autoctl create postgres --pgdata ./[node-2] --pgport [port] --pgctl `which pg_ctl` -˓→nodename [node-2] --monitor postgres://autoctl_node:[monitor_node_
˓→password]@[monitor]:[port]/pg_auto_failover --auth scram-sha-256
pg_autoctl config set replication.password [replication-password] --pgdata ./[node-2]
pg_autoctl run --pgdata ./[node-2]/ &

Machine: monitor
Show state to verify the setup:
pg_autoctl show state --pgdata ./[monitor]
Name
|
Port
| Group | Node |
Current State |
Assigned␣
˓→State
---------------------------+-----------+-------+-------+-------------------+------------˓→----[node-1]
|
[port] |
0 |
1 |
primary |
␣
˓→primary
[node-2]
|
[port] |
0 |
1 |
secondary |
␣
˓→secondary

Set up the mmsuite database and edit config files
Machine: node-1
Enter the postgresql database as user postgres:
psql -p [port]
> CREATE DATABASE mmsuite ENCODING = 'LATIN1' LC_CTYPE = 'POSIX' LC_COLLATE='POSIX'␣
˓→TEMPLATE template0;
> GRANT ALL PRIVILEGES ON DATABASE mmsuite TO postgres;
Edit the pg_hba.conf to allow access to the database from the outside:
echo "host mmsuite postgres [ip-address-of-central-primary]/32 scram-sha-256" >> ./[node˓→1]/pg_hba.conf
echo "host mmsuite postgres [ip-address-of-central-secondary]/32 scram-sha-256" >> ./
˓→[node-1]/pg_hba.conf
psql -p [port] -c 'SELECT pg_reload_conf();'
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Machine: node-2
Edit the pg_hba.conf to allow access to the database from the outside:
echo "host mmsuite postgres [ip-address-of-central-primary]/32 scram-sha-256" >> ./[node˓→2]/pg_hba.conf
echo "host mmsuite postgres [ip-address-of-central-secondary]/32 scram-sha-256" >> ./
˓→[node-2]/pg_hba.conf
psql -p [port] -c 'SELECT pg_reload_conf();'

Further information
Connect Central to the PostgreSQL high availability cluster
Machine: monitor
To see the connection string we run this command on the monitor machine:
pg_autoctl show uri --formation default --pgdata ./[monitor]
The connection string will look somewhat like this:
postgres://[node-1]:[port],[node-2]:[port]/postgres?target_session_attrs=read-write
But we have to change to this (postgres to mmsuite):
postgres://[node-1]:[port],[node-2]:[port]/mmsuite?target_session_attrs=read-write

Machine: central-primary
Update the /etc/hosts file:
echo "[ip-address-node-1] [node-1]" >> /etc/hosts
echo "[ip-address-node-2] [node-2]" >> /etc/hosts
Add this to the Men&Mice Central preferences.cfg file:
<Database value="postgresql"/>
<DatabaseServer value="postgres://[node-1]:[port],[node-2]:[port]/mmsuite?target_session_
˓→attrs=read-write" />
<DatabaseUsername value="postgres" />
<DatabasePassword value="plaintext:[postgres-password]" />
<DatabaseConnectionPolling value="1" />
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Machine: central-secondary
Update the /etc/hosts file:
echo "[ip-address-node-1] [node-1]" >> /etc/hosts
echo "[ip-address-node-2] [node-2]" >> /etc/hosts
Add this to the Men&Mice Central preferences.cfg file:
<Database value="postgresql"/>
<DatabaseServer value="postgres://[node-1]:[port],[node-2]:[port]/mmsuite?target_session_
˓→attrs=read-write" />
<DatabaseUsername value="postgres" />
<DatabasePassword value="plaintext:[postgres-password]" />
<DatabaseConnectionPolling value="1" />

Migrate data from another database
The new PostgreSQL High Availability setup has the database mmsuite but with no data. If you have a pre-existing
database you need to migrate the data to the new setup.
Create a dump using pg_dump:
pg_dump -U postgres -p [pre-existing-database-port] -O mmsuite > mmsuite_dump.sql
If you’ve already created the mmsuite database in the HA PostgreSQL server, first drop it and recreate:
psql -U postgres -p [port] -c "DROP DATABASE mmsuite;"
psql -U postgres -p [port] -c "CREATE DATABASE mmsuite ENCODING = 'LATIN1' LC_CTYPE =
˓→'POSIX' LC_COLLATE='POSIX' TEMPLATE template0;"
Finally execute the commands in the dump file to copy the data:
psql -U postgres -p [port] -d mmsuite -f mmsuite_dump.sql

PostgreSQL HA tweaks
Lower timeout threshold
Machine: monitor
We want to lower the database timeout value, i.e. when the failover should be performed if the primary database is
unreachable:
psql -p [port] -d pg_auto_failover
# List the health_check variables
SELECT name, setting FROM pg_settings WHERE name ~ 'pgautofailover\.health';
# Check status of database every 5s, setthe timeout to 2s and set the node unhealthy␣
˓→timeout to 5s
ALTER SYSTEM SET pgautofailover.health_check_period TO 5000;
ALTER SYSTEM SET pgautofailover.health_check_timeout TO 2000;
(continues on next page)
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ALTER SYSTEM SET pgautofailover.node_considered_unhealthy_timeout TO 5000;
# Reload config:
select pg_reload_conf();
# Verify changes
SELECT name, setting FROM pg_settings WHERE name ~ 'pgautofailover\.health';
SELECT name, setting FROM pg_settings WHERE name ~ 'pgautofailover\.node';

Create a startup service
For each machine create a startup service that runs the pg_autoctl process:
Machine: monitor
pg_autoctl -q show systemd --pgdata /var/lib/pgsql/[monitor]/ | sudo tee /etc/systemd/
˓→system/pgautofailover.service
systemctl enable pgautofailover.service

Machine: node-1
pg_autoctl -q show systemd --pgdata /var/lib/pgsql/[node-1]/ | sudo tee /etc/systemd/
˓→system/pgautofailover.service
systemctl enable pgautofailover.service

Machine: node-2
pg_autoctl -q show systemd --pgdata /var/lib/pgsql/[node-2]/ | sudo tee /etc/systemd/
˓→system/pgautofailover.service
systemctl enable pgautofailover.service

Configuring PostgreSQL logging
Machine: monitor
sudo su - postgres
export PATH="$PATH:/usr/pgsql-12/bin"
psql -p [port]
ALTER SYSTEM SET log_truncate_on_rotation = 'on';
ALTER SYSTEM SET log_filename = 'postgresql-%a.log';
ALTER SYSTEM SET log_rotation_age = '1440';
ALTER SYSTEM SET log_line_prefix = '%m - %l - %p - %h - %u@%d - %x';
ALTER SYSTEM SET log_directory = 'pg_log';
ALTER SYSTEM SET log_min_messages = 'WARNING';
ALTER SYSTEM SET log_min_error_statement = 'NOTICE';
(continues on next page)

1.28. Micetro reference articles

497

Micetro by Menamp;Mice Documentation, Release 10.2

(continued from previous page)

ALTER SYSTEM SET log_min_duration_statement = '10s';
ALTER SYSTEM SET log_checkpoints = 'on';
ALTER SYSTEM SET log_lock_waits = 'on';
ALTER SYSTEM SET log_temp_files = '0';
ALTER SYSTEM SET log_connections=on;
ALTER SYSTEM SET log_disconnections=on;
ALTER SYSTEM SET log_duration=on;
SELECT pg_reload_conf();

Machine: node-1
sudo su - postgres
export PATH="$PATH:/usr/pgsql-12/bin"
psql -p [port]
ALTER SYSTEM SET log_truncate_on_rotation = 'on';
ALTER SYSTEM SET log_filename = 'postgresql-%a.log';
ALTER SYSTEM SET log_rotation_age = '1440';
ALTER SYSTEM SET log_line_prefix = '%m - %l - %p - %h - %u@%d - %x';
ALTER SYSTEM SET log_directory = 'pg_log';
ALTER SYSTEM SET log_min_messages = 'WARNING';
ALTER SYSTEM SET log_min_error_statement = 'NOTICE';
ALTER SYSTEM SET log_min_duration_statement = '10s';
ALTER SYSTEM SET log_checkpoints = 'on';
ALTER SYSTEM SET log_lock_waits = 'on';
ALTER SYSTEM SET log_temp_files = '0';
ALTER SYSTEM SET log_connections=on;
ALTER SYSTEM SET log_disconnections=on;
ALTER SYSTEM SET log_duration=on;
SELECT pg_reload_conf();

Machine: node-2
sudo su - postgres
export PATH="$PATH:/usr/pgsql-12/bin"
psql -p [port]
ALTER SYSTEM SET log_truncate_on_rotation = 'on';
ALTER SYSTEM SET log_filename = 'postgresql-%a.log';
ALTER SYSTEM SET log_rotation_age = '1440';
ALTER SYSTEM SET log_line_prefix = '%m - %l - %p - %h - %u@%d - %x';
ALTER SYSTEM SET log_directory = 'pg_log';
ALTER SYSTEM SET log_min_messages = 'WARNING';
ALTER SYSTEM SET log_min_error_statement = 'NOTICE';
ALTER SYSTEM SET log_min_duration_statement = '10s';
ALTER SYSTEM SET log_checkpoints = 'on';
ALTER SYSTEM SET log_lock_waits = 'on';
ALTER SYSTEM SET log_temp_files = '0';
ALTER SYSTEM SET log_connections=on;
ALTER SYSTEM SET log_disconnections=on;
(continues on next page)
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ALTER SYSTEM SET log_duration=on;
SELECT pg_reload_conf();

PostgreSQL HA operations
Triggering a failover
To call the function successfully, you need to figure out the formation and group of the group where the failover happens.
The following commands when run on a pg_auto_failover keeper node provide for the necessary information:
Machine: node-1
Get the variables [formation] and [group] from these commands:
su - postgres
export PATH="$PATH:/usr/pgsql-12/bin"
# [formation] -> the default value is 'default'
pg_autoctl config get pg_autoctl.formation --pgdata ./[node-1]
# [group] -> the default value is '0'
pg_autoctl config get pg_autoctl.group --pgdata ./[node-1]

Machine: monitor
sudo su - postgres
export PATH="$PATH:/usr/pgsql-12/bin"
psql -p [port] -d pg_auto_failover
> select pgautofailover.perform_failover(formation_id => '[formation]', group_id =>␣
˓→[group]);

Implementing a controlled switchover
It is generally useful to distinguish a controlled switchover from a failover. In a controlled switchover situation it is
possible to organize the sequence of events in a way to avoid data loss and lower downtime to a minimum. In the case of
pg_auto_failover, because we use synchronous replication, we don’t face data loss risks when triggering a manual
failover. Moreover, our monitor knows the current primary health at the time when the failover is triggered and drives
the failover accordingly. So to trigger a controlled switchover with pg_auto_failover you can use the same API as
for a manual failover above.
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Maintenance of a secondary node
It is possible to put a secondary node in any group in a MAINTENANCE state so that the Postgres server is not doing
synchronous replication anymore and can be taken down for maintenance purposes, such as security kernel upgrades
or the like.
Machine: node-1 | node-2
To enable maintenance we use:
pg_autoctl enable maintenance --pgdata ./[node-1 | node-2]
When a standby node is in maintenance, the monitor sets the primary node replication to WAIT_PRIMARY: in this
role, the PostgreSQL streaming replication is now asynchronous and the standby PostgreSQL server may be stopped,
rebooted, etc.
Note: pg_auto_failover does not provide support for primary server maintenance.
To disable maintenance we use
pg_autoctl disable maintenance --pgdata ./[node-1 | node-2]

Show current state and events
$ pg_autoctl show state --pgdata [monitor | node-1 | node-2]
$ pg_autoctl show events --pgdata [monitor | node-1 | node-2]

Monitoring pg_auto_failover in production
The monitor reports every state change decision to a LISTEN/NOTIFY channel named state. PostgreSQL logs on the
monitor are also stored in a table, pgautofailover.event, and broadcast by NOTIFY in the channel log.
Machine: monitor
sudo su - postgres
tail -f ./[monitor]/pg_log/postgresql-[WeekDay].log
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Possible disaster scenarios

Failure of:
PSQL database service

Server shutdown

Server reboot

pg_autoctl
corrupted and/or deleted

Machine
affected
Primary
Secondary
Monitor
Primary
Secondary
Monitor
All
Primary
Secondary
Monitor
All
All

HA system response
Failover, automatic service reboot. Replication stops in the meantime.
Automatic service reboot. Replication stops in the meantime.
Automatic service reboot. Replication continues but no failover possible
in the meantime.
Failover. Replication stops, waits for a signal from secondary.
Replication on primary stops. Waits for a signal from secondary.
The primary database is still usable. Primary and secondary nodes wait for
a connection to monitor. Replication continues.
Database unavailable, no replication, no failover possible.
Failover, automatic service reboot on startup.
Automatic service reboot. Replication stops in the meantime.
Automatic service reboot. Replication continues but no failover possible
in the meantime.
Database unavailable, no replication, no failover possible.
Database unavailable, no replication, no failover possible.

Controlled switchover

Note: In a controlled switchover situation it is possible to organize the sequence of events in a way to avoid data loss
and lower downtime to a minimum. Because the HA cluster described here uses synchronous replication, triggering a
manual failover doesn’t risk data loss risks. The monitor server keeps the current primary health at the time when the
failover is triggered, and drives the failover accordingly.
Triggering a controlled switchover is the same as a manual failover described above.
Recovery
Database service failure
If the PostgreSQL database fails on one of the machines, the system will automatically reboot the affected service, but
the replication process is unavailable for the duration.
Server shutdown
If either of the component machines is shut down, a manual restart is required. The failover processes will automatically
start with the machine, and reinitialize the connections. If only the monitor server is affected, replication continues and
failover is still possible.

1.28. Micetro reference articles

501

Micetro by Menamp;Mice Documentation, Release 10.2

Server reboot
The failover system is configured to automatically restart with the server, and no manual intervention is required. If
only the monitor server is affected, replication continues but no failover can be triggered until it’s available.
pg_autoctl setup failure
On the current primary database machine:
/usr/pgsql-12/bin/postgres -D /var/lib/pgsql/[node-?] -p [port]
Edit the preferences.cfg file for Central, and change the following line, using the connection string:
postgres://[node-?]:[port]/mmsuite?target_session_attrs=read-write
Restart Central:
systemctl restart mmcentral

Complete shutdown
If the startup scripts are correct in all of the machines a manual boot of the machines in the correct order (1. monitor; 2.
primary; 3. secondary) will be enough to reinitialize the cluster. On each machine, use the ps -ef | grep monitor
(or primary/secondary) command after boot to verify the pg_autoctl process is running.
If something’s not working, or you’d like to manually restart the services to recover, follow these steps.
Note: You can create bash scripts of each step to execute instead of manually running through them.
Start the monitor machine:
sudo su - postgres
export PATH="$PATH:/usr/pgsql-12/bin"
pg_autoctl run --pgdata ./[monitor]/
Start the primary machine:
sudo su - postgres
export PATH="$PATH:/usr/pgsql-12/bin"
pg_autoctl run --pgdata ./[node-1]/
If an error message states an instance is already running, remove the referenced file:
rm /tmp/pg_autoctl/var/lib/pgsql/[node-1]/pg_autoctl.pid
And re-run the application:
pg_autoctl run --pgdata ./[node-1]/
Start the secondary machine(s):
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sudo su - postgres
export PATH="$PATH:/usr/pgsql-12/bin"
pg_autoctl run --pgdata ./[node-2]/
If an error message states an instance is already running, remove the referenced file:
rm /tmp/pg_autoctl/var/lib/pgsql/[node-2]/pg_autoctl.pid
And re-run the application:
pg_autoctl run --pgdata ./[node-2]/

1.28.24 Always On Availability Groups
Important: Configuring high availability for the database is the responsibility of your database team.
While all possible steps were taken to verify accuracy, Men&Mice assumes no responsibility for the information herein.

Note: Please note that Always On Availability Groups are only supported for Men&Mice Central running on Linux.
Men&Mice Central supports the use of Always On Availability Groups (v9.3.0 and above), In case of a failover the
Men&Mice Central will refresh its database connections to the new primary replica.
To use Always On Availability Groups, change the DatabaseServer value in the preferences.cfg to the virtual IP address
or the FQDN of the availability group listener:
<DatabaseServer value="virtual ip/fqdn of availability group listener><,port>\<Instance␣
˓→name>@<Database name>" />
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